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INTRODUCTION 
 
This Data Acquisition and Processing Report outlines the acquisition and processing procedures used for 
Hydrographic projects surveyed in 2009 by the NOAA Ship Fairweather.  

Survey specific details will be listed in Descriptive Reports as needed.  Unless otherwise noted, the acquisition 
and processing procedures used and deliverables produced are in accordance with the NOAA Hydrographic 
Survey Specifications and Deliverables Manual (HSSD) April 2009, the Field Procedures Manual (FPM), May 
2009, and all active Hydrographic Surveys Technical Directives (HTD). 
 
Any additions and changes to the following will be included with the individual Descriptive Reports. 
  

A EQUIPMENT 
 
Detailed descriptions of the equipment and systems, including hardware and software, used for bathymetric data 
acquisition, horizontal and vertical control operations, shoreline acquisition, and processing are listed below. 
 
1.0 Hardware 
 
The hardware listed in this section was used throughout the 2009 field season. 

1.1 Hardware Systems Inventory 
 
Detailed hardware information, including installation dates and serial numbers, is included in Appendix I of this 
report. Manufacturer’s product specifications are included in Appendix II. 

1.2 Echo Sounding Equipment 

1.2.1 RESON 8111ER Multibeam Echosounder (MBES) 
 
Fairweather is equipped with a RESON SeaBat 8111 MBES with the Extended Range (ER) and snippet options.  
The 8111ER is a 100 kHz multibeam system with swath coverage of 150°.  The swath is made up of 101 discrete 
beams with an along-track and across-track beamwidth of 1.5°.  It has a specified depth range of 3 to 1200 meters, 
though the typical operational depth range of the 8111ER on the Fairweather is 20 to 300 meters.  No calibration 
information was provided by the manufacturer for the system. 
 
The 8111ER is hull-mounted within a reinforced projection that extends 27 inches below the keel.  It is located 
39.5” starboard of the centerline at approximately frame 29 (see Figures 1 & 2).   
 

1.2.2 RESON 8160 Multibeam Echosounder (MBES) 
 
Fairweather is equipped with a RESON SeaBat 8160 MBES with the snippet option.  The 8160 is a 50 kHz 
multibeam system with a swath coverage of greater than 4x water depth.  Each swath is made up of 126 discrete 
beams with an along-track and across-track beamwidth of 1.5°.  It has a specified depth range of 10 to 3000 
meters, though the typical operational depth range of the RESON 8160 on Fairweather is 300 to 1000 meters. No 
calibration information was provided by the manufacturer of the system. 
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The 8160 is hull-mounted within a reinforced projection that extends 13.6 inches below the keel.  It is located 54 
inches port of the centerline at approximately frame 29 (see Figures 3 & 4).   
 
 

    
Figure 1: RESON SeaBat 8111ER MBES Figure 2: RESON SeaBat 8111ER MBES on 

Fairweather 
 
 
 

  
Figure 3: RESON SeaBat 8160    Figure 4: RESON SeaBat 8160 on Fairweather 

 

 

1.2.3 RESON 8101ER Multibeam Echosounder (MBES) 
 
Survey Launches 1010 and 1018 are each equipped with a RESON SeaBat 8101 MBES with the Extended Range 
and snippet option.  The 8101ER is a 240 kHz multibeam system with a swath coverage of 150°.  The swath is 
made up of 101 discrete beams with an along-track and across-track beamwidth of 1.5°.  It has a specified depth 
range of up to 500 meters.  The typical operational depth range of the RESON 8101 on launches 1010 and 1018 is 
3 to 100 meters.  Under optimal conditions with a hard bottom, high power and high gain, the depth range of the 
8101 ER was observed to be as deep as 350 m producing a swath of ±45º from nadir.  No calibration information 
was provided by the manufacturer for the system. 
 
Each system is attached to a launch using a swing mount which is starboard of the keel and approximately 
centered fore and aft (see Figures 5 & 6).   
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     Figure 5: Launch 1010 with 8101 extended        Figure 6: Launch 1010 with 8101 retracted 
 

1.2.4 RESON 8125 Multibeam Echosounder (MBES) 
 
Survey Launch 1018 can be equipped with a RESON SeaBat 8125 MBES with snippet option.  The 8125 is a 455 
kHz multibeam system with swath coverage of 120°.  The swath is made up of 240 discrete beams with an along-
track beamwidth of 1° and an across-track beam spacing of 0.5°.  It has a maximum range scale of 120 meters for 
surveying depths less than 60 meters with a complete swath.  The typical operational depth range of the 8125 on 
launch 1018 is 3 to 50 meters.  No calibration information was provided by the manufacturer for the system. 
 
The system is attached to the launch using a bolted-on sled mount which is on the port side of the keel and 
approximately centered fore and aft (see Figure 7).   
 
 

 
Figure 7: Launch 1018 with 8125 

 

1.2.5 Odom Echotrac CVM (VBES) 
 
The Odom Echotrac CVM Vertical Beam Echo Sounder (VBES) is portable (Figure 8), and is intended for use 
during shoreline acquisition or as necessary with vessels 2302 and 1706. The CVM vertical beam system can 
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utilize either a 4 degree or a smaller 9 degree 200 kHz side mounted transducer and has a depth range up to 180 
meters (Figure 9). The CVM links directly into one Trimble Pathfinder® Pro XRS unit for positioning and 
provides a real-time bottom profile. Files are logged in Hypack as BIN files to obtain accurate depth records for 
the Shoreline NALL Buffer, VBES mainscheme, and/or VBES crosslines.  
 

 

               Figure 8: Odom Echotrac CVM                     Figure 9: Four degree (left) & nine degree transducers 
 
 

1.2.6 Klein Series 5000 Side Scan Sonar 
 
The Klein Series 5000 Sonar System consists of a side scan sonar instrument-mounted towfish (Figure 10), a 
Transceiver and Processing Unit (TPU), and Windows-based computer for display and control, along with a tow 
cable and various interconnect cables.  The 5000 series operates at a nominal frequency of 500 kHz (455 kHz 
actual) and has a depth rating to 200 meters. It is software driven on a PC platform employing Klein's SonarProtm 
software.  Files are logged in SDF format and converted into Caris HIPS and SIPS using the Conversion Wizard. 
 
Preliminary testing of the Klein 5000 occurred in May 2009. Full testing and documentation will be conducted 
prior to data collection and system utilization. 
 
The towfish can be used in one of two configurations, hull-mounted on launch 1018 or towed from Fairweather.  
In the hull-mounted configuration the towfish is bolted to a sled on the bottom of the launch.  The sled is situated 
to port of the keel and is approximately centered fore and aft.  In the towed configuration the towfish is fitted with 
a K-wing depressor and affixed to armored coaxial cable for deployment from Fairweather’s  A-frame.  The 
amount of tow cable being used is manually entered into SonarProtm for towfish layback calculation. 
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Figure 10: Klein 5000 Side Scan Sonar 

 

1.3 Manual Sounding Equipment  

1.3.1 Diver’s Least Depth Gauge 
 
The diver’s least depth gauge (DLDG) is a hand-held device that uses pressure to determine depth of water over a 
discrete point (e.g. mast of a shipwreck).  A raw sounding obtained during a dive is corrected with verified tides 
and Conductivity/Temperature/Depth (CTD) information acquired in the vicinity of the object.  
 
The divers least depth gauge (see Figure 11) was calibrated by PTC Electronics Incorporated on April 2, 2008, 
documentation is included in Appendix V.  Prior to field season use on April 22, 2009, raw DLDG sounding with 
simultaneous lead line readings allowed for comparison measurements for check purposes to ensure appropriate 
readings, the associated Divers Least Depth Gauge Report is include in Appendix V.  Depths acquired with the 
DLDG are processed using the same procedures as other shoreline features that require tide correction as 
described in section B.2.2 of this report.  
 
During projects that required DLDG use, periodic quality assurance checks are conducted as outlined in section 
1.5.6 of the FPM.  Daily DQA checks and pre and post dive DQAs are performed.  Documentation and DQA files 
are included with the individual descriptive reports with the Sound Speed DQA data for the particular surveys that 
required the use of the DLDG. 
 
 

 
Figure 11: Diver's least depth gauge 
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1.3.2 Lead Lines 
 
Vessels 1010, 1018, 1706, and 2302 are each equipped with a lead line.  Lead lines are used for depth 
measurements near shore over submerged shoals and for echosounder depth comparisons.   
 
Leadlines were created, measured and calibrated according to Section 1.5.3 of the FPM with the exception that the 
lines were calibrated to the meter instead of decimeter.  Calibration was performed during April 2009.  Calibration 
reports for the leadlines are included in Appendix V.     

1.4 Positioning, Heading, and Attitude Equipment 

1.4.1 TSS Positioning and Orientation System for Marine Vehicles (POS/MV) 
 
Fairweather and her launches are each equipped with a TSS POS/MV 320 V4, configured with TrueHeave™.  
The POS/MV calculates position, heading, attitude, and vertical displacement (heave) of a vessel.  It consists of a 
rack mountedPOS Computer System (PCS) (Hardware Version 2.9-7 on Fairweather and version 2.6-7 on both 
Launches), a strap down IMU-200 Inertial Measurement Unit (IMU), and two GPS antennas corresponding to 
GPS receivers in the PCS.  The port side antenna is designated as the primary receiver, and the starboard side 
antenna is the secondary receiver (see Figures 12 & 13).  Differential correctors are supplied to the POS MV by a 
CSI wireless MBX-3S Automatic Differential GPS receiver. The POS MV firmware version 3.42 and the 
controller software version 4.0.2.0 are currently the installed versions utilized. 
 
For all multibeam systems aboard Fairweather and her launches, timing between the sonar swath, position, 
heading and attitude information was synchronized by utilizing the proprietary UTC string from POS/MV 320 
v.4’s.  A timing string is sent from the POS/MV to the RESON topside unit via serial connection and to the 
Hypack acquisition computer via ethernet.  Vessel wiring diagrams are included in Appendix III. 
 
POS/MV controller software was used to monitor position accuracy and quality during data acquisition.  This 
ensured that positioning accuracy requirements are met, as outlined in section 3.2.1 of the HSSD.  The POS/MV 
controller software provides clear visual indications whenever accuracy thresholds are exceeded.   

1.4.2 POS/MV GAMS Calibration 
 
GAMS (GPS Azimuth Measurement Sub-system) calibrations were performed on each of the three POS/MV 
units.  The GAMS calibration procedure was conducted in accordance with instructions in chapter 4 of the 
POSMV V4 Installation and Operation Guide, 2005.  Results are included in the individual vessel reports and 
spreadsheets, with calibration details located in Appendix III. 
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        Figure 12: POS/MV antennas on 1018                           Figure 13: POS/MV antennas on 1010 
 
 

1.4.3 CSI Wireless MBX-3S DGPS Receiver 
 
Fairweather is equipped with commercial grade CSI Wireless MBX-3S DGPS Receivers that are used in 
conjunction with TSS POS/MV to provide vessel positioning during data acquisition.  The DGPS receivers are 
configured in manual mode to allow reception of only one U.S. Coast Guard (USCG) differential GPS beacon 
station.  Vessel wiring diagrams are in Appendix III-vssl-5. 
 
Differential GPS (DGPS) is the primary method of real-time positioning.  The individual descriptive reports list 
the U.S. Coast Guard beacon sites and frequencies used for differential corrections utilized during hydrographic 
surveying. 
 
 
 

1.4.4 Trimble Backpack 
 
Fairweather uses two GPS Pathfinder® Pro XRS receivers in conjunction with a field computer to acquire 
detached positions during shoreline verification in the field.  Data can also be collected with a handheld TSCe 
data collector.  Fairweather’s field computers are Panasonic Toughbooks. Currently in use are two CF-30’s, one 
CF-29, one CF-19, and one CF-18. The receivers have integrated beacon/satellite differential antennas which 
allow access to digital real-time sub-meter accuracy solutions.  Data quality assurance testing was conducted by 
Fairweather personnel in April 2009.    Trimble units were tested over a published benchmark.  Trimble positions 
matched the published benchmark position within 0.6m.  Test results are located in Appendix V. 
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Figure 14: Trimble Backpack Unit 

1.4.5 Impulse LR Hand-held Laser 
 
The Impulse Laser Rangefinder and TruPulse 200 Laser Rangefinder are used in conjunction with the Trimble 
Backpack GPS unit to acquire distances and heights during shoreline verification.  These data are entered directly 
into the shoreline acquisition software and annotated on the detached position forms.  The Impulse LR and 
TruPulse 200 Laser Rangefinder do not function properly in low light or in choppy seas when a feature is not 
distinguishable from surroundings.  
 
 

   
                  Figure 15: IMPULSE LR laser                    Figure 16: TruPulse 200 Laser Rangefinder 
 
Data quality assurance testing was conducted in April 2009 by Fairweather personnel.  Vertical and horizontal 
readings were taken with the laser rangefinders and compared to measurements taken with a steel tape.  The laser 
rangefinder was set up on a tripod and a staff of known height was measured at distances of 10, 20, 50, and 100 
meters.  Three horizontal and three vertical readings were taken at each interval.  The results of the laser 
rangefinder accuracy testing are located in Appendix V. 
 
 

1.5 Sound Velocity Equipment 

1.5.1 SBE 19plus SEACAT Profiler 
 
Fairweather is equipped with three SBE 19plus and two SBE 19plusV2 SEACAT sound velocity profilers used to 
acquire conductivity, temperature, and depth (CTD) data in the water column to determine the speed of sound 
through water.  Two of the SBE 19plus profilers have pressure sensors rated to 1000 meters.  The third SBE 
19plus profiler has a pressure sensor rated to 3,500 meters.  The two SBE 19plusV2 profilers have pressure 
sensors and units rated to 600 meters. 
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The SBE 19plus and SBE 19plusV2 SEACAT sound velocity profilers were calibrated by the manufacturer and 
current calibration files were returned with the units.  Calibration files are located in Appendix V.   
 
Periodic quality assurance checks include comparison casts between CTD instruments.  Data quality assurance 
(DQA) checks include comparison casts between two instruments as per section 1.5.2.2.2 of the FPM for each 
survey.  Records of the DQA tests performed are kept aboard the ship and are included with the digital Separates 
II – Sound Speed Data for each survey.   
 
To ensure that the CTDs continue to function properly a stringent maintenance schedule is followed using 
guidelines from the manufacturer's recommendations.  This includes a thorough rinsing of the instrument with 
distilled water after each cast and periodically each CTD is flushed with a Triton X-100 solution.   
 

1.5.2 Moving Vessel Profiler 200 
 
A Brooke Ocean Technology, Ltd. (BOT) Moving Vessel Profiler 200 (MVP200) is mounted in the aft starboard 
corner of the fantail (see Figure 15).  The MVP200 system is a self contained sound velocity profiling system 
capable of sampling water column profiles to 200m depth from a vessel moving up to 12 knots.  The system is 
configured with a Single Sensor Free Fall Fish (SSFFF) outfitted with an Applied Microsystems Ltd. Sound 
Velocity and Pressure Smart Sensor.  Deeper profiles can be obtained by reducing the vessel speed.  When the 
vessel is holding station, the system is capable of recording casts over 400m in depth. 
 
The MVP system consists of a winch, cable, fish (the towed unit with the sound velocity sensor), support 
assembly, and controlling hardware and software. During ship acquisition, the fish is deployed using the on-deck 
controller and towed with enough cable out to keep the fish 3-5 m below the water surface. A “messenger” (a 
short cable-thickening sleeve) is set to allow the system to keep the appropriate amount of cable out and is reset as 
needed when the ship acquisition speed is altered. 
 
During SVP acquisition, the controlling computer application, BOT MVP version 2.4 is used to control the MVP 
system and to acquire SVP data. MVP allows for three acquisition modes: 1) automatic continuous multiple cast 
freefall casting while at speed, 2) single cast freefall casting while at speed, and 3) single cast winch speed casting 
while stationary. The user limits the depth to which the fish will fall by setting 1) the depth-off-bottom and 2) the 
maximum depth.  Either single, individually initiated casts can be performed at the discretion of the Hydrographer 
or the auto deploy function can be enabled and set with varying intervals (every 10 minutes, for example) for 
deployment. 
 
On 19 August 2009 the MVP Controller software was updated to version 2.401. 
 
Fairweather has three Applied Microsystems Ltd. Sound Velocity and Pressure Smart Sensors. All of the sensors 
were calibrated by the manufacturer and current calibration files were returned with the units.  Calibration files are 
located in Appendix V. 
 
Periodic quality assurance checks include comparison casts between the MVP and one of the SBE 19plus or SBE 
19plusV2 SEACATs.  Data quality assurance (DQA) checks include comparison casts among the instruments as 
per section 1.5.2.2.2 of the FPM for each survey.  Records of the DQA tests performed are kept aboard the ship 
and are included with the digital Separates II – Sound Speed Data for each survey.   
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Figure 17: Fairweather’s MVP200 sound velocity system 

 
 

1.5.3 RESON Sound Velocity Probe (SVP 70)   
 
Fairweather is equipped with one RESON SVP 70.  The SVP 70 measures the speed of sound near the ship’s hull 
mounted transducers to provide real time surface sound speed values.  The unit is mounted adjacent to the 
RESON 8160 as shown in Figure 18.   

 

 
Figure 18: Fairweather’s SVP 70 sound speed unit (left) and the 8160 

 
The sound speed is output to the RESON 8160’s processing unit.  The 8160 - a flat faced transducer - requires 
sound velocity information for beam forming.  The 8160 cannot be used to acquire data without real time sound 
velocity information. 
 
The unit was installed during the winter drydock period in Seattle at Lake Union Drydock Company.  The current 
calibration report is included in Appendix V. 
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1.5.4 Odom Digibar Pro   
 
Fairweather is equipped with one Odom Digibar Pro.  The Digibar measures the speed of sound near the RESON 
8125 on the sled attached to Launch 1018 to provide real-time surface sound speed values.  The unit is mounted 
vertically just aft of the RESON 8125 on the sled as shown in Figure 19.   

 

 
Figure 19: Fairweather’s Odom Digibar Pro mounted on Launch 1018. 

 
The sound speed is output to the RESON 8125 processing unit.  The 8125 requires surface sound speed 
information for beam forming due to the flat faced transducer. 
 
The unit was calibrated on April 16, 2009 and the current calibration report is included in Appendix V. 

1.6 Vertical Control Equipment 

1.6.1 Water Level Gauges 
 
Five Sutron 8210 tide gauges were provided to Fairweather by the Center for Operational Oceanographic 
Products and Services (CO-OPS) at the start of the 2009 field season.  These gauges are equipped with Paros 
Scientific Sensors for pressure measurements.  The tide gauges are checked annually by CO-OPS Field 
Operations Division personnel to ensure that their accuracy standards are being met.  
 
CO-OPS does not provide calibration or quality assurance documentation to the Fairweather.  Installation and 
removal of the water level gauges is the responsibility of Fairweather personnel.  To ensure full functionality of 
the vertical control equipment prior to deployment for field operations, new gauges undergo testing by 
Fairweather personnel.  Five gauges underwent testing in April 2009 and results are included in Appendix V. 

1.6.2 Leveling Equipment 
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Fairweather is equipped with four universal automatic levels (two Zeiss NI2 333 and two Leica NA2 100) and 
graduated metric staffs to assist in leveling tide gauges.   
 
A Kukkamaki procedure is performed prior to leveling in order to verify the collimation error.  Procedures used 
followed those described in the User’s Guide for the Installation of Bench Marks and Leveling Requirements for 
Water Level Stations, October 1987.  Kukkamaki results for 2009 are located in the Tides section of Appendix V.     

1.7 Horizontal Control Equipment 
 
Fairweather is equipped with two Trimble NetR5 receivers and one Ashtech Z-Xtreme dual-frequency GPS base 
stations used for the positioning of horizontal control marks, tidal benchmarks and aids to navigation. These base 
stations can be configured for use as a portable DGPS or RTK reference station, or as a static receiver to record 
observations for use with PPK. 
 
When deployed for PPK the base stations log data locally, either to internal memory or external memory, and the 
data is downloaded periodically. The data is downloaded either by visiting the site or remotely via Freewave 900 
MHz spread spectrum Ethernet radios. Station power needs are supported by batteries and solar panels. 
 
The Ashtech antenna can be equipped with an optional ground plane and all receiver antennas are used with a 
Seco fixed height GPS tripod. 
 
Data quality assurance (DQA) testing of the Ashtech receiver was performed April 30th, 2009 by Fairweather 
personnel. The receiver was installed over control mark “VIXEN HBR 2009” (NGS PID: BBBK46) in Ernest 
Sound, AK using a Seco fixed height tripod. The receiver acquired data for 8 hours. The recorded observations 
were submitted to OPUS. The OPUS position of the receiver was half a centimeter from the published position. 
The OPUS solution is included in Appendix V. 
 
Data quality assurance testing of all three GPS units was performed May 1st, 2009 by Fairweather personnel. The 
receivers were set up over Benchmark No. 37 (NGS PID: AI4914) in Ketchikan, AK using a Seco fixed height 
tripod. Each receiver acquired data for 2 hours. The recorded observations were submitted to OPUS. The OPUS 
position of each of the two Trimble receivers was within three centimeters of the published position for the mark. 
The Ashtech receiver had a position over a decimeter from the published position; this is likely due to fewer 
satellites observed during the recording period as compared with the two Trimble receivers and the significantly 
shorter observation period as compared to the previous DQA testing. The OPUS solutions are included in 
Appendix V.  
 
Horizontal control equipment serial numbers and installation dates are located in the hardware section of 
Appendix I, System Tracking.   
 
 
2.0 Software 

2.1 Software Systems Inventory 
 
An extensive software inventory with documentation, of the software systems used by NOAA ship Fairweather, 
is maintained as a Survey Software spreadsheet and is included with the Supplemental Survey Records for the 
individual Descriptive Reports.  This spreadsheet includes specifics such as software applications, versions, and 
hot fixes, in addition to dates loaded on specific computers within the survey department. 

2.2 Data Acquisition Software  

2.2.1 HYPACK® HYSWEEP 
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Fairweather uses the Hypack®  software package  to acquire multibeam echo sounder and backscatter data on all 
of its multibeam platforms.  Hypack is used to log VBES data, which is acquired in two formats: .BIN and .RAW 
(used for processing).   
 
Hysweep is a module of the Hypack software suite that allows for real-time data planning and acquisition.  
Hysweep combines geo-referenced bathymetric digital terrain models and reference files such as raster charts and 
vector shoreline files to display real-time bathymetric bottom coverage.  Data is acquired in three formats: .RAW, 
.HSX (containing bathymetry), and .81X (containing snippets data).  All three file types are logged but only the 
.HSX and .81X files are utilized, stored, and submitted. 

2.2.2 CARIS Notebook 

CARIS Notebook™ can be used to directly collect detached shoreline positions and verify shoreline.  The 
software is run on a field computer and receives the Trimble GPS data output from the GPS Pathfinder® Pro XRS 
receivers.   
GPS settings in CARIS Notebook are as follows:  

• Maximum Horizontal Dilution of Precision (HDOP) = 3  
• Maximum Positional Dilution of Precision (PDOP) = 6 
• Minimum Signal-to-Noise Ratio (SNR) = 12 
• Minimum Elevation Mask = 8° 
• Minimum # of Satellites = 4 

 
Real-Time settings in CARIS Notebook are as follows:  

• Source Type: Integrated Beacon – Manual Mode 
• Position Mode: Corrected Only 
• Age Limit: 20 seconds 

 
Differential GPS correction is applied in real-time, using the unit’s integrated beacon as the primary corrector. 
The unit can be setup to run without using DGPS with position mode set to “Autonomous Only” or with values 
different than those listed above.  These special circumstances of acquisition with altered parameters are recorded 
and documented in the individual Descriptive Report as appropriate.    

2.3 Data Processing Software 

2.3.1 NOAA Hydrographic Systems and Technology Programs (HSTP) Software 
 
Sound speed data is processed with Velocwin, in-house software produced and maintained by NOAA’s 
Hydrographic Systems and Technology Programs (HSTP) division.  Velocwin creates and archives water column 
profiles, performs quality assurance, and processes pressure based depth data.  Velocwin creates a standard file 
format across NOAA’s hydrographic fleet for sound speed profiles applied to shallow water multibeam and single 
beam data.  
 
Pydro, another NOAA program produced and maintained by HSTP, is used to produce Smooth Tides Requests 
along with DTON and AWOIS Reports. In addition, PYDRO is used for Tidal Constituent and Residual 
Interpolation (TCARI) tide application in conjunction with CARIS HIPS.  
 
 
 
 
 

2.3.2 CARIS 
 
CARIS HIPS™ (Hydrographic Information Processing System) is used to process all multibeam data including 
data conversion, filtering, sound velocity, tide correcting, merging and cleaning. Vertical beam data is also 
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processed using CARIS HIPS, where .RAW data is converted, filtered, tide corrected, merged, and displayed in 
Fieldsheets. CARIS HIPS also calculates the Total Propagated Error (TPE) used to produce Bathymetry 
Associated with Statistical Error (BASE) surfaces which assist the Hydrographer in data cleaning, analysis, and to 
produce BASE surface deliverables.   
 
CARIS SIPS™ (Sonar Information Processing System) is used to process all side scan imagery data including 
data conversion, slant-range correction, beam pattern correction, and despeckling, if appropriate. CARIS SIPS is 
also used to inspect the imagery for contacts and to produce side-scan imagery mosaics. 
 
CARIS Notebook™ is used to compile and display source shoreline, shoreline updates and S-57 features that are 
collected directly in the field, digitized, or imported from Pydro.  The .hob files created in Notebook are the 
current shoreline deliverables.    
CARIS BaseEditor™ will be used for data quality assurance checks on the BASE surface deliverables. At the 
time of writing the software was not available to Fairweather personnel.  

2.3.3 Fledermaus™ 
 
Fledermaus ™, an Interactive Visualization Systems 3D™ (IVS 3D) program, is used for data visualizations and 
creation of data quality control products, public relations material and reference surface comparisons.   
 
As an additional data quality assurance check, Fledermaus ™ is used to examine the CARIS surfaces prior to 
submission.  The combined BASE surface is exported from CARIS and then converted to a Fledermaus .sd file 
via the Avggrid and Dmagic modules.   

2.3.4 Geocoder 
 
The Geocoder program is provided by University of New Hampshire CCOM and another implementation is 
provided by Hypack.  Our primary use of these programs is to produce imagery of gathered snippets and 
bathymetry data.  Hypack’s .81X and .HSX files are used to assemble snippets data and along with CARIS HIPS 
processed depths as xyz grids for digital terrain model production.   
 
3.0 Vessels  

3.1 Vessel Inventory 
 
The NOAA Ship Fairweather (S220) and her survey launches 1010 and 1018 are equipped to acquire multibeam 
echosounder (MBES) and sound velocity profile (SVP) data.  Launch 1018 is also the primary vessel for dive 
operations.  The AMBAR (2302) and Monark (1706) are used during shoreline verification, bottom sampling, and 
horizontal and vertical control operations.   All vessels may be used in support of tide gauge operations.  See 
Appendix I for the complete vessel inventory. 

3.2 Noise Analysis 
 
The Fairweather sonar systems, RESON 8160 and RESON 8111ER, underwent noise analysis testing on October 
10 and 11, 2004 respectively.  The results are used during acquisition to enhance data quality and are included in 
Appendix III-S220-7.  Standard operating procedures utilizing the RESON 8160 and RESON 8111ER aboard the 
Fairweather have survey speeds set to minimize noise based on these noise analyses.     

 
4.0 Data Acquisition 

4.1 Horizontal Control 
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A complete description of horizontal control will be included in the project’s Horizontal and Vertical Control 
Report (HVCR), submitted for each project under separate cover when necessary as outlined in the HSSD and 
section 5.2.3.2.3 of the FPM. 
 
The horizontal datum for all projects is the North American Datum of 1983 (NAD83) unless otherwise noted in 
the individual descriptive reports.   
 
Multibeam and shoreline data are differentially corrected in real time using correctors provided by Coast Guard 
beacons.  The specific beacons used for a given survey will be included in the Horizontal Control section of the 
survey’s descriptive report.  If loss of the differential beacon resulted in any data being recorded with C/A GPS 
positions it will be noted in the Descriptive Report for the specific survey.   
 
If DGPS is commonly lost during the survey, the original navigation of the survey vessel can be replaced with a 
post processed kinematic (PPK) single best estimate of trajectory (SBET). The PPK solution is dependent on a 
local base station supported by the ship and processed in Applanix POSPac software using Single Base mode. The 
resulting navigation from PPK is an improvement over C/A and DGPS navigation. The use of PPK for a given 
survey will be included in the Horizontal Control section of the survey’s descriptive report.   

4.2 Multibeam Echosounder Acquisition and Monitoring Procedures 
 
Methods of acquisition took into consideration system performance limitations, the bottom topography, water 
depth, and the ability of the vessel to safely navigate the area.   
 
All multibeam data are acquired in Hypack’s HYSWEEP® SURVEY extension  (HSX) format and monitored in 
real-time using the 2-D and 3-D data display windows and the on-screen displays for the RESON SeaBat 8101ER,  
8111ER, and 8160.  Adjustable parameters that are used to control the RESON either directly or from the Hypack 
software include range scale, power, gain, and pulse width.  These parameters are adjusted as necessary to ensure 
best data quality.  Vessel speed was predominantly between 6-6.5 knots and reduced as needed to eliminate noise 
from the data and to ensure the required along-track coverage for object detection in accordance with the HSSD.  
Survey personnel follow standard operating procedures documented aboard the Fairweather while setting and 
utilizing the RESON systems and Hypack for acquisition of data. 
 
Mainscheme multibeam sounding acquisition lines using the RESON SeaBat 8101ER,  8111ER, and 8160 are 
generally run parallel to the contours and spaced no greater than three to four times the water depth and in most 
cases at a tighter line spacing to ensure the appropriate data density for a given resolutions at a given depth range.  
For discrete item developments, line separation was reduced to 2 times water depth to ensure least-depth 
determination by multibeam near-nadir beams.  Hypack Hysweep was used in lieu of planned line files.  Hysweep 
displays the acquired multibeam swath during acquisition and was monitored to ensure overlap and full bottom 
coverage.  If coverage was not adequate, additional lines are run while still in the area. 

4.3 Shoreline Verification 
 
Fairweather personnel conduct field shoreline verification at times near predicted low water, in accordance with 
the Project Instructions and section 3.5 of the FPM.   
 
The composite source file (CSF) provided with the project instructions is the primary source for shoreline features 
to be verified.  Additionally, AWOIS items and other features to be investigated are provided for a given survey 
and are included in the files utilized during shoreline verification.  Specific details regarding the composite source 
and investigation features are included in the individual descriptive reports. 
 
A Mean High Water (MHW) Buffer line, offset 0.8 mm at the scale of the largest chart in the area, is provided 
with the project instructions or created from the composite source MHW line. This MHW Buffer line is used in 
the shoreline acquisition software and on the boat sheet as a reference, and to determine the Navigable Area Limit 
Line (NALL).  The NALL is determined in the field as the farthest off-shore of either the MHW buffer specified 
above, the 4-meter depth contour, or the inshore limit of safe navigation.  All shoreline features from the 
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composite source seaward of the Navigable Area Limit Line (NALL) are verified (including an update to depth 
and/or position as necessary) or disproved during shoreline operations.  Features off-shore of the NALL and not 
addressed or features of an ambiguous nature are flagged with a marker note for further clarification. 
 
Detached positions (DPs) acquired during shoreline verification indicate new features, revisions to source 
features, or source features not found in the field.  They are recorded in the shoreline acquisition software and on 
DP forms.  
 
5.0 Bottom Sample Acquisition 
 
Bottom samples are acquired according to section 7.1 of the HSSD.  Samples are acquired using the current 
shoreline acquisition system and processed similarly to other shoreline features as outlined in the Descriptive 
Report for the specific survey.  Bottom sample results are included in the Notebook .hob deliverable layer, 
HXXXXX_ Final_Feature_File. 

B QUALITY CONTROL 
 
The Fairweather has numerous standard operating procedures (SOPs) that are followed by personnel throughout 
the survey to ensure consistent high quality data and products. 
 
1.0 Uncertainty Modeling 
 
Error values for the multibeam and positioning systems on Fairweather and her survey launches were compiled 
from manufacturer specification sheets for each sensor (Heave, Pitch, Roll, Position, and Heading) and from 
values set forth in section 4.2.3.6 and Appendix 4 – CARIS HVF Uncertainty Values of the FPM.   
 
Estimates for the Motion Reference Unit ( MRU) alignment errors are the standard deviations of the values 
determined by multiple personnel processing the patch test data  (see section C 4.0). Initial MRU values were 
significantly large and impacted the Total Propagated Uncertainty/Error (TPU/TPE) values in CARIS 
inappropriately. Final MRU values used did not include the outlier patch test values to allow for more reasonable 
MRU uncertainty and CARIS TPE values.   
 
The Fairweather TPU Values spreadsheet located in Appendix IV, lists the final uncertainty values for 
Fairweather and her launches, including the default tides and sound velocity values.  Uncertainty values relating 
to vessels and survey systems are entered into the HIPS Vessel File (HVF) for each platform.  The tidal errors for 
the gauge and for zoning are determined on a project by project basis. Sound speed uncertainties for a given 
survey are based upon either the defaults listed in the TPU value spreadsheet or based on utilization of NOAA 
sound speed uncertainty estimation software.  Survey specific uncertainty values for tides and sound speed that 
are entered during the Compute TPE step in CARIS HIPS and how they were determined will be included in the 
individual Descriptive Report.  
 
2.0 Data Processing 

2.1 Multibeam Echosounder Data Processing 
 
Bathymetry processing followed section 4.2 of the FPM unless otherwise noted.   
 
Raw HSX multibeam data are converted to Caris HDCS format using established and internally documented 
settings.  True heave, sound velocity and water level data are then applied to all lines and the lines merged.  Once 
lines are merged Total Propagated Error (TPE) was computed.   
 
The data acquired by the systems aboard Fairweather and her launches do not provide adequate densities to allow 
for representation at the resolutions and depth ranges specified in Hydrorgaphic Technical Directive (HTD) 2009-
2.  A waiver from this specification was obtained from Jeffrey Ferguson, Chief, Hydrographic Surveys Division to 
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Fairweather on May 19, 2009 and is included in Appendix VI. The general resolution, depth ranges, and CUBE 
parameter settings outlined in the waiver and used for processing are listed in Table 1.  These values may also 
require adjustment by sheet managers for individual surveys to address visualization gaps between finalized 
surfaces in areas of greater slope.  The lesser depth range value of a coarser grid will be adjusted shoaler if 
adjustment is necessary (ie 35-80m for an 8m resolution adjusted to 30-80m).  Adjustments to the depth ranges 
will be communicated to and agreed upon with the appropriate processing branch prior to data submission. A 
detailed listing of the actual depth ranges used during the processing of each survey, along with the corresponding 
fieldsheet(s), will be provided in the Descriptive Report of each survey.   
 
BASE surfaces are created using the Combined Uncertainty and Bathymetric Estimator (CUBE) algorithm and 
parameters contained in the NOAA Cubeparams.xml file as provided with (HTD) 2009-2. The Cubeparams.xml 
will be included with the HIPS Vessel Files with the individual survey data.  The NOAA parameter configurations 
for resolutions 1-16 meters are used as listed in Table 1.   
 
 
 

 
 
 
 
 
 
 

 
 
 

 
Table 1: Resolutions and Depth Ranges 

 
 
Multibeam data are reviewed and edited in HIPS swath editor and in subset mode as necessary.  The finalized 
BASE surfaces and CUBE hypotheses are used for directed data editing at the appropriate depth range in subset 
editor.  The surfaces and subset editor viewing are also used to demonstrate coverage and to check for errors 
resulting from tide, sound velocity, attitude and timing. 
 
Vessel heading, attitude, and navigation data are reviewed in HIPS navigation editor and attitude editor if deemed 
necessary upon review of surfaces.  Where necessary, fliers or gaps in heading, attitude, or navigation data are 
manually rejected or interpolated for small periods of time.  Any editing of this nature will outlined in the 
Descriptive Report for the particular survey. 
 
The Surface Filtering functionality in HIPS may be used in the processing of survey data to reject errant 
soundings.  If utilized, the individual Descriptive Report shall list the confidence level settings for standard 
deviation used and discuss the particular way the surface filter was applied.  
 
In areas of navigational significance, depths less than 30 meters, where the BASE surface did not depict the 
desired depth for the given area, a designated sounding was selected.  Designated soundings are selected as 
outlined in section 5.1.1.3 of the HSSD. 
 
Layers determining “IHOness” are added to the CUBE surfaces allowing the Hydrographer to see where and if the 
surfaces meet IHO Order.  The process is easily performed in HIPS and allows the Hydrographer to identify 
problem areas and determine the severity of the situation.  This is a spatial quality control check rather than just a 
statistical list of nodes and allows for specific areas with problems to be isolated and addressed.   
 
IHO surfaces are utilized during data collection as an additional child layer of the finalized surfaces to indicate 
problem areas that need attention.  Additionally, IHO child layer(s) are included with the submitted surface(s).   
 

Surface Resolutions CUBE Parameters 

Depth Range Grid Resolution Configuration Name 
0 to 23 meters 1  meter NOAA_1m 
18 to 40  meters 2  meter NOAA_2m 
35 to 80  meters 4  meter NOAA_4m 

75  to  160  meters 8  meter NOAA_8m 
155+  meters   16  meter NOAA_16m 
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The combined surface’s IHO layer exported from CARIS is examined to allow the Hydrographer to see the full 
data distribution rather than just the minimum and maximum values in the surface.  This data distribution is used 
to assess the quality of the survey.  Ninety-five percent of the data is highlighted in the histogram which allows 
the Hydrographer to show whether the data for a given survey meets the appropriate IHO order as specified in 
section 5.1.1.1 of the HSSD.  An image of the histogram and/or its derived statistics will be included with the 
Descriptive Report for the specific survey.    
 
Additionally, a combined surface is reviewed in Fledermaus or CARIS Base Editor to ensure that the data are 
sufficiently cleaned for submission. 

2.2 Shoreline Data Processing 
 
During shoreline verification, field detached positions (DP) are acquired with CARIS Notebook.  Tide application 
for features requiring tide correction is applied in CARIS Notebook when using discrete zoning and via Pydro 
when TCARI is to be used.   
 
An original composite source file (H#####_Original_Composite_Source.hob), clipped to the sheet limits for a 
particular survey, is saved prior to being edited and is submitted with the individual survey.  New features and any 
updates to the composite source shoreline, such as ledges or reefs, are acquired or digitized with S57 attribution 
and reside in the H#####_Final_Feature_File.hob.  Updates to a source shoreline feature primarily include a 
change in depth/height, position, or S57 classification.  Notebook’s editing tools are used to modify source feature 
extents or positions.   
 
The SORIND and SORDAT S57 attribute fields for new features or modified source features are updated to 
reflect the information for the associated survey number and date.  All new or modified features are S57 attributed 
as applicable.  All unmodified source features retain their original SORIND and SORDAT values. 
 
Short descriptive comments taken from the boat sheets or DP forms along with investigation or survey methods 
are listed under the Remarks field.  For significant features that deserve additional discussion or disprovals, the 
Hydrographer included recommendations to the cartographer in the Recommendations field, along with the 
Hydrographer notes and investigation methods provided in the Remarks field.  
 
Features that are disproved or that do not adequately portray the shoreline are moved to the 
H#####_Disprovals.hob layer from the H#####_Final_Feature_File.hob layer.  Features in the disprovals layer 
retain their original SORIND and SORDAT values.  
 
Photos labeled and associated with a DP number are included with the survey data and stored in the 
CARIS/Notebook photo folder with the deliverables. 
 
AWOIS investigation items are received in the Project Reference File and investigated as necessary.  Shoreline 
features correlated to the AWOIS item are included in either the H#####_Final_Feature_File.hob or 
H#####_Disprovals hob layers and labeled with the appropriate AWOIS number and include a remark and 
recommendation from the Hydrographer.   
 
The CARIS Notebook files along with CARIS HIPS BASE surface(s) are viewed to compare soundings and 
features simultaneously.  Standard operating procedures, for processing shoreline features in CARIS Notebook, 
are followed by survey personnel aboard NOAA Ship Fairweather as outlined in section 4.4 of the FPM.  A 
detailed discussion of the procedures used and any deviations in shoreline processing from standard procedures or 
the FPM are documented in the individual Descriptive Reports. 
 
Final Shoreline Deliverables may include a report in spreadsheet format of features named the 
H#####_Tabulated_Features_Listing included in Appendix II of the individual Descriptive Reports and up to 
three Notebook HOB files: 
 
 



 

 - C-19 -  

2009 DAPR NOAA Ship Fairweather 

HXXXXX_Original_Composite_Source, 
HXXXXX_Final_Feature_File, 
HXXXXX_Disprovals.  
 

 
3.0 Data Review 
 
Specific procedures are used on Fairweather to ensure quality control of data throughout acquisition, processing, 
and submission.  These procedures are documented and followed by the Hydrographer. A detailed Quality Control 
Check is performed by the survey manager.  A detailed Review is conducted by qualified survey personnel (FOO, 
CST, SST, or PS) other than the survey manager as an outside review of the survey data and deliverables.  
Submission checklists are used to ensure that all data and deliverables are complete and included upon 
submission.  Documentation of these tasks is completed for every survey but only the final processing log, 
HXXXXX_Data_Log, is submitted with the individual survey data. 
 

C Corrections to Echo Soundings 
 
1.0 Vessel HVFs 
 
CARIS HIPS Vessel Files (HVF) are created by Fairweather personnel and used to define a vessel’s offsets and 
equipment uncertainty.  The HVF is used for converting and processing data collected by each survey platform.  
The HVFs used for a given project are included with the digital data submitted with those surveys.   
 
2.0 Vessel Offsets  
 
Sensor offsets are measured with respect to each vessel’s reference point.  The reference point for Fairweather 
and survey launches 1010 and 1018 is the IMU.  Specific offset values are input into the POS/MV and the CARIS 
HIPS Vessel File (HVF).   
 
A ship survey was completed for the Fairweather by Westlake Consultants, Inc on September 23, 2003. A 
POS/MV components spatial relationship survey of the Fairweather was conducted by National Geodetic Survey 
(NGS) in February 2007. An additional POS/MV components spatial relationship survey was conducted by NGS 
on February 15, 2009 while the ship was at Lake Union Drydock in Seattle, WA.  The results of these surveys 
were used to determine the offsets for the ship.  The reports from each survey are located in Appendix III.  The 
S220 Offsets & Measurements spreadsheet is also included in Appendix III, listing the final values for 
Fairweather’s offsets with explanations of how they were calculated.  
 
Permanent control points were established on launches 1010 and 1018 in July of 2004.  Sensor offsets were 
measured by Fairweather personnel according to documented procedures.  Total stations were utilized for 
positioning the permanent control points (see Figure 20).  The total station specifications are located in Appendix 
II, the calibration certificates for the Nikon DTM 310 and the Sokkia SET 5F are included in Appendix V.  A steel 
tape was used to verify and update specific vessel offsets in March 2009 and the results are located in the 
respective vessel’s Minimum Physical Measurements_2009 spreadsheet in Appendix III-101X-1.  The final offsets 
for survey launches 1010 and 1018 are derived from a combination of values from the original full survey and the 
values updated in the verification surveys.  The 2009 transducer measurement values indicated agreement with the 
2008 values. Since the angle bias was not documented during 2009 measurement the 2008 offset values were 
used. Additionally, the values in the POSMV for the distances between the IMU to the Port Antenna and Heave 
point remained those used in 2008 and were not updated with the 2009 measurements for both launch 1010 and 
1018. Though this creates a slight difference to the lever arm in the POSMV, no appreciable affects have been 
observed. The measurements, derivations, descriptions of methodology used, diagrams, and coordinate system 
references are included in the respective vessel’s Offsets & Measurements spreadsheet in Appendix III-101X-1. 
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Figure 20: Permanent Control Point "Benchmark C" on launch 1018 

 
 
3.0 Static and Dynamic Draft 
  
The static drafts (Waterline Height in the HVF) for launch 1010 and 1018 were calculated based on steel tape 
measurements of the distance from benchmarks on the port and starboard quarter of the vessel to the waterline.   
 
The bow and stern draft marks were used to perform a linear interpolation of the static draft at the Fairweather’s 
IMU.  The static draft was measured under different loading conditions: with different amounts of fuel.  The Ship 
Draft 2009 spreadsheet records the static draft values and is included with the ship offset documentation in 
Appendix III-S220-1. 
 
The values and calculations for static draft are listed in each vessel’s Minimum Physical Measurements and 
Offsets & Measurements spreadsheets located in Appendix III-vssl-1. 
 
Dynamic Draft measurements were conducted for Fairweather in February 2009, and for survey launches 1010 
and 1018 in April of 2009.  The measurements were made using the change in ellipsoid height while traveling at 
different speeds in Lake Washington. The ellipsoid heights were determined using Post Processed Kinematics 
(PPK) by recording POSPac on each vessel and then processing the data with local reference stations in Applanix 
POSPac software. The resulting Single Best Estimate of Trajectory (SBET) was exported from POSPac and the 
speed versus ellipsoid height was fit to a polynomial curve using a least squares fit method in a Python Script 
written by ship’s personnel. The polynomial curve was used to derive the table used in the CARIS HVF’s for the 
Reson 8101 multibeams that are swing-arm mounted to both launches 1010 and 1018, and the standard deviation 
of the residuals was used to determine the associated uncertainty in the measurement.  A written report about the 
initial measurements carried out in February is provided for in Fairweather’s 2009 HSRR  along with 
spreadsheets containing applicable graphs and tables with comparison to previous years for launches 1010 and 
1018.  Documentation for the dynamic draft testing is located in the respective vessel’s folder in Appendix III.  
Launch 1018 also completed a traditional bottom referenced dynamic draft measurement, and the results from this 
test are plotted in the ellipsoidally referenced graph. 
 
The dynamic draft measurement for Launch 1018 taken in February 2009 was conducted without the mounting 
sled and Reson 8125 multibeam sonar head mounted to the hull of the vessel, which was mounted for the first 
time in May 2009.  A new dynamic draft measurement specifically for the Reson 8125 and sled mount 
configuration was taken on August 7, 2009, in Dutch Harbor, AK, using the “Echosounder method” described on 
page 31 of the FPM.  The applicable acquisition, processing, and analysis spreadsheet is contained in Appendix 
III.  The dynamic draft values entered in the CARIS HVF for Launch 1018 are the derived values from this 
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measurement.  All data acquired during the 2009 field season to date with the Reson 8125 mounted to Launch 
1018 has been corrected using these values.   
 
4.0 Patch Tests 
 
Patch tests were conducted in April 2009 on Fairweather for the RESON 8111 and 8160 multibeam acquisition 
systems. Survey launches 1010 and 1018 with RESON 8101 transducers were also tested in April 2009.  Survey 
launch 1018 can be outfitted with an 8125 transducer attached via sled mount. Since this system is detachable a 
patch test is conducted after each reattachment. The 8125 has had a patch test conducted in May 2009 during the 
Ernest Sound (O119) project and in June 2009 during the Shumagin (P183) project.  Additional patch tests will be 
conducted after remounting of the 8125 sled and as necessary for the other systems.  The results of all patch tests 
to date, along with the acquisition and processing logs, are included in the individual MBES Calibration files in 
Appendix III-vssl-4. Also included in Appendix III is the Sounding System Comparison. This comparison 
includes leadline to MBES comparisons and surface differencing between MBES reference surfaces.  Average 
differences between systems are less than one meter. 
 
5.0 Attitude  
 
All attitude corrections are generated by the POS/MV using data from the IMU-200 Inertial Measurement Unit 
(IMU).  All attitude data are applied in post-processing in HIPS for systems acquiring data with the RESON 8101, 
8111, and 8125.  The RESON 8160 has real-time roll and pitch stabilization applied, thus these components of 
attitude were not applied in post-processing as to not double apply the correctors.   
 
IMU values for uncertainty of heave, pitch and roll are included in the manufacturer specification in Appendix II 
and are included in the Fairweather_TPE Values_2009 spreadsheet located in Appendix IV.   

5.1 True Heave 
 
Fairweather and her launches are equipped with the POS/MV TrueHeave™ (TH) option.  True Heave™ is a 
‘delayed’ heave corrector as opposed to ‘real time’ heave corrector and is fully described in Section 6 of the 
POS/MV Version 4 Installation and Operation Manual.  TrueHeave is logged along with other POSPac data in the 
daily POS files (2009-ddd_vssl_.000) through the Ethernet Logging function in the POS/MV controller software.  
To ensure proper calculation of TH, files are logged for at least three minutes past the end of each day’s survey 
operations.   
 
During daily processing the occurrence of “corrupted” TrueHeave files can occur. This is generally due to a 
formatting problem in the POS file.  A fix has been provided by CARIS in a tool called “fixTrueHeave.exe.”  In 
cases where this is necessary a new “fixed” file is created with the extension “.fixed” (2009-ddd_vssl_.000.fixed). 
The new fixed True Heave file is then applied to the data in the CARIS HIPS program.  The original corrupted file 
is retained along with the fixed file with the raw data.  Occurrences of this for specific surveys are noted in the 
individual Descriptive Reports. 
 
In cases where TrueHeave™ could not be applied, real time heave correctors are used.  Real time heave data are 
recorded in Hypack/Hysweep software and stored in the .HSX format and can be applied as the heave corrector 
for multibeam data.  Data that does not have TrueHeave™ applied will be listed in the individual Descriptive 
Report for the survey.  
 
6.0 Sound Velocity 
 
SBE 19plus and SBE 19plusV2 sound velocity profilers are used regularly to collect sound speed data for the 
RESON 8101 and RESON 8125 multibeam sonars on survey launches 1010 and 1018 and used on an as needed 
basis for the Fairweather’s RESON 8111 and 8160 multibeam systems.  The Brooke Ocean Technology Moving 
Vessel Profiler (MVP) is primarily used to collect sound velocity data for sound speed correction of data acquired 
with Fairweather’s RESON 8111 and 8160 multibeam systems. 
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Daily sound speed profiles from the SBE 19plus and SBE 19plusV2 profilers are processed with Velocwin and 
concatenated into single .svp files for each vessel per survey.  Individual .svp files and the concatenated vessel 
files for the survey are submitted with each survey.    
 
Sound speed profiles acquired using the Brooke Ocean Technology Moving Vessel Profiler 200 (MVP) are stored 
in files labeled .001, .001c, .001d, and .001e (collectively called BOT files) where the number increments by one 
with each subsequent cast. The .00#c file for each cast was opened with Velocwin and converted into CARIS .svp 
file format.  The individual .svp profiles are concatenated into vessel specific .svp files for the entire survey. 
Individual sound velocity profile files taken by the MVP will not be submitted due to the large number of casts 
acquired; however, the daily concatenated files are submitted for backup purposes.   
 
The concatenated sound velocity files are applied to multibeam data in CARIS HIPS during data processing.  
CARIS HIPS uses one of four different algorithms to automatically apply a sound velocity profile stored in a 
concatenated sound velocity file.  They are: “previous in time,” “nearest in time,” “nearest in distance” and 
“nearest in distance within time.”  In general, “previous in time” is the method used for applying sound velocity 
information in HIPS for launch data and “nearest in distance within time” is used for ship data, although the other 
methods may be used in certain situations.  The method of applying sound velocity is included in the processing 
logs that are submitted with each survey. 
 
7.0 Water Level 
 
The vertical datum for projects conducted is Mean Lower Low Water (MLLW).  Predicted, preliminary, and/or 
verified water level correctors from the primary tide station(s) listed in the project letter instructions may be 
downloaded from the CO-OPS website and used for water level corrections during the course of the project.  
These tide station files are collated to include the appropriate days of acquisition and then converted to CARIS .tid 
file format using FetchTides or HydroMI in MapInfo.   
 
Water level data in the .tid files are applied to data in CARIS HIPS using the zone definition file (.zdf) or a Tidal 
Constituent and Residual Interpolation (TCARI) model supplied by CO-OPS.   Upon receiving final approved 
water level data, all data are reduced to MLLW using the final approved water levels (smooth tides) as noted in 
the Descriptive Report included with the survey data. 
 
A complete description of vertical control utilized for a given project can be found in the project specific 
Horizontal and Vertical Control Report (HVCR), submitted for each project under separate cover when necessary 
as outlined in section 5.2.3.2.3 of the FPM. 



Appendix I 
 
 
System Tracking 
 

• Vessel Inventory 
• Hardware Inventory 
• Computer Inventory 

 



Field Unit: FAIRWEATER
Effective Date: April 20, 2009

Updated Through: July 18 2009

Hydrographic Vessel Inventory

Updated Through: July 18, 2009

Vessel Name FAIRWEATHER Launch 1010 Launch 1018 Ambar 700 Skiff FRB

V l I

SURVEY VESSELS

Vessel Image

Hull Number S 220 1010 1018 2302 1706 2301

Call Letters WTEB

Manufacturer Aerojet-General Shipyards The Boat Yard, Inc. The Boat Yard, Inc. Marine Silverships, Inc MonArk Zodiak of North America

Year of Construction 1967 1973 1973 1998 2004

Type of Construction Welded steel hull -
 ice strengthened Aluminum hull Aluminum Hull RHIB Aluminum Hull RHIB

Length Overall 70.4 m (231 ft) 8.8 m (28ft 10in) 8.8 m (28ft 10in) 7.0 m (23 ft) 5.2 m (17 ft) 6.7 m (22 ft)

Beam 12.8 m (42 ft) 3.3 m (10ft 8in) 3.3 m (10ft 8in) 2.9 m (9ft 4in) 2.3 m (7ft 2in) 2.6 m (8ft 6in)

Draft 4.7 m (15ft 6in) 1.2 m (4 ft) 1.2 m (4 ft) 0.4 m (1ft 4in) 0.4 m (1ft 3in) 0.6 m (22 in)Draft 4.7 m (15ft 6in) 1.2 m (4 ft) 1.2 m (4 ft) 0.4 m (1ft 4in) 0.4 m (1ft 3in) 0.6 m (22 in)

Cruising Speed 12.5 knots 24 knots 24 knots 22 knots 20 knots 18 knots

Max Survey Speed 6 knots 6 knots 6 knots

Date of Effective Full Vessel 
Static Offset Survey

Origninal Survey 9/23/2003     
POS/MV Offsets Surveyed 

2/2007 and 2/15/2009
2004 2004

Organization which Conducted 
th Eff ti F ll Off t S

Original Survey -  Westlake 
Consultants                 NOAA Personnel             

(W t l S di F li h)
NOAA Personnel             

(W t l S di F li h)the Effective Full Offset Survey Consultants                 
POS/MV Spatial Surveys - NGS (Wetzler, Sampadian, Froelich) (Wetzler, Sampadian, Froelich)

Date of Last Partial Survey or 
Offset Verification & Methods 
Used

n/a 3/20/2009                   
Steel Tape

8101: 3/20/2009              
8125: 4/29/2009              

Steel Tape

Date of Last Static Draft 
Determination & Method Used

April-2009                   
Draft Marks                  

4/7/2009
Waterline to Benchmarks

4/7/2009
Waterline to Benchmarks

Date of Last Settlement and 2/23/2009                   4/17/2009                   4/16/2009                   
Squat/Dynamic Draft 
Measurements & Method Used

2/23/2009                   
Post Processed Kinematic 
(Ellipsoidally referenced)

4/17/2009                   
Post Processed Kinematic 
(Ellipsoidally referenced)

4/16/2009                   
Post Processed Kinematic 
(Ellipsoidally referenced)



Field Unit:

Effective Date:

Updated Through:

Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install 
Date Location Date of last Field 

Cal/Testing

Date of last 
Manufacturer 
Cal/Service

Additional Information

Processor RESON 81-P (8111) 35652 Dry: 8111-E209-6114    
Wet: 8111-E101-AFAA Mar 2009 S220 N/A Bar Code : CD0001065312

Transducer RESON 8111ER unknown N/A Mar 2009 S220 4/28/2009 replaced transducer 
Mar-2009

Processor RESON 81-P (8160) 35385 Dry: 8160-2.09-7C6D    
Wet: 8160-1.00-E9E1 May-2004 S220 N/A Bar Code : CD0001065313

Transducer RESON 8160 unknown N/A Apr-2004 S220 4/28/2009 installed in hull,      
2004

Processor RESON 81-P 35737 Dry: 8101-2.09-E34D    
Wet: 8101-1.08-C215 Jul-2004 1010 N/A Bar Code : CD0001065349

Transducer RESON 8101 ER 2701011 N/A Jul-2004 1010 4/17/2009

Processor RESON 81-P 34497 Dry: 8101-2.09-E34D    
Wet: 8101-1.08-C215 Jul-2004 1018 N/A Bar Code : CD0001065351

Transducer RESON 8101 ER 3102026 N/A Jul-2004 1018 4/16/2009

Processor RESON 81-P 31562 Dry: 8125-2.10-A50F    
Wet: 8125-1.08-9E98 Unknown 1018 N/A Bar Code: CD0000825308

Transducer RESON 8125 4400007 N/A Unknown 1018 O119: 5/24/2009    
P183: 6/27/2009 Unknown on loan from RUDE

Towfish Klein 5000 293 N/A 1018 / S220 preliminary testing   
5/14/2009

Bar Code: CD0000825404

Processor Klein Sonar Workstation 23-326-2WS Sonar Pro 11.3 1018/S220 preliminary testing   
5/14/2010

Bar Code: CD0000825155

Processor Odom Hydrographic 
Systems Echotrac CVM-A 26034 Version 4.01 2302 / 1706 new unit, May-2007 Bar Code: CD0001703210,        

ChartView Dongle (100.001.001.098)

Transducer (2) Odom Hydrographic 
Systems SMBB200-4A TR5162/TR5159 N/A N/A 2302 / 1706 N/A N/A Two 4 degree (large)

Transducer (2) Odom Hydrographic 
Systems SMBB200_9 TR5138/TR5139 N/A N/A 2302 / 1706 N/A N/A Two 9 degree (small)

Divers Least Depth Gauge PTC MODIII 68377 N/A N/A S220 4/22/2009 4/2/2008 CD0001698256

Lead Line FA Personnel Traditional 10_01_05 N/A N/A any 4/20/2009

Lead Line FA Personnel Traditional 10_02_05 N/A N/A any 4/20/2009

Lead Line FA Personnel Traditional 20_01_05 N/A N/A any 4/28/2009

Lead Line FA Personnel Traditional 20_02_05 N/A N/A any 4/28/2009

Lead Line FA Personnel Traditional 20_03_05 N/A N/A any 4/28/2009

Lead Line FA Personnel Traditional 30_01_05 N/A N/A any 4/28/2009

Lead Line FA Personnel V-100/Non-Traditional 10_05_09 N/A N/A any 4/28/2009

Lead Line FA Personnel V-100/Non-Traditional 10_06_09 N/A N/A any work in progress

Hydrographic Hardware Inventory
FAIRWEATHER

4/20/2009

7/21/2009
SONAR & SOUNDING EQUIPMENT



Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install 
Date Location Date of last Field 

Cal/Testing

Date of last 
Manufacturer 
Cal/Service

Additional Information

POS/MV PCS Applanix 320 V.4 2411 HW2.9-7, SW03.42      
POS Cntrlr v. 4.0.2.0

Jun-2008 S220            
IP:129.100.1.231

4/27/2009 Bar Code : CD0001697462  Auth. 
No. 811025-00534537 

POS/MV IMU Applanix LN200 292 N/A Apr-2004 S220 Bar Code : CD0001696450

POS/MV Primary              
GPS Receiver Applanix BD950 SN:4611A66708 v.00211 Feb-2007 S220

POS/MV Secondary         
GPS Receiver Applanix BD950 SN:4602A62806 v.00211 Feb-2007 S220

POS/MV Port Antenna Applanix OEM2 3151R S/N 60103854 HW1 Feb-2007 S220 P/N 39105-00 DC 4602

POS/MV Stbd Antenna Applanix OEM2 3151R S/N 60125191 HW1 Feb-2007 S220 P/N 39105-00 DC 4602

DGPS Receiver CSI Wireless MBX-3S 0324-11969-0002 N/A Jul-2004 S220 Bar Code: CD0001065375

DGPS Antenna CSI Wireless MGL3 9824-1779-0002 N/A Apr-2004 S220

POS/MV PCS Applanix 320 V.4 2564 HW 2.6-7, SW 03.42     
POS Cntrlr v. 3.4.0.0

Jun-2008 1010            
IP:129.100.1.231

4/15/2009 1/15/2008 Bar Code : CD0001601275

POS/MV IMU Applanix LN200 294 N/A Jul-2004 1010 Bar Code : CD0001696449

POS/MV Primary              
GPS Receiver Applanix BD950 SN:4624A70264 v.00211 Mar-2007 1010

POS/MV Secondary         
GPS Receiver Applanix BD950 SN:4624A68956 v.00211 Mar-2007 1010

POS/MV Port Antenna Applanix OEM2 3151R S/N 60162863 HW1 Mar-2007 1010 P/N 39105-00 DC 4626

POS/MV Stbd Antenna Applanix OEM2 3151R S/N 60145247 HW1 Mar-2007 1010 P/N 39105-00 DC 4614

DGPS Receiver CSI Wireless MBX-3S 0331-12579-0008 N/A Jul-2004 1010 Bar Code: CD0001065289

DGPS Antenna CSI Wireless MGL3 0331-12579-0009 N/A Jul-2004 1010

POS/MV PCS Applanix 320 V.4 2560 HW 2.6-7, SW 03.42     
POS Cntrlr v. 3.4.0.0 Jun-2008 1018            

IP:129.100.1.231 4/15/2009 1/15/2008 Bar Code : CD0001601274

POS/MV IMU Applanix LN200 007 N/A Feb-2007 1018
POS/MV Primary              
GPS Receiver Applanix BD950 SN:4624A70243 v.00211 Feb-2007 1018

POS/MV Secondary         
GPS Receiver Applanix BD950 SN:4624A70263 v.00211 Feb-2007 1018

POS/MV Port Antenna Trimble OEM2 3151R S/N 60145158 N/A Feb-2007 1018 39105-00 DC 4618

POS/MV Stbd Antenna Trimbe OEM2 3151R S/N 60130644 N/A Feb-2007 1018 39105-00 DC 4604

DGPS Receiver CSI Wireless MBX-3S 0328-12362-0001 N/A Jul-2004 1018 Bar Code:00010652291

DGPS Antenna CSI Wireless MGL3 0328-12352-0002 N/A Jul-2004 1018

Trimble Backpack 1 Trimble Pathfinder Pro XRS 0224078543 Firmware v1.96 RevA Mar-2008 S220 Bar Code: CD0001269835

Trimble Backpack 1: 
Antenna Trimble 33580-50 0220341062 N/A N/A S220 no Bar Code

Trimble Backpack 2 Trimble Pathfinder Pro XRS 0224090101 Firmware v1.96 RevA Mar-2008 S220 Bar Code: CD0001269836

Trimble Backpack 2: 
Antenna Trimble 33580-50 0220321059 N/A N/A S220 no Bar Code

Handheld data collector Trimble TSCe 37318 N/A N/A S220 no Bar Code , PN 45268-50

Antenna cable Trimble P/N22628 S220

Camcorder Batteries Trimble P/N17466 S220

NMEA/RTCM cable Trimble P/N30232-00 S220

data/power cable Trimble P/N30231-00                             S220

dual battery cable Trimble  P/N24333 S220
GPS Pathfinder field 
device cable Trimble P/N45052 S220

Laser Laser Tech Inc. Impulse Laser 
Rangefinder i09290 N/A N/A S220 Bar Code: CD0001269812

Laser Laser Tech Inc. TruPulse 200 Laser 
Rangefinder 001481 N/A N/A S220 no Bar Code

Laser Laser Tech Inc. TruPulse 200 Laser 
Rangefinder 000676 N/A N/A S220 no Bar Code

POSITIONING & ATTITUDE EQUIPMENT



Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install 
Date Location Date of last Field 

Cal/Testing

Date of last 
Manufacturer 
Cal/Service

Additional Information

Moving Vessel Profiler 
winch

Brooke Ocean 
Technology Inc. MVP-200-5 10328 S220 N/A Apr-2009 Visit by BOT tech Darrell Groom

Moving Vessel Profiler
fish

Brooke Ocean 
Technology Inc. MVP-FFF-SS-32-1 10478 S220 N/A Apr-2009 Visit by BOT tech Darrell Groom, 

primary fish

Moving Vessel Profiler
fish

Brooke Ocean 
Technology Inc. MVP-FFF-SS-32-1 10329 S220 N/A Apr-2009 Visit by BOT tech Darrell Groom, 

spare fish

Moving Vessel Profiler 
sensor

Applied Micro Systems 
Ltd. AML Smart SV +P 4986 S220 DQAs weekly 10/2/2009 installed in primary fish

Moving Vessel Profiler 
sensor Applied Micro Systems AML Smart SV +P 5229 S220 DQAs weekly if in 

service
Returned to AML for service, April 

2009

Moving Vessel Profiler 
sensor

Applied Micro Systems 
Ltd. AML Smart SV +P 5466 S220 DQAs weekly if in 

service 10/30/2009 Purchased 2008, installed in 
spare fish

SEACAT Profiler Sea-Bird SBE 19plus 19P36026-4585 1.4D S220 DQAs weekly 12/24/2008 CON file: 4585.con

SEACAT Profiler Sea-Bird SBE 19plus 19P36026-4616 1.4D 1010 or 1018 DQAs weekly 12/30/2008 CON file: 4616.con

SEACAT Profiler Sea-Bird SBE 19plus 19P36026-4617 1.4D 1010 or 1018 DQAs weekly 12/20/2008 CON file: 4617.con

SEACAT Profiler Sea-Bird SBE 19plus V2 19P50959-6121 2.1 1010 or 1018 DQAs weekly 8/28/2009 CON file: 6121.con

SEACAT Profiler Sea-Bird SBE 19plus V2 19P50959-6122 2.1 1010 or 1018 DQAs weekly 8/29/2009 CON file: 6122.con

Real Time                         
Sound Speed Profiler RESON SVP 70 4008077 S220 DQAs weekly 1/4/2009

Real Time                         
Sound Speed Profiler

Odom Hydrographic 
Systems Digibar Pro 98013-041609 SW 1.11 1018 DQAs weekly 4/16/2009

Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install 
Date Location Date of last Field 

Cal/Testing

Date of last 
Manufacturer 
Cal/Service

Additional Information

Level Carl Zeiss N12 333 100056 N/A N/A S220  Mar-2009  Mar-2008

Level Carl Zeiss N12 333 103267 N/A N/A S220  Mar-2009  Mar-2008

Level Leica NA2 100 5332739 N/A N/A S220 Spare

Level Lecia NA2 100 5332747 N/A N/A S220 Spare

SOUND SPEED MEASUREMENT EQUIPMENT

TIDES & LEVELING EQUIPMENT



Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install 
Date Location Date of last Field 

Cal/Testing

Date of last 
Manufacturer 
Cal/Service

Additional Information

GPS Reciever Trimble NetR5 4910K61066 4.03 Apr-2009 S220 Apr-2009 obtained Apr-2009 Bar Code: CD0001526972

GPS Antenna Trimble Zephyr Geodetic 2 S220 Apr-2009 obtained Apr-2009 no Bar Code

GPS Reciever Trimble NetR5 4910K61054 4.03 Apr-2009 S220 Apr-2009 obtained Apr-2009 Bar Code: CD0001526973

GPS Antenna Trimble Zephyr Geodetic 2 30767941 S220 Apr-2009 obtained Apr-2009 no Bar Code

GPS Receiver Ashtech Z-Xtreme ZE1200339016  ZE21 Mar-2008 S220 Apr-2009 obtained Apr-2004 Bar Code: CD0001062363

GPS Antenna Ashtech Geodetic 4 8365 S220 Apr-2009 obtained Apr-2004 No Barcode

UHF Radio FreeWave HTP-900RE 884-8978 2.17 Mar-2009 S220 obtained Mar-2009 Bar Code: CD0001526970

UHF Radio FreeWave HTP-900RE 884-9190 2.17 Mar-2009 S220 obtained Mar-2009 Bar Code: CD0001526971

UHF Radio FreeWave HTP-900RE 8849511 2.17 May-2009 S220 obtained May-2009 no Bar Code

UHF Radio FreeWave HTP-900RE 8849301 2.17 May-2009 S220 obtained May-2009 no Bar Code

UHF Antenna PCTEL MAX9053 S220 obtained May-2009 no Bar Code

UHF Antenna PCTEL MAX9053 S220 obtained May-2009 no Bar Code

UHF Antenna PCTEL MAX9053 S220 obtained May-2009 no Bar Code

UHF Antenna PCTEL MAX9053 S220 obtained May-2009 no Bar Code

Solar Charger PWM EPRC5 S220 obtained May-2009 no Bar Code

Solar Charger PWM EPRC5 S220 obtained May-2009 no Bar Code

Solar Charger PWM EPRC5 S220 obtained May-2009 no Bar Code

Solar Panel Uni-Solar FLX-32 USF-32-14639 N/A N/A S220 no Bar Code

Solar Panel Uni-Solar FLX-32 USF-32-14634 N/A N/A S220 no Bar Code

Solar Panel Uni-Solar FLX-32 USF-32-14633 N/A N/A S220 no Bar Code

Solar Panel Uni-Solar FLX-32 USF-32-14529 N/A N/A S220 no Bar Code

Solar Panel Uni-Solar FLX-32 USF-32-14631 N/A N/A S220 no Bar Code

Solar Panel Uni-Solar FLX-32 USF-32-14625 N/A N/A S220 no Bar Code

Solar Panel Uni-Solar FLX-32 USF-32-14645 N/A N/A S220 no Bar Code

Solar Panel Uni-Solar MBC-525 525-011590 N/A N/A S220  Bar Code: CD000684513

Solar Panel Uni-Solar MBC-526 525-011093 N/A N/A S220  Bar Code: CD000684507

Solar Panel Uni-Solar MBC-527 525-011589 N/A N/A S220  Bar Code: CD000684510

Solar Panel Uni-Solar MBC-528 525-011607 N/A N/A S220  Bar Code: CD000684512

Solar Panel Uni-Solar MBC-529 525-011587 N/A N/A S220  Bar Code: CD000684511

Solutions Dongles Ashtech 600586 (A) KEB2083 N/A N/A S220 no Bar Code

Solutions Dongles Ashtech 600586 (A) KEB2077 N/A N/A S220 no Bar Code

HORIZONTAL AND VERTICAL CONTROL EQUIPMENT



Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install 
Date Location Date of last Field 

Cal/Testing

Date of last 
Manufacturer 
Cal/Service

Additional Information

GPS RTK Receiver Trimble DSM-232 225111661 3.57 Mar-2008 S220 Bar Code: CD0001697439

GPS Receiver Trimble DSM-232RS 225111655 3.57 Mar-2008 S220 Bar Code: CDCD0001697422

DGPS Antenna Trimble 33580-00 220395038 N/A N/A S220

GPS Antenna Trimble Zephyr Geodetic 
Antenna

30325441 N/A N/A S220 no Bar Code

GPS Antenna Trimble SPS MSK 5876 N/A N/A S220 no Bar Code

GPS RTK Reciver Trimble MS 750 220339262 Bar Code: CD 0001478898

GPS Antenna Trimble Trimble Micro Centered 
L1/L2

220298707 N/A N/A S220 NOAA Launch Barcode A2008

Position Data Link High
Powered Base Unit Pacific Crest PDL 4135 0424 0171 2.40 Apr-2004 S220 5/3/2007 obtained Apr-2004 Bar Code: CD0001269910

Position Data Link Rover Pacific Crest PDL 4100 04240154 2.4 Apr-2004 S220 5/3/2007 obtained Apr-2004

Position Data Link Rover Pacific Crest PDL 4100 03473047 2.32 Apr-2004 S220 5/3/2007 obtained Apr-2004

Position Data Link Rover Pacific Crest PDL 4100 04240155 2.4 Apr-2004 S220 5/3/2007 obtained Apr-2004

ADDITIONAL POSITIONING EQUIPMENT



FAIRWEATHER Computers

Machine Name
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New DELL deskptop installed week of 12/4/07

Machine Name

FA_Proc_1 Plot Room DELL Precision 490 XP Pro 2002 SP3 Nov-07 2.66 GHz 3GB 2 256 MB 9MP1PD1 CD0001615385

Plot Room DELL Precision 490 XP Pro 2002 SP3 Nov-07 2.66 GHz 3GB 2 256 MB 4NP1PD1 CD0001615382

Plot Room DELL Precision 490 XP Pro 2002 SP3 Nov-07 2.66 GHz 3GB 2 256 MB 6MP1PD1 CD0001615383

Plot Room DELL Precision 490 XP Pro 2002 SP3 Nov-07 2.66 GHz 3GB 2 256 MB 2NP1PD1 CD0001615380

Plot Room DELL Precision 490 XP Pro 2002 SP3 Nov-07 2.66 GHz 3GB 2 256 MB 3MP1PD1 CD0001615381

Plot Room Dell Precision T3400 XP Pro 2002 SP3 Apr-08 3.0GHz 3GB 2 512MB 1JKCZF1 CD0001615471

Plot Room DELL Precision 490 XP Pro 2002 SP3 Nov-07 2.66 GHz 3GB 2 256 MB 8MP1PD1 CD0001615384

Plot Room Dell Precision T3400 XP Pro 2002 SP3 Apr-08 3.0GHz 3GB 2 512MB 5JKCZF1 CD0001615467

Plot Room Dell Precision T3400 XP Pro 2002 SP3 Apr-08 3.0GHz 3GB 2 512MB 3JKCZF1 CD0001615472

DP-2 Dell Precision T3400 XP Pro 2002 SP3 Apr-08 3.0GHz 3GB 2 512MB JHKCZF1 CD0001615468

Field Office Dell Precision T3400 XP Pro 2002 SP3 Apr-08 3.0GHz 3GB 2 512MB 4JKCZF1 CD0001615469

Field Office Dell Precision T3400 XP Pro 2002 SP3 Apr-08 3.0GHz 3GB 2 512MB DHKCZF1 CD0001615470

O-LAB Dell Prcision 360 XP Pro 2002 SP3 3.0GHz 3.5GB 2 128MB GBBG451 CD0001741480

Laptop Panasonic   CF-18 XP Pro 2002 SP2 ~ March 2004 ~ July 2006 1.1 GHz 2.5 GB N/A 1 64 MB 4HKSA59499 CD0001269860

Laptop Panasonic  CF-18 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 1.1 GHz 2.5 GB N/A 1 64 MB 4HKSA59560 CD0001269858

Laptop Panasonic  CF-18 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 1.1 GHz 2.5 GB N/A 1 64 MB 4GKSA55049 CD0001269859

Laptop Panasonic  CF-29 XP Pro 2002 SP2 March 2006 N/A 1.6 GHz 2.5 GB N/A 1 128 MB 6AKSB06863 CD0001698251

Laptop Panasonic CF-30 XP Pro 2002 SP3 March 2009 1.7GHz 1 Gb 0 384 MB 8HKSB80630 CD0001447100

Laptop Panasonic CF-30 XP Pro 2002 SP3 March 2009 1.7GHz 1 Gb 0 384 MB

Laptop Panasonic CF-19 XP Pro 2002 SP3 March 2009 1.1GHz 1 Gb 1 384 MB 9AKSB43281 CD0001696424

Launch 1010 ICI XP Pro 2002 SP2 Mar-08 2.66GHz 3GB 3 128MB CD0001615466

Launch 1018 ICI XP Pro 2002 SP2 Mar-08 2.66GHz 3GB 3 128MB CD0001615463

Plot Room Dell Precision T3400 XP Pro 2002 SP2 Mar-08 3.0GHz 3GB 3 512MB CSH8NF1 CD0001615444

Plot Room MVP-C1-2001 2000 SP4 ~ March 2004 ~ September 2005 2.4 GHz 230 MB 230 MB 1 64 MB SN: 10330 CD0001269854

Toughbook 6

New DELL deskptop installed week of 12/4/07

New DELL deskptop installed week of 12/4/07

FA_Proc_1

FA_Proc_2

S220_ACQ

1010_ACQ

1018_ACQ

Toughbook 1

Toughbook 2

Toughtab 1

Toughbook 3

Toughbook 4

Toughbook 5

FA_O-LAB*

FA_FOO

FA_CST

FA_Proc_8

FA_Proc_9

FA_Proc_10

New DELL deskptop installed week of 12/4/07

New DELL deskptop installed week of 12/4/07FA_Proc_5

FA_Proc_6

FA_Proc_7*

FA_Proc_3 New DELL deskptop installed week of 12/4/07

New DELL deskptop installed week of 12/4/07

New DELL deskptop installed week of 04/06/08

FA_Proc_4

New DELL deskptop installed week of 04/14/08

New DELL deskptop installed week of 04/06/08

New DELL deskptop installed week of 04/06/08

New DELL deskptop installed week of 04/06/08

New DELL deskptop installed week of 04/06/08

*rebuilt after crash July 2006

out for service

out for service

FA_MVP200



Appendix II 
 
 
Equipment Specifications 
 

1. Sonar Systems 
a. RESON 

i. 8101 Equipment Specs 
ii. 8111 Equipment Specs 
iii. 8160 Equipment Specs 

b. VBES 
i. Odom Echotrac CVM 
ii. SMBB200-9 Transducer Information 
iii. SMSW200-4a Transducer Information 

c. SSS 
i. Klein 5000 

2. Positioning 
a. POS MV 

i. v320 
b. DGPS 

i. MBX-3S 
ii. SF-2050 

3. Shoreline 
a. Trimble 

i. Accuracy 
ii. Specs 
iii. TSCe 

b. Lasers 
i. TruPulse 200 
ii. Impulse 200 LR 

4. SV 
a. MVP 

i. MVP 200 
b. SBE 

i. SBE 45 
ii. SVP 70 
iii. Specs-19p-4585 
iv. Specs-19p-4616 
v. Specs-19p-4617 
vi. Specs-19pV2-6121 
vii. Specs-19pV2-6122 

5. Control 
a. Leveling 

i. Leica NA2 level 
ii. Zeiss NI2 level 

b. HorCon 
i. PDL 
ii. Z-Xtreme Ashtech GPS 



6. Total Stations 
a. Nikon DTM310  
b. Sokkia SET5F 



!! Phase and Amplitude
Bottom Detection

!! 150EE Wide Swath
Coverage

!! 240 kHz Frequency

!! Up to 500m Range
Capability

!! Portable
Configuration

!! Meets USACE Class 1
Standards

!! Meets IHO Standards

The SeaBat 8101 Multibeam Echo Sounder measures discrete depths, enabling
complex underwater features to be mapped with precision.  Dense coverage is
achieved utilizing up to 3,000 soundings per second for a swath that can be over
500 meters wide, even as the survey vessel travels at speeds of over 18 knots.

With high accuracy and a measurement rate up to 30 profiles per second, the
SeaBat 8101 enables surveys to be completed faster and in greater detail than
previously realized.  The SeaBat is an integral part of the new, integrated
bathymetry surveying systems.

The SeaBat transducer is available pressurized for depths from 100 to over 3,000
meters.  Small and lightweight, it can be can be mounted on small underwater
vehicles (ROV, AUV or towed) and taken to where accurate measurements are
required.

SeaBat 8101
PRODUCT SPECIFICATION

240kHz MULTIBEAM ECHO SOUNDER



©1999 RESON Inc.
Version 4.0  Due to our policy of continuous product improvement,
032399 specifications are subject to change without notice.

SeaBat 8101 Head
with Optional Fairings

SeaBat 8101 Built-In Test
Environment (“BITE”) Screen

SYSTEM SPECIFICATIONS

Operating Frequency: 240kHz
Range Scales: 5, 10, 15, 20, 25, 35, 50, 75, 100, 125,

150, 175, 200, 250, 300, 350, 400, 450,
500m. 

Range Resolution: 1.25 cm
Number of Beams: 101

Horizontal Beamwidth: 1.5E
Horizontal Coverage: 150E
Vertical Beamwidth: 1.5E

Update Rate: Range-variable up to
30 times per second

SONAR HEAD SPECIFICATIONS

Power Requirement: 24VDC, 2 Amps max.
(Power available from
surface processor.)

Uplink: Digital, 76.8 Mbaud
Down Link Control: RS-232 or RS-422, 19,200 baud

Operating Depth: 100 meters
(300m, 1500m, 3000m & 6000m avbl.)

Dimensions: 266x320mm W/Diam 
(does not include projector)

Temperature: Operating: -5E to +40EC
Storage: -30E to +55EC

Weight (aluminum): Dry: 26.8 kg (59 lbs)
Wet: 4.8 kg (10.6 lbs)

Weight (titanium): Dry: 40 kg (88 lbs)
Wet: 18 kg (39.6 lbs)

DISPLAY SPECIFICATIONS

Screen Size: 14 inch Diagonal 
Input: SVGA (800x600, 72 Hz)

Display: High Resolution Color
Power Consumption: 62 W

PROCESSOR SPECIFICATIONS

Power Requirements: 115/230VAC, 50/60Hz,
100W max.

Data Output: Selectable, 300-155.2 Kbaud
or Ethernet 10 base T
or 10 base 2

Video Output: SVGA (800x600, 72 Hz)
or NTSC or PAL video.

Graphics Colors: 256 colors (8-bit)
Display Mode: Sector Format

Display Arc: 150E
Input Device: 3-Button Trackball
Dimensions: 19" rack, 4U high

(266x483x434mm HWD)
Temperature: Operating: 0E to +40EC

Storage: -30E to +55EC
Weight: 20 kg (44 lbs)

OPTIONS

Option 033: Side Scan Upgrade
Option 034: Mounting Plate Assembly
Option 035: Fairings (pictured above)
Option 036: Spares Kit
Option 037: Titanium Housing
Option 038: 210° Swath
Option 040: Extended-Range Projector
Option 049: Increase Transducer Depth 

Rating



SeaBat 8111
PRODUCT SPECIFICATION

MULTIBEAM ECHOSOUNDER

•• Phase and amplitude
bottom detection

•• 100 kHz frequency

•• 150° swath coverage

•• Real-time quality
control

•• Sidescan upgradeable

•• Modular and portable

•• Pitch stabilization

The SeaBat 8111 is a modular multibeam echosounder system operating at
100 kHz. When installed on a vessel, it produces high-density, high-accuracy
soundings on the seafloor over a 150° swath. Major system components
include a transducer array, a transceiver unit, and a processor unit.

The SeaBat 8111 transducer array is comprised of a cylindrical receive array
and a linear transmitter array, mounted together on a support cradle that
provides mounting points to the vessel. Lightweight and portable, the array
can be installed temporarily over the side of a vessel of opportunity––a first for
a system in this frequency range.

The SeaBat 8111 transceiver features plug-in cards for easy maintenance and
is controlled from the sonar processor.

The Seabat 8111 processor is compatible with other SeaBat sonar heads, can
be updated in minutes to accommodate future requirements, and features a
user-friendly point-and-click interface.



MECHANICAL INTERFACE

Dimensions (in mm):
Transducer Array:

Hydrophone: 636 x 118 (Dia./Length)
Projector: 113 x 650 (Dia./Length)

Processor: 177 x 483 x 417
Transceiver: 267 x 483 x 489

Weight:
Transducer Array: 72 kg (dry) / 59 kg (wet)

with cables
Processor: 20 kg
Transceiver: 13.6 kg

Cable Length: 15m

SEAFLOOR COVERAGE
(with Extended Range option)

SeaBat 8111 SYSTEM SPECIFICATIONS

Version: B006 030205
©1999 RESON Inc.

Due to our policy of continuous product improvement,
RESON reserves the right change specifications without notice.

Transceiver
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Transducer Array
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650118
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Hydrophone Projector

SYSTEM PERFORMANCE

Frequency: 100 kHz

Range Resolution: 3.7 cm

Swath Coverage: 150º

Range: 3m to 1200m
(with Option 040)

Number of Beams: 101

Along-Track Beamwidth: 1.5º 3.0º 4.5º 6.0º*
Across-Track Beamwidth: 1.5º

Stabilization: Pitch stabilization 
within +/-15º

Projector Beam Control: External motion
sensor required

Accuracy: IHO Compliant

Operational Speed: Up to 20 knots

Max. Update Rate: 35 Hz

Transducer Pressure Rating: 100m

*operator selectable

INTERFACE

System Supply: 90 to 260VAC, 50/60 Hz,
200W max.

Video Display: SVGA, 800 x 600, 72 Hz

System Control: Trackball or from Ethernet

Data Output: 10 MB Ethernet or
serial RS232C

Data Uplink: High-speed digital coax
with fiber-optic option

Temperature: Operating: 0° to +40° C
Storage: -30° to +55° C

RELATED PRODUCTS
• Option 040 Extended range capabilities
• Option 033 Sidescan upgrade
• Option 051 24DC power supply for SeaBat

81-P Processor

Bottom Depth (meters) Swath Width (meters)
5 to 150 Up to 1110 (7.4 x water depth)

300 960 (3.2 x water depth)
450 810 (1.8 x water depth)
600 600 (1.0 x water depth)
750 450 (0.6 x water depth)
900 360 (0.4 x water depth)



SeaBat 8160
PRODUCT SPECIFICATION
MULTIBEAM ECHOSOUNDER SYSTEM

•• Swath coverage
greater than 4x
water depth

•• Operational depth:
10m to 3000m

•• 50 kHz frequency

•• 126 beams

•• Hull-mount or
portable

•• Meets IHO
accuracy

•• Sidescan
upgradable

The SeaBat 8160 is a new addition to the 8100 series of multibeam
echosounders. Operating at 50 kHz, the system ensonifies the whole
swath in a single ping, generating 126 simultaneous high-resolution
receive beams.

The SeaBat 8160 transducer array is comprised of a linear receive and
transmit array mounted together on a support base. The T-shaped array
geometry provides the basis for a compact, high-resolution sonar which
is easily installed for portable or hull mounts––a first for a high-resolution
system in this frequency range.

The system features a pitch-stabilized transmitter and an active roll-
compensated receiver.

The SeaBat 8160 processor is compatible with other SeaBat sonar heads.
It can be updated in minutes to accommodate future requirements, and
features a user-friendly point-and-click interface.

RESON, INC. • USA
Tel +1 805 964 6260
Fax +1 805 964 7537
Email: sales@reson.com

RESON A/S •  DENMARK
Tel +45 47 38 00 22
Fax +45 47 38 00 66
Email: reson@reson.dk
RESON OFFSHORE •  UK
Tel +44 1224 709 900
Fax +44 1224 709 910
Email: sales@reson.co.uk

w w w. r e s o n . c o m

RESON, GmbH • GERMANY
Tel +49 431 720 7180
Fax +49 431 720 7181
Email: reson@reson-gmbh.de



SYSTEM PERFORMANCE

Frequency: 50 kHz

Depth Resolution: 2.4 cm / 9.6 cm

Swath Coverage: Greater than 4x 
water depth

Max Operational Depth: 3000 m

Number of Beams: 126

Along-Track Beamwidth: 1.5º

Across-Track Beamwidth: 1.5º

Pitch Stabilization: ±10º

Accuracy: IHO Special Order

Operational Speed: Up to 20 knots

Max. Update Rate: 15

Transducer Depth Rating:

100m

INTERFACE

System Supply: 115V/230V 50/60 Hz,
350W

Video Display: SVGA, 800 x 600, 72 Hz

System Control: Trackball or from
Ethernet

Data Output: 10 MB Ethernet or
serial RS232C

Data Uplink: High-speed digital coax
with fiber-optic option

Temperature: Operating: 0° to +40° C
Storage: -30° to +55° C

MECHANICAL INTERFACE

Dimensions (HWD in mm):
Transducer Array: 1474.5 x 1100 x 90.5
Processor: 177 x 483 x 417
Transceiver: 265 x 483 x 492

Weight:

Transducer Array: 50 kg (dry) / 30 kg (wet)
Processor: 20 kg
Transceiver: 13.6 kg

SeaBat 8160 SYSTEM SPECIFICATIONS

Version: B34-PDF-011009
Due to our policy of continuous product improvement,

RESON reserves the right change specifications without notice.
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Transceiver Processor

Transducer Array

Mounting Frame
Option 034H







SMBB200-9_information_sheet 
Stem Mount, 200khz-9d, BROADBAND, SS510-2, C33, 10m,5P 

      
odomhydrographic.com 
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Performance Data 

Frequency 200kHz - BClq 
Beam Width 9° 
Q (transmit) 2.5 

Rated RMS Power 500 W 
Balanced Impedance 60 ohms 
Peak Figure of Merit -16 

Bandwidth  
Acoustic Window Material Urethane 

Threads ½” –14NPS 
Cable Type C33 (2-20 AWG) 
Cable Size 6mm 

Weight 1.3Kg. 

 
Broadband with superlow Q of 2.5.  Small housing with short stem 
used primarily for navigation and survey applications.  This model is 
usually mounted on an extension tube but is adaptable to portable 
survey and navigation systems.  It contains a transformer which can 
be used to match the impedance of the echosounder or allow the use 
of longer cables.  The transducer is available in either a bronze or 
stainless steel housing.  Model SS510 provides good definition in hard 
bottoms with side lobes. 

Odom Hydrographic Systems, Inc.
1450 Seaboard Avenue

Baton Rouge, LA. 70810 –6261
225.769.3051, Facsimile 225.766.5122



SMSW200-4a_information_sheet 
Stem Mount, Shallow Water BB 200kHz-4d,SS538,C37,10m,SS,5p 
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Performance Data 

Frequency 200kHz 
Beam Width 4° 
Q (transmit)  

Rated RMS Power  
Balanced Impedance 60 ohms 
Peak Figure of Merit  

Bandwidth  
Acoustic Window Material Urethane 

Threads    ¾” –14NPS 
Cable Type C37 (2-20 AWG) 
Cable Size 6mm 

Weight 1.3Kg. 

 
The compact stainless steel housing is easily adapted to portable or hull 
mounted applications.  This unit is primarily used for shallow and mid-depth 
survey applications where delineation of steep slopes and sounding in very 
shallow water are important features. It contains a transformer that matches 
the impedance of the transducer to that of the echo sounder and allows for 
the use of longer cables without affecting performance.   
 

Odom Hydrographic Systems, Inc.
1450 Seaboard Avenue

Baton Rouge, LA. 70810 –6261
225.769.3051, Facsimile 225.766.5122
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KLEIN SYSTEM 5000

HIGH-RESOLUTION, DYNAMICALLY FOCUSED,
MULTI-BEAM SIDE SCAN SONAR

Conventional side scan sonar systems use a 

single sonar beam per side to generate an image of

the seafloor. The physics of this type of sonar

results in degradation of image resolution with

range poor along track resolution, and requires

speeds of 5 knots or less to insure 100 percent 

bottom coverage.

From a design perspective, these shortcomings can

be eliminated by designing a sonar that, through

beam steering and focusing techniques, simul-

taneously generates several adjacent, parallel

beams per side. Such a multi-beam design

approach permits higher towing speeds with 100

percent bottom coverage, while providing 

high-resolution imaging to the maximum range of

the sonar.

This design approach is principally employed 

by military side scan sonar systems designed 

for high speed mine hunting applications. L-3 Klein

is the first commercial company to offer 

a multi-beam side scan sonar using similar design

techniques to military sonars, but at a fraction of

the cost.

The two main benefits of the high-speed, 

high- resolution System 5000 series are: 

higher towing speeds with no loss of bottom 

coverage, and range independent high-resolution

image capability.

Since operation costs are dependent on the amount

of at-sea time required to complete a survey, the

Klein System 5000 Multi-Beam Side Scan Sonar

with survey speeds more than twice that of 

conventional side scan sonars, minimize at-sea

time, thus greatly reducing survey costs.

THE DIFFERENCE

IS IN THE IMAGE

K E Y  F E A T U R E S

• Multiple simultaneous beams
per side each ping

• High tow speed capability

• Dynamic digital auto-focusing

• Very high resolution and 100%
coverage

• Sonar connected to PC display
on Ethernet LAN

The System 5000 is a 5-beam side scan sonar designed for hydrographic, military and commer-
cial applications requiring high-resolution images of the sea floor and bottom obstructions,
while operating at tow speeds up to 10 knots and with an overall swath width of 300 meters.



L-3. Headquartered in New York City, L-3 Communications employs over 64,000 people worldwide and is a prime contractor in aircraft
modernization and maintenance, C3ISR (Command, Control, Communications, Intelligence, Surveillance and Reconnaissance) systems and
government services.  L-3 is also a leading provider of high technology products, subsystems and systems.  

Cleared for public release. Specifications subject to change without notice. Call for latest revision. Windows NT, 2000, VxWorks, and Kevlar - are registered trademarks 
of Microsoft Corp., Wind River Systems, Inc., and DuPont - respectively.  SonarPro® is a registered trademark of L-3 Klein Associates, Inc.        4/09

Klein Associates, Inc.

11 Klein Drive

Salem, NH 03079-1249  USA

Phone: 603.893.6131

Fax: 603.893.8807

Klein.Mail@L-3com.com

www.L-3Klein.com

 Towfish Specifications

Number of beams 5 port & 5 starboard 

Frequency 455 kHz ± 1%

Range scales 50, 75, 100, 150 m

Pulse length 50 to 200 μsec.

High-resolution mode
(along track)

10 cm to 38 m

Standard resolution
mode (along track)

20 cm to 75 m, thereafter
increasing to maximum of 36
cm @ 150 m maximum range

Resolution (across track) 7.5 to 30 cm

Operating speed envelope 2-10 knots @ 150 m sonar range

Sonar digitization 16 bit / channel  

Maximum operating range 150 m (300 m Swath)

Array length 120 cm (47.2 in)

Body length 194 cm (76.4 in)

Body diameter 15.2 cm (6 in)

Weight (in air) 70 kg (155 lbs)

Sensors:
Heading
Pitch & roll

Standard 
Standard 

Pressure / altimeter Standard

Depth rating* 200 m standard

K l e i n  A s s o c i a t e s ,  I n c .

KLEIN SYSTEM 5000

HIGH-RESOLUTION, DYNAMICALLY FOCUSED,
MULTI-BEAM SIDE SCAN SONAR

Workstation PC

Workstation PC
SonarPro® installed
Windows OS installed

Optional, with SonarPro software
installed

* For deeper depth rated systems, please contact Klein

Options

Yaw rate and high-resolution roll sensors

Responder / transponder

Splash-proof TPU housing

Fiber optic interface

Tow Cable

Type: steel Coaxial or fiber-optic double armored

Transceiver Processor Unit (TPU) Specifications

Width Standard 19-in rack-mount

Height 13.2 cm (5.2 in)

Depth 54.6 cm (21.5 in)

Weight 12.7 kg (28 lbs)

Input voltage 115/240 VAC, 50/60 Hz

Power 120 W (includes towfish)

Navigation input NMEA 0183

Data output 100 BaseT Ethernet LAN



The new POS MV V4 - a tightly-coupled system utilizing 
advanced Inertially-Aided Real-Time Kinematic (IARTK) 
technology designed to increase your operational capability 
and reduce downtime.

Tightly integrated inertial navigation – Continuous positioning 
data can be generated while surveying in areas where GPS reception 
is compromised by multipath effect and signal loss, such as close to 
offshore structures, or in ports, harbors, near-shore coastal waters 
and rivers. Raw GPS data from as few as one satellite can now be 
processed directly within the POS MV reducing position drift and RTK 
re-acquisition time. 

The V4 Advantage 
The Major Benefi ts

• Faster, more robust heading aiding from GPS Azimuth 
Measurement Subsystem (GAMS) when compared to V3

• Proprietary Inertially Aided RTK providing almost 
instantaneous reacquisition of RTK following a GPS outage

• Superior low elevation tracking performance using lighter, 
smaller Trimble Zephyr ™ geodetic antenna technology

• Faster initial system calibration 
• Maintains heading accuracy longer when in a high multipath 

environment 
• Increased component reliability
• Automatic identifi cation and error estimation for lever arm 

distances and angles

The Latest Technology
V4 uses the latest Trimble BD950 receivers with the following 
attributes:

• Extremely fast response time
• Latency of less than 20 milliseconds (at 20 times per second) Latency of less than 20 milliseconds (at 20 times per second) 
• Very low noise L1 and L2 carrier phase Very low noise L1 and L2 carrier phase 

measurements
• Uses the Maxwell 4 Custom Survey 

GPS chip for enhanced tracking 
capability    

Straightforward Installation and Operation 
• All components mounted and installed using a straightforward, 

one-time-only, systematic procedure. 

Faster, More Reliable Networking Potential
• An improved Ethernet raw data logging capability for 

streamlined data acquisition of all motion variables with 
microsecond-accurate time stamping   

Upgradeability*
• Convenient upgrade program for PCS and antennas, to allow 

for maximum interoperability when moving from L1 only to a 
full L1/L2 RTK unit

The Most Accurate Position and Orientation Solution
POS MV V4 maintains positioning accuracy under the most demanding 
conditions regardless of vessel dynamics. With its high data update rate, 
the system delivers a full six degree-of-freedom position and orientation 
solution to provide the following:

• Position (latitude, longitude and elevation)
• Velocity (north, east and vertical)
• Attitude (roll, pitch and true heading)
• Heave (real-time, delayed)
• Acceleration Vectors
• Angular Rate Vectors

* For detailed upgrade information please call your Applanix Marine offi ce 

SYSTEM COMPONENTS
POS Computer System (PCS) – A rugged, compact computer system contains the 
core POS processor and IMU interface electronics, plus two GPS receivers and an optional 
removable PC-card disk drive. The PCS provides system timing, position and velocity aiding, 
together with GPS raw observables for use with GAMS.

POS Inertial Measurement Unit – The system’s primary sensor allows for the 
continuous output of position and orientation data. 

Primary GPS Receiver Antenna – A dual frequency antenna for use with GAMS.

Secondary GPS Receiver Antenna – A dual frequency antenna for use with GAMS.

Latency of less than 20 milliseconds (at 20 times per second) Latency of less than 20 milliseconds (at 20 times per second) 
Very low noise L1 and L2 carrier phase Very low noise L1 and L2 carrier phase 

DATASHEET
The New POS MV - Providing the Marine Industry with robust, reliable, and 
repeatable position and orientation solutions



SPECIFICATIONS
Accuracy

POS MV 320 Main Specifi cations (with Differential Corrections)

Roll, Pitch accuracy: 0.02° (1 sigma with GPS or DGPS)

0.01° (1 sigma with RTK) 

Heave Accuracy: 5 cm or 5% (whichever is greater) for periods of 20 
seconds or less

Heading Accuracy: 0.02° (1 sigma) with 2 m antenna baseline, 0.01 (1 
sigma) with 4 m baseline

Position Accuracy: 0.5 - 2 m (1 sigma) depending on quality of differential 
corrections

0.02 - 0.10 m (RTK) with input from auxiliary RTK or 
optional internal RTK receiver

Velocity Accuracy: 0.03 m/s horizontal

POS MV 320 during GPS Outages

Roll, Pitch accuracy: 0.02° (1 sigma) 

Heave accuracy: 5 cm or 5% (whichever is greater) for wave periods 
of 18s or less

Heading accuracy: Drift less than 1° per hour (negligible for outages < 
60s)

Position accuracy
degradation:

2.5 m (1 sigma) for 30 s outages
<6 m (1 sigma) for 60 s outages

POS MV 220 Main Specifi cations (with Differential Corrections)

Roll, Pitch accuracy: 0.05° (1 sigma with GPS or DGPS)

<0.05° (1 sigma with RTK) 

Heave Accuracy: 5 cm or 5% (whichever is greater) for periods of 20 
seconds or less

Heading Accuracy: 0.1° (1 sigma) with 2 m antenna baseline, 0.05° (1 
sigma) with 4 m baseline

Position Accuracy: 0.5 - 4 m (1 sigma) depending on quality of differential 
corrections

0.02 – 0.10 m (RTK) with input from auxiliary RTK or 
optional internal RTK receiver

Velocity Accuracy: 0.05 m/s horizontal DPGS, .03 m/s horizontal RTK

POS MV 220 during GPS Outages

Roll, Pitch accuracy: 0.05° (1 sigma) 

Heave accuracy: 5 cm or 5% (whichever is greater) for wave periods 
of 18s or less

Heading accuracy: Drift less than 3° per hour (negligible for outages < 
60s)

Position accuracy 
degradation:

2.5 m (1 sigma) for 30 s outages
<6 m (1 sigma) for 60 s outages

Physical Characteristics

Size

IMU: 204 mm X 204 mm 
X 168 mm

7.95 in X 7.95 in 
X 6.55 in

PCS: 432 mm X  89 mm 
X 356 mm 

17.00 in X3.50 in 
X 14.05 in

2.0U 19 in rack 
mount 

GPS Antenna (x2): 187 mm X 53 mm 7.4 in X 2.1 in

Weight

IMU: 3.5 kg 7.7 lb (international)

Processor: 5 kg 11.0 lb (international)

GPS Antenna: <0.5 kg <1.1 lb (international)

Power

Processor: 110/230 Vac, 50/60 Hz, auto-switching 80 Watt

IMU: Power provided by PCS

GPS Antennas: Power provided by PCS

Environmental

Temperature Range (Operating)

IMU: -40 °C to +60 °C -40 °F to +140 °F

Processor:    0 °C to +55 °C +32 °F to +131 °F

GPS Antenna: -40 °C to +70 °C -40 °F to +158 °F

Temperature Range (storage)

IMU: -40 °C to +60 °C -40 °F to +140 °F

Processor: -25 °C to +85 °C -13 °F to +185 °F

GPS Antenna: -50 °C to +70 °C -58 °F to +158 °F

Humidity
IMU: 10 - 80% RH, Ingress Protection of 65
Processor: 10 - 80% RH, non-condensing
GPS Antenna: 0 - 100% RH

Shock & Vibration (IMU)
Operating: 90 g, 6 ms terminal saw tooth

Non-Operating: 220 g, 5 ms half-sine

Applanix Marine Offi ces
Applanix Corporation

85 Leek Crescent
Richmond Hill, Ontario

Canada L4B-3B3 

Tel: +1 905-709-4600
Fax: +1 905-709-6027

Applanix LLC
17461 Village Green Drive

Houston, TX 
USA 77040

Tel: +1 713-896-9900
Fax: +1 713-896-9919

Applanix United Kingdom
Forester’s House, 

Old Racecourse, Oswestry 
SY10 7PW UK

Tel: +44 1691 659359
Fax: +44 1691 659299

 





MBX-3S
The most popular commercial-grade 
Coast Guard Beacon Receiver

www.csi-wireless.com

• Dual-channel Coast Guard beacon receiver

• Supplements GPS systems with free differential corrections,
enhancing accuracy

• Fast signal acquisition

• Wide input voltage range for a variety of power sources

• Low power consumption extends battery life 

• Automatic tuning mode for hands-free operation

• Integrated signal splitter outputs GPS signal from combined 
GPS /differential antennas

• Front-panel interface for easy configuration and status monitoring



Receiver Specifications 
Channels: 2 independent channels
Channel Spacing: 500 Hz
Frequency Range: 283.5 to 325.0 Hz
MSK Bit Rates: 50, 100, 200 bps 
Cold Start Time: <1 min
Warm Start Time: <2 seconds
Demodulation: Minimum shift keying
Sensitivity: 2.5 µV/m for 6 dB SNR
Dynamic Range: 100 dB
Frequency Offset: ±8 Hz (27 ppm)
Adjacent Channel Rejection: 61 dB fo ± 400 Hz
Correction Output Protocol: RTCM SC-104
Input Status Protocol: NMEA 0183

Communications 
Interface: RS-232C or RS-422
Baud Rates: 2400, 4800, 9600

Environmental Specifications
Operating Temperature: -30°C to +70°C
Storage Temperature: -40°C to +80°C
Humidity: 95% non-condensing
EMC: EN 60945

EN 50081-1
EN 50082-1
FCC: Part 15, sub-part J,
class A digital device

Power Specifications
Input Voltage Range: 9 to 40 VDC
Nominal Power: 2.5 W
Nominal Current: 210 mA
Antenna Voltage Output: 10 VDC (5 VDC optional)
Antenna Input Impedance: 50 Ω

Mechanical Specifications
Dimensions: 150 mm L x 125 mm W x 51 mm H

(5.9” L x 4.9” W x 2.0” H)
Weight: 0.64 kg (1.4 lb)
Display: 2-line x 16-character LCD
Keypad: 3-key switch membrane
Power Connector: 2-pin circular locking
Data Connector: DB9-S
Antenna Connector: BNC-S
Optional GPS Output Port: TNC-S

Operating Modes
MBX-3 Mode (Default): RTCM SC-104 correction and

NMEA status message output 
(Default Mode)

MBX-E Mode: RTCM SC-104 correction and 
NMEA status message output 
and GPS NMEA message 
input for position and satellite 
status display

NMEA 0183 I/O
• Receiver Automatic and Manual tune command
• Frequency and data rate query
• Receiver performance and operating status queries
• Automatic search almanac queries (proprietary)
• Baud rate selection command
• Receiver tune command
• Force cold start command (proprietary)
• Software upgrade command (proprietary)
• Configuration up-load command (proprietary)

Accessories
Antenna: Various
Power Cables: Various
Antenna Cables: Various
Data Cables: Various
CSI Beacon 
Command Center: MS Windows 95® beacon 

control software

Pin-out
RS, 232C (DB9 PIN#)

Pin 2 TXD,RTCM SC-104/Status Output
Pin 3 RXD, configuration input
Pin 5 Signal return 

RS-422 (DB9 PIN#)

Pin 1 TXD +, RTCM SC-104 / 
Status Output

Pin 2 TXD -, RTCM SC-104 / 
Status Output

Pin 4 RXD -, configuration input
Pin 5 Signal return
Pin 7 RXD +, configuration input

© Copyright September 2002, CSI Wireless Inc. All rights reserved. Specifications subject to change without notice.

CSI Wireless and the CSI Wireless logo are trademarks of CSI Wireless Inc. Made in Canada.

Warranty: Each CSI Wireless product is covered by a limited one-year warranty on parts and labor.

Avery label #05260 (laser print)
4110 - 9th Street SE • Calgary • AB • Canada • T2G 3C4

Phone (403) 259•3311 • Fax (403) 259•8866
Printed in Canada.

CSI Wireless Dealer  

The most popular commercial-grade DGPS Beacon ReceiverMBX-3S



NavCom’s SF-2050G and SF-2050M 
modular StarFire™ receivers provide instant
position information for decimeter-level 
position accuracy, anywhere in the world, 
anytime. Onboard memory, and a geodetic
quality antenna enable millimeter level 
accuracy from post-processing.

APPLICATIONS
The rugged and reliable SF-2050 series is
designed for productivity with minimal 
setup time. The SF-2050G is designed for
backpack GIS and mapping applications while
the SF-2050M is ideal for vehicle mounting 
to suit a wide variety of machine guidance and
control applications. The primary operating
mode uses the StarFire™ service, and offers
decimeter level accuracy for immediate results
in the field; great for navigation and relocation
of existing assets. The two onboard
WAAS/EGNOS channels provide free 
GPS corrections, which coupled with dual 
frequency measurements and NavCom’s
enhanced SBAS algorithm typically provides
half-meter real-time accuracy. Simply connect
your controller solution to the serial port and
receive NMEA format position information, 
or use a NavCom Partner controller solution
for additional configuration and monitoring
capabilities.

BENEFITS
The SF-2050 receivers use our NCT-2100D
GPS Engine, the fourth generation of the
Touchstone™ ASIC family, of which more 
than 25,000 are in use worldwide. This
incorporates our patented interference 
suppression and multi-path mitigation, up 
to 50Hz raw data rate, geodetic quality 
measurements, and up to 25Hz positioning.

The SF-2050 utilizes a compact tri-band 
antenna capable of receiving GPS and
StarFire signals. This antenna provides 
excellent phase center stability in a small,
robust, lightweight format.

Coupled with NavCom Technology’s StarFire
subscription service, the SF-2050 delivers 
10 cm position fixes without the use of a 
second receiver serving as a base station.
Add the RTK option to your SF-2050, and 
an external radio capable of receiving RTK
corrections from a Base station, and now your
SF-2050 is able to do RTK level surveys for
unsurpassed accuracy.

FLEXIBLE INTERFACE
The SF-2050 receivers are easily configured
by the provided Windows®-based utility 
program. For system integrators needing 
maximum flexibility, the receivers offer a binary
user interface that allows for complete 
command and control of the GPS and L-Band
Module, thus enabling customization of the
interface and receiver operation.  The sensor
can receive GPS corrections in NCT
(NavCom’s ultra compact binary format),
RTCM and CMR thus permitting optimum 
correction source usage with seamless 
position output.

FEATURES

• Fully integrated receiver in robust housing

• “All-in-view” tracking on 26 channels 
(12 L1/L2 GPS + 2 SBAS)

• Global decimeter level accuracy using 
StarFire™ corrections

• Fully automatic acquisition of StarFire 
broadcast corrections

• Two dedicated WAAS/EGNOS channels

• L1 & L2 full wavelength carrier
phase tracking

• C/A, P1 & P2 code tracking

• 64MB internal memory for 
data recording 

• User programmable measurement and 
navigation data rates

• Minimal data latency

• Superior interference suppression

• Patented multipath rejection

• Output format NMEA 0183 or 
NavCom binary format 

• CAN bus interface (SF-2050M Only)

• 1PPS Output (SF-2050M Only)

• Event Marker (SF-2050M Only)

• TruBlu™ Wireless Connectivity,
Bluetooth® compatible

UPGRADES

• Raw measurement data rates 
up to 50Hz 

• Positioning rates up to 25Hz

• RTK positioning rates up to 25Hz 
(external comm-link required)

• RTK Extend™ - RTK positioning  
during comm. outages
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A John Deere Company

Modular GPS 

and StarFire™

receiver provides

worldwide decimeter

level accuracy 

anywhere, anytime

20780 Madrona Avenue, Torrance, CA 90503 • tel: + 1 310.381.2000 • fax: + 1 310.381.2001 • sales@navcomtech.com
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5.67” (144mm)

8.18”
(207.8mm)

3.06”
(77.7mm)

GPS
Antenna
(TNC)

COM 1
(7 pin Lemo)

COM 2
(7 pin Lemo)

DC Power
(4 pin Lemo)

Event Marker/Can
Bus (5 pin Lemo)

1PPS
(BNC)

Back Panel SF-2050M Only

Technical specifications are subject to change at NavCom’s discretion.
NCT-SF-2050/060119-6

PHYSICAL/ENVIRONMENTAL
• Size (L x W x H): ..............................8.18in x 5.67in x 3.06in

(208mm x 144mm x 78mm)

• Weight: ............................................................4lbs (1.81 kg)

• External Power:
Input Voltage: ........................................10 VDC to 30 VDC
Consumption: ..............................................................< 8 W

• Connectors:
I/O: ................................................................2 x 7 pin Lemo 
DC Power: ..........................................................4 pin Lemo 
GPS Antenna: ............................................................TNC-F
CAN bus + Event: ..................5 pin Lemo (SF-2050M Only)
1PPS Output: ....................................BNC (SF-2050M Only)

• Temperature (ambient):
Operating: ............................-40º to +55ºC (-40º to +131ºF)
Storage: ................................-40º to +85ºC (-40º to +185ºF)

• Humidity: ..............................................95% non-condensing

• Tested in accordance with MIL-STD-810F for: 
low pressure, solar radiation, rain, humidity, salt fog, 
sand & dust, and vibration

PERFORMANCE 1

• Measurement Precision (RMS):
Raw C/A code:........................................20 cm @ 42 dB-Hz 
Raw carrier phase noise: ..............L1: 0.95 mm @ 42 dB-Hz

L2: 0.85 mm @ 42 dB-Hz 

• Velocity: ..................................................................0.01 m/s 

• Real-time StarFire Accuracy (RMS):
Position (H):  ............................................................<10 cm
Position (V): ..............................................................<15cm

• Enhanced SBAS (WAAS/EGNOS) Positioning Accuracy:
Horizontal: ....................................................................0.5m 
Vertical: ........................................................................0.7m

• Code Differential GPS Positioning <200kms (RMS):
Horizontal: ......................................................12 cm + 2ppm 
Vertical: ..........................................................25 cm + 2ppm 

• RTK Positioning <10kms (Software option) (RMS):
Horizontal: ......................................................1 cm + 1ppm 
Vertical: ..........................................................2 cm + 1ppm 

• RTK Extend (Software option) (RMS):
Horizontal: ......................................................2 cm + 1ppm 
Vertical: ..........................................................4 cm + 1ppm 

• User programmable output rates:
Position Velocity Time: ..............5 Hz (10Hz, 25Hz Optional) 
Raw measurement data: ..5 Hz (10Hz, 25Hz, 50Hz Optional) 

• Data Latency:
Position Velocity Time: ............................< 20 ms at all rates
Raw measurement data: ........................< 20 ms at all rates

• Time-to-first-fix:
Cold Start, Satellite Acquisition: ........< 60 seconds (typical)
Satellite Reacquisition: ...................................... < 1 second

• Dynamics: (Speed & Altitude restricted by export laws)
Acceleration: ............................................................up to 6g
Speed:............................................< 1,000 knots (515 m/s)
Altitude: ................................................< 60,000 ft (18.3km)

• 1PPS Resolution: ............................12.5ns relative accuracy
(SF-2050M Only)

1 Performance dependent on location, satellite geometry, atmospheric 
conditions and GPS corrections.

COMMUNICATIONS
• Messages:

Data/Control: ....................................NCT Binary Messages
NMEA: ..........................ALM, GGA, GLL, GSA, GST, GSV, 

RMC, VTG, ZDA

• Corrections:..............................RTCM Code (Msg. 1, 3 & 9)
SBAS (WAAS/EGNOS)

StarFire™

• RTK Corrections: ........................................NCT Proprietary
(Optional) RTCM (Msg. 18/19 or 20/21)

CMR (Msg. 0, 1, 2)
CMR+



Key Features

High-performance 
GPS with a world of 
real-time options 
The versatile GPS Pathfinder® Pro XRS receiver is 
the thoroughbred of GPS receivers. Offering a full 
range of accurate real-time correction sources, 
great performance in all GPS conditions, and 
rugged design for the toughest environments, the 
Pro XRS is an essential tool for collecting and 
maintaining GPS data.

Built to meet your demands
With the Pro XRS, you don’t have to worry 
whether your GPS receiver can stand up to harsh 
conditions. All its components are sealed in a 
robust casing. Waterproof, dustproof, and  
shock-resistant, the Pro XRS can work  
anywhere you can. 

Just as tough is the custom-designed ergonomic 
backpack. But it’s light and comfortable, so you 
can wear it all day.

You’re spoiled for real-time choice
If you’re navigating in the field, or finding your way 
back to a previously recorded feature, you’ve got 
all the real-time options covered. Corrections from 
a radiobeacon, a satellite differential service such 
as OmniSTAR, or a satellite-based augmentation 
system (SBAS) like WAAS1 or EGNOS2 are not 
just built in, they’re seamlessly integrated into 
the receiver. Want the freedom to connect to an 
external correction source like a virtual reference 
station (VRS)? You’ve got it. This array of real-time 
sources makes the Pro XRS the most adaptable 
real-time GPS receiver around.

High quality, accurate data for your GIS
With the Pro XRS, you can be sure that the data 
you collect meets your high standards. Offering 
submeter accuracy in real time, and centimeter-
level postprocessed accuracy, it’s the obvious 
choice for collecting the high quality GPS data 

you need in your GIS. And it has advanced  
design features, like EVEREST™ multipath 
rejection technology, to ensure you get only the 
best positions.

Get the results you want
The GPS Pathfinder Pro XRS’s advanced design 
gives you complete control over GPS quality. You 
can focus on productivity, to keep working even in 
adverse GPS conditions. Or you can configure the 
receiver to deliver only the most precise positions. 
It’s up to you. 

Flexible data collection options
Pick the field device and software that fits your 
workflow. The Pro XRS is ready to use with a 
variety of field computers, including Trimble’s own 
range of handheld computers: the GIS TSCe™ 
field device, the Trimble® Recon™ handheld, and 
the GeoExplorer® series.

Choosing software? Try the TerraSync™ software, 
for a complete solution from the field to the  
office and back. Choose off-the-shelf GPS field 
software. Or use the GPS Pathfinder Tools SDK 
to build your own application that’s totally 
customized to your needs.

All you need
You need equipment that’s as 
adaptable and hard-working 
as you are. So when you’re 
choosing GPS equipment, 
don’t compromise. Get a 
GPS Pathfinder Pro XRS receiver 
and have it all. 

Key Features

• Real-time submeter accuracy

• Integrated satellite, beacon, 
and WAAS/EGNOS differential 
receiver

• EVEREST multipath rejection

• Rugged design

• Ergonomic, comfortable 
backpack system

• Choice of field device and field 
software 

GPS Pathfinder Pro XRSGPS Pathfinder Pro XRS
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SPECIFICATIONS FOR LASER TECH TRUPULSE 200 LASER RANGEFINDER 

 

Dimensions 5" x 2" x 3.5" (12cm x 5cm x 9cm) 
Weight 8 ounces (220 g) 
Data Communication Serial, via wired RS232 (standard)  
Power                                 3.0 volts DC nominal 
     Battery Type (2) AA or (1) CRV3  

     Battery Duration AA:  Approximately 7,500 measurements                                                                  
CRV3:  Approximately 15,000 measurements 

Eye Safety  FDA Class 1 (CFR 21) 
Environmental Impact, Water & Dust Resistant. NEMA 3, IP 64 
Temperature -4°F to +140°F (-20°C to +60°C) 
Optics 7X Magnification  (Field-of-view; 330 ft @ 1000 yards) 
Display In-scope LCD 
Units Feet, Yards, Meters, and Degrees 
Monopod/tripod mount ¼ " - 20 female thread 
Measurement Range  
     Distance 0 to 3280 ft (1000 m) typical, 6560 ft (2000m) max to reflective target 
     Inclination ± 90 degrees 
Accuracy  
     Distance ±1 ft (± 30 cm) to high quality targets, ±1 yd (±1 m) to low quality targets 
     Inclination ±0.25 degrees 

Measurement Modes Horizontal Distance, Vertical Distance, Slope Distance and Inclination, and 3-point 
flexible height routine with auto sequencing 

Target Modes Standard, Closest, Farthest, Continuous, and Filter (requires reflector and foliage 
filter) 

 

 

 



Impulse 200 LR Laser 
Our Impulse lasers are specifically designed for optimal performance under whatever conditions you might encounter
in the field. They are lightweight, extremely rugged, completely waterproof and versatile. Use them as a handheld
unit or mount them on a tripod for added stability. 

Impulse Laser w/
1.5 to 4 X Zoom Scope
and Mounting Bracket

Impulse Laser w/
Red-dot Scope
and Hand Strap

Hardware Specifications: 

7070 S. Tucson Way, Centennial, CO  80112 USA 
Toll Free: 1 (800) 280-6113  |  Local: 1 (303) 649-1000

 Web Page: www.lasertech.com  |  E-mail: info@lasertech.com

* All specifications are subject 
to change without notice.  

(Rev. 11/15/03)

Key Features: 

- Custom backlit LCD display
- Audible and visual indicators
- RS232 serial output for
   electronic data storage
- Selective range gating for
  positive target acquisition
- Built-in tilt sensor 
- Filter system to discriminate
  reflective targets
- Cumulative distance capability
- Determines the distance 
   between two in-line objects
- Integrates with GPS

For 3-D data collection,
integrate the Impulse with

a MapStar System.

Package Includes: 

- Impulse laser
- Red-dot scope
- Hand strap
- Tripod / monopod
   mounting bracket
- (2) AA batteries
- Operator's manual
- Padded carrying case

Optional Accessories:

- 1.5 to 4 X zoom scope
- Yoke and staff
- Remote trigger data cable

MapStar
Angle

Encoder

MapStar 
Compass
Module

Typical Target                   IMPULSE 200 LR

Accuracy & Range (Imperial) (Metric)

Accuracy (Typical) 0.1 - 0.2 ft 3 - 5 cm

Accuracy (Max) 0.5 ft 15 cm

Overhead cable / Stake 330 ft 100 m

Phone pole / Stockpile 655 ft 200 m

Tree / Tower 985 ft 300 m

Rock Face / Building 1640 ft 500 m

Max Distance 1885 ft 575 m

Range Resolution .01 ft 0.01 m

Inclination Limits  +/- 90 deg  +/- 90 deg

Inclination Accuracy  +/- 0.1 deg  +/- 0.1 deg

Weight 2.2 lbs. 1 kg

Size  6 x 2.5 x 5 in. 15.2 x 6.4 x 12.7 cm 

Power Supply  (2) AA batteries (20 hours of use)

Environment  Waterproof to IP 67 and NEMA 6

Temperature  - 22 to + 140 F  -30 to + 60 C   

(Max distances are approximate)



















•	 Accurate & reliable sound 	
	 velocity measurement in 	
	 seawater

•	 Compact housing in titanium 	
	 for corrosion immunity and 	
	 high strength

•	 Mechanical design for easy 	
	 cleaning, optimal flow and 	
	 flexible integration

•	 Galvanically isolated multiple 	
	 communication interfaces as 	
	 standard

•	 Direct path ultrasonic echo-	
	 sounding with 2MHz trans-	
	 ducer element

•	 Instant electronic temperature 	
	 and pressure compensation 	
	 via internal sensors

•	 Integrated electronics and up 	
	 to 6000m depth rating

The RESON SVP 70 sound velocity probe is developed for fixed-mount 
installation on surface ships, outboard rigs, submarines, AUVs, ROVs and 
other self-propelled platforms. The SVP 70 uses the latest electronic 
technology combined with an innovative mechanical design to yield a 
compact, robust, yet very flexible product.

The SVP 70 uses a direct path echosounding technique that instantly 
compensates for temperature and pressure with internal sensors.

The SVP 70 comes in a water resistant case including brackets for mounting, 
a 3m accessory cable, bolts, and a user manual with system description.
Additional adaptor kits and fairing accessories are available.

SVP 70

SVP 70
A new generation of fixed-mount sound velocity probes

www.reson.com



PRODUCT SPECIFICATION
Sound velocity
Range:	 1350 -1800m/s
Resolution:	 0.01m/s
Accuracy: 	 (0-50m ±0.05m/s
Accuracy: 	 (6000m) ±0.25m/s
Sampling Rate:	 20Hz and lower, programmable
Sampling Mode: 	 On request, continuous

I/O Interfaces
Connector: 	 Birns MCBH9MTT* (Titanium)
Output: 	 (MCBH9M) True RS-232 and True RS-422
Baud Rate: 	 2400-115200
Galvanic Insulation: 	 Yes
Output Options: 	 Direct, filtered, validity
Output Formats: 	 Universal Programmable ASCII, Valeport, AML, SVP24, NMEA, 	
	 and others

Electrical
Supply: 	 8-55VDC
Current: 	 150mA @ 12V

Physical
Diameter: 	 44mm (maximum)
Length: 	 165mm (excl. connector)
End-Cap Height:	 69mm (maximum)
Connector (MCBH9M): 	 52.5mm x Ø23mm
Weight: 	 approximately 1.0kg (excl. cable)

Environmental
Pressure: 	 0-630bar
Temperature: 	 -20 to +55°C

Version: B178 090304/ A
4

SVP 70
A new generation of fixed-mount sound velocity probes

RESON reserves the right to change specifications without notice. © 2006 RESON A/S
For Acoustical Measurement Accuracy please refer to www.reson.com or contact sales.

Sales Package
900-63-0000-00   -  SVP 70
904-63-0800-00   -  Accessories Kit (5 pcs. DIN912 M6*10, 5 pcs. DIN933 M6*10, 4 x Mounting 
                                O-rings, 7.5ml Silicon oil for connectors, Microfibre cloth
7211C03              -  2 x Mounting Brackets with rubber membrane
904-63-0801-00   -  Plastic Transport Case
904-63-0802-00   -  Operators Manual
904-63-0803-00   -  Quick Reference Manual
904-63-0804-00   -  Test Cable 1.5m long terminated with RS232 and RS232 D-sub connections
904-63-0808-00   -  25m Wet Cable with connector
906-63-0800-00   -  MCA Female locking sleeve

Optional Cables (All wet cable pigtails with connectors)
904-63-0805-00  -  1.5m  •  904-63-0806-00  -  5m  •  904-63-0807-00  - 10m  •  
904-63-0808-00  -  25m  •  904-63-0809-00  -  60m

                            

RESON GmbH	
Germany	
Tel: +49 431 720 7180	
E-mail: reson@reson-gmbh.de

RESON A/S	
Denmark	
Tel: +45 4738 0022	
E-mail: reson@reson.com

RESON Inc.	
USA	
Tel: +1 805 964-6260	
E-mail: sales@reson.com

RESON B.V.	
The Netherlands	
Tel: +31 (0) 10 245 1500	
E-mail: info@reson.nl

RESON Offshore Ltd.	
United Kingdom	
Tel: +44 1224 709 900	
E-mail: sales@reson.co.uk

RESON (Pte.) Ltd.	
Singapore	
Tel: +65 6725 9851	
E-mail: sales@reson.com

www.reson.com



 

 
 

 
Sea-Bird Electronics, Inc. 
1808 136th Place NE 
Bellevue, Washington 98005 USA 
Tel: 425/643-9866 
Fax:425/643-9954 

SBE 19plus
SEACAT PROFILER
Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4585



L I M I T E D   L I A B I L I T Y   S T A T E M E N T 

Extreme care should be exercised when using or servicing this equipment.  It should be used or
serviced only by personnel with knowledge of and training in the use and maintenance of
oceanographic electronic equipment.

SEA-BIRD ELECTRONICS, INC. disclaims all product liability risks arising from the use or servicing of
this system.  SEA-BIRD ELECTRONICS, INC. has no way of controlling the use of this equipment or of
choosing the personnel to operate it, and therefore cannot take steps to comply with laws pertaining to
product liability, including laws which impose a duty to warn the user of any dangers involved in
operating this equipment.  Therefore, acceptance of this system by the customer shall be conclusively
deemed to include a covenant by the customer to defend, indemnify, and hold SEA-BIRD
ELECTRONICS, INC. harmless from all product liability claims arising from the use of servicing of this
system.
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WARNING !!
Do not submerge this instrument (S/N 19P36026-4585)

beyond the depth rating of the lowest rated component listed below!

Main Housing (Titanium) 7000 meters

Pressure Sensor (3500 dBar) Druck 3500 meters

Pump (SBE 5M) 10500 meters
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 SYSTEM CONFIGURATION 14 June 2004 
 
   
   
 Model SBE 19plus S/N 19P36026-4585 
 Instrument Type SBE 19plus SeaCaT Profiler 
 Firmware Version 1.4D 
 Communications 9600 baud, 8 data bits, no parity, one stop bit 
 Memory 8192K 
 Housing 7000 meter (3AL-4V Titanium) 
 0 Conductivity Raw Frequency 2630.97 Hz 
 Pressure Sensor Strain Gauge: 3500 dBar, S/N 5433 
   
 Number of Voltages Sampled: 0 
   
 Serial RS-232C Sensor None 
   
 Data Format:  
 Count Temperature 
 Frequency Conductivity 
 Count Pressure, Strain gauge 
   
 
          Pump (SBE 5M) 050647 
 
   
   
 Voltage Delay Setting (standard) (standard) 0 seconds 
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IMPORTANT SOFTWARE & HARDWARE CONFIGURATION INFORMATION 
 
Sea-Bird supplies two versions of our software package for communication, real-time data acquisition, and data 
analysis and display: 
• SEASOFT-Win32 - Windows software for PC running Win 95/98/NT/2000/XP 
• SEASOFT-DOS - DOS software for IBM-PC/AT/386/486 or compatible computer with a hard drive 
Detailed information on the use of the Windows software follows: 
 
SEASOFT-Win32 
SEASOFT-Win32 software was supplied on a CD-ROM with your CTD. This software package is designed to run on a PC running Win 
95/98/NT/2000/XP. The CD-ROM also contains software manuals that describe the appropriate applications for the various programs, the 
procedure for installing the software, and instructions on using the programs. There are three primary programs used with the CTD for 
setup, data collection and retrieval, data display, and data processing: 
• SEATERM - terminal program for setup of the CTD and uploading of data from the CTD memory (Note: If using the CTD with the 

90208 Auto Fire Module or SBE 17plus V2 SEARAM, use SeatermAF instead of SEATERM) 
• SEASAVE - real-time data acquisition program 
• SBE Data Processing - data processing program 
Instructions for using the software are found in their Help files. 
 
To communicate with the CTD to set it up or to upload data from the CTD memory to the computer hard drive, 
SEATERM must have information about the CTD hardware configuration (communication parameters, internal 
firmware, etc.) and about the computer. To communicate with the CTD, double click on Seaterm.exe: 
1. In the Configure menu, select the CTD. The Configuration Options dialog box appears. 

A. On the COM Settings tab, select the firmware version (if applicable), baud rate, data bits, and parity to match the CTD’s 
configuration sheet. If necessary, change the com port to match the computer you are using. 

B. On the Upload Settings tab, enter upload type (all as a single file, etc.) as desired.  
For the SBE 17 and 25 only: enter the serial number for the SBE 3 (temperature) and SBE 4 (conductivity) modular sensors, 
exactly as they appear in the configuration (.con) file. 

C. On the Header Information tab, change the settings as desired. 
Click OK when done. SEATERM saves the settings in a SEATERM.ini file. 

2. On the Toolbar, click Connect to communicate with the CTD. 
3. To set up the CTD prior to deployment: 

On the Toolbar, click Status. SEATERM sends the Status command and displays the response. Verify that the 
CTD setup matches your desired deployment. If not, send commands to modify the setup. 

4. To upload data from the CTD: 
On the Toolbar, click Upload to upload data from the CTD memory to the computer. 

 
Sea-Bird CTDs store and/or transmit data from their primary and auxiliary sensors in the form of binary or 
hexadecimal number equivalents of the sensors’ frequency or voltage outputs. This is referred to as the raw data. 
The calculations required to convert from raw data to engineering units of the measured parameters (temperature, 
conductivity, pressure, dissolved oxygen, pH, etc.) are performed using the software, either in real time, or after 
the data has been stored in a file. SEASAVE creates the file in real time. As noted above, SEATERM uploads the 
recorded data and creates the file on the computer hard drive.  
 
To successfully store data to a file on the computer and subsequently convert it to engineering units, the software 
must know the CTD type, CTD configuration, and calibration coefficients for the sensors installed on the CTD. 
This information is unique to each CTD, and is contained in a configuration file. The configuration file, which has 
a .con extension, was written onto a floppy disk and the CD-ROM shipped with the CTD. The .con file for a given 
CTD is named with the last four digits of the serial number for that CTD (e.g., 1234.con). The configuration file is 
created or modified (e.g., changing coefficients after recalibration, or adding another sensor) by using the 
Configure menu in SEASAVE or  
SBE Data Processing. The configuration file is used by SEASAVE to convert raw data to engineering units  
when it acquires, stores, and displays real-time data. The configuration file is also used by some modules in  
SBE Data Processing (Data Conversion and Derive) that convert raw data to engineering units during data 
processing. 
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The instrument type and instrument configuration settings of the .con file and the required setup for the 
SEATERM.ini file for the CTD as delivered are documented below. The calibration coefficients for the CTD's 
sensors are contained in the calibration coefficient section of the CTD manual. 
 
 NOTE: 
SEATERM will not upload data correctly without a properly configured SEATERM.ini file. SEASAVE and SBE 
Data Processing will not interpret the data correctly without the correct .con file. 

 
 
 
 
 
 

SEASOFT CONFIGURATION: 
 
The correct instrument type for your instrument is SBE 19plus SEACAT Profiler.  The correct settings for the configuration of your 
instrument as delivered are documented below: 

 
  

  

0 

 

 
 
 

6



SPECIFICATIONS
SBE 19plus Specifications.................................................................................................................................................................................................................................1

SBE 5M Pump...............................................................................................................................................................................................................................................3

97



SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

The SBE 19plus is the next generation Personal CTD, bringing numerous improvements in accuracy, resolution (in fresh as
well as salt water), reliability, and ease-of-use to the wide range of research, monitoring, and engineering applications
pioneered by its legendary SEACAT predecessor. The 19plus samples faster (4 Hz vs 2), is more accurate (0.005 vs 0.01 in
T, 0.0005 vs 0.001 in C, and 0.1% vs 0.25% — with seven times the resolution — in D), and has more memory (8 Mbyte vs 1).
There is more power for auxiliary sensors (500 ma vs 50), and they are acquired at higher resolution (14 bit vs 12). Cabling is
simpler and more reliable because there are four differential auxiliary inputs on two separate connectors, and a dedicated
connector for the pump. All exposed metal parts are titanium, instead of aluminum, for long life and minimum maintenance.

The 19plus can be operated without a computer from even the smallest boat, with data recorded in non-volatile FLASH
memory and processed later on your PC. Simultaneous with recording, real-time data can be transmitted over single-core,
armored cable directly to your PC’s serial port (maximum transmission distance dependent on number of auxiliary sensors,
baud rate, and cable properties). The 19plus’ faster sampling and pump-controlled TC-ducted flow configuration significantly
reduces salinity spiking caused by ship heave, and allows slower descent rates for improved resolution of water column features.
Auxiliary sensors for dissolved oxygen, pH, turbidity, fluorescense, PAR, and ORP can be added, and for moored deployments the
19plus can be set to time-series mode using software commands. External power and two-way real-time communication over
10,000 meters of cable can be provided with the SBE 36 CTD Deck Unit and Power and Data Interface Module (PDIM).

The 19plus uses the same temperature and conductivity sensors proven in 5000 SEACAT and MicroCAT instruments, and a
superior new micro-machined silicon strain gauge pressure sensor developed by Druck, Inc. Improvements in design,
materials, and signal acquisition techniques yield a low-cost instrument with superior performance that is also easy to use.
Calibration coefficients, obtained in our computer-controlled high-accuracy calibration baths, are stored in EEPROM memory.
They permit data output in ASCII engineering units (degrees C, Siemens/m, decibars, Salinity [PSU], sound velocity [m/sec],
etc.). The 19plus can be factory-configured to emulate the .hex output format and 2 Hz data rate of old SEACATs for
compatibility with existing software or instrument fleets.

Accuracy, convenience, portability, software, and support; compelling reasons why the 19plus is today’s best low-cost CTD.

CONFIGURATION AND OPTIONS

A standard SBE 19plus is supplied with:
• Plastic housing for depths to 600 meters
• Strain-gauge pressure sensor
• 8 Mbyte FLASH RAM memory
• 9 D-size alkaline batteries
• Impulse glass-reinforced epoxy bulkhead connectors: 4-pin I/O,

2-pin pump, and two 6-pin (two differential auxiliary A/D inputs each)
• SBE 5M miniature pump and T-C Duct

Options include:
• Titanium housing for depths to 7000 meters
• Sensors for oxygen, pH, fluorescence, light (PAR), light transmission,

and turbidity
• SBE 5T pump in place of SBE 5M for use with dissolved oxygen and/or

other pumped sensors
• Stainless steel cage
• MCBH Micro connectors
• Ni-Cad batteries and charger

SOFTWARE

SEASOFT©-Win32, our complete Windows 95/98/NT/2000/XP software package,
is included at no extra charge. Its modular programs include:
• SEATERM© — communication and data retrieval
• SEASAVE© — real-time data acquisition and display
• SBE Data Processing© — filtering, aligning, averaging, and plotting of CTD and

auxiliary sensor data and derived variables

Shown with
optional cage,
SBE 5T pump,

& SBE 43
DO sensor
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SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

Water intake

SBE 5M 
pump

Y-fitting

Air bleed 
valve

Data I/O 
cable

Pump 
inlet port

Pump 
exhaust port

Conductivity cell guard 
(covering temperature 
sensor, TC duct, & 
conductivity sensor)

Dimensions
in millimeters
(inches)

Data I/O

Auxiliary
Differential
Inputs

Pump

Optional
Auxiliary
Input

575 (22.65)

99 (3.90) DIA

 808 (31.80)

136 
(5.37)

103 
(4.05)

SPECIFICATIONS
Measurement Range
Temperature -5 to +35 °C
Conductivity 0 to 9 S/m
Pressure 0 to 20 / 100 / 350 / 1000 / 2000 / 3500 / 7000 meters
Initial Accuracy
Temperature 0.005 °C
Conductivity 0.0005 S/m
Pressure 0.1% of full scale range
Typical Stability (per month)
Temperature 0.0002 °C
Conductivity 0.0003 S/m
Pressure 0.004% of full scale range
Resolution
Temperature 0.0001 °C
Conductivity 0.00005 S/m (most oceanic waters; resolves 0.4 ppm in salinity)

0.00007 S/m (high salinity waters; resolves 0.4 ppm in salinity)
0.00001 S/m (fresh waters; resolves 0.1 ppm in salinity)

Pressure 0.002% of full scale range
Memory 8 Mbyte non-volatile FLASH memory
Data Storage Recorded Parameter Bytes/Sample

T + C 6
pressure 5
each external voltage 2

Real-Time Clock 32,768 Hz TCXO accurate to ±1 minute/year
Internal Batteries 9 alkaline D-cells provide 60 hours continuous CTD operation;

optional 9-cell rechargeable nickel-cadmium battery pack
provides approximately 24 hours operation per charge

External Power Supply 9 - 28 VDC
Power Requirements
Sampling 65 mA
SBE 5M pump 95 mA
Quiescent 30 µA
Auxiliary Voltage Sensors
Auxiliary power out up to 500 mA at 10.5 - 11 VDC
A/D resolution 14 bits
Input range 0 - 5 VDC
Housing Materials — Depth Rating — Weight
Acetal Copolymer Plastic housing — 600 meter (1950 feet) — 7.3 kg (16 lbs)
3AL-2.5V Titanium housing — 7000 meter (22,900 feet) — 13.7 kg (30 lbs)
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Sea-Bird Electronics, Inc. E-mail: seabird@seabird.com 
1808 136th Place NE, Bellevue, Washington  98005  USA Telephone: (425) 643-9866 
Website: http://www.seabird.com Fax: (425) 643-9954 

Mini Submersible Pump  SBE 5M 
 
 
The SBE 5M pump module consists of a centrifugal pump 
head and a long-life, DC ball bearing motor contained in a 
compact, titanium, pressure housing usable to  
10,500 meters deep. The pump impeller and electric drive 
motor are coupled magnetically through the housing, 
providing high reliability by eliminating moving seals. Motor 
speed and pumping rate remain constant over the entire 
input voltage range. The motor drive electronics is 
intrinsically protected against accidental reversed polarity. 
 
 
APPLICATIONS 
 
The SBE 5M is standard on the SBE 19 and 19plus 
SEACAT Profiler CTD. It is optional on the SBE 16, 16plus, 
and 16plus-IM SEACAT C-T Recorder. The pump flushes 
water through the conductivity cell at a constant rate, 
independent of the CTD's motion, improving dynamic 
performance. For applications requiring pumping through 
additional sensors (for example, a dissolved oxygen 
sensor), use the SBE 5T pump instead. 
 
Specify: 
• Option 5M-1 for profiling (continuous duty) applications 

such as the SBE 19plus. 
• Option 5M-2 for moored (pulsed duty) applications such 

as the SBE 16plus or 16plus-IM. 
Contact Sea-Bird for use in other applications. 
 
SPECIFICATIONS 
 
Option 5M-1 (continuous duty):  
Input voltage range 9 - 18 VDC  
 
Flow Rate 25 ml/s supply current 95 ma 
 
Note: Supply current is independent of operating voltage. 
 
 
Option 5M-2 (pulsed duty):  
Input voltage range 6 - 18 VDC  
 
Pulse Duration Flow Volume Electrical Charge 

0.5 seconds 15 ml 0.148 amp-seconds 
1.0 seconds 21 ml 0.283 amp-seconds 
1.5 seconds 31 ml 0.418 amp-seconds 
2.0 seconds 40 ml 0.553 amp-seconds 
 
 
 
 
Weight 
In Air: 0.42 kg (0.91 lbs) 
In Water: 0.28 kg (0.60 lbs) 
 06/03 

Optional  
wet-pluggable 
connector, 
MCBH-2MTI 
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1808 136th Place NE, Bellevue, Washington  98005  USA                 Tel: (425) 643-9866
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Sea-Bird Electronics, Inc. FAX: (425) 643-9954

SBE 5M MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number:

Job Number:

Customer:

Delivery Date:

Single Connector Housing with Titanium screws

Pressure Case:  10,500 meters (titanium)

Maxon Motor Type:

P/N 90337, Motor PN 20130 (Low power 6 VDC, 2000 RPM MAX)

P/N 90335, Motor PN 20130 (Low power 9 VDC, 2000 RPM MAX)

0647

36026

NOAA/PMC

6/14/2004

Vin 15V voltage across C2: VDC      Current mA8.015 7.73

Vin 9V voltage across C2: VDC      Current mA8.014 7.4

Vin 6V voltage across C2: VDC      Current mA5.888 7.61

Pump submerged test, no load, Vin 12VDC Average current draw in water: 121 mA
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Sea-Bird Electronics, Inc. 
1808 136th Place NE 
Bellevue, Washington 98005 USA 
Tel: 425/643-9866 
Fax:425/643-9954 

SBE 19plus
SEACAT PROFILER
Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4616



WARNING !!
Do not submerge this instrument (S/N 19P36026-4616)

beyond the depth rating of the lowest rated component listed below!

Main Housing (Plastic) 600 meters

Pressure Sensor (1000 dBar) Druck 1000 meters

Pump (SBE 5M) 10500 meters
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 SYSTEM CONFIGURATION 14 June 2004 
 
   
   
 Model SBE 19plus S/N 19P36026-4616 
 Instrument Type SBE 19plus SeaCaT Profiler 
 Firmware Version 1.4D 
 Communications 9600 baud, 8 data bits, no parity, one stop bit 
 Memory 8192K 
 Housing 600 meter (Celcon plastic) 
 0 Conductivity Raw Frequency 2686.52 Hz 
 Pressure Sensor Strain Gauge: 1000 dBar, S/N 5512 
   
 Number of Voltages Sampled: 0 
   
 Serial RS-232C Sensor None 
   
 Data Format:  
 Count Temperature 
 Frequency Conductivity 
 Count Pressure, Strain gauge 
   
 
          Pump (SBE 5M) 050651 
 
   
   
 Voltage Delay Setting (standard) (standard) 0 seconds 
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IMPORTANT SOFTWARE & HARDWARE CONFIGURATION INFORMATION 
 
Sea-Bird supplies two versions of our software package for communication, real-time data acquisition, and data 
analysis and display: 
• SEASOFT-Win32 - Windows software for PC running Win 95/98/NT/2000/XP 
• SEASOFT-DOS - DOS software for IBM-PC/AT/386/486 or compatible computer with a hard drive 
Detailed information on the use of the Windows software follows: 
 
SEASOFT-Win32 
SEASOFT-Win32 software was supplied on a CD-ROM with your CTD. This software package is designed to run on a PC running Win 
95/98/NT/2000/XP. The CD-ROM also contains software manuals that describe the appropriate applications for the various programs, the 
procedure for installing the software, and instructions on using the programs. There are three primary programs used with the CTD for 
setup, data collection and retrieval, data display, and data processing: 
• SEATERM - terminal program for setup of the CTD and uploading of data from the CTD memory (Note: If using the CTD with the 

90208 Auto Fire Module or SBE 17plus V2 SEARAM, use SeatermAF instead of SEATERM) 
• SEASAVE - real-time data acquisition program 
• SBE Data Processing - data processing program 
Instructions for using the software are found in their Help files. 
 
To communicate with the CTD to set it up or to upload data from the CTD memory to the computer hard drive, 
SEATERM must have information about the CTD hardware configuration (communication parameters, internal 
firmware, etc.) and about the computer. To communicate with the CTD, double click on Seaterm.exe: 
1. In the Configure menu, select the CTD. The Configuration Options dialog box appears. 

A. On the COM Settings tab, select the firmware version (if applicable), baud rate, data bits, and parity to match the CTD’s 
configuration sheet. If necessary, change the com port to match the computer you are using. 

B. On the Upload Settings tab, enter upload type (all as a single file, etc.) as desired.  
For the SBE 17 and 25 only: enter the serial number for the SBE 3 (temperature) and SBE 4 (conductivity) modular sensors, 
exactly as they appear in the configuration (.con) file. 

C. On the Header Information tab, change the settings as desired. 
Click OK when done. SEATERM saves the settings in a SEATERM.ini file. 

2. On the Toolbar, click Connect to communicate with the CTD. 
3. To set up the CTD prior to deployment: 

On the Toolbar, click Status. SEATERM sends the Status command and displays the response. Verify that the 
CTD setup matches your desired deployment. If not, send commands to modify the setup. 

4. To upload data from the CTD: 
On the Toolbar, click Upload to upload data from the CTD memory to the computer. 

 
Sea-Bird CTDs store and/or transmit data from their primary and auxiliary sensors in the form of binary or 
hexadecimal number equivalents of the sensors’ frequency or voltage outputs. This is referred to as the raw data. 
The calculations required to convert from raw data to engineering units of the measured parameters (temperature, 
conductivity, pressure, dissolved oxygen, pH, etc.) are performed using the software, either in real time, or after 
the data has been stored in a file. SEASAVE creates the file in real time. As noted above, SEATERM uploads the 
recorded data and creates the file on the computer hard drive.  
 
To successfully store data to a file on the computer and subsequently convert it to engineering units, the software 
must know the CTD type, CTD configuration, and calibration coefficients for the sensors installed on the CTD. 
This information is unique to each CTD, and is contained in a configuration file. The configuration file, which has 
a .con extension, was written onto a floppy disk and the CD-ROM shipped with the CTD. The .con file for a given 
CTD is named with the last four digits of the serial number for that CTD (e.g., 1234.con). The configuration file is 
created or modified (e.g., changing coefficients after recalibration, or adding another sensor) by using the 
Configure menu in SEASAVE or  
SBE Data Processing. The configuration file is used by SEASAVE to convert raw data to engineering units  
when it acquires, stores, and displays real-time data. The configuration file is also used by some modules in  
SBE Data Processing (Data Conversion and Derive) that convert raw data to engineering units during data 
processing. 
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The instrument type and instrument configuration settings of the .con file and the required setup for the 
SEATERM.ini file for the CTD as delivered are documented below. The calibration coefficients for the CTD's 
sensors are contained in the calibration coefficient section of the CTD manual. 
 
 NOTE: 
SEATERM will not upload data correctly without a properly configured SEATERM.ini file. SEASAVE and SBE 
Data Processing will not interpret the data correctly without the correct .con file. 

 
 
 
 
 
 

SEASOFT CONFIGURATION: 
 
The correct instrument type for your instrument is SBE 19plus SEACAT Profiler.  The correct settings for the configuration of your 
instrument as delivered are documented below: 

 
  

  

0 
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SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

The SBE 19plus is the next generation Personal CTD, bringing numerous improvements in accuracy, resolution (in fresh as
well as salt water), reliability, and ease-of-use to the wide range of research, monitoring, and engineering applications
pioneered by its legendary SEACAT predecessor. The 19plus samples faster (4 Hz vs 2), is more accurate (0.005 vs 0.01 in
T, 0.0005 vs 0.001 in C, and 0.1% vs 0.25% — with seven times the resolution — in D), and has more memory (8 Mbyte vs 1).
There is more power for auxiliary sensors (500 ma vs 50), and they are acquired at higher resolution (14 bit vs 12). Cabling is
simpler and more reliable because there are four differential auxiliary inputs on two separate connectors, and a dedicated
connector for the pump. All exposed metal parts are titanium, instead of aluminum, for long life and minimum maintenance.

The 19plus can be operated without a computer from even the smallest boat, with data recorded in non-volatile FLASH
memory and processed later on your PC. Simultaneous with recording, real-time data can be transmitted over single-core,
armored cable directly to your PC’s serial port (maximum transmission distance dependent on number of auxiliary sensors,
baud rate, and cable properties). The 19plus’ faster sampling and pump-controlled TC-ducted flow configuration significantly
reduces salinity spiking caused by ship heave, and allows slower descent rates for improved resolution of water column features.
Auxiliary sensors for dissolved oxygen, pH, turbidity, fluorescense, PAR, and ORP can be added, and for moored deployments the
19plus can be set to time-series mode using software commands. External power and two-way real-time communication over
10,000 meters of cable can be provided with the SBE 36 CTD Deck Unit and Power and Data Interface Module (PDIM).

The 19plus uses the same temperature and conductivity sensors proven in 5000 SEACAT and MicroCAT instruments, and a
superior new micro-machined silicon strain gauge pressure sensor developed by Druck, Inc. Improvements in design,
materials, and signal acquisition techniques yield a low-cost instrument with superior performance that is also easy to use.
Calibration coefficients, obtained in our computer-controlled high-accuracy calibration baths, are stored in EEPROM memory.
They permit data output in ASCII engineering units (degrees C, Siemens/m, decibars, Salinity [PSU], sound velocity [m/sec],
etc.). The 19plus can be factory-configured to emulate the .hex output format and 2 Hz data rate of old SEACATs for
compatibility with existing software or instrument fleets.

Accuracy, convenience, portability, software, and support; compelling reasons why the 19plus is today’s best low-cost CTD.

CONFIGURATION AND OPTIONS

A standard SBE 19plus is supplied with:
• Plastic housing for depths to 600 meters
• Strain-gauge pressure sensor
• 8 Mbyte FLASH RAM memory
• 9 D-size alkaline batteries
• Impulse glass-reinforced epoxy bulkhead connectors: 4-pin I/O,

2-pin pump, and two 6-pin (two differential auxiliary A/D inputs each)
• SBE 5M miniature pump and T-C Duct

Options include:
• Titanium housing for depths to 7000 meters
• Sensors for oxygen, pH, fluorescence, light (PAR), light transmission,

and turbidity
• SBE 5T pump in place of SBE 5M for use with dissolved oxygen and/or

other pumped sensors
• Stainless steel cage
• MCBH Micro connectors
• Ni-Cad batteries and charger

SOFTWARE

SEASOFT©-Win32, our complete Windows 95/98/NT/2000/XP software package,
is included at no extra charge. Its modular programs include:
• SEATERM© — communication and data retrieval
• SEASAVE© — real-time data acquisition and display
• SBE Data Processing© — filtering, aligning, averaging, and plotting of CTD and

auxiliary sensor data and derived variables

Shown with
optional cage,
SBE 5T pump,

& SBE 43
DO sensor
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SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

Water intake

SBE 5M 
pump

Y-fitting

Air bleed 
valve

Data I/O 
cable

Pump 
inlet port

Pump 
exhaust port

Conductivity cell guard 
(covering temperature 
sensor, TC duct, & 
conductivity sensor)

Dimensions
in millimeters
(inches)

Data I/O

Auxiliary
Differential
Inputs

Pump

Optional
Auxiliary
Input

575 (22.65)

99 (3.90) DIA

 808 (31.80)

136 
(5.37)

103 
(4.05)

SPECIFICATIONS
Measurement Range
Temperature -5 to +35 °C
Conductivity 0 to 9 S/m
Pressure 0 to 20 / 100 / 350 / 1000 / 2000 / 3500 / 7000 meters
Initial Accuracy
Temperature 0.005 °C
Conductivity 0.0005 S/m
Pressure 0.1% of full scale range
Typical Stability (per month)
Temperature 0.0002 °C
Conductivity 0.0003 S/m
Pressure 0.004% of full scale range
Resolution
Temperature 0.0001 °C
Conductivity 0.00005 S/m (most oceanic waters; resolves 0.4 ppm in salinity)

0.00007 S/m (high salinity waters; resolves 0.4 ppm in salinity)
0.00001 S/m (fresh waters; resolves 0.1 ppm in salinity)

Pressure 0.002% of full scale range
Memory 8 Mbyte non-volatile FLASH memory
Data Storage Recorded Parameter Bytes/Sample

T + C 6
pressure 5
each external voltage 2

Real-Time Clock 32,768 Hz TCXO accurate to ±1 minute/year
Internal Batteries 9 alkaline D-cells provide 60 hours continuous CTD operation;

optional 9-cell rechargeable nickel-cadmium battery pack
provides approximately 24 hours operation per charge

External Power Supply 9 - 28 VDC
Power Requirements
Sampling 65 mA
SBE 5M pump 95 mA
Quiescent 30 µA
Auxiliary Voltage Sensors
Auxiliary power out up to 500 mA at 10.5 - 11 VDC
A/D resolution 14 bits
Input range 0 - 5 VDC
Housing Materials — Depth Rating — Weight
Acetal Copolymer Plastic housing — 600 meter (1950 feet) — 7.3 kg (16 lbs)
3AL-2.5V Titanium housing — 7000 meter (22,900 feet) — 13.7 kg (30 lbs)
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Mini Submersible Pump  SBE 5M 
 
 
The SBE 5M pump module consists of a centrifugal pump 
head and a long-life, DC ball bearing motor contained in a 
compact, titanium, pressure housing usable to  
10,500 meters deep. The pump impeller and electric drive 
motor are coupled magnetically through the housing, 
providing high reliability by eliminating moving seals. Motor 
speed and pumping rate remain constant over the entire 
input voltage range. The motor drive electronics is 
intrinsically protected against accidental reversed polarity. 
 
 
APPLICATIONS 
 
The SBE 5M is standard on the SBE 19 and 19plus 
SEACAT Profiler CTD. It is optional on the SBE 16, 16plus, 
and 16plus-IM SEACAT C-T Recorder. The pump flushes 
water through the conductivity cell at a constant rate, 
independent of the CTD's motion, improving dynamic 
performance. For applications requiring pumping through 
additional sensors (for example, a dissolved oxygen 
sensor), use the SBE 5T pump instead. 
 
Specify: 
• Option 5M-1 for profiling (continuous duty) applications 

such as the SBE 19plus. 
• Option 5M-2 for moored (pulsed duty) applications such 

as the SBE 16plus or 16plus-IM. 
Contact Sea-Bird for use in other applications. 
 
SPECIFICATIONS 
 
Option 5M-1 (continuous duty):  
Input voltage range 9 - 18 VDC  
 
Flow Rate 25 ml/s supply current 95 ma 
 
Note: Supply current is independent of operating voltage. 
 
 
Option 5M-2 (pulsed duty):  
Input voltage range 6 - 18 VDC  
 
Pulse Duration Flow Volume Electrical Charge 

0.5 seconds 15 ml 0.148 amp-seconds 
1.0 seconds 21 ml 0.283 amp-seconds 
1.5 seconds 31 ml 0.418 amp-seconds 
2.0 seconds 40 ml 0.553 amp-seconds 
 
 
 
 
Weight 
In Air: 0.42 kg (0.91 lbs) 
In Water: 0.28 kg (0.60 lbs) 
 06/03 

Optional  
wet-pluggable 
connector, 
MCBH-2MTI 
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Sea-Bird Electronics, Inc. FAX: (425) 643-9954

SBE 5M MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number:

Job Number:

Customer:

Delivery Date:

Single Connector Housing with Titanium screws

Pressure Case:  10,500 meters (titanium)

Maxon Motor Type:

P/N 90337, Motor PN 20130 (Low power 6 VDC, 2000 RPM MAX)

P/N 90335, Motor PN 20130 (Low power 9 VDC, 2000 RPM MAX)

0651

36026

NOAA/PMC

6/14/2004

Vin 15V voltage across C2: VDC      Current mA7.929 9.29

Vin 9V voltage across C2: VDC      Current mA7.928 8.8

Vin 6V voltage across C2: VDC      Current mA5.885 7.99

Pump submerged test, no load, Vin 12VDC Average current draw in water: 120 mA
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Sea-Bird Electronics, Inc. 
1808 136th Place NE 
Bellevue, Washington 98005 USA 
Tel: 425/643-9866 
Fax:425/643-9954 

SBE 19plus
SEACAT PROFILER
Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4617



L I M I T E D   L I A B I L I T Y   S T A T E M E N T 

Extreme care should be exercised when using or servicing this equipment.  It should be used or
serviced only by personnel with knowledge of and training in the use and maintenance of
oceanographic electronic equipment.

SEA-BIRD ELECTRONICS, INC. disclaims all product liability risks arising from the use or servicing of
this system.  SEA-BIRD ELECTRONICS, INC. has no way of controlling the use of this equipment or of
choosing the personnel to operate it, and therefore cannot take steps to comply with laws pertaining to
product liability, including laws which impose a duty to warn the user of any dangers involved in
operating this equipment.  Therefore, acceptance of this system by the customer shall be conclusively
deemed to include a covenant by the customer to defend, indemnify, and hold SEA-BIRD
ELECTRONICS, INC. harmless from all product liability claims arising from the use of servicing of this
system.
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WARNING !!
Do not submerge this instrument (S/N 19P36026-4617)

beyond the depth rating of the lowest rated component listed below!

Main Housing (Plastic) 600 meters

Pressure Sensor (1000 dBar) Druck 1000 meters

Pump (SBE 5M) 10500 meters
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 SYSTEM CONFIGURATION 14 June 2004 
 
   
   
 Model SBE 19plus S/N 19P36026-4617 
 Instrument Type SBE 19plus SeaCaT Profiler 
 Firmware Version 1.4D 
 Communications 9600 baud, 8 data bits, no parity, one stop bit 
 Memory 8192K 
 Housing 600 meter (Celcon plastic) 
 0 Conductivity Raw Frequency 2801.47 Hz 
 Pressure Sensor Strain Gauge: 1000 dBar, S/N 5513 
   
 Number of Voltages Sampled: 0 
   
 Serial RS-232C Sensor None 
   
 Data Format:  
 Count Temperature 
 Frequency Conductivity 
 Count Pressure, Strain gauge 
   
 
          Pump (SBE 5M) 050649 
 
   
   
 Voltage Delay Setting (standard) (standard) 0 seconds 
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IMPORTANT SOFTWARE & HARDWARE CONFIGURATION INFORMATION 
 
Sea-Bird supplies two versions of our software package for communication, real-time data acquisition, and data 
analysis and display: 
• SEASOFT-Win32 - Windows software for PC running Win 95/98/NT/2000/XP 
• SEASOFT-DOS - DOS software for IBM-PC/AT/386/486 or compatible computer with a hard drive 
Detailed information on the use of the Windows software follows: 
 
SEASOFT-Win32 
SEASOFT-Win32 software was supplied on a CD-ROM with your CTD. This software package is designed to run on a PC running Win 
95/98/NT/2000/XP. The CD-ROM also contains software manuals that describe the appropriate applications for the various programs, the 
procedure for installing the software, and instructions on using the programs. There are three primary programs used with the CTD for 
setup, data collection and retrieval, data display, and data processing: 
• SEATERM - terminal program for setup of the CTD and uploading of data from the CTD memory (Note: If using the CTD with the 

90208 Auto Fire Module or SBE 17plus V2 SEARAM, use SeatermAF instead of SEATERM) 
• SEASAVE - real-time data acquisition program 
• SBE Data Processing - data processing program 
Instructions for using the software are found in their Help files. 
 
To communicate with the CTD to set it up or to upload data from the CTD memory to the computer hard drive, 
SEATERM must have information about the CTD hardware configuration (communication parameters, internal 
firmware, etc.) and about the computer. To communicate with the CTD, double click on Seaterm.exe: 
1. In the Configure menu, select the CTD. The Configuration Options dialog box appears. 

A. On the COM Settings tab, select the firmware version (if applicable), baud rate, data bits, and parity to match the CTD’s 
configuration sheet. If necessary, change the com port to match the computer you are using. 

B. On the Upload Settings tab, enter upload type (all as a single file, etc.) as desired.  
For the SBE 17 and 25 only: enter the serial number for the SBE 3 (temperature) and SBE 4 (conductivity) modular sensors, 
exactly as they appear in the configuration (.con) file. 

C. On the Header Information tab, change the settings as desired. 
Click OK when done. SEATERM saves the settings in a SEATERM.ini file. 

2. On the Toolbar, click Connect to communicate with the CTD. 
3. To set up the CTD prior to deployment: 

On the Toolbar, click Status. SEATERM sends the Status command and displays the response. Verify that the 
CTD setup matches your desired deployment. If not, send commands to modify the setup. 

4. To upload data from the CTD: 
On the Toolbar, click Upload to upload data from the CTD memory to the computer. 

 
Sea-Bird CTDs store and/or transmit data from their primary and auxiliary sensors in the form of binary or 
hexadecimal number equivalents of the sensors’ frequency or voltage outputs. This is referred to as the raw data. 
The calculations required to convert from raw data to engineering units of the measured parameters (temperature, 
conductivity, pressure, dissolved oxygen, pH, etc.) are performed using the software, either in real time, or after 
the data has been stored in a file. SEASAVE creates the file in real time. As noted above, SEATERM uploads the 
recorded data and creates the file on the computer hard drive.  
 
To successfully store data to a file on the computer and subsequently convert it to engineering units, the software 
must know the CTD type, CTD configuration, and calibration coefficients for the sensors installed on the CTD. 
This information is unique to each CTD, and is contained in a configuration file. The configuration file, which has 
a .con extension, was written onto a floppy disk and the CD-ROM shipped with the CTD. The .con file for a given 
CTD is named with the last four digits of the serial number for that CTD (e.g., 1234.con). The configuration file is 
created or modified (e.g., changing coefficients after recalibration, or adding another sensor) by using the 
Configure menu in SEASAVE or  
SBE Data Processing. The configuration file is used by SEASAVE to convert raw data to engineering units  
when it acquires, stores, and displays real-time data. The configuration file is also used by some modules in  
SBE Data Processing (Data Conversion and Derive) that convert raw data to engineering units during data 
processing. 
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The instrument type and instrument configuration settings of the .con file and the required setup for the 
SEATERM.ini file for the CTD as delivered are documented below. The calibration coefficients for the CTD's 
sensors are contained in the calibration coefficient section of the CTD manual. 
 
 NOTE: 
SEATERM will not upload data correctly without a properly configured SEATERM.ini file. SEASAVE and SBE 
Data Processing will not interpret the data correctly without the correct .con file. 

 
 
 
 
 
 

SEASOFT CONFIGURATION: 
 
The correct instrument type for your instrument is SBE 19plus SEACAT Profiler.  The correct settings for the configuration of your 
instrument as delivered are documented below: 

 
  

  

0 
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SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

The SBE 19plus is the next generation Personal CTD, bringing numerous improvements in accuracy, resolution (in fresh as
well as salt water), reliability, and ease-of-use to the wide range of research, monitoring, and engineering applications
pioneered by its legendary SEACAT predecessor. The 19plus samples faster (4 Hz vs 2), is more accurate (0.005 vs 0.01 in
T, 0.0005 vs 0.001 in C, and 0.1% vs 0.25% — with seven times the resolution — in D), and has more memory (8 Mbyte vs 1).
There is more power for auxiliary sensors (500 ma vs 50), and they are acquired at higher resolution (14 bit vs 12). Cabling is
simpler and more reliable because there are four differential auxiliary inputs on two separate connectors, and a dedicated
connector for the pump. All exposed metal parts are titanium, instead of aluminum, for long life and minimum maintenance.

The 19plus can be operated without a computer from even the smallest boat, with data recorded in non-volatile FLASH
memory and processed later on your PC. Simultaneous with recording, real-time data can be transmitted over single-core,
armored cable directly to your PC’s serial port (maximum transmission distance dependent on number of auxiliary sensors,
baud rate, and cable properties). The 19plus’ faster sampling and pump-controlled TC-ducted flow configuration significantly
reduces salinity spiking caused by ship heave, and allows slower descent rates for improved resolution of water column features.
Auxiliary sensors for dissolved oxygen, pH, turbidity, fluorescense, PAR, and ORP can be added, and for moored deployments the
19plus can be set to time-series mode using software commands. External power and two-way real-time communication over
10,000 meters of cable can be provided with the SBE 36 CTD Deck Unit and Power and Data Interface Module (PDIM).

The 19plus uses the same temperature and conductivity sensors proven in 5000 SEACAT and MicroCAT instruments, and a
superior new micro-machined silicon strain gauge pressure sensor developed by Druck, Inc. Improvements in design,
materials, and signal acquisition techniques yield a low-cost instrument with superior performance that is also easy to use.
Calibration coefficients, obtained in our computer-controlled high-accuracy calibration baths, are stored in EEPROM memory.
They permit data output in ASCII engineering units (degrees C, Siemens/m, decibars, Salinity [PSU], sound velocity [m/sec],
etc.). The 19plus can be factory-configured to emulate the .hex output format and 2 Hz data rate of old SEACATs for
compatibility with existing software or instrument fleets.

Accuracy, convenience, portability, software, and support; compelling reasons why the 19plus is today’s best low-cost CTD.

CONFIGURATION AND OPTIONS

A standard SBE 19plus is supplied with:
• Plastic housing for depths to 600 meters
• Strain-gauge pressure sensor
• 8 Mbyte FLASH RAM memory
• 9 D-size alkaline batteries
• Impulse glass-reinforced epoxy bulkhead connectors: 4-pin I/O,

2-pin pump, and two 6-pin (two differential auxiliary A/D inputs each)
• SBE 5M miniature pump and T-C Duct

Options include:
• Titanium housing for depths to 7000 meters
• Sensors for oxygen, pH, fluorescence, light (PAR), light transmission,

and turbidity
• SBE 5T pump in place of SBE 5M for use with dissolved oxygen and/or

other pumped sensors
• Stainless steel cage
• MCBH Micro connectors
• Ni-Cad batteries and charger

SOFTWARE

SEASOFT©-Win32, our complete Windows 95/98/NT/2000/XP software package,
is included at no extra charge. Its modular programs include:
• SEATERM© — communication and data retrieval
• SEASAVE© — real-time data acquisition and display
• SBE Data Processing© — filtering, aligning, averaging, and plotting of CTD and

auxiliary sensor data and derived variables

Shown with
optional cage,
SBE 5T pump,

& SBE 43
DO sensor
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SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

Water intake

SBE 5M 
pump

Y-fitting

Air bleed 
valve

Data I/O 
cable

Pump 
inlet port

Pump 
exhaust port

Conductivity cell guard 
(covering temperature 
sensor, TC duct, & 
conductivity sensor)

Dimensions
in millimeters
(inches)

Data I/O

Auxiliary
Differential
Inputs

Pump

Optional
Auxiliary
Input

575 (22.65)

99 (3.90) DIA

 808 (31.80)

136 
(5.37)

103 
(4.05)

SPECIFICATIONS
Measurement Range
Temperature -5 to +35 °C
Conductivity 0 to 9 S/m
Pressure 0 to 20 / 100 / 350 / 1000 / 2000 / 3500 / 7000 meters
Initial Accuracy
Temperature 0.005 °C
Conductivity 0.0005 S/m
Pressure 0.1% of full scale range
Typical Stability (per month)
Temperature 0.0002 °C
Conductivity 0.0003 S/m
Pressure 0.004% of full scale range
Resolution
Temperature 0.0001 °C
Conductivity 0.00005 S/m (most oceanic waters; resolves 0.4 ppm in salinity)

0.00007 S/m (high salinity waters; resolves 0.4 ppm in salinity)
0.00001 S/m (fresh waters; resolves 0.1 ppm in salinity)

Pressure 0.002% of full scale range
Memory 8 Mbyte non-volatile FLASH memory
Data Storage Recorded Parameter Bytes/Sample

T + C 6
pressure 5
each external voltage 2

Real-Time Clock 32,768 Hz TCXO accurate to ±1 minute/year
Internal Batteries 9 alkaline D-cells provide 60 hours continuous CTD operation;

optional 9-cell rechargeable nickel-cadmium battery pack
provides approximately 24 hours operation per charge

External Power Supply 9 - 28 VDC
Power Requirements
Sampling 65 mA
SBE 5M pump 95 mA
Quiescent 30 µA
Auxiliary Voltage Sensors
Auxiliary power out up to 500 mA at 10.5 - 11 VDC
A/D resolution 14 bits
Input range 0 - 5 VDC
Housing Materials — Depth Rating — Weight
Acetal Copolymer Plastic housing — 600 meter (1950 feet) — 7.3 kg (16 lbs)
3AL-2.5V Titanium housing — 7000 meter (22,900 feet) — 13.7 kg (30 lbs)
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Sea-Bird Electronics, Inc. E-mail: seabird@seabird.com 
1808 136th Place NE, Bellevue, Washington  98005  USA Telephone: (425) 643-9866 
Website: http://www.seabird.com Fax: (425) 643-9954 

Mini Submersible Pump  SBE 5M 
 
 
The SBE 5M pump module consists of a centrifugal pump 
head and a long-life, DC ball bearing motor contained in a 
compact, titanium, pressure housing usable to  
10,500 meters deep. The pump impeller and electric drive 
motor are coupled magnetically through the housing, 
providing high reliability by eliminating moving seals. Motor 
speed and pumping rate remain constant over the entire 
input voltage range. The motor drive electronics is 
intrinsically protected against accidental reversed polarity. 
 
 
APPLICATIONS 
 
The SBE 5M is standard on the SBE 19 and 19plus 
SEACAT Profiler CTD. It is optional on the SBE 16, 16plus, 
and 16plus-IM SEACAT C-T Recorder. The pump flushes 
water through the conductivity cell at a constant rate, 
independent of the CTD's motion, improving dynamic 
performance. For applications requiring pumping through 
additional sensors (for example, a dissolved oxygen 
sensor), use the SBE 5T pump instead. 
 
Specify: 
• Option 5M-1 for profiling (continuous duty) applications 

such as the SBE 19plus. 
• Option 5M-2 for moored (pulsed duty) applications such 

as the SBE 16plus or 16plus-IM. 
Contact Sea-Bird for use in other applications. 
 
SPECIFICATIONS 
 
Option 5M-1 (continuous duty):  
Input voltage range 9 - 18 VDC  
 
Flow Rate 25 ml/s supply current 95 ma 
 
Note: Supply current is independent of operating voltage. 
 
 
Option 5M-2 (pulsed duty):  
Input voltage range 6 - 18 VDC  
 
Pulse Duration Flow Volume Electrical Charge 

0.5 seconds 15 ml 0.148 amp-seconds 
1.0 seconds 21 ml 0.283 amp-seconds 
1.5 seconds 31 ml 0.418 amp-seconds 
2.0 seconds 40 ml 0.553 amp-seconds 
 
 
 
 
Weight 
In Air: 0.42 kg (0.91 lbs) 
In Water: 0.28 kg (0.60 lbs) 
 06/03 

Optional  
wet-pluggable 
connector, 
MCBH-2MTI 
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1808 136th Place NE, Bellevue, Washington  98005  USA                 Tel: (425) 643-9866
Website: http://www.seabird.com                                                         Email: seabird@seabird.com

Sea-Bird Electronics, Inc. FAX: (425) 643-9954

SBE 5M MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number:

Job Number:

Customer:

Delivery Date:

Single Connector Housing with Titanium screws

Pressure Case:  10,500 meters (titanium)

Maxon Motor Type:

P/N 90337, Motor PN 20130 (Low power 6 VDC, 2000 RPM MAX)

P/N 90335, Motor PN 20130 (Low power 9 VDC, 2000 RPM MAX)

0649

36026

NOAA/PMC

6/14/2004

Vin 15V voltage across C2: VDC      Current mA7.947 11.8

Vin 9V voltage across C2: VDC      Current mA7.948 11.0

Vin 6V voltage across C2: VDC      Current mA5.868 10.2

Pump submerged test, no load, Vin 12VDC Average current draw in water: 124 mA
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Sea-Bird Electronics, Inc. 
1808 136th Place NE 
Bellevue, Washington 98005 USA 
Tel: 425/643-9866 
Fax:425/643-9954 

SBE 19plusV2
SEACAT PROFILER
Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P50959-6121

User Manual, Version 002



L I M I T E D   L I A B I L I T Y   S T A T E M E N T 

Extreme care should be exercised when using or servicing this equipment.  It should be used or
serviced only by personnel with knowledge of and training in the use and maintenance of
oceanographic electronic equipment.

SEA-BIRD ELECTRONICS, INC. disclaims all product liability risks arising from the use or servicing of
this system.  SEA-BIRD ELECTRONICS, INC. has no way of controlling the use of this equipment or of
choosing the personnel to operate it, and therefore cannot take steps to comply with laws pertaining to
product liability, including laws which impose a duty to warn the user of any dangers involved in
operating this equipment.  Therefore, acceptance of this system by the customer shall be conclusively
deemed to include a covenant by the customer to defend, indemnify, and hold SEA-BIRD
ELECTRONICS, INC. harmless from all product liability claims arising from the use of servicing of this
system.
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WARNING !!
Do not submerge this instrument (S/N 19P50959-6121)

beyond the depth rating of the lowest rated component listed below!

Main Housing (Plastic) 600 meters

Pressure Sensor (600 dBar) Druck 600 meters

Pump (SBE 5M) 600 meters
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 SYSTEM CONFIGURATION 30 September 2008 

 
   
   
 Model SBE 19plusV2 S/N 19P50959-6121 
 Instrument Type SBE 19plusV2 SeaCaT Profiler 
 Firmware Version 2.1 
 Communications 9600 baud, 8 data bits, no parity, one stop bit 
 Memory 64MB 
 Housing 600 meter (Acetron Plastic) 
 0 Conductivity Raw Frequency 3148.83 Hz 
 Pressure Sensor Strain Gauge: 600 dBar, S/N 2752079 
   
 Computer communications (Data I/O) connector Located on the P/N 17709 Y-Cable 
   
 Number of Voltages Sampled: 0 
   
 Serial RS-232C Sensor None 
   
 Data Format:  
 Count Temperature 
 Frequency Conductivity 
 Count Pressure, Strain Gauge 
   
 
          Pump (SBE 5M) 051056 
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IMPORTANT SOFTWARE & HARDWARE CONFIGURATION INFORMATION 

 
Sea-Bird supplies two versions of our software package for communication, real-time data acquisition, and data 
analysis and display: 
• SEASOFT-Win32 - Windows software for PC running Win 95/98/NT/2000/XP 
• SEASOFT-DOS - DOS software for IBM-PC/AT/386/486 or compatible computer with a hard drive 
Detailed information on the use of the Windows software follows: 
 
SEASOFT-Win32 

SEASOFT-Win32 software was supplied on a CD-ROM with your CTD. This software package is designed to run on a PC running Win 

95/98/NT/2000/XP. The CD-ROM also contains software manuals that describe the appropriate applications for the various programs, the 

procedure for installing the software, and instructions on using the programs. There are three primary programs used with the CTD for 

setup, data collection and retrieval, data display, and data processing: 

• SEATERM - terminal program for setup of the CTD and uploading of data from the CTD memory (Note: If using the CTD with the 

90208 Auto Fire Module or SBE 17plus V2 SEARAM, use SeatermAF instead of SEATERM) 

• SEASAVE - real-time data acquisition program 

• SBE Data Processing - data processing program 

Instructions for using the software are found in their Help files. 

 
To communicate with the CTD to set it up or to upload data from the CTD memory to the computer hard drive, 
SEATERM must have information about the CTD hardware configuration (communication parameters, internal 
firmware, etc.) and about the computer. To communicate with the CTD, double click on Seaterm.exe: 
1. In the Configure menu, select the CTD. The Configuration Options dialog box appears. 

A. On the COM Settings tab, select the firmware version (if applicable), baud rate, data bits, and parity to match the CTD’s 

configuration sheet. If necessary, change the com port to match the computer you are using. 

B. On the Upload Settings tab, enter upload type (all as a single file, etc.) as desired.  

For the SBE 17 and 25 only: enter the serial number for the SBE 3 (temperature) and SBE 4 (conductivity) modular sensors, 

exactly as they appear in the configuration (.con) file. 

C. On the Header Information tab, change the settings as desired. 

Click OK when done. SEATERM saves the settings in a SEATERM.ini file. 
2. On the Toolbar, click Connect to communicate with the CTD. 
3. To set up the CTD prior to deployment: 

On the Toolbar, click Status. SEATERM sends the Status command and displays the response. Verify that the 
CTD setup matches your desired deployment. If not, send commands to modify the setup. 

4. To upload data from the CTD: 
On the Toolbar, click Upload to upload data from the CTD memory to the computer. 

 
Sea-Bird CTDs store and/or transmit data from their primary and auxiliary sensors in the form of binary or 
hexadecimal number equivalents of the sensors’ frequency or voltage outputs. This is referred to as the raw data. 
The calculations required to convert from raw data to engineering units of the measured parameters (temperature, 
conductivity, pressure, dissolved oxygen, pH, etc.) are performed using the software, either in real time, or after 
the data has been stored in a file. SEASAVE creates the file in real time. As noted above, SEATERM uploads the 
recorded data and creates the file on the computer hard drive.  
 
To successfully store data to a file on the computer and subsequently convert it to engineering units, the software 
must know the CTD type, CTD configuration, and calibration coefficients for the sensors installed on the CTD. 
This information is unique to each CTD, and is contained in a configuration file. The configuration file, which has 
a .con extension, was written onto a floppy disk and the CD-ROM shipped with the CTD. The .con file for a given 
CTD is named with the last four digits of the serial number for that CTD (e.g., 1234.con). The configuration file is 
created or modified (e.g., changing coefficients after recalibration, or adding another sensor) by using the 
Configure menu in SEASAVE or  
SBE Data Processing. The configuration file is used by SEASAVE to convert raw data to engineering units  
when it acquires, stores, and displays real-time data. The configuration file is also used by some modules in  
SBE Data Processing (Data Conversion and Derive) that convert raw data to engineering units during data 
processing. 
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The instrument type and instrument configuration settings of the .con file and the required setup for the 
SEATERM.ini file for the CTD as delivered are documented below. The calibration coefficients for the CTD's 
sensors are contained in the calibration coefficient section of the CTD manual. 
 
 NOTE: 
SEATERM will not upload data correctly without a properly configured SEATERM.ini file. SEASAVE and SBE 
Data Processing will not interpret the data correctly without the correct .con file. 

 
 
 
 
 

 
SEASOFT CONFIGURATION: 
 
The correct instrument type for your instrument is SBE 19plus V2 SEACAT Profiler.  The correct settings for the configuration of 

your instrument as delivered are documented below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

Strain Gauge 

0 

None 

 

 

3. Count                   Pressure, Strain Gauge 
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SEACAT Profiler CTD SBE 19plus V2

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

E-mail: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

The SBE 19plus V2 (Version 2) Seacat Profiler CTD measures conductivity, temperature, and pressure (depth) and provides high accuracy
and resolution, reliability, and ease-of-use for a wide range of research, monitoring, and engineering applications. The pump-controlled,
T-C ducted flow configuration minimizes salinity spiking caused by ship heave and allows for slow descent rates without slowing sensor
responses, improving dynamic accuracy and resolving small scale structure in the water column. The V2 is the most versatile successor
in the line of Personal CTDs begun with the original SBE 19 SEACAT in 1987.

Compared to the previous 19plus, the 19plus V2 incorporates an electronics upgrade and additional features. The V2 has two additional
(6 total) auxiliary A/D input channels, FLASH memory is increased from 8 to 64 MB, and one RS-232 data input channel is added. An
optional Digiquartz® pressure sensor provides highest-accuracy pressure measurement. Data can be output in XML as well as ASCII and
HEX formats. Firmware upgrades can be downloaded through the communications port by the user, without opening the instrument.

The 19plus V2 samples continuously at up to 4 scans per second (4 Hz) (2 Hz with Digiquartz®), is battery-powered and self-recording,
and is commonly used in the field without a computer, recording up to 1000 individual profiles. Data can be uploaded to a PC and
processed later, or can typically be transmitted in real time more than 100 meters to a PC for acquisition and display using SEASOFT
software provided (maximum cable length is dependent on the number of auxiliary sensors, sampling rate, baud rate, and cable properties).
The 19plus V2 can supply power to 7 external sensors and log their outputs with each CTD scan. Nine D-size alkaline batteries provide
up to 60 hours of continuous operation when logging C, T, and P at 4 Hz (operation time is shorter if powering auxiliary sensors).

The 19plus V2 is easily integrated with an SBE 32 Carousel Water Sampler and is ideal for integration with the SBE 55 ECO Water Sampler.
Both real-time and autonomous auto-fire operations are possible with any Sea-Bird CTD / Water Sampler system.

The 19plus V2 can operate in moored mode, recording time series measurements at user-programmable intervals. Moored mode is easily
configured using setup commands and by removing the profiling T-C Duct and installing optional anti-fouling devices. (If profiling is not
needed, the 16plus V2 Seacat Recorder offers greater moored-mode programming flexibility and a pressure sensor is optional.)

Accuracy, convenience, portability, software, and support: compelling reasons why the 19plus V2 is today’s best low-cost CTD.

CONFIGURATION, OPTIONS, AND ACCESSORIES

A standard SBE 19plus V2 is supplied with:
• Plastic housing for depths to 600 meters
• Strain-gauge pressure sensor
• 64 Mbyte FLASH RAM memory
• 9 D-size alkaline batteries
• Glass-reinforced epoxy bulkhead connectors
• SBE 5M miniature pump with plastic housing for depths to 600 m, and T-C Duct

Options and accessories include:
• Titanium housing for depths to 7000 meters
• Wet-pluggable MCBH series connectors
• SBE 5M miniature pump with titanium housing for 7000 meters
• SBE 5P (plastic) or 5T (titanium) in place of SBE 5M for use with dissolved oxygen and/or other

pumped sensors
• Digiquartz® pressure sensor
• Stainless steel protection cage
• Auxiliary sensors for Dissolved Oxygen, pH (Profiling mode only), fluorescence, radiance

(PAR), light transmission, and optical backscatter (turbidity)
• Plastic shipping case
• Nickel Metal Hydride (NiMH) batteries and charger
• Moored mode conversion kit with anti-foulant device fittings
• Load-bearing underwater cables for hand-hauled, real-time profiling
• SBE 36 CTD Deck Unit and Power/Data Interface Module (PDIM) for real-time operation on

single-core armored cable up to 10,000 meters

SOFTWARE

The SBE 19plus V2 is supplied with a powerful Windows 2000/XP software package, SEASOFT©-Win32, which includes programs for
communication and data retrieval, real-time data acquisition and display, and data processing (filtering, aligning, averaging) and plotting.

Shown with
optional cage,
SBE 5P pump,

& SBE 43
DO sensor
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Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

E-mail: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

SPECIFICATIONS

Memory 64 Mbyte non-volatile FLASH memory

Data Storage Recorded Parameter Bytes/Sample
T + C 6
pressure - strain gauge or Quartz 5
each external voltage 2
auxiliary RS-232 sensor sensor dependent

Real-Time Clock 32,768 Hz TCXO accurate to ±1 minute/year

Internal Batteries 9 alkaline D-cells (Duracell MN1300, LR20) provide 60 hours profiling;
optional 9-cell NiMH battery pack provides 40 hours profiling per charge;
optional 9-cell Ni-Cad battery pack provides 24 hours profiling per charge

External Power Supply 9 - 28 VDC; consult factory for required current

Power Requirements
Sampling 70 mA
Pump SBE 5M: 100 mA Optional SBE 5T or 5P: 150 mA
Communications 65 mA
Quiescent 20 μA

Auxiliary Sensors
Auxiliary power out up to 500 mA at 10.5 - 11 VDC
Voltage sensor A/D resolution 14 bits
Voltage sensor input range 0 - 5 VDC

Housing Materials, Depth Rating, Weight in air*, Weight in water*
Acetal Copolymer Plastic housing, 600 m (1950 ft), 7.3 kg (16 lbs), 2.3 kg (5 lbs)
3AL-2.5V Titanium housing, 7000 m (22,900 ft), 13.7 kg (30 lbs), 8.6 kg (19 lbs)
*Weights listed are without pump; pump adds (in air) 0.3 to 0.7 kg (0.6 to 1.5 lbs),
depending on pump model selected. See pump brochures for details.
Optional Cage
(for 19plus V2 with strain-gauge pressure) 1016 x 241 x 279 mm (40 x 9.5 x 11 in.), 6.3 kg (14 lbs)
(for 19plus V2 with Digiquartz pressure) 1219 x 241 x 279 mm (48 x 9.5 x 11 in.)

Measurement Initial Typical
Range Accuracy Stability Resolution

0.00005 (most oceanic waters; resolves 0.4 ppm in salinity)
Conductivity (S/m) 0 to 9 0.0005 0.0003/month 0.00007 S/m (high salinity waters; resolves 0.4 ppm in salinity)

0.00001 S/m (fresh waters; resolves 0.1 ppm in salinity)

Temperature (°C) -5 to +35 0.005 0.0002/month 0.0001
0 to 20/100/350/600/ 0.1% of 0.1% of

Pressure - 1000/2000/3500/ full scale full scale 0.002% of full scale range
Strain Gauge 7000 meters range range/year

0 to 20/60/130/200/
Pressure - 270/680/1400/ 0.02% of 0.025% of 0.0025% of full scale range
Quartz 2000/4200/7000/ full scale full scale

10,500 meters range range/year

02/08

SBE 19plus V2SEACAT Profiler CTD

Dimensions
in millimeters
(inches)

*Note: 19plus V2 with optional
Quartz pressure sensor is
190 mm (7.5 inches) longer
than shown in drawing.*
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Mini Submersible Pump  SBE 5M 
 
 
The SBE 5M pump module consists of a centrifugal pump head and a 
long-life, DC, ball-bearing motor contained in a compact, titanium 
pressure housing usable to 10,500 meters (34,400 ft) deep. A plastic 
housing for depths to 600 meters (1960 ft) is available as an option. The 
pump impeller and electric drive motor are coupled magnetically through 
the housing, providing high reliability by eliminating moving seals. Motor 
speed and pumping rate remain constant over the entire input voltage 
range. The motor drive electronics is intrinsically protected against 
accidental reversed polarity. 
 
 
APPLICATIONS 
 
The SBE 5M is standard on the SBE 19plus V2 SEACAT Profiler CTD, 
and is optional on the SBE 16plus V2 and 16plus-IM V2 SEACAT C-T 
Recorders. The pump flushes water through the conductivity cell at a 
constant rate, independent of the CTD's motion, improving dynamic performance. For applications requiring pumping 
through additional sensors (for example, a dissolved oxygen sensor), use the SBE 5T or 5P pump instead. 
 
Specify: 
• Option 5M-1 for profiling (continuous duty) applications such as the  

SBE 19plus V2. 
• Option 5M-2 for moored (pulsed duty) applications such as the  

SBE 16plus V2 or 16plus-IM V2. 
 
Contact Sea-Bird for use in other applications. 
 
 
 
 
SPECIFICATIONS 
 
Option 5M-1 (continuous duty):  
Input voltage range 9 - 18 VDC 
 
Flow Rate 25 ml/s Supply current 95 mA 
Note: Supply current is independent of operating voltage. 
 
 
Option 5M-2 (pulsed duty):  
Input voltage range 6 - 18 VDC 
 
Pulse Duration Flow Volume Electrical Charge 

0.5 seconds 15 ml 0.148 Amp-seconds 
1.0 seconds 21 ml 0.283 Amp-seconds 
1.5 seconds 31 ml 0.418 Amp-seconds 
2.0 seconds 40 ml 0.553 Amp-seconds 
 
 
Weight 
With standard titanium housing:  
     In Air - 0.42 kg (0.91 lbs); In Water - 0.28 kg (0.60 lbs) 
With optional plastic housing:  
     In Air - 0.28 kg (0.60 lbs); In Water - 0.13 kg (0.29 lbs) 

Standard 
titanium 
housing 

Optional 
plastic 
housing 

05/08 
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SBE 5M MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number:

Job Number:

Customer:

Delivery Date:

Single Bulkhead Connector.

Pressure Case:  10,500 meters (titanium)

Maxon Motor Type:

P/N 801605, Motor PN 20130 (Pulsed Duty 6 VDC, 2000 RPM MAX)P/N 801605, Motor PN 20130 (Pulsed Duty 6 VDC, 2000 RPM MAX)P/N 801605, Motor PN 20130 (Pulsed Duty 6 VDC, 2000 RPM MAX)P/N 801605, Motor PN 20130 (Pulsed Duty 6 VDC, 2000 RPM MAX)

P/N 801606, Motor PN 20127 (Continuous Duty 9 VDC, 2000 RPM MAX)P/N 801606, Motor PN 20127 (Continuous Duty 9 VDC, 2000 RPM MAX)P/N 801606, Motor PN 20127 (Continuous Duty 9 VDC, 2000 RPM MAX)P/N 801606, Motor PN 20127 (Continuous Duty 9 VDC, 2000 RPM MAX)

1056105610561056

50959509595095950959

NOAA/PMCNOAA/PMCNOAA/PMCNOAA/PMC

10/3/200810/3/200810/3/200810/3/2008

Vin 15V voltage across C2: VDC      Current mA7.967.967.967.96 15.815.815.815.8

Vin 9V voltage across C2: VDC      Current mA7.967.967.967.96 15.715.715.715.7

Vin 6V voltage across C2: VDC      Current mA5.95.95.95.9 10.410.410.410.4

Pump submerged test, no load, Vin 12VDC Average current draw in water: 120120120120 mA
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Bellevue, Washington 98005 USA 
Tel: 425/643-9866 
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SBE 19plusV2
SEACAT PROFILER
Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P50959-6122

User Manual, Version 002



L I M I T E D   L I A B I L I T Y   S T A T E M E N T 

Extreme care should be exercised when using or servicing this equipment.  It should be used or
serviced only by personnel with knowledge of and training in the use and maintenance of
oceanographic electronic equipment.

SEA-BIRD ELECTRONICS, INC. disclaims all product liability risks arising from the use or servicing of
this system.  SEA-BIRD ELECTRONICS, INC. has no way of controlling the use of this equipment or of
choosing the personnel to operate it, and therefore cannot take steps to comply with laws pertaining to
product liability, including laws which impose a duty to warn the user of any dangers involved in
operating this equipment.  Therefore, acceptance of this system by the customer shall be conclusively
deemed to include a covenant by the customer to defend, indemnify, and hold SEA-BIRD
ELECTRONICS, INC. harmless from all product liability claims arising from the use of servicing of this
system.

2



WARNING !!
Do not submerge this instrument (S/N 19P50959-6122)

beyond the depth rating of the lowest rated component listed below!

Main Housing (Plastic) 600 meters

Pressure Sensor (600 dBar) Druck 600 meters

Pump (SBE 5M) 600 meters
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 SYSTEM CONFIGURATION 1 October 2008 

 
   
   
 Model SBE 19plusV2 S/N 19P50959-6122 
 Instrument Type SBE 19plusV2 SeaCaT Profiler 
 Firmware Version 2.1 
 Communications 9600 baud, 8 data bits, no parity, one stop bit 
 Memory 64MB 
 Housing 600 meter (Acetron Plastic) 
 0 Conductivity Raw Frequency 2523.44 Hz 
 Pressure Sensor Strain Gauge: 600 dBar, S/N 2752080 
   
 Computer communications (Data I/O) connector Located on the P/N 17709 Y-Cable 
   
 Number of Voltages Sampled: 0 
   
 Serial RS-232C Sensor None 
   
 Data Format:  
 Count Temperature 
 Frequency Conductivity 
 Count Pressure, Strain Gauge 
    
 
          Pump (SBE 5M) 051058 
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IMPORTANT SOFTWARE & HARDWARE CONFIGURATION INFORMATION 

 
Sea-Bird supplies two versions of our software package for communication, real-time data acquisition, and data 
analysis and display: 
• SEASOFT-Win32 - Windows software for PC running Win 95/98/NT/2000/XP 
• SEASOFT-DOS - DOS software for IBM-PC/AT/386/486 or compatible computer with a hard drive 
Detailed information on the use of the Windows software follows: 
 
SEASOFT-Win32 

SEASOFT-Win32 software was supplied on a CD-ROM with your CTD. This software package is designed to run on a PC running Win 

95/98/NT/2000/XP. The CD-ROM also contains software manuals that describe the appropriate applications for the various programs, the 

procedure for installing the software, and instructions on using the programs. There are three primary programs used with the CTD for 

setup, data collection and retrieval, data display, and data processing: 

• SEATERM - terminal program for setup of the CTD and uploading of data from the CTD memory (Note: If using the CTD with the 

90208 Auto Fire Module or SBE 17plus V2 SEARAM, use SeatermAF instead of SEATERM) 

• SEASAVE - real-time data acquisition program 

• SBE Data Processing - data processing program 

Instructions for using the software are found in their Help files. 

 
To communicate with the CTD to set it up or to upload data from the CTD memory to the computer hard drive, 
SEATERM must have information about the CTD hardware configuration (communication parameters, internal 
firmware, etc.) and about the computer. To communicate with the CTD, double click on Seaterm.exe: 
1. In the Configure menu, select the CTD. The Configuration Options dialog box appears. 

A. On the COM Settings tab, select the firmware version (if applicable), baud rate, data bits, and parity to match the CTD’s 

configuration sheet. If necessary, change the com port to match the computer you are using. 

B. On the Upload Settings tab, enter upload type (all as a single file, etc.) as desired.  

For the SBE 17 and 25 only: enter the serial number for the SBE 3 (temperature) and SBE 4 (conductivity) modular sensors, 

exactly as they appear in the configuration (.con) file. 

C. On the Header Information tab, change the settings as desired. 

Click OK when done. SEATERM saves the settings in a SEATERM.ini file. 
2. On the Toolbar, click Connect to communicate with the CTD. 
3. To set up the CTD prior to deployment: 

On the Toolbar, click Status. SEATERM sends the Status command and displays the response. Verify that the 
CTD setup matches your desired deployment. If not, send commands to modify the setup. 

4. To upload data from the CTD: 
On the Toolbar, click Upload to upload data from the CTD memory to the computer. 

 
Sea-Bird CTDs store and/or transmit data from their primary and auxiliary sensors in the form of binary or 
hexadecimal number equivalents of the sensors’ frequency or voltage outputs. This is referred to as the raw data. 
The calculations required to convert from raw data to engineering units of the measured parameters (temperature, 
conductivity, pressure, dissolved oxygen, pH, etc.) are performed using the software, either in real time, or after 
the data has been stored in a file. SEASAVE creates the file in real time. As noted above, SEATERM uploads the 
recorded data and creates the file on the computer hard drive.  
 
To successfully store data to a file on the computer and subsequently convert it to engineering units, the software 
must know the CTD type, CTD configuration, and calibration coefficients for the sensors installed on the CTD. 
This information is unique to each CTD, and is contained in a configuration file. The configuration file, which has 
a .con extension, was written onto a floppy disk and the CD-ROM shipped with the CTD. The .con file for a given 
CTD is named with the last four digits of the serial number for that CTD (e.g., 1234.con). The configuration file is 
created or modified (e.g., changing coefficients after recalibration, or adding another sensor) by using the 
Configure menu in SEASAVE or  
SBE Data Processing. The configuration file is used by SEASAVE to convert raw data to engineering units  
when it acquires, stores, and displays real-time data. The configuration file is also used by some modules in  
SBE Data Processing (Data Conversion and Derive) that convert raw data to engineering units during data 
processing. 

6



 
The instrument type and instrument configuration settings of the .con file and the required setup for the 
SEATERM.ini file for the CTD as delivered are documented below. The calibration coefficients for the CTD's 
sensors are contained in the calibration coefficient section of the CTD manual. 
 
 NOTE: 
SEATERM will not upload data correctly without a properly configured SEATERM.ini file. SEASAVE and SBE 
Data Processing will not interpret the data correctly without the correct .con file. 

 
 
 
 
 

 
SEASOFT CONFIGURATION: 
 
The correct instrument type for your instrument is SBE 19plus V2 SEACAT Profiler.  The correct settings for the configuration of 

your instrument as delivered are documented below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

Strain Gauge 

0 

None 

 

 

3. Count                   Pressure, Strain Gauge 
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SEACAT Profiler CTD SBE 19plus V2

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

E-mail: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

The SBE 19plus V2 (Version 2) Seacat Profiler CTD measures conductivity, temperature, and pressure (depth) and provides high accuracy
and resolution, reliability, and ease-of-use for a wide range of research, monitoring, and engineering applications. The pump-controlled,
T-C ducted flow configuration minimizes salinity spiking caused by ship heave and allows for slow descent rates without slowing sensor
responses, improving dynamic accuracy and resolving small scale structure in the water column. The V2 is the most versatile successor
in the line of Personal CTDs begun with the original SBE 19 SEACAT in 1987.

Compared to the previous 19plus, the 19plus V2 incorporates an electronics upgrade and additional features. The V2 has two additional
(6 total) auxiliary A/D input channels, FLASH memory is increased from 8 to 64 MB, and one RS-232 data input channel is added. An
optional Digiquartz® pressure sensor provides highest-accuracy pressure measurement. Data can be output in XML as well as ASCII and
HEX formats. Firmware upgrades can be downloaded through the communications port by the user, without opening the instrument.

The 19plus V2 samples continuously at up to 4 scans per second (4 Hz) (2 Hz with Digiquartz®), is battery-powered and self-recording,
and is commonly used in the field without a computer, recording up to 1000 individual profiles. Data can be uploaded to a PC and
processed later, or can typically be transmitted in real time more than 100 meters to a PC for acquisition and display using SEASOFT
software provided (maximum cable length is dependent on the number of auxiliary sensors, sampling rate, baud rate, and cable properties).
The 19plus V2 can supply power to 7 external sensors and log their outputs with each CTD scan. Nine D-size alkaline batteries provide
up to 60 hours of continuous operation when logging C, T, and P at 4 Hz (operation time is shorter if powering auxiliary sensors).

The 19plus V2 is easily integrated with an SBE 32 Carousel Water Sampler and is ideal for integration with the SBE 55 ECO Water Sampler.
Both real-time and autonomous auto-fire operations are possible with any Sea-Bird CTD / Water Sampler system.

The 19plus V2 can operate in moored mode, recording time series measurements at user-programmable intervals. Moored mode is easily
configured using setup commands and by removing the profiling T-C Duct and installing optional anti-fouling devices. (If profiling is not
needed, the 16plus V2 Seacat Recorder offers greater moored-mode programming flexibility and a pressure sensor is optional.)

Accuracy, convenience, portability, software, and support: compelling reasons why the 19plus V2 is today’s best low-cost CTD.

CONFIGURATION, OPTIONS, AND ACCESSORIES

A standard SBE 19plus V2 is supplied with:
• Plastic housing for depths to 600 meters
• Strain-gauge pressure sensor
• 64 Mbyte FLASH RAM memory
• 9 D-size alkaline batteries
• Glass-reinforced epoxy bulkhead connectors
• SBE 5M miniature pump with plastic housing for depths to 600 m, and T-C Duct

Options and accessories include:
• Titanium housing for depths to 7000 meters
• Wet-pluggable MCBH series connectors
• SBE 5M miniature pump with titanium housing for 7000 meters
• SBE 5P (plastic) or 5T (titanium) in place of SBE 5M for use with dissolved oxygen and/or other

pumped sensors
• Digiquartz® pressure sensor
• Stainless steel protection cage
• Auxiliary sensors for Dissolved Oxygen, pH (Profiling mode only), fluorescence, radiance

(PAR), light transmission, and optical backscatter (turbidity)
• Plastic shipping case
• Nickel Metal Hydride (NiMH) batteries and charger
• Moored mode conversion kit with anti-foulant device fittings
• Load-bearing underwater cables for hand-hauled, real-time profiling
• SBE 36 CTD Deck Unit and Power/Data Interface Module (PDIM) for real-time operation on

single-core armored cable up to 10,000 meters

SOFTWARE

The SBE 19plus V2 is supplied with a powerful Windows 2000/XP software package, SEASOFT©-Win32, which includes programs for
communication and data retrieval, real-time data acquisition and display, and data processing (filtering, aligning, averaging) and plotting.

Shown with
optional cage,
SBE 5P pump,

& SBE 43
DO sensor
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Fax: (425) 643-9954

SPECIFICATIONS

Memory 64 Mbyte non-volatile FLASH memory

Data Storage Recorded Parameter Bytes/Sample
T + C 6
pressure - strain gauge or Quartz 5
each external voltage 2
auxiliary RS-232 sensor sensor dependent

Real-Time Clock 32,768 Hz TCXO accurate to ±1 minute/year

Internal Batteries 9 alkaline D-cells (Duracell MN1300, LR20) provide 60 hours profiling;
optional 9-cell NiMH battery pack provides 40 hours profiling per charge;
optional 9-cell Ni-Cad battery pack provides 24 hours profiling per charge

External Power Supply 9 - 28 VDC; consult factory for required current

Power Requirements
Sampling 70 mA
Pump SBE 5M: 100 mA Optional SBE 5T or 5P: 150 mA
Communications 65 mA
Quiescent 20 μA

Auxiliary Sensors
Auxiliary power out up to 500 mA at 10.5 - 11 VDC
Voltage sensor A/D resolution 14 bits
Voltage sensor input range 0 - 5 VDC

Housing Materials, Depth Rating, Weight in air*, Weight in water*
Acetal Copolymer Plastic housing, 600 m (1950 ft), 7.3 kg (16 lbs), 2.3 kg (5 lbs)
3AL-2.5V Titanium housing, 7000 m (22,900 ft), 13.7 kg (30 lbs), 8.6 kg (19 lbs)
*Weights listed are without pump; pump adds (in air) 0.3 to 0.7 kg (0.6 to 1.5 lbs),
depending on pump model selected. See pump brochures for details.
Optional Cage
(for 19plus V2 with strain-gauge pressure) 1016 x 241 x 279 mm (40 x 9.5 x 11 in.), 6.3 kg (14 lbs)
(for 19plus V2 with Digiquartz pressure) 1219 x 241 x 279 mm (48 x 9.5 x 11 in.)

Measurement Initial Typical
Range Accuracy Stability Resolution

0.00005 (most oceanic waters; resolves 0.4 ppm in salinity)
Conductivity (S/m) 0 to 9 0.0005 0.0003/month 0.00007 S/m (high salinity waters; resolves 0.4 ppm in salinity)

0.00001 S/m (fresh waters; resolves 0.1 ppm in salinity)

Temperature (°C) -5 to +35 0.005 0.0002/month 0.0001
0 to 20/100/350/600/ 0.1% of 0.1% of

Pressure - 1000/2000/3500/ full scale full scale 0.002% of full scale range
Strain Gauge 7000 meters range range/year

0 to 20/60/130/200/
Pressure - 270/680/1400/ 0.02% of 0.025% of 0.0025% of full scale range
Quartz 2000/4200/7000/ full scale full scale

10,500 meters range range/year

02/08

SBE 19plus V2SEACAT Profiler CTD

Dimensions
in millimeters
(inches)

*Note: 19plus V2 with optional
Quartz pressure sensor is
190 mm (7.5 inches) longer
than shown in drawing.*
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Mini Submersible Pump  SBE 5M 
 
 
The SBE 5M pump module consists of a centrifugal pump head and a 
long-life, DC, ball-bearing motor contained in a compact, titanium 
pressure housing usable to 10,500 meters (34,400 ft) deep. A plastic 
housing for depths to 600 meters (1960 ft) is available as an option. The 
pump impeller and electric drive motor are coupled magnetically through 
the housing, providing high reliability by eliminating moving seals. Motor 
speed and pumping rate remain constant over the entire input voltage 
range. The motor drive electronics is intrinsically protected against 
accidental reversed polarity. 
 
 
APPLICATIONS 
 
The SBE 5M is standard on the SBE 19plus V2 SEACAT Profiler CTD, 
and is optional on the SBE 16plus V2 and 16plus-IM V2 SEACAT C-T 
Recorders. The pump flushes water through the conductivity cell at a 
constant rate, independent of the CTD's motion, improving dynamic performance. For applications requiring pumping 
through additional sensors (for example, a dissolved oxygen sensor), use the SBE 5T or 5P pump instead. 
 
Specify: 
• Option 5M-1 for profiling (continuous duty) applications such as the  

SBE 19plus V2. 
• Option 5M-2 for moored (pulsed duty) applications such as the  

SBE 16plus V2 or 16plus-IM V2. 
 
Contact Sea-Bird for use in other applications. 
 
 
 
 
SPECIFICATIONS 
 
Option 5M-1 (continuous duty):  
Input voltage range 9 - 18 VDC 
 
Flow Rate 25 ml/s Supply current 95 mA 
Note: Supply current is independent of operating voltage. 
 
 
Option 5M-2 (pulsed duty):  
Input voltage range 6 - 18 VDC 
 
Pulse Duration Flow Volume Electrical Charge 

0.5 seconds 15 ml 0.148 Amp-seconds 
1.0 seconds 21 ml 0.283 Amp-seconds 
1.5 seconds 31 ml 0.418 Amp-seconds 
2.0 seconds 40 ml 0.553 Amp-seconds 
 
 
Weight 
With standard titanium housing:  
     In Air - 0.42 kg (0.91 lbs); In Water - 0.28 kg (0.60 lbs) 
With optional plastic housing:  
     In Air - 0.28 kg (0.60 lbs); In Water - 0.13 kg (0.29 lbs) 

Standard 
titanium 
housing 

Optional 
plastic 
housing 

05/08 
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SBE 5M MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number:

Job Number:

Customer:

Delivery Date:

Single Bulkhead Connector.

Pressure Case:  10,500 meters (titanium)

Maxon Motor Type:

P/N 801605, Motor PN 20130 (Pulsed Duty 6 VDC, 2000 RPM MAX)P/N 801605, Motor PN 20130 (Pulsed Duty 6 VDC, 2000 RPM MAX)P/N 801605, Motor PN 20130 (Pulsed Duty 6 VDC, 2000 RPM MAX)P/N 801605, Motor PN 20130 (Pulsed Duty 6 VDC, 2000 RPM MAX)

P/N 801606, Motor PN 20127 (Continuous Duty 9 VDC, 2000 RPM MAX)P/N 801606, Motor PN 20127 (Continuous Duty 9 VDC, 2000 RPM MAX)P/N 801606, Motor PN 20127 (Continuous Duty 9 VDC, 2000 RPM MAX)P/N 801606, Motor PN 20127 (Continuous Duty 9 VDC, 2000 RPM MAX)

1058105810581058

50959509595095950959

NOAA/PMCNOAA/PMCNOAA/PMCNOAA/PMC

10/3/200810/3/200810/3/200810/3/2008

Vin 15V voltage across C2: VDC      Current mA7.957.957.957.95 13.213.213.213.2

Vin 9V voltage across C2: VDC      Current mA7.957.957.957.95 13131313

Vin 6V voltage across C2: VDC      Current mA5.875.875.875.87 9.969.969.969.96

Pump submerged test, no load, Vin 12VDC Average current draw in water: 116116116116 mA
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LEICA NA2 • NAK2

Universal automatic level



LEICA NA2 
The classical level from Leica Geosystems

The NA2 universal auto-
matic level meets all
requirements regarding
precision, convenience 
and reliability.

It was designed by sur-
veyors and development
engineers with years of
experience and who know
what a field instrument 
has to be able to do.

The NA2 soon pays for 
itself, because it can be
used for all types of sur-
veying job; on building
sites for routine levelling, 
in engineering projects, 
and for geodetic control at
all levels of accuracy.

Universal application

• Levelling of all types and
all orders of accuracy

• Precise levelling and
settlement determinations
on buildings

• Routine heighting for 
the construction of roads,
railways, pipelines,
tunnels and so forth

• Setting-out work and
control measurements on
the construction site

• Area levelling of high
accuracy

• Tacheometric levelling
with the K-version on flat
terrain by combining 
stadia and angular meas-
urements with height 
readings

• Deformation measure-
ment and monitoring of
bridges



Quickly set up, simple to use

Strong tripods

In principle, the NA2 
can be set up on any Leica
Geosystems tripod. In
practice, for all-round
purposes, we recommend
the heavy-duty GST20
telescopic-leg tripod. 
For precise levelling the
GST40 fixed-leg tripod 
is suitable because of its
extreme rigidity.

The modular relationship
between instrument and
tripod is an advantage
when transport space is
limited.

Centring is easy

The circular level only
needs to be centred
approximately to bring the
compensator well into its
working range of ~30', and
so setting-up goes quicker. 

The bubble is viewed
positively via a pentaprism
and is monitored down 
the eyepiece.

Play-free footscrews

The pitch of the smooth-
running and backlash-free
footscrews is such that 
the bubble can be centred
in a very short time.

Independent of 
temperature

Unlike the tubular level of 
a traditional instrument, the
NA2 universal automatic
level is relatively insensitive
to direct solar radiation 
and an umbrella need only 
be considered for the most
precise levelling. 

Open sight

Rapid / fine focusing knob

Pentaprism for viewing circular level

Endless horizontal drive

Footscrew

Push-button for compensator control

Endless horizontal drive

Footscrew



Adjust the line of sight automatically

Easy to level up

The advantage of this
instrument is that, as soon
as the bubble is centred,
the line of sight is horizontal
for all pointings of the
telescope. The observer is
freed of the time-consuming
centring procedure involved
with the traditional tubular
level, and can concentrate
on the business of staff
readings.

Minimum maintenance

In the unlikely event that
the compensator is
damaged (and this can only
happen as a result of
extremely harsh treatment)
it is replaced easily, being
held only by three screws.

NA2/NAK2 compensator

1 Suspension tapes
2 Prism (fixed)
3 Compensator body
4 Pendulum with prism
5 Line of sight
6 Push-button
7 Spring which taps pendulum
8 Pneumatic damping mechanism

Push-button control –
added security

With most automatics one
taps the tripod or instru-
ment to check if the com-
pensator is functioning.
Leica Geosystems offers a
far more sophisticated
solution.

Pressing the button under
the NA2 eyepiece gives the
compensator a gentle tap,
so that you see the staff
image swing smoothly

away and then float gently
back to give the horizontal
line of sight. This check,
which takes less than 
a second, is technically
perfect, as the pendulum
itself is activated and
swings through its full
range. It is also immediately
apparent if the bubble 
is not centred.

Robust and automatic

The compensator is
essentially a pendulum 
with a prism (4). 

The suspension system
comprises four flexed 
tapes (1) made of a special
alloy to ensure faultless
functioning even at extreme
temperatures. The compen-
sator, which is located
between the focusing lens
and the crosshair reticle, 
is pneumatically damped
against mechanical vibra-
tion and is screened against
magnetic fields.



Top-class optics

Top-class optics

The telescope is of excellent
quality and gives a bright,
high-contrast, erect image,
even in poor light – an
essential for accurate
levelling. With the standard
eyepiece the magnification
is 32×, the optimum for
most applications of the
instrument. Optional
eyepieces are available; the
40× may be preferred for
precise levelling, the 25×
in hot, shimmer conditions.
Eyepiece exchange takes
only a second or so.

The focusing knob has a
coarse/fine movement:
– coarse, for rapid setting

with minimum turning
– fine, for the final delicate

touch to give the perfect
image.

Fatigue-free viewing

The reticle has:
– a single horizontal hair

for reading normal staffs
– a wedge-shaped hair for

use with invar staffs
– stadia hairs for distance

measurement and three-
wire levelling.

The general layout of 
the controls, the smooth
friction-braked rotation 
of the instrument, and the
endless horizontal drive
with bilateral knobs, 
all combine to make the
instrument easy to use.

At an advantage on 
unstable ground

If a tubular level is used 
on unstable ground it tilts
out of range and has to be
continuously reset. By
contrast, the pendulum of
the NA2 “compensates”
and keeps the line of sight
horizontal.

Angle measurement 
with the NAK2

Civil engineers and contrac-
tors often require a circle
for angle measurement 
and setting-out work. Even
simple detail surveys, by
taking angle, distance and
height, and plotting with
the polar method, can be
done with a level.

The model NAK2 has an
internal glass circle which
is read via a scale micro-
scope and which can be set
to any value by turning 
the rim around the base 
of the instrument.

NA2 field of view with metric levelling staff
Reading at horizontal hair: 1.143 m

NAK2 
circle reading (400 gon)

392.66 gon

NAK2 
circle reading (360°) 

314°42'



High-performance accessories for precise levelling

GPM3 
parallel-plate micrometer

This optional accessory
slips over the telescope
objective and blends
perfectly with the smooth
lines of the NA2. With 
a compensator setting
accuracy of ±0.3“ (equiva-
lent to 0.01 mm in 10 m)
and a micrometer reading
to 0.1 mm direct and 
0.01 mm by estimation, the
NA2 with GPM3 is an ideal
combination for precise
levelling, deformation 
studies, and even optical
tooling. The micrometer
drive for raising and lower-
ing the line of sight is con-
veniently located and read-
ings are taken on a glass
scale viewed through an
eyepiece just above the
telescope eyepiece. This
optical reading system,
which is digital apart from
the last and estimated
figure in the metric and
inch versions, is superior 
to the usual metal drum
system.

GPM6 
parallel-plate micrometer

There are tasks for which 
a micrometer is needed, 
yet for which the very high
accuracy of the GPM3 is 
not essential. 

To meet this requirement, 
a simpler micrometer
attachment, the GPM6 
with drum reading, 
is available for the NA2.

The GPM6 fits on to the
telescope objective in the
same manner as the GPM3,
but the graduation is
engraved on a metal drum.

Eyepiece accessories for
specialized tasks

Because of the bayonet
fastening of the inter-
changeable eyepiece, all
theodolite eyepiece acces-
sories can be used with 
the NA2.

• Diagonal eyepiece for
observing from above,
below, and from the side;
useful in cramped spaces

• Eyepiece lamp for con-
verting the NA2 into 
a horizontal collimator 
for laboratory work

• Autocollimation eye-
piece for setting machine 
parts and instrument 
components precisely
vertical



Precise

Reliable, automatic, 
maintenance-free

Easy handling

Quick levelling-up

Superb telescope

Abundant accessories; 
many applications

Effortless focusing

The rugged NA2 is indifferent
to weather conditions and 
is extremely reliable in the
rough world of the building
site. The pendulum compen-
sator is protected against
knocks and shocks. There is
a highly-effective vibration-
damping mechanism.

The high setting accuracy
ensures that the line of
sight stays put. The attach-
able parallel-plate micro-
meter renders the NA2 
ideal for precise fine 
levelling.

The instantaneous check
facility with the push-button
control not only makes 
work easier; it also
promotes confidence.

The convenient, well-
arranged controls are
designed for maximum 
convenience. The bilateral,
endless horizontal 
drive promotes rapid 
fine-pointing.

The instrument is quickly 
set up with the three rapid-
action footscrews. Their 
self-adjusting threads 
make subsequent resetting
unnecessary.

Telescope with excellently-
corrected optics for bright,
high-contrast images. 
All optical components are
coated on both sides.

The erect image seen down
the telescope is quickly 
and accurately brought into
focus with the convenient
rapid and fine focusing
knob.

Additional items such as 
the parallel-plate micro-
meter, the laser eyepiece, 
or theodolite eyepiece
accessories, offer almost
unlimited possibilities.

Compact



LEICA NA2 • NAK2
Proven reliability ensures precise results

Versatile accessories for
demonstrable success

A comprehensive program
of accessories enables you
to expand the performance
and applications range 
of each instrument. 
This way, you can match 
your equipment exactly 
to requirements. 

The possibilities are
described in brochure
“Survey accessories” 
710 883en.

Total Quality Management – 
Our commitment to total 
customer satisfaction

Ask your local Leica
Geosystems agent for 
more information 
about our TQM program.

Illustrations, descriptions, and technical data are not binding and may be changed.
Printed in Switzerland – Copyright Leica Geosystems AG, Heerbrugg, Switzerland, 1999
710 837en – V.03 – RDV

Technical data

Standard deviation for 1 km double-run 
levelling, depending on type of staff and on 
procedure up to 0.7 mm
With parallel-plate micrometer 0.3 mm

Telescope erect image
Standard eyepiece 32×
FOK73 eyepiece (optional) 40×
FOK117 (optional) 25×
Clear objective aperture 45 mm
Field of view at 100 m 2.2 m
Shortest focusing distance 1.6 m
Multiplication factor 100
Additive constant 0

Working range of compensator ~30’
Setting accuracy of compensator (stand. dev.) 0.3“
Sensitivity of circular level 8’/2 mm

Glass circle (K version) 400 gon (360°)
Graduation diameter 70 mm
Graduation interval 1 gon (1°)
Reading by estimation to 10 mgon (1’)

Water- and dust resistance IP53

Temperature range:
Operation –20°C to +50°C (– 4°F to 122°F)
Storage –40°C to +70°C (–40°F to 158°F)

Parallel-plate micrometer Range Interval Estimation
(optional accessory)

GPM3, with glass scale 10 mm 0.1 mm 0.01 mm

GPM6, with metal drum 10 mm 0.2 mm 0.05 mm

Robust container for 
safe transport

The NA2 is supplied in a
foam-padded container
made of high performance
synthetic material. The
foam padding absorbs all
jolts and shocks. The
container provides perfect
protection for the NA2.

ISO 9001 / ISO 14001

Leica Geosystems AG
CH-9435 Heerbrugg

(Switzerland)
Phone +41 71 727 31 31

Fax +41 71 727 46 73
www.leica-geosystems.com
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PDL

Positioning Data Link™

19,200 Baud Rate
Higher Over-the -Air Link Rate

Extends Your Battery Life

Enhanced User Interface
Change Channels in the Field

View Status Information

Compatible with GPS
RTK Equipment

Worldwide
Complete Kit Solutions Available

for Your Application

Reliable
Rugged, All Season Operation

2 Year Warranty
Lower Cost of Ownership

High Performance
Data Link

Designed for Survey Systems

Surveyors utilizing Global Positioning Systems require a rugged radio
modem data link for precise positioning information. The PDL is compact
and lightweight and offers power efficient operation. It is easy to use, and
provides high performance and rugged dependability for the toughest
survey environments.

PDL Products are designed to easily mount on all standard tripods and
range poles. Complete kit solutions are available.

™



RF Power Select	 	 Low/High. 		 			Factory Programmable. 	 	 	N/A.

External
Internal Battery 	 	 N/A 	 	 	 	 	 N/A. 	 	 	 	 	 Lithium Ion Battery Pack.
During TX (nominal) 		 110 Watts.	 	 	 	 11 Watts. 		 	 	 	 N/A.
During RX (nominal) 		 1.9 Watts.		 	 	 	 0.9 Watts. 	 	 	 	 0.3 Watts.
Antenna
External 		 	 50 Ohm, BNC.	 	 	 	 50 Ohm, NMO.	 	 	 	 50 Ohm, NMO.
Modem Specifications
Link Rate/Modulation

Hamming Code (12, 8) with Data Interleaving.

On/Off Button.

Digital Display.
Modem/Power Status Indicators.
RF Power Select  Toggle Switch.

19,200 bps/4 Level FSK.

9600 bps/GMSK.
4800 bps/GMSK.

RoverHigh Power Base

3 Wire, RS-232, 38.4k Baud Maximum.

ANSI/ASAE EP455.

990 Richard Avenue, Suite 110, Santa Clara, CA 95050
1-800-795-1001, Tel: 408-653-2070, Fax: 408-748-9984
Web: www.paccrst.com, E-mail: sales@paccrst.com
©2000 Pacific Crest Corporation.
License required prior to operation of radio communication equipment. Specifications subject to change without prior notice.
TRIMTALK™ is a trademark of Trimble Navigation Limited. M00526-9/02

Positioning Data Link™

Refer to price list for available frequency bands.

Synthesized 12.5k Hertz Resolution.
±2.5 ppm Stability.

-116 dBm (12 dB SINAD).
>-70 dB at 9600 bps/GMSK.
>-60 dB at 19,000 bps/4 Level FSK.

-22     to +140    F (-30   to +60   C).
-67     to +185    F (-55   to +85   C).

IEC 60529 I.P. 66.
Water Tight and Dust Proof.

9 – 16 VDC.

Low Power Base

Transparent, Packet Switched, Digipeater,
TRIMTALK.™

Transparent, Packet Switched, Digipeater,
TRIMTALK.™

Transparent, Packet Switched, TRIMTALK.™

6.23" W x 2.77" H x 6.58" L.
(15.8 cm W x 7.0 cm H x 16.7 cm L).

8.25" L x 2.40" Diameter.
(21.0 cm L x 6.1 cm Diameter).

8.25" L x 2.40" Diameter.
(21.0 cm L x 6.1 cm Diameter).

All models are type accepted and certified for operation in the U.S. and Canada.
For detailed information concerning your country's type certification, please contact your sales representative.

On/Off Button.

Digital Display.
Modem/Power Status Indicators.

On/Off Button.

Digital Display.
Modem/Power Status Indicators.

-4   to +140   F (-20   to +85   C).
-4   to +185   F (-20   to +85   C).

General Specifications
DTE – DCE Interface
User Interface

Power

Link Protocols

Forward Error Correction
Radio Specifications
Frequency Bands
Frequency Control

Sensitivity
Adjacent Channel Selectivity

Type Certification

Environmental Specifications
Operating Temperature
Storage Temperature
Vibration/Shock
Enclosure

Mechanical Specifications
Dimensions

Weight 	 	 	 2.96 lbs. (1.34 Kg).	 					 	 	 	 0.65 lbs. (0.30 Kg). 	  	 	 	 	0.75 lbs. (0.34 Kg).
Data/Power Connector	 5 Pin LEMO #1 Shell. 				 	 	 	 5 Pin LEMO #0 Shell. 				 	 	 	 5 Pin LEMO #0 Shell.
Mount 	 	 	 Tripod Bracket. 	 			 	 	 	 5/8" – 11 Range Pole. 				 	 	 	 5/8" – 11 Range Pole.

Channel Button with AutoBase and AutoRover.™ ™Channel Button with AutoBase and AutoRover.™ ™Channel Button with AutoBase and AutoRover.™ ™

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

Antenna

Modem Specifications

RF Transmitter Output 	 3/35 Watts Maximum. 	 	 	 0.5 – 2 Watts. 	 		 	 	  	 	0 Watt (Receive Only).

>-60 dB. >-60 dB.

9600 bps/4 Level FSK.



THALES NAVIGATION

Z-XTREME
The Ashtech® Z-XtremeTM from Thales Navigation professional
products is a rugged, weather-proof, dual-frequency GPS receiver
designed to provide surveyors with cost-effective, centimeter-accurate
positions in a variety of system configurations.

The Z-Xtreme receiver begins with state-of-the-art satellite electronics
coupled with patented Z-Tracking™ to deliver the highest GPS signal
reception level.  A removable battery and flash memory card provide
enough capacity to last all day for maximum utility. Components are
completely integrated inside a weather-proof, high impact plastic
housing, ensuring your investment is safe, rain or shine. Use the easy-
to-operate interface on the front panel for important functions such as
site information entry, survey status, and set-up of RTK base stations
without the additional cost of a handheld controller. The result: 
Z-Xtreme with Instant-RTK® outperforms all other receivers in its class!

ZX-SOLUTIONS
The Z-Xtreme survey system from Thales Navigation provides a range
of solutions designed for the vast array of positioning needs – from
entry level static or kinematic post-processed surveys, all the way up
to real-time functions such as stake out. The entry level ZX-SolutionsTM

system dramatically increases your productivity for control surveys and
other post-processed applications. Add an optional kinematic kit to
make topographic feature collection more cost effective. Use Ashtech
Solutions™ software to easily process the field data, export results and

generate reports. Purchase only what you need for the job at hand
because ZX-Solutions is fully upgradeable.

ZX-SUPERSTATION
Eclipse the productivity of optical instrument stake out with a ZX-
SuperStationTM. The ZX-SuperStation is a field-to-finish GPS surveying
system that combines the Z-Xtreme receiver with a powerful data
collector and wireless modems for centimeter accuracy in real-time.
Instant-RTK gives you the ability to initialize the centimeter solution in
a fraction of the time of conventional RTK systems.  Powerful data
collection software gives you the ability to efficiently perform GPS
surveying techniques and to interface seamlessly with optical total stations.

Z-Xtreme
Survey System

INSTANT-RTK TECHNOLOGY

www.thalesnavigation.com



Z-XTREME

TECHNICAL SPECIFICATIONS

Ashtech Technology

• 12 channel all-in-view operation
• Full-wavelength carrier on L1 and L2
• Z-Tracking
• Multipath mitigation
• Dual-frequency smoothing for improved code   

differential
• Instant-RTK

Performance Figures1

Static, Rapid Static
• Horizontal: 0.005 m + 1 ppm 

(0.016ft+1ppm)
• Vertical: 0.010 m + 1 ppm 

(0.033ft + 1ppm)
Post-Processed Kinematic
• Horizontal: 0.010 m + 1 ppm 

(0.033ft + 1ppm)
• Vertical: 0.020 m + 1 ppm 

(0.065ft+1ppm)
Real-Time Code Differential Position
• <1 m (3.28 ft)
Real-Time Z Kinematic Position (Fine Mode)
• Horizontal: 0.010 m + 2 ppm

(0.033ft + 2 ppm)
• Vertical: 0.020 m + 2 ppm 

(0.065ft + 2 ppm)
• Azimuth (arc sec): 0.4 + 2.0/baseline (km)
RTK Occupation Time
• 2 seconds (typical - sub-centimeter accuracy 

with longer occupation time)
Instant-RTK Initialization
• 99.9% reliability
• Typically <2 seconds with 6 or more satellites, 

PDOP <5, baseline length <7 km (4.35 mi), 
open sky and low multipath conditions

RTK Operating Range
• Recommended: 10 km (6.21 mi)
• Maximum: 40 km (24.85 mi)

Standard Features

• 16 MB PCMCIA removable memory card
• NMEA 0183 output
• Selectable update rate from 999 sec to 10 Hz
• Event marker
• Point positioning
• 1 PPS timing signal
• Session programming

• Wide array of coordinate transformations
• Removable internal battery
• 8-character alphanumeric LED display with 4-    

button interface
• 3 function LED display - Radio,Memory, 

Satellites/Power
• Multi-function audible alarm
• Quick reference card holder
• External mount capabilities
• External power input
• 4 RS-232 ports (115200 baud max, 3   

external, 1 internal)
• 1-year warranty
• Free factory technical support

Standard Accessories

• Communications software
• Padded system bag and hard case
• RS-232 data cable
• Receiver operating manual
• Quick reference field card

Technical Data

Environmental
Z-Xtreme Receiver
• Meets MIL-STD 810E for wind driven rain  

and dust
• Operating temperature: -30° to +55°C 

(-22° to 131°F)
• Storage temperature: -40° to +85°C

(-40° to 185°F)
Geodetic 4 Antenna
• Meets IPX7 specifications for submersion
• Operating temperature: -55 to +75°C

(-40° to 149°F)
• Storage temperature: -55° to +75°C 

(-67° to 167°F)

Physical
Weight
• Receiver: 1.59 kg (3.50 lb)
• Antenna: 0.82 kg (1.81 lb)
• Battery: 0.43 kg (0.95 lb)
Dimensions
• 76.2 H x 196.85 W x 222.25 D mm 
• (0.25 H x 0.646 W x 0.729 D ft)
Power
• 10 - 28 VDC, 6.0 W

Internal battery
• Capacity: 6000 mAh
• >9 hours (typical) @  25°C (77°F)
• Operating temperature: -30° to +55°C 

(-22° to 131°F)
• Storage temperature: -40 to +60°C 

(-40° to + 140°F)

PC card
• ATA Type II PCMCIA memory card (16 MB  

standard)
• Temperature range: -40° to +85°C

(-40° to 185°F)
• Data capacity: 4500 epochs per 2 MB*
* Based on one session, eight satellites' data
and full measurements. This number can vary
significantly depending on the conditions of the
session.

Optional Features

• Real-time kinematic (base and rover modes)  
for cm-accuracy

• RTCM 2.2 (Types 1, 2, 3, 9, 16, 18, 19, 20, 
21, 22)

• Internal UHF or spread spectrum radio for 
RTK rover operations

• External UHF or spread spectrum radio for
RTK base and rover operations

• Geodetic 4 antenna ground plane kit
• Kinematic antenna kit
• Aircraft antenna kit
• AC power cable
• Choke ring antenna
• Long haul backpack kit
• All-on-a-pole kit

Optional Application Software

GPS data processing
• Ashtech Solutions

Land Surveying and Construction
• TDS Survey Pro
• Carlson SurvCE
• Ashtech Survey Control II
• Ashtech GPS Fieldmate

Mining and Land Seismic
• Ashtech Mine Surveyor II
• Ashtech Seismark II 

1 Specifications assume operation follows all the

procedures recommended in the product manual utilizing

Instant-RTK, post processing with Ashtech Solutions or

Ashtech Office Suite for Survey. High-multipath areas,

high PDOP values, low satellite visibility, and periods of

adverse atmospheric conditions and/or other adverse

circumstances will degrade system performance. All

accuracy specifications are RMS values.

Thales Navigation follows a policy of continuous product improvement; specifications and descriptions are thus subject to change without notice.
Please contact Thales Navigation for the latest product information.

© 2003 Thales Navigation, Inc. All rights reserved. Ashtech, Z-Xtreme, Instant-RTK, ZX-SuperStation, ZX-Solutions, Z-Tracking, GPS FieldMate, Survey Control II and Ashtech Solutions are trademarks
of Thales Navigation. All other product and brand names are trademarks or registered trademarks of their respective holders. Ashtech P-code GPS technology has been FGCC tested and is capable
of performing first order surveys (report available upon request).  rev(5.03)  part # 830190

Thales Navigation, Inc.
Corporate Headquarters, Santa Clara, CA, USA 
+1 408 615 5100 * Fax +1 408 615 5200
Toll Free (Sales in USA/Canada) 1 800 922 2401
Email   professionalsales@thalesnavigation.com
In Washington, DC   +1 703 476 2212 * Fax +1 703 476 2214
In South America   +56 2 234 56 43 * Fax +56 2 234 56 47
In China   +86 10 6566 9866 * Fax +86 10 6566 0246

European Headquarters, Carquefou, France  
+33 2 28 09 38 00 * Fax +33 2 28 09 39 39
Email   professionalsalesemea@thalesnavigation.com
In Germany   +49 81 6564 7930 * Fax +49 81 6564 7950
In Russia   +7 095 956 5400 * Fax +7 095 956 5360
In UK   +44 (0) 870 601 0000 * Fax +44 (0) 208 391 1672     
In the Netherlands   +31 78 61 57 988 * Fax +31 78 61 52 027
Web site   www.thalesnavigation.com















������ SET5F
Version 01-00

TOTAL STATION

SURVEYING INSTRUMENTS

Enhanced software with 3,000-point data memory.



Flexible, Friendly and Featherweight
The SET5F's powerful EDM, dependable dual-axis compensator and 3,000-point data memory
are conveniently packaged in a compact, lightweight body. Software [Version 01-00) has
been enhanced for more effective survey work, and "softkey" assignments can be freely
customized to suit all user needs.

Dependable
Hardware

Proven Dual-axis Compensator
•Since its introduction with the Series C
total station in 1989, Sokkia's dual-axis
compensator has proven its reliability and
accuracy at survey sites all over the world.
•The dual-axis tilt sensor monitors
deviations of both the X and Y axes and the
correct horizontal and vertical angle
readings are automatically computed and
applied. The result is easier and faster
instrument leveling.

Spacious 3,000-point Internal
Memory
•The SET5F's internal memory is large—
holding a full 3,000 data points—and
secure. For optimum convenience,
measurements can be performed and
recorded at the touch of a key.
•Up to five (5) job files can be created to
efficiently organize multiple survey tasks.
•Forty (40) feature codes (max.13 charac-
ters each) can be kept in the memory for
easy recall as needed.

The High-performing EDM
•1,500m/4,900ft range with a single prism
under good ambient conditions (40km/
25miles visibility, with no haze, overcast,
no scintillation).
•Outstanding precision;
±(3+2ppmxD)mm. This corresponds to a

deviation of a mere ±3.2mm at a distance
of 100m and ±5mm at 1,000m.
•Supreme speed; only 1.7 seconds initial
measuring time in the rapid measurement
mode.

Average Conditions Good Conditions
CP01 Compact Prism 700 m/2,300 ft.
One AP01 Prism 1,200 m/3,900 ft. 1,500 m 4,900 ft.
Three AP01 Prisms 1,600 m/5,200 ft. 2,000 m 6,500 ft.

Powerful Telescope
•Highest magnification in its class: 30x
•Easy, accurate sighting of prisms or
targets

Outstanding Mobility
•Total carrying weight (including instrument,
tribrach, battery and hard case) is a mere 8
kg/18 lbs. The secret lies in the lightest and
most compact carrying case of its kind

(W390 x D255 x
H220mm / W15.3 x
D10.0 x H8.6in.), making
the SET5F supremely

portable.
•A convenient
shoulder strap is
provided as
standard. An
optional back
pack (SC94) is
ideal for longer
day treks.

Enhanced
Software

The SET5F can be easily customized
to your preferred key assignments.
•The SET5F offers optimum keyboard
flexibility. Any keyboard layout can be
configured. For example, functions can be
assigned to any key position on any page,
and unused functions can be temporarily
deleted.
•A powerful "softkey" feature facilitates
input of coordinate values,
feature codes, etc.

Sophisticated Application Software
Missing Line Measurement (MLM)
•The SET5F measures horizontal distance,
slope distance, height difference, and slope
in percent (%) between two prisms, all at the
touch of a key.

EDM

THEO

S-O

Key assignment mode



The SET5F brings full freedom to survey work.

Remote Elevation Measurement
(REM)
•The SET5F can be used to easily
determine the height of a point where a
prism cannot be placed. The system
sights a prism directly above or below the
target point, and then sights the point
desired.

Angle Repetition
•For enhanced accuracy in the horizontal
angle measurement, the SET5F can
measure in repetition. It then calculates
and displays the average of the multiple
angle measurements.

Azimuth Angle Setting
•Using the coordinates of the instrument
station and a backlight point, the SET5F
can automatically set the horizontal angle
to the azimuth of the backlight.

Resection
•With 2 to 5 known points, the SET5F can
be used to determine the azimuth and
coordinates of the unknown instrument
station.
•When using 2 known points, both angles
and distances are measured. When
using 3 or more points, the distance does
not always have to be measured.

3-D Coordinate Measurement
•The SET5F calculates 3-D coordinate
values of measuring points.
•The operator may choose display settings
either of "N, E, Z" or "E, N, Z."

3-D Setting-out
•The SET5F can be used to perform
3-dimensional setting-out with N, E and/or
Z coordinates.

Offset Measurements
Two basic offset measurement methods
are provided to measure the hidden
points. One calls for input of the offset
distance and the direction between the
measuring point and the prism. The other
uses a prism set on the left or right side of
the measuring point at the same distance
from the SET5F; the angles and distance
to the prism are measured, and the
measuring point is sighted. In both cases,
the SET5F calculates the horizontal and
vertical angles and distance, or the N, E,
Z coordinates.



Standard Configuration
The SET5F comes with two (2) BDC25
rechargeable batteries EDC19 battery
charging adapter CDC27, CDC31 or
CDC31A quick charger, CP7 tubular
compass, sunshade, lens cap, plumb bob,
vinyl cover, tool kit, operator's manual,
carrying case and shoulder strap.

Electronic Field Books
(SDR33/SDR31)
Thanks to its advanced two-way commu-
nications port, the SET5F's functions can
all be accessed by external controller. For
example, by connecting one of the
Sokkia's acclaimed Electronic Field Books
(SDR33 or SDR31), complex field
operations such as traverse adjustment,
intersection, area calculations and roading
can be carried out with remarkable ease.

Optional Accessories
DE17A Diagonal Eyepiece
OF1/OF1A Solar Filters
SC94 Back Pack

Designs and specifications are subject to change without notice.

SOKKIA CO.,LTD.
1-1, TOMIGAYA l-CHOME, SHIBUYA-KU, TOKYO, 151 JAPAN
PHONE +81-3-3465 5211 FAX +81-3-346-5203
INTERNATIONAL DEPT. PHONE +81-3-346-5201 FAX +81-3-3465-5202

SET5F Specifications
Telescope Fully transiting, coaxial EDM
Length 165mm (6.5in)
Objective aperture 45mm (1.8in)
Magnification, image 30x, Erect
Resolving power 3.0"
Field of view 1°30'(26m/1,000m)
Minimum focus 1.3m (4.3ft.)
Reticle illumination Bright or Dim, selectable
Angle measurement Incremental encoder, diametrical detection
Display resolution H&V 1"/ 0.2 mgon/ 0.005 mil, 5"/1 mgon/ 0.02 mil
Angle unit H&V Degree/Gon/Mil
Accuracy H&V 5" (1.5 mgon/ 0.02 mil) according to DIN18723
Dual-axis compensator Liquid dual-axis tilt sensor, range: ±3' (±55 mgon)
Display mode H Clockwise/ Counterclockwise, Repetition, Oset, Hold available

V Zenith 0°/ Horizontal 0°/ Horizontal 0°±90°/ Slope%
Distance measurement Electro-optical with modulated infrared LED.
Measuring range (slope distance) A: Average conditions; slight haze, visibility about 20km(12 miles),

  sunny periods, weak scintillation.
G: Good conditions; no haze, visibility about 40km (25 miles),
  overcast, no scintillation.
Maximum ranges are achieved with Sokkia CP/AP prisms.

With CP01 compact prism A: 1.3m (4.3ft.) to 700m (2,300ft.)
With one AP01 prism A: 1.3m (4.3ft.) to 1,200m (3,900ft.), G: 1,500m (4,900ft.)
With three AP01 prism A: 1.3m (4.3ft.) to 1,600m (5,200ft.), G: 2,000m (6,500ft.)
Distance unit Meters or feet, selectable
Accuracy (Fine measurement) ±(3+2ppmxD)mm D=measuring range, unit=mm
Measuring unit and time Fine 0.001 m Every 3.2 seconds (initial 4.7 seconds)
(slope distance) Rapid 0.001 m 1.7 seconds

Tracking 0.01 m Every 0.3 seconds (initial 1.4 seconds)
Average 0.0001 m (average of 2 to 9 times measurement)

Atmospheric correction Key-in the temperature and pressure, or -499 to +499ppm.
Prism constant -99 to 0mm (1 mm steps)
Refraction & Earth-curvature On/off selectable (K=0.142)
  correction
General
Display LCD dot matrix display (20 characters x 4 lines) on both faces with

  back light.
Keyboard 5 keys on both faces, free assignment of functions.
Resume function On/off selectable
Sensitivity of levels Plate level: 40"/2mm, Circular level: 10'/2mm (in tribrach)
Optical plummet Image: erect, Magnification: 3x, Minimum focus: 0.5m (1.6ft.)
Interface Asynchronous serial, RS-232C compatible, baud rate 1200/

  9600bps
2-way communication Provided
Data storage 3,000-point data memory
Operating temperature -20°C to +50°C (-4°F to +122°F)
Tilting/Trunnion axis height 236mm (9.3in) from tribrach bottom, 193mm (7.6in) from

  tribrach dish.
Size with handle and battery W150 x D165 x H353mm, W5.9 x D6.5 x H13.9in.
Weight with handle and battery 5.4kg (11.9lbs)
Weight of parts BDC25 battery: 240g (8.5oz.), Handle: 100g (3.5oz.),

  Tribrach: 740g (1.6 lbs), Case:2.4kg (5.3lbs)
Power supplies
Battery level display 4 steps with warning message.
Automatic power cut-off On/off selectable (30 minutes after the last operation)
Power source BDC25 rechargeable battery, Ni-Cd 6V, 2 supplied as standard.
Working duration at 25°C (77°F) Distance & angle measurement: about 5 hours, about 600 points
    w/one BDC25 battery (Fine & single measurement with 30 seconds intervals).

Angle measurement only: about 9 hours.
Charging time CDC27/31: about 80 minutes, CDC31A: about 90 minutes



Appendix III 
 
 
Vessel Reports, Offsets, and Diagrams 
 
 
Launch 1010  
 

1. Offsets 
2. Patch Test 
3. DDSSM and Settlement & Squat 
4. POS Gams Calibration 
5. Wire Diagram 

 
Launch 1018 
 

1. Offsets 
2. Patch Test 
3. DDSSM and Settlement & Squat 
4. POS Gams Calibration 
5. Wire Diagram 

 
S220 
 

1. Offsets 
2. Patch Test 
3. DDSSM and Settlement & Squat 
4. POS Gams Calibration 
5. Wire Diagram 
6. Correspondence 

 



Fill in Yellow squares only!
Measuring Party:
Waterline Measurements should be Negative!

Date: 4/7/2009 Dn 097
Fuel Level: .5+

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0327 -0.0443 -0.0770

Stdev

BM Z-value (m) BM C to WL Average (m)
BM C to WL (m) -0.927 (This value added to 1010_Offsets & Measurements_200X.xls)

Individual -0.88217 -0.93783
measurement -0.88617 -0.94483
StDev for TPU xls 0.04986 -0.89617 -1.01283 utilized in Offsets and Measurements and TPU spreadsheet
(of 6 #'s)

-0.8680

-88.5

Benchmark A to Waterline

-86.80

-86.6 -89.2

-87.6 -96.0

Waterline Measurements
Rice, Argento, Campbell, Beduhn

1010

-86.2

Benchmark B to Waterline

-0.965
-0.02017 -0.05283

-0.9123

-91.23

0.041430.00721

-0.888



All offsets are in the Theodolite Coordinate System
BM E x 1.665536 Port Ant x 2.316862

y -0.892424 y -0.886431
z 1.612667 z Unknown

BM F x 1.668082 Stbd Ant x 2.324270
y -0.001217 y 0.952574
z 1.649000 z Unknown

BM G x 1.668115
y 0.957794
z 1.578000

Measuring Party (fill in yellow spaces only): Date: Serial #- Port Serial #- Stbd
4/7/2009

z Values

60162863 60145247Rice, Argento, Campbell, Beduhn

This spreadsheet is designed to compute the z-values of the phase centers of 
the new POS M/V antenna.

z-Values
Distances Ant. Base Phase Center
Port Ant to BM 'E' 0.693 0.693 0.693 0.70575 1.884369 1.930369
Port Ant to BM 'F' 1.11 1.11 1.112 1.1234167 1.888889 1.934889
Port Ant to BM 'G' 1.967 1.97 1.97 1.98175 1.902489 1.948489

1.886629 1.932629 AVERAGE
0.0094 STDEV

Stbd Ant to BM 'E' 1.959 1.964 1.962 1.9744167 1.858381 1.904381
Stbd Ant to BM 'F' 1.166 1.167 1.167 1.1794167 1.874221 1.920221
Stbd Ant to BM 'G' 0.707 0.705 0.705 0.7184167 1.870499 1.916499

1.872360 1.918360 AVERAGE
Antenna Post Diameter Radius 0.0083 STDEV

0.0255 0.01275

The distances from the antenna post to each benchmark was measured 
three times and averaged. The post offset to phase center (radius) was then 
added.

The distance is 0.046m (4.60cm) from the bottom of the 
antenna to the Phase center, obtained from the POSM/V 
v4 guide, see image above. 



79
Date DN

Serial Number of Transducer
2701011

Campbell, Argento, Beduhn
Personnel

Offsets from Aft Benchmark to Phase Center of Transducer

3/20/2009 Launch 1010
Vessel

Instructions: The purpose of this measurement is to check for 
gross movement of the tranducer.  Fill in yellow spaces only.

While the boat is in the cradle, gently lower the transducer and 
lock it in place.  Using a metric tape measure, plumb bob and 
carpenter's level, measure the horizontal and vertical offsets from 
the aft benchmark (BM H) to the phase center of the transducer.  
The phase center is measured at the forward edge of the black 
insulating layer, as shown in the photos.  If you have trouble 
locating the center, borrow a compass from the navigation 
department.

Notwithstanding a major accident, BM H will be outboard, aft and 
higher than the phase center; as such, enter all offsets as positive 
numbers (in cm) and the proper signs will be applied.  

Once offsets have been measured, apply a digital level to the IMU 
to determine any pitch or roll bias in the orientation of the launch.  
For the purposes of this spreadsheet, a positive angle (measured 
in degrees) will imply the bow is higher than the stern and the port 
side is higher than the starboard side.

All measurements should be done in triplicate to aid in the 
calculation of the uncertainty (needed in the HVF).  The IMU to 

BM H

Offset Measurements (positive cm): Average Angle Bias (deg):
Bow-Stern 10.6 10.7 11.0 10.8 Bow Up Bow-Stern 0.16
Port-Stbd 15.9 15.9 15.8 15.9 Port Up Port-Stbd 0.05
Up-Down 35.5 35.4 36.0 35.6 The measuring crew should Up-Down 0.30

 insure there will be no yaw bias.
BM H to Phase Center IMU to Phase Center

(Theodolite Coordinate System) (CARIS Coordinate System)

x #REF! cm x #REF! m

y #REF! cm y #REF! m

z #REF! cm z #REF! m

Measured by NOAA Personnel Calculated Value for check purposes
inserted into Offset Worksheet, 
if to be used in IMU to 8101 calculation

Std Dev:

These 2009 values were not used for the hvf 
offsets due to the angle bias not being entered. 
The 2008 values were used instead and the 2009 
values were used as a check that the unit had not 
been displaced.

Phase Center values will be calculated automatically.



 1010 Offsets and Measurements - Summary

Measurement IMU to RP* 8101 to RP*
aka
Coord. Sys. Caris Caris Caris Caris Caris
x 0.000 0.250 0.250 1.147 n/a
y 0.000 -0.133 -0.133 1.066 n/a
z 0.000 0.549 0.549 3.665 -0.256

*IMU is RP (Reference Pt)

Vessel Offsets for 1010_8101 are derived from the Horizontal, Vertical & XYZ worksheets in this spreadsheet. 2008 Measured Values

Coord. Sys.
Theodolite IMU (m) x 3.516 IMU (m) x 3.516 IMU (m) x 3.516

y 0.011 y 0.011 y 0.011
z -1.183 z -1.183 z -1.183

BM H x 3.271447 Port Antenna x 2.317 BM C x 0.000
y 0.425598 y -0.886 y 0.000
z -1.37667 z 1.933 z 0.000

IMU x -0.244 IMU to x -1.199 BM C to IMU
to BM H y 0.415 Port Antenna y -0.897 x n/a

z -0.194 z 3.116 y n/a
z -1.183

BM H to x 11.10496 IMU to x -0.133
Phase Ctr (cm)   y -16.466 Phase Ctr y 0.250 BM C to Waterline
measured z -35.540 z -0.549 measured x n/a

y n/a
BM H to x 0.11105 z -0.927
Phase Ctr (m)     y -0.16466

z -0.3554
see 

Coord. Sys.
Theodolite IMU to x -0.133 x 1.066 x n/a

Phase Ctr y 0.250 y 1.147 y n/a
z -0.549 z -3.665 z 0.256

Coord. Sys. CARIS Coord. Sys. CARIS Coord. Sys. CARIS
x 0.250 x 1.147 x n/a
y -0.133 y 1.066 y n/a
z 0.549 z 3.665 z -0.256

RP* to Waterline

RP to Waterline

RP to WaterlineIMU to 8101 IMU to 8101 Port Ant to 8101

Nav to Trans x,y,zSWATH1 x,y,z  & MRU to Trans
Port Ant to 8101

Port Ant to 8101

IMU to 8101

8101 to RP* IMU to 8101
Calculations



 1010 Offsets and Measurements - Summary

Caris Pos/Mv Caris Pos/Mv
Scalar Distance 1.839 -0.897 -1.199 -0.011 -1.176

-1.199 -0.897 -1.176 -0.011
-3.117 -3.117 -0.243 -0.243

2009 Measured Values 2007 Measured Values

Port Ant (m) x 2.317 IMU (m) x 3.516 IMU (m) y 0.011
y -0.886 y 0.011 x is n/a z -1.183
z 1.933 z -1.183

Heave Pt (m)
Stbd Ant (m) x 2.324 Port Ant (m) x 2.317 (centerline) y 0.000

y 0.953 y -0.886
z 1.918 z 1.934 BM C to Waterline (m) -0.940

measured scalar dist 

BM C
x&y are n/a z 0.000

BM C to Waterline (m)
(Heave Pt) z -0.940

IMU to LCG x -1.176
See IMU to Heave tab

x -1.199 x -1.176
Scalar Distance 1.839 y -0.897 y -0.011

z 3.117 z 0.243

Coord. Sys. Pos/Mv Coord. Sys. Pos/Mv
x -1.199 x -1.176
y -0.897 y -0.011
z -3.117 z -0.243

See IMU to Heave tab

IMU to Port Antenna

Port Ant to Stbd Ant IMU to Port Antenna IMU to Heave

IMU to Heave

IMU to Port Antenna IMU to Heave

Port Ant to Stbd Ant

Port Ant to Stbd Ant

Values in the POSMV remained as entered in 2008. 



Description of Offsets for Launch 1010
All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 1010 was based from benchmark (BM) C as the 0 point.  Physical locations were measured with x,y,z offsets 
from this point.  These locations were used to calculate offsets of items with respect to each other, as described for each offset.

x=0.250

z=0.549

z=3.665

x=1.147

z=-3.112

x=-0.897
1.839

z=-0.243
x=-0.011

z=0.549

y=-0.133

z=3.661

y=1.066

z=-0.256

z=-3.117

y=-1.199

z=-0.243
y=-1.176



x y z x y z x y z x y z x y z
0.250 -0.133 0.549 1.147 1.066 3.665 N/A N/A -0.256 -0.897 -1.199 -3.117 -0.011 -1.176 -0.243

IMU to Port Antenna IMU to Heave
Scalar Distance

1.839

IMU to 8101 Port Ant to 8101 RP to Waterline Port Ant to Stbd Ant

The physical positions of the IMU 
and the phase center of the 8101 
with respect to the Ship 
Reference Frame were 
measured by NOAA personnel.  
These physical measurements 
were used to calculate the xyz 
offsets from the IMU to BM H. 
Measurements from BM H to the 
Phase Center of the 8101 were 
collected by NOAA personnel 
while the boat was secured on 
the pier and thought to be as 
level as possible.  The measured 
offsets from BM H to the phase 
center were then added to the 
offset from the IMU to BM H.  
The result is the offset from the 
IMU to the phase center of the 
transducer.  The values in the X 
and Y fields are transposed and 
the inverse of the Z value is used 
to give the offsets in CARIS 
coordinates.

NOAA personnel calculated the 
distance between the port 
antenna and the phase center of 
the port antenna subtracting  the 
IMU to Port Antenna value from 
the IMU to Phase Center value.   

The average vertical distance 
from BM A and B to the waterline 
was measured by 
FAIRWEATHER personnel using 
a steel tape and bubble level.  
These values were used to 
calculate the BM C to the 
waterline value.  With the 
knowledge of the BM C height 
above the IMU, the waterline 
height above the IMU could be 
calculated.  On launch 1010, the 
IMU is used as the reference 
point.  

The location of the IMU and the 
location of the port antenna were 
measured by NOAA personnel 
with respect to the Ship 
Reference Frame (SRF).  The 
xyz offsets from the IMU to the 
port antenna could be calculated 
from these physical locations. 

The heave point was positioned 
differently on each of the axes.  
The distance for the longitundinal 
axis was determined as 
described in the "IMU to Heave" 
tab in this workbook.  The 
athwart ships axis was the vessel
centerline.  Lastly, the waterline 
was used as the height of the 
heave point, which was 
calculated earlier in 'RP to 
Waterline'.  

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
measured by NOAA personnel 
with respect to the SRF.  The 
scalar distance between the 
phase centers was then 
calculated. 



1010 Vessel Diagram
All Values Shown are in Theodolite Coordinates

Note:   Both antenna have been replaced for the POS 
V4.  While their x-y values are not thought to have 
changed, the z-value has been remeasured.



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

4/17/2009
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

4/17/2009
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

0:00 51
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

0:00 51
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

0:00 15 20
SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

TH_1010_107

47/39/15.82 122/15/31.53

09107210.0nv 47/39/08.84 122/14/06.18

Launch 1010

Marcum, Rice, Forney, Beduhn

Rice, Beduhn, Forney, Marcum

not availableSwing Arm-Hull Mount

107

Reson 8101

357372701011

4/15/2009

Lake Washington, Seattle, Washington

09107175_4616.5nv

Swing Arm

10m-80m

5-10kt, >1ftLake Washington

DGPS - Woodby Island

3/20/2009

09107202.3nv

107

Beacon: 302 Hz Whidbey, MBES lines 2009__1071850_1 through 2009__1072047_5, 24 lines collected

47/39/01.97 122/16/17.32



NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

1 271 5.4
1 093 5.1
1 272 5.0
1 091 5.0
1 272 2.9
1 090 2.7
1 272 2.5

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

1 2009__1071850_1 272 4
1 2009__1071910_1 92 4
1 2009__1071905_1 93 4
1 2009__1071907_1 271 4
1 2009__1071903_1 270 4

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

1 2009__1071945_4 272 4
1 2009__1071938_4 272 4
1 2009__1071935_4 94 4
1 2009__1071941_4 93 4
1 2009__1071955_2 092 4
1 2009__1071959_2 272 4
1 2009__1071949_2 092 4
1 2009__1071952_2 272 4

ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

2 2009__1072043_5 04 3.8
2 2009__1072039_5 183 3.5
2 2009__1072047_5 184 3.5
2 2009__1072035_5 03 3.9

XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

XTF Line Filename

XTF Line Filename

XTF Line Filename

2009_1071925_1

2009_1071917_1

S

2009_1071914_1

N
N
N

S

N

S

2009_1071923_1

2009_1071929_1

2009_1071931_1

S

2009_1071927_1



Processing Log
4/18/2009
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
-0.05 0.20 1.50 0.50
0.02 -0.35 1.50 0.35
0.01 0.43 1.48 0.28
0.06 1.48
0.02 0.00 1.46 0.20
0.00 -0.40 1.48 0.60

0.01 -0.02 1.48 0.39
0.04 0.36 0.04 0.02 0.16 0.08
0.00 -0.02 1.48 0.39

Resulting HVF File Name
Actual values used

MRU Align StdDev gyro 0.16 Value from standard deviation of Heading offset values 0.075
MRU Align StdDev 
gyro

MRU Align StdDev Roll/Pitch 0.19 Value from averaged standard deviations of pitch and roll offset values 0.025
MRU Align StdDev 
Roll/Pitch

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 04/24/09CST/FOO/Welton

na

PATCH TEST RESULTS/CORRECTORS

FOO Ringel
B. Welton

FINAL VALUES
Standard Deviation

averages with outliers removed

Data converted --> HDCS_Data in CARIS

108 Welton

Final Values based on

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias
Compute correctors in this order

Lines from Dn108 (2009_1081822_11 through 2009_1082211_2) were also utilized to assess patch test values.

CST Morgan

G. Rice
N.Morgan
A. Raymond

Averages

Do not enter/apply correctors until all evaluations are complete and analyzed.

Initial MRU values were too high, TPU values reassessed with outliers removed.

FA_1010_Reson8101_2009.hvf

Dn108 did not have True Heave applied as the Pos file was not logged, therefore a full patch write-up was not conducted.

Removed N. Morgan pitch (-1.6 deg) and yaw (1.62) values from the averages as outliers.  



Ellipsoid Referenced Dynamic Draft Launch 1010

4/17/2009 107 Lake Washington Rice
Date DN Local Area Processor

SEAI TH_1010_107.000.002 1018_ERDDM.txt
Primary Station POSPac File SBET File

proc_erddm.py, v0.12 4
Processing Method Coefficients



2009 HVF Values
2009-ERDDM-Descrete

speed (m/s) draft (m)
0 0

0.5 -0.05
1 -0.07

1.5 -0.06
2 -0.03

2.5 -0.01
3 0.01

3.5 0.02
4 0.02

4.5 -0.01
5 -0.05

5.5 -0.1
6 -0.17

2008 2007 2006

speed (m/s) draft (m) speed (m/s) draft speed (m/s) draft
0 0 0 0 0 0

2.68 0.08 2.58 -0.041 2.385 -0.07
3.81 0.11 3.1 -0.031 3.205 -0.03
4.68 0.17 3.98 0.023 4.2 -0.02
5.92 0.08 4.6 0.053 5.065 -0.01

5.17 0.102 6.29 -0.03
5.37 0.089

Dynamic Draft Comparison

-0.2

-0.15

-0.1

-0.05

0

0.05

0.1

0.15

0.2

0 1 2 3 4 5 6 7 8

Speed (m/s)

D
ra

ft 
(m

)
2009-ERDDM-Descrete

2008

2007

2006



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: FAIRWEATHER Vessel: 1010
Date: 4/15/2009 Dn: 105
Personnel: W Renoud, L Morgan, T Beduhn

PCS Serial # IMU Serial #

IP Address: 129.100.1.231

Port Antenna Serial # Stbd Antenna Serial #

POS controller Version (Use Menu Help > About) 3.4.0.0

POS Version (Use Menu View > Statistics)

GPS Receivers
Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:
Approximate Position: Lat 47 43 41

Lon 122 16 30

DGPS Beacon Station: DGPS Receiver Serial#:
Frequency: 302HZ

294

MV-320,VER4,S/N2564,HW2.6-7,SW03.42-May28/07,ICD03.25, 
OS425B14,IMU2,PGPS13,SGPS13,RTK-0,THV-0,DPW-0

60162863 60145247

NOAA POS/MV Calibration Report

Lake Washington, N of Sandpoint

2564

Whidbey 0331-12579-0008

4624A70264

4622A68956



Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

PDOP 1.736 (Use View> GAMS Solution)

POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Configuration Notes:

Secondary GPS



POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time:
End time:
Heading accuracy achieved for calibration: 0.091°

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

GAMS Status Online X
Save Settings X

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: 1010_Dn105_POS_Config_new.nvm

General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:
a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.



SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

COM2

COM3

COM4

COM5



SETTINGS Continued
Heave Filter (Use Settings > Heave)

Events (Use Settings > Events)

Time Sync (Use Settings > Time Sync)

User Time Conversion (Units/Sec.)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)



Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

Frame Control (Use Tools > Config)

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled

GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver



$UTC, 9600, N,8,1, NULL
1 Hz

Crossover
Patch

Serial

1010-Acq

DGPS Reciever

9600, N,8,1, NULL
RTCM 104DIFF

Key

129.100.1.211

129.100.1.231
Group 102, Group 111

25 Hz
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Fill in Yellow squares only!
Measuring Party:
Waterline measurements should be negative!

Date: 4/7/2009
Fuel Level: 0.75

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0237 -0.0060 -0.0297

Stdev

BM Z-value (m) BM C to WL Average (m)
BM C to WL (m) -0.526 (Add this value to 1018_Offsets & Measurements_200X.xls)

Individual -0.50867 -0.53433
measurement -0.51367 -0.54533
StDev for TPU xls 0.016742 -0.51167 -0.54333 utilized in Offsets and Measurements and TPU spreadsheet
(of 6 #'s)

Measuring Party:

Date: 4/16/2009
Fuel Level: half full

Measure 1 Draft Tube: na

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0237 0.0040 -0.0197

Stdev

BM Z-value (m) BM C to WL Average (m)
BM C to WL (m) -0.533 (or add this value to 1018_Offsets & Measurements_2008)

Individual -0.52467 -0.54633
measurement -0.52367 -0.54633
StDev for TPU xls 0.011572 -0.52067 -0.53533
(of 6 #'s)

-82.4 -82.2

1018

-0.523 -0.543

0.00208 0.00635

0.29933 0.27567

-82.23

-0.8183

-82.3 -82.2

-82.0 -81.1

-81.83

-0.8223

Benchmark A to Waterline Benchmark B to Waterline

-80.8 -81.0

-81.9

-81.67

0.29933

0.00252 0.00586

1018
Benchmark A to Waterline Benchmark B to Waterline

-0.541

-81.3 -82.1

-0.8167

-81.1

-81.07

-0.8107

Waterline Measurements
Rice, Argento, Campbell, Beduhn

Raymond, Welton

0.27567
-0.511



All offsets are in the Theodolite Coordinate System
BM E x 1.825761 Port Ant x 2.445325

y -0.861405 y -0.913449
z 2.018667 z Unknown

BM F x 1.826865 Stbd Ant x 2.444676
y -0.002043 y 0.920569
z 2.054333 z Unknown

BM G x 1.828354
y 0.918931
z 1.998333

Measuring Party (fill in yellow spaces only): Date: Serial #- Port Serial #- Stbd
4/7/2009

z-Values
Distances Ant. Base Phase Center
Port Ant to BM 'E' 0.652 0.652 0.653 0.665083 2.254818 2.300818
Port Ant to BM 'F' 1.109 1.11 1.111 1.12275 2.272081 2.318081
Port Ant to BM 'G' 1.941 1.945 1.943 1.95575 2.292759 2.338759

2.263449 2.309449 AVERAGE
0.019 STDEV

Stbd Ant to BM 'E' 1.884 1.882 1.889 1.89775 2.225956 2.271956
Stbd Ant to BM 'F' 1.111 1.112 1.113 1.12475 2.233664 2.279664
Stbd Ant to BM 'G' 0.648 0.647 0.647 0.660083 2.234669 2.280669

2.234166 2.280166 AVERAGE
Antenna Post Diameter Radius 0.005 STDEV

0.0255 0.01275

Rice, Argento, Campbell, Beduhn 60145158 60130644

This spreadsheet is designed to compute the z-values of the phase 
centers of the new POS M/V antenna.

The distances from the antenna post to each benchmark was measured 
three times and averaged. The post offset to phase center (radius) was 
then added.

The distance is 0.046m (4.60cm) from the bottom of 
the antenna to the Phase center, obtained from the 
POSM/V v4 guide, see image above. 
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Date DN

Serial Number of Transducer

Offset Measurements (positive cm): Average Angle Bias (deg):
Bow-Stern 8.7 8.7 8.8 8.7 Bow Up Bow-Stern 0.06
Port-Stbd 15.9 15.9 15.8 15.9 Port Up Port-Stbd 0.06
Up-Down 35.5 35.4 36.0 35.6 The measuring crew should Up-Down 0.32

 insure there will be no yaw bias.

BM H to Phase Center IMU to Phase Center (8101)
(Theodolite Coordinate System) (CARIS Coordinate System)

x 8.733 cm x 0.287 m

y -15.867 cm y -0.156 m

z -35.633 cm z 0.546 m

Measured by NOAA Personnel Calculated Value for check purposes
inserted into Offset Worksheet, 
if to be used in IMU to 8101 calculation

Offsets from Aft Benchmark to Phase Center of Transducer

3/20/2009

3102026

launch 1018 Campbell, Argento, Rice, Beduhn
Vessel Personnel

These 2009 values were not used for the hvf 
offsets due to the angle bias not being 
entered. The 2008 values were used instead 
and the 2009 values were used as a check 
that the unit had not been displaced.

Std Dev:

* see Math Explanation tab

Instructions:  The purpose of this measurement is to check for 
gross movement of the tranducer. Fill in yellow spaces only. 

While the boat is in the cradle, gently lower the transducer and 
lock it in place.  Using a metric tape measure, plumb bob and 
carpenter's level, measure the horizontal and vertical offsets from 
the aft benchmark (BM H) to the phase center of the transducer.  
The phase center is measured at the forward edge of the black 
insulating layer, as shown in the photos.  If you have trouble 
locating the center, borrow a compass from the navigation 
department.

Notwithstanding a major accident, BM H will be outboard, aft and 
higher than the phase center; as such, enter all offsets as positive 
numbers (in cm) and the proper signs will be applied.  

Once offsets have been measured, apply a digital level to the IMU 
to determine any pitch or roll bias in the orientation of the launch.  
For the purposes of this spreadsheet, a positive angle (measured 
in degrees) will imply the bow is higher than the stern and the port 
side is higher than the starboard side.

All measurements should be done in triplicate to aid in the 
calculation of the uncertainty (needed in the HVF).  The IMU to 
Phase Center  values will be calculated automatically.

BM H
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Date DN

Serial Number of Transducer

Offset Measurements (positive cm): Average Angle Bias (deg):
Bow-Stern 123.2 122.0 122.4 122.5 Bow Up -0.5 Bow-Stern 0.61
Port-Stbd 84.2 84.4 84.1 84.2 Port Up -2.0 Port-Stbd 0.15
Up-Down 55.7 56.2 56.5 56.1 The measuring crew should Up-Down 0.40

 insure there will be no yaw bias.

BM H to Phase Center IMU to Phase Center (8125)
(Theodolite Coordinate System) (CARIS Coordinate System)

x 122.533 cm x -0.396 m

y -84.233 cm y 0.982 m

z -56.133 cm z 0.751 m

Measured by NOAA Personnel Calculated Value for check purposes
inserted into Offset Worksheet, 
if to be used in IMU to 8101 calculation

Std Dev:

* see Math Explanation tab

Offsets from Aft Benchmark to Phase Center of Transducer

4/29/2009

4400007

launch 1018 Argento, Andrews, Foster, Nuckols
Vessel Personnel

Instructions:  The purpose of this measurement is to check for 
gross movement of the tranducer. Fill in yellow spaces only. 

While the boat is in the cradle, connect the 8125 sled with the 
sonar head attached.  Using a metric tape measure, plumb bob 
and carpenter's level, measure the horizontal and vertical offsets 
from the aft benchmark (BM H) to the phase center of the 
transducer.  The phase center is measured at the center middle of 
the black insulating layer below the flat faced transducer, as 
shown in the photos.  If you have trouble locating the center, 
borrow a compass from the navigation department.

Notwithstanding a major accident, BM H will be outboard, aft and 
higher than the phase center; as such, enter all offsets as positive 
numbers (in cm) and the proper signs will be applied.  

Once offsets have been measured, apply a digital level to the IMU 
to determine any pitch or roll bias in the orientation of the launch.  
For the purposes of this spreadsheet, a positive angle (measured 
in degrees) will imply the bow is higher than the stern and the port 
side is higher than the starboard side.

All measurements should be done in triplicate to aid in the 
calculation of the uncertainty (needed in the HVF).  The IMU to 
Phase Center  values will be calculated automatically.

Phase center



Measurement
aka SWATH1 x,y,z  & MRU to Trans Nav to Trans x,y,z
Coord. Sys. Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x -0.396 0.502 n/a Scaler Distance 1.834 -0.898 -1.101 0.015 -1.114
y 0.982 2.082 n/a -1.101 -0.898 -1.114 0.015
z 0.751 3.919 -0.333 -3.161 -3.161 -0.336 -0.336

Vessel Offsets Horizontal,  Vertical & XYZ worksheets in this spreadsheet. 2009 Measured Value

Calculations
Coord. Sys.
Theodolite IMU (m) x 3.54587 IMU (m) x 3.545867

y -0.01516 y -0.01516
z -0.85883 z -0.85883

BM H x 3.30204 Port Ant (m) x 2.445
y 0.43081 y -0.913
z -1.0485 z 2.309

IMU x -0.244 IMU to x -1.101
to BM H y 0.446 Port Antenna y -0.898

z -0.190 z 3.168

BM H to x 122.533 IMU to x 0.982
Phase Ctr (cm)   y -84.216 Phase Ctr y -0.396
measured z -56.133 z -0.751

BM H to x 1.225
Phase Ctr (m)     y -0.842

z -0.561

Coord. Sys.
Theodolite IMU to x 0.982 x 2.082

Phase Ctr y -0.396 y 0.502
z -0.751 z -3.919

Coord. Sys. CARIS Coord. Sys. CARIS
x -0.396 x 0.502
y 0.982 y 2.082
z 0.751 z 3.919

IMU to HeaveRP* to Waterline  Port Ant to Stbd Ant IMU to Port AntIMU to 8125 Port Ant to 8125

IMU to 8125 Port Ant to 8125

IMU to 8125 Port Ant to 8125



Description of Offsets for Launch 1018
All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 1018 was based from benchmark (BM) C as the 0 point.  Physical locations were measured with x,y,z offsets from this point.  These locations 
were used to calculate offsets of items with respect to each other, as described for each offset.

x=0.282

z=0.548

z=3.717

x=1.181

z=-3.161

x=-0.898
1.834

z=-0.296
x=0.015

z=0.548

y=-0.145

z=3.717

z=-0.333

y=0.955

z=-3.161

y=-1.101

z=-0.336
y=-1.114

x=-0.396
z=0.751

y=0.982
z=0.751

y=2.082

z=3.919

x=0.502

z=3.919



x y z x y z x y z x y z x y z
0.282 -0.145 0.548 1.181 0.955 3.717 N/A N/A -0.333 -0.898 -1.101 -3.161 0.015 -1.114 -0.336

x y z x y z
-0.396 0.982 0.751 0.502 2.082 3.919

IMU to 8101 Port Ant to 8101 RP to Waterline Port Ant to Stbd Ant IMU to Port Antenna

IMU to 8125

IMU to Heave
Scalar Distance

1.834

Port Ant to 8125

The physical positions of the IMU 
and the phase center of the 8101 
with respect to the Ship 
Reference Frame were 
measured by NOAA personnel.  
These physical measurements 
were used to calculate the xyz 
offsets from the IMU to BM H. 
Measurements from BM H to the 
Phase Center of the 8101 were 
collected by NOAA personnel 
while the boat was secured on 
the pier and thought to be as 
level as possible.  The measured 
offsets from BM H to the phase 
center were then added to the 
offset from the IMU to BM H.  
The result is the offset from the 
IMU to the phase center of the 
transducer.  The values in the X 
and Y fields are transposed and 
the inverse of the Z value is used 
to give the offsets in CARIS 
coordinates.

NOAA personnel calculated the 
distance between the port 
antenna and the phase center of 
the port antenna subtracting  the 
IMU to Port Antenna value from 
the IMU to Phase Center value.   

The average vertical distance 
from BM A and B to the waterline 
was measured by 
FAIRWEATHER personnel using 
a steel tape and bubble level.  
These values were used to 
calculate the BM C to the 
waterline value.  With the 
knowledge of the BM C height 
above the IMU, the waterline 
height above the IMU could be 
calculated.  On launch 1018, the 
IMU is used as the reference 
point. 

The location of the IMU and the 
location of the port antenna were 
measured by NOAA personnel 
with respect to the Ship 
Reference Frame (SRF).  The 
xyz offsets from the IMU to the 
port antenna could be calculated 
from these physical locations. 

The heave point was positioned 
differently on each of the axes.  
The distance for the longitundinal 
axis was determined as 
described in the "IMU to Heave" 
tab in this workbook.  The 
athwart ships axis was the vessel 
centerline.  Lastly, the waterline 
was used as the height of the 
heave point, which was 
calculated earlier in 'RP to 
Waterline'.  

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
measured by NOAA personnel 
with respect to the SRF.  The 
scalar distance between the 
phase centers was then 
calculated. 



1018 Vessel Diagram
All Values Shown are in Theodolite Coordinates

Note:   Both antenna have been replaced for the POS 
V4.  While their x-y values are not thought to have 
changed, the z-value has been remeasured.



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

4/16/2009
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

4/16/2009
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

0:00
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

POSMV v4 GPS (DGPS corrected)

CalmL. Washington

03/20/2009

Launch 1018

Welton, ENS Morgan, Raymond, Heiner

FOO Ringel, CST Morgan, LT Welton, ENS Morgan

not available1018

106

8101

L. Washington

Hull mounted swing arm

344973102026

04/15/2009

081060818

106

TH_1018_Patch_Test_Dn105

30-190 feet



ROLL
SV Cast # Heading Speed (kts) Remarks

005_1832.81X 3 5.9 roll
183 6.0
03 6.0

PITCH
SV Cast # Heading Speed (kts) Remarks

274 5.1
092 5.1
272 5.2
092 5.1

HEADING/YAW
SV Cast # Heading Speed (kts) Remarks

91060818 274 5.1
092 5.1
272 5.2
092 5.1

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

272 4.8
092 8.0

092 5.1

Processing Log

4/16/2009
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

DN106

Do not enter/apply correctors until all evaluations are complete and analyzed.

001_1823.81X

Compute correctors in this order

timing

001_1741.81X

ENS Morgan

timing

Heading

001_1811.81X

Data converted --> HDCS_Data in CARIS

Heading

Heading (1805 overtaking boat noise)

001_1741.81X
002_1751.81X
002_1801.81X

Heading

Heading001_1730.81X

005_1838.81X
005_1844.81X

roll
roll

yes

na

zerotide.tid

yes

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

XTF Line Filename

XTF Line Filename

XTF Line Filename
001_1730.81X
001_1741.81X
002_1751.81X
002_1801.81X

XTF Line Filename



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
-0.05 -0.80 2.88 -0.40
0.00 0.30 2.86 -0.50
0.03 -0.94 2.86 -0.35
-0.03 -1.06 2.90 -0.10

-0.01 -0.63 2.88 -0.34
0.04 0.63 0.13 0.02 0.17 0.04
0.00 -0.63 2.88 -0.34

CST/FOO Averages Averages Averages

Resulting HVF File Name
Actual values used

MRU Align StdDev gyro 0.17 Value from standard deviation of Heading offset values 0.035
MRU Align StdDev 
gyro

MRU Align StdDev Roll/Pitch 0.32 Value from averaged standard deviations of pitch and roll offset values 0.075
MRU Align      
StdDev Roll/Pitch

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 4/18/09

Initial MRU values were too high, TPU values reassessed with outliers removed.

Values based on two patch tests- one performed on DN106 in Lake Washington using the bounded slope method and one 
performed on DN107on the Shilshole reference surface using the target method.  

FA_1018_Reson8101_2009

Nick
Bri

Final Values based on

Averages
Standard Deviation

FINAL VALUES

FOO (in progress)

Ringel, Welton, Morgan

PATCH TEST RESULTS/CORRECTORS

CST



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

6/27/2009
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

6/27/2009
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

Launch 1018

178 Shumagin Islands, Near Northeast Harbor

Welton, FOO Ringel, CST Morgan

8125 1018 uknown (on loan from RUDE)

4400007 31562

Sled hull mount 4/29/2009

POSMV w/ DGPS correctors 4/15/2009

178 Shumagin Islands, Near Northeast Harbor Wind lgt vrb, waves <1ft (Awesome)

rock 20-30 meters

Froelich, Francksen, Walker

2009-178_1018.000



NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks
H12702_1018_Dn1 022 6.0

PITCH view parallel to track, same line (nadir) over feature or bounded slope [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks
H12702_1018_Dn1 110 6.0

290 6.0

HEADING/YAW view parallel to track, offset lines from feature or slope (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

110 6.0
290 6.0

ROLL view across track, same line over flat area in [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks
H12702_1018_Dn1 110 6.0

290 6.0

view parallel to track, one line with induced roll (outerbeam) or same lines over bounded slope or 
feature (nadir) [run same direction, different speed]

Line Filename
2009L_1781804 roll time bias method

Line Filename
2009L_1781750
2009L_1781753

Line Filename
2009L_1781756
2009L_1781800

Line Filename
2009L_1781750
2009L_1781753



Processing Log

6/27/2009
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -0.90 -1.98 -2.20
0.00 -0.30 -1.95 -1.70
0.00 -0.40 -1.91 -1.50

0.00 -0.53 -1.95 -1.80
0.00 0.32 0.04 0.36
0.00 -0.53 -1.95 -1.80

Resulting HVF File Name

MRU Align StdDev gyro 0.36 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.18 Value from averaged standard deviations of pitch and roll offset values

178 `

Data converted --> HDCS_Data in CARIS

Previous in Time

predicted- Sand Point, AK

Compute correctors in this order
1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Do not enter/apply correctors until all evaluations are complete and analyzed.

PATCH TEST RESULTS/CORRECTORS

Welton
FOO
CST

Averages
Standard Deviation

FINAL VALUES

Final Values based on Averages

added to FA_1018_Reson8125_2009



Ellipsoid Referenced Dynamic Draft Launch 1018

4/16/2009 106 Lake Washington Rice
Date DN Local Area Processor

SEAI TH_1018_patch_test_dn105.000.002 1018_ERDDM.txt
Primary Station POSPac File SBET File

proc_erddm.py, v0.12 4
Processing Method Coefficients



2009 HVF Values
2009-ERDDM-Descrete 2009 Bottom Referenced

speed (m/s) draft (m) speed (m/s) draft (m)

-0.2
-0.15

-0.1
-0.05

0
0.05

0.1
0.15

0.2
0.25

0 2 4 6 8D
ra

ft 
(m

)

Speed (m/s)

Dynamic Draft Comparison 2009-ERDDM-Descrete

2009 Bottom Referenced

2008

2007

2006

p ( ) ( ) p ( ) ( )
0 0 0 0

0.5 0.05 2.52 0.062
1 0.06 3.07 0.088

1.5 0.07 3.66 0.131
2 0.07 4.06 0.149

2.5 0.07 4.47 0.152
3 0.09

3.5 0.1
4 0.1

4.5 0.07
5 0

5.5 -0.15

speed (m/s) draft (m) speed (m/s) draft (m) speed (m/s) draft (m)
0 0 0 0 0 0

3.09 0.09 2.58 0.039 2.5 0.109
4.12 0.18 3.1 0.061 3 0.079
5.14 0.19 3.82 0.11 4 0.135
6.17 0.21 4.24 0.151 5.1 0.19

4.81 0.133 6 0.01
5.32 0.074

2008 2007 2006



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: FAIRWEATHER Vessel: 1018
Date: 4/15/2009 Dn: 104
Personnel: Andrews, Welton, Forney, Shetler 

PCS Serial # IMU Serial #

IP Address: 129.100.1.231

Port Antenna Serial # Stbd Antenna Serial #

POS controller Version (Use Menu Help > About) 3.4.0.0

POS Version (Use Menu View > Statistics) MV-320,Ver 4
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:
Approximate Position: Lat 47 39 35.8

Lon 122 15 35.6

DGPS Beacon Station: DGPS Receiver Serial#:
Frequency: 302

2560

Whidbey Island 0328-12352-0001

4624A70243

4624A70263

007

NOAA POS/MV Calibration Report

Lake Washington, Seattle, WA

60145158 60130644



Satellite Constellation (Use View> GPS Data)

Primary GPS

PDOP 1.823 (Use View> GAMS Solution)

POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Configuration Notes:

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time: 1722 UTC
End time: 1723 UTC
Heading accuracy achieved for calibration: 0.324

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

GAMS Status Online Ready Online
Save Settings Yes

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: C:\Documents and Settings\1018acq\Desktop\POS-MV Settings\GAMS_Parameter_104_2009.nvm

Secondary GPS



General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:
a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.



SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

COM2

COM3



SETTINGS Continued
Heave Filter (Use Settings > Heave)

Events (Use Settings > Events)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)



Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver



$UTC, 9600, N,8,1, NULL
1 Hz

Crossover
Patch

Serial

1018-Acq

DGPS Reciever

9600, N,8,1, NULL
RTCM 104DIFF

Key

129.100.1.230

129.100.1.231
POSPAC Groups

25 Hz

10.48.12.32

10.48.12.28
UDP 1070C

O
M

2

COM2

9600, N,8,1, NULL
Reson Controller

Data Y

COM1

COM1

19200, N
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Measurement
Coord. Sys. Caris Caris Caris
x 2.868 2.071 n/a Scaler Distance 1.997
y 8.252 20.144 n/a
z 4.752 17.792 0.014

*Top of IMU is RP (Reference Pt)

2009 Measured Value

Calculations

Coord. Sys. Westlake NGS 2009 IMU Base to baseline at Keel NGS 2009
IMU easting 0.000 Top of Port x -11.892 (ft) elevation 12.856 Top of x -11.892
Base northing 0.000 Ant y 0.797 IMU Base to baseline at Keel Port Ant y 0.797

(ft/m) elevation 0.000 (m) z 13.047 (m) elevation 3.919 (m) z 13.047
Westlake Top of Ant to Phase Center 
8111 easting 27.072 (m) z 0.007 Waterline to Keel Top of Ant to Phase Center 

(ft) northing 9.410 Phase Cntr x -11.892 (ft) elevation 13.45 (m) z 0.007
elevation 15.042 Port Ant y 0.797 Waterline to Keel

Westlake (m) z 13.040 (m) elevation 4.100 NGS 2009
8111 easting 8.252 CARIS See Ship's Draft Tab Top of x -11.886

(m) northing 2.868 Port x 0.797 Stbd Ant y 2.794
elevation 4.585 Ant y -11.892 Top of IMU to Base of IMU (m) z 13.051

Westlake (m) z -13.040 (m) elevation 0.168
Base of IMU to Top of IMU Westlake Top of IMU to Keel

(m) elevation -0.168 (m) easting 8.252 (m) 4.086
Top of IMU northing 2.868
 to 8111 elevation 4.752
CARIS

(m) x 2.868
Top of IMU y 8.252
 to 8111 z 4.752

These rows 
Westlake (m) easting 8.252 CARIS x 2.071 (m) easting N/A
unless noted Top of IMU northing 2.868 y 20.144 Waterline northing N/A Scalar Distance (m) 1.997
otherwise  to 8111 elevation 4.752 (m) z 17.792  to IMU elevation 0.014

Coord Sys. CARIS Coord Sys. CARIS Coord. Sys.CARIS
x 2.868 x 2.071 x N/A
y 8.252 y 20.144 y N/A
z 4.752 z 17.792 z 0.014

See Description Tab

IMU to 8111

IMU to 8111 Port Ant to Stbd AntPort Ant to 8111 Waterline to RP*

Port Ant to 8111 Waterline to RP*

Waterline to RP* Port Ant to Stbd Ant

Port Ant to Stbd Ant

Vessel Offsets for S220_8111 are derived from Westlake-Survey-Report-NOAA-Fairweather-09-23-03.pdf
and Fairweather_NGS_Report_Feb_2007.doc

IMU to 8111 (MRU to Trans) Port Ant to 8111 (Nav to Trans)



Caris Pos/Mv Caris Pos/Mv
0.797 -11.892 1.866 -7.028

-11.892 0.797 -7.028 1.866
13.047 -13.047 -2.086 -2.086

NGS 2009 IMU to Bulkhd (Frame) 52 IMU Base to baseline at Keel
IMU Top (m) x 0.000 (ft) easting -11.638 (ft) elevation 12.856

y 0.000 (m) easting -3.547 (m) elevation 3.919
z 0.000

NGS 2009 Frame 0 (FP) to Frame 52 Top of IMU to Base of IMU
Top of Port x -11.892 (m) easting -27.737 (m) elevation 0.168
Ant y 0.797 Top of IMU to Keel

(m) z 13.047 IMU to Frame 0 (FP) (m) elevation 4.086
(m) easting 24.190

Top of Ant to Phase Center Center of Gravity above baseline
(m) z 0.007 Heave Pt* to Frame 0 (FP) (ft) elevation 16.37

(ft) easting 102.42 Mean Metacentric height
NGS 2009 (m) easting 31.218 (ft) elevation 3.88
Phase Cntr x -11.892
Port Ant y 0.797 IMU to Centerline Heave Pt* to baseline at Keel

(m) z 13.047 (ft) northing 6.122 (ft) elevation 20.25
(m) northing 1.866 (m) elevation 6.172

Heave Pt* to Centerline (*Heave Pt is Metacenter)
(m) northing 0 (FP is Forward Perpendicular)

NGS 2009 (m)        x -11.892 (m) easting -7.028
Top of IMU y 0.797 Top of IMU northing 1.866
 to Port Ant z 13.047 to Heave Pt* elevation -2.086

Coord Sys. Pos/Mv Coord. Sys. Pos/Mv
x -11.892 x -7.028
y 0.797 y 1.866
z -13.047 z -2.086

see Description Tab

IMU to Port Ant

IMU to Heave

IMU to HeaveIMU to Port Ant

IMU to Heave

IMU to Port Ant

Value in POSMV is top of 
antenna rather than the phase 
center to IMU. 



Measurement
Coord. Sys. Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.493 -0.304 n/a Scaler Distance 1.997 0.797 -11.892 1.866 -7.028
y 7.665 19.557 n/a -11.892 0.797 -7.028 1.866
z 4.726 17.766 0.014 13.047 -13.047 -2.086 -2.086

*Top of IMU is RP (Reference Pt)

Derivations
Coord. Sys.

Westlake NGS 2009
IMU easting 0.000 Top of Port x -11.892
Base northing 0.000 Ant y 0.797

(ft/m) elevation 0.000 (m) z 13.047
Westlake Top of Ant to Phase Center 
8160 easting 25.149 (m) z 0.007

(ft) northing 1.619 Phase Cntr x -11.892
elevation 14.956 Port Ant y 0.797

Westlake (m) z 13.040
8160 easting 7.665 CARIS

(m) northing 0.493 Port x 0.797
elevation 4.559 Ant y -11.892

(m) z -13.040
Base of IMU to Top of IMU Westlake

(m) elevation -0.168 (m) easting 7.665
Top of IMU northing 0.493
 to 8160 elevation 4.726
CARIS

(m) x 0.493
Top of IMU y 7.665
 to 8111 z 4.726

Westlake easting 7.665 CARIS x -0.304
Top of IMU northing 0.493 y 19.557
to 8160 (m) elevation 4.726 (m) z 17.766

Coord Sys Caris Coord Sys Caris
x 0.493 x -0.304
y 7.665 y 19.557
z 4.726 z 17.766

Port Ant to 8160

IMU to Port Ant

IMU to 8160

IMU to 8160 (MRU to Trans)

IMU to 8160

Port Ant to 8160 (Nav to Trans)

Port Ant to 8160

IMU to HeavePort Ant to Stbd AntWaterline to RP*

Vessel Offsets for S220_8111 are derived from Westlake-Survey-Report-NOAA-Fairweather-09-23-03.pdf, 
Fairweather_NGS_Report_02-07.pdf, and , FairweatherCenterlineSurvey_03-09.pdf.



Description of Offsets for FAIRWEATHER S-220
All Values Shown are in CARIS Coordinates

IMU to Heave Point
x: 1.866
y: -7.028
z: -2.086

IMU=Reference Point (RP)
x: 0.000
y: 0.000
z: 0.000

IMU to Seabat 8111
x: 2.868
y: 8.252
z: 4.752

IMU to Seabat 8160
x: 0.493
y: 7.665
z: 4.726

Scaler Distance 1.997

IMU to Port Antenna
x: 0.797

y: -11.892
z: -13.047

IMU to Heave Point
x: 1.866
y: -7.028
z: -2.086

Port Antenna to 8160
x: -0.304
y: 19.557
z: 17.766

Port Antenna to 8111
x: 2.071
y: 20.144
z: 17.792

IMU to Seabat 8160
x: 0.493
y: 7.665
z: 4.726

IMU to Seabat 8111
x: 2.868
y: 8.252
z: 4.752

IMU=Reference Point (RP)
x: 0.000
y: 0.000
z: 0.000

Port Antenna to 8111
x: 2.071
y: 20.144
z: 17.792

Port Antenna to 8160
x: -0.304
y: 19.557
z: 17.766

IMU to Port Antenna
x: 0.797

y: -11.892
z: -13.047



x y z x y z
2.868 8.252 4.752 0.493 7.665 4.726

x y z x y z
2.071 20.144 17.792 -0.304 19.557 17.766

x y z
Scaler Distance 1.997 0.797 -11.892 13.047

x y z x y z From pg 3 of the Westlake Survey
n/a n/a 0.014 1.866 -7.028 -2.086

Lynn - read through and check

IMU to 8160 (MRU to Trans)

The lever arms between the IMU 
and phase center of the 8111 
transducer are taken from the 
Westlake report with the addition 
of the 0.168 m offset included for 
the height of the IMU.

Port Ant to 8160 (Nav to Trans)

The lever arms between the IMU 
and phase center of the 8160 
transducer are taken from the 
Westlake report with the addition of 
the 0.168 m offset included for the 
height of the IMU.

This information comes from a 
combination of the Westlake and 
NGS surveys. Subtraction of the 
distance between Top of Antenna 
and the Phase Center were 
included in final value 
determination. Relative positions 
obtained from Port Ant to 8111 via 
IMU.

This information comes from a 
combination of the Westlake and 
NGS surveys. Subtraction of the 
distance between Top of Antenna 
and the Phase Center were 
included in final value 
determination. Relative positions 
obtained from Port Ant to 8160 via 
IMU.

Referencing the metacenter (Heave Point, HP) to the IMU information requires information about the frame spacing of the vessel.  From the 
Westlake survey, the IMU is located 3.547 m forward of frame 52.  From Inclination document, the HP is 31.217 m aft of the forward 
perpendicular.  From engineering drawings of the ship frame spacing is approximately 21 inches.  The calculation for the longitudinal location 
of the HP with respect to frame zero, the Forward Perpendicular (FP) is as follows:

52 (frame) * 21 (inches/frame)/12(inches/ft)*.3048(m/ft)-3.547 m = 24.190 m from frame 0.

31.217 m (HP aft of FP) – 24.190 m (IMU aft of FP) =  7.027 m (HP aft of IMU)

The calculation for the vertical separation between the IMU and the HP is based on the height of the metacenter being 6.172m and the height
of the IMU being 4.087 m above the keel.  Differencing yields the metacenter being 2.085 m above the IMU.

The calculation for the athwartship separation is based upon the assumption that the HP is on the centerline and the knowledge that the IMU 
is 1.866 m to port of the centerline.

Port Ant to Stbd Ant

Using the NGS 2009 survey values 
for the antennas, a calculated 
vector for antenna separation was 
determined. The distance from Top 
of Antenna to Phase Center does 
not affect this calculation and 
therefore was not included.

This information comes directly 
from the NGS 2009 survey.  
Subtraction of the distance 
between Top of Antenna and the 
Phase Center were included in 
final value determination.

IMU to Heave

* From the Art Anderson inclination experiment the position of the metacenter was used as the position of the ship’s Heave Point. (There may
be a better way to determine the Heave Point, but this decision was based upon available information).  The metacenter is defined by the 
center of buoyancy.  As a vessel inclines through small angles, the center of buoyancy moves through the arc of a circle whose center is at 
the metacenter.  

Important numbers and information determined from the Art Anderson report are the location of the metacenter and how it is positioned with 
respect to the vessel.  The longitudinal location of the metacenter is defined as 102.42 feet (31.217 m) aft of the forward perpendicular.  The 
height of the metacenter is 20.25 feet (6.172 m) above the keel.  There is an assumption of the metacenter being on the centerline of the 
vessel.  Similar values for the RAINIER’s metacenter are 32.52 m aft of the forward perpendicular and 5.2 m above the keel.  The difference 
in the height of the metacenter can be attributed to the difference between the FA’s and RA’s average draft which is 13.12 feet as opposed to 
approximately 14.5 feet respectively.

IMU to 8111 (MRU to Trans)

Port Ant to 8111 (Nav to Trans)

Waterline to RP*

IMU to Heave

The height of the IMU above the 
keel comes from the Westlake 
survey value of 3.919 m plus the 
measured value of the top of the 
IMU to the base plate, to get an 
IMU height above the keel.  The 
draft (waterline to keel) used for the 
FAIRWEATHER is based on 
observations, Ship's Draft 
spreadsheet.  Differencing the 
value of IMU to keel and waterline 
to keel gives the waterline to RP 
distance.  

Key points on the IMU, from the 
Westlake survey, are its location 
with respect to the ship’s reference
frame.  It is 4.087 m (3.919 m to 
base line + 0.168 m for IMU height 
above base plate) above the keel, 
1.866 m port of centerline and 
3.547 m forward of frame 52.  This 
information is needed to reference 
the IMU to the ship’s Heave 
Measurement Location (Heave 
Point). *

IMU to Port Ant

IMU to Heave



Sources

On September 23, 2003 an offset survey of the NOAA Ship FAIRWEATHER was conducted by:
Westlake Consultants, Incorporated
15115 SW Sequoia Parkway, Suite 150
Tigard, Oregon 97224
Phone (503) 684-0652

…and the relocation of the POS M/V antenna forced a partial resurvey in Feb. 2007 by Steven Breidenbach of NGS.

On July 16, 2004 an inclination experiment was conducted at MOC-P by:

Art Anderson Associates
202 Pacific Avenue
Bremerton, WA  98337-1932

Calculations

These values relate the physical positions of one sensor to the next with the base plate of the IMU being the point of origin.  All 
dimensions in the document are given in feet and decimal feet.  

The values for the required lever arms are listed in the S220_Offsets and Measurements spreadsheet.  The reference point and the 
IMU are identical.  Difference in documentation between Westlake and FA calculations are based off of measuring up from the 
IMU base (Westlake’s origin) and the top of the IMU.  The top center of the IMU for the POS/MV is the defined origin for the 
POS/MV and the origin that is being used on all FAIRWEATHER vessels.  The distance from the base plate to the top of the 
IMU is 0.168 m, a value measured by ship’s complement.  Conversions factor from feet to meters is 0.3048 m/ft.

As a requirement for the TPE, the standard deviation for each position is 3 mm.  This value is based upon a conversation with 
Elaine McDonald of Westlake and is followed up by an Email documenting that fact.  The email is located at the end of this 
document.

Offset values for the ship were derived from three sources.  Two static offset surveys, an inclination experiment, and values measured or 
approximated by ship’s personnel.
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NOAA SHIP FAIRWEATHER 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
PURPOSE 
 
The primary purpose of the survey was to precisely determine the spatial relationship of various 
components of a POS MV navigation system aboard the NOAA ship FAIRWEATHER.  
Additionally, various reference points (bench marks) were re-established onboard the vessel to 
aid in future spatial surveys aboard the boat. 
 
 
PROJECT DETAILS 
 
This survey was conducted while the ship was in dry dock at the Lake Union dry dock in Seattle, 
WA.  The weather conditions over the two days required to conduct this survey were windy, 
cool, with intermittent rain.   
 
 
INSTRUMENTATION 
 
The Leica TC2003 total station was used to make all measurements. 

Technical Data: 
    
  Standard Deviation 
   Horizontal angle  0.5 seconds 
   Vertical angle   0.5 seconds 
   Distance measurement 0.2mm + 2ppm 
 
A Leica precision prism was used as a sighting target.  This prism was configured to have a zero 
mm offset.   
 
 
PERSONNEL 
  
  
 Kendall Fancher NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
 
 Dennis Lokken           NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
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DEFINITION OF THE REFERENCE FRAME 
 
To conduct this survey a local coordinate reference frame was established where the Northing 
(Y) axis runs along the centerline of the ship and is positive from the IMU towards the bow of 
the ship.  The Easting (X) axis is perpendicular to the centerline of the ship and is positive from 
the IMU towards the right, when looking at the ship from the stern.  The Up (Z) axis is positive 
in an upward direction from the IMU.   
 
 
SURVEY METHODOLOGY 
 
02/15/2009 
 
Coordinates of 100.000N, 100.000E, and 100.000U were assumed for temporary control point 1.  
A distance and height difference were measured between temporary control points 1 and 3.  
These values were used to determine the coordinates at temporary control point 3.  Temporary 
control points 1 and 3 were located along the top deck and on the north side of the dry dock 
vessel.   
 
Temporary control point 1 was occupied and temporary control point 3 was observed for a 
backsight.  After initialization, temporary control points 2 and 4(located on the top deck of the 
dry dock vessel), H1 (located on the bottom deck of the dry dock vessel), and BOW BM were 
observed in both direct and reverse. 
 
Temporary control point 2 was occupied and temporary control point 3 was observed for a 
backsight.  After initialization, temporary control point W1 (located on the top deck of the dry 
dock vessel) and D1 (located inside the ship on the D deck along the port side) were observed in 
both direct and reverse.  Temporary control point 1 was also observed and yielded an inverse 
check of 0.001m horizontally and 0.001m vertically. 
  
Temporary control point 4 was occupied and control point 1 was observed for a backsight.  After 
initialization, temporary control point 5 (located on the south side and on the top deck of the dry 
dock vessel) was observed in both direct and reverse.  
 
Temporary control point 5 was occupied and control point 4 was observed for a backsight.  After 
initialization, temporary control point D2 (located inside the ship on the D deck along the 
starboard side) was observed in both direct and reverse. 
 



Temporary control point H1 was occupied and control point 1 was observed for a backsight.  
After initialization, temporary control point H2 (located on the bottom deck of the dry dock 
vessel), and USBL BM were observed in both direct and reverse. 
 
Temporary control point H2 was occupied and temporary control point H1 was observed for a 
backsight.  After initialization, 8111 BM and 8160 BM were observed in both direct and reverse.  
Temporary control point W1 was also observed and yielded an inverse check of 0.019m 
horizontally and 0.033m vertically. 
 
Temporary control point D1 was occupied and temporary control point D2 was observed for a 
backsight.  After initialization, temporary control point D3 (located in the doorway leading to the 
mess hall on the D deck) was observed in both direct and reverse.   
 
Temporary control point D3 was occupied and temporary control point D1 was observed for a 
backsight.  After initialization, temporary control point C1 (located on the C deck near the IMU) 
was observed in both direct and reverse.  Temporary control point D2 was also observed and 
yielded an inverse check of 0.026m horizontally and 0.0001m vertically. 
 
Temporary control point C1 was occupied and temporary control point D3 was observed for a 
backsight.  After initialization, IMU, IMU BOW PORT CORNER, IMU BOW STAR CORNER, 
IMU STERN STAR CORNER, and IMU STERN PORT CORNER were observed in both direct 
and reverse. 
 
02/16/2009 
 
Temporary control point 4 was occupied and control point 1 was observed for a backsight.  After 
initialization, temporary control point 6 (located on the south side and on the top deck of the dry 
dock vessel) and BOW BM were observed in both direct and reverse. Temporary control point 
D2 was also observed and yielded an inverse check of 0.0004m horizontally and 0.083m 
vertically. 
 
Temporary control point 6 was occupied and temporary control point 4 was observed for a 
backsight.  After initialization, TRANSOM PIVOT POINT PORT, STERN BM, POS GPS ANT 
RAIL BM, POS IMU ANT DECK BM, POS GPS ANT STARBOARD, and POS GPS ANT 
PORT were observed in both direct and reverse. 
 
Temporary control point 3 was occupied and temporary control point 1 was observed for a 
backsight.  After initialization, TRANSOM PIVOT POINT STARBOARD, STERN BM, POS 
GPS ANT STARBOARD, and POS GPS ANT PORT were observed in both direct and reverse. 
Temporary control point 6 was also observed and yielded an inverse check of 0.0006m 
horizontally and 0.001m vertically.  
 
The reference frame was rotated using STERN BM as the point of rotation.  A zero degree 
azimuth was used during the rotation from STERN BM to BOW BM. The reference frame was 
then translated to relocate the origin of the reference frame to the IMU. 
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INVERSE RESULTS 
 
Inverses were computed between the determined positions of those ship benchmarks and 
sensor points which were determined from two separate locations  The results of these inverses 
are: 
 
ID    Horizontal Dist.(m) Elevation Diff(m) 
BOW BM    0.0150    0.0240 
STERN BM    0.0060    0.0010 
POS GPS ANT STARBOARD  0.0100    0.0001 
POS GPS ANT PORT   0.0100    0.0000 
 
 
DISCUSSION 
 
The Fairweather was in dry dock during this survey, however, the dry dock vessel was still 
subject to movement due to wave action.   Conducting a survey such as this while the ship is 
moving requires that the automatic compensators in the survey instrument be turned off.  The 
survey is therefore conducted with all survey instrumentation set up relative to the mean 
movement of the related level vials.  While every effort was made to make the most precise 
measurements possible, some additional error accumulation cannot be avoided under these type 
observing conditions.   
 
The POS GPS antenna coordinates were determined to the top center of the antennas.  The Z 
value should be corrected to the Antenna Reference Point (ARP).  In order to apply this 
correction, the mechanical height of the antenna should be determined and subtracted from the Z 
value determined during this survey for both of the POS GPS antennas. 
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Coordinate Listing using IMU as the Reference Frame Origin  
 
 

ID  X(NORTHING)m Y(EASTING)m  Z(UP)m 
IMU CENTER  0.000 0.000 0.000 
IMU STERN PORT CORNER  ‐0.071 ‐0.089 ‐0.001 
IMU BOW PORT CORNER  0.070 ‐0.086 ‐0.001 
IMU BOW STARBOARD CORNER  0.069 0.087 0.000 
IMU STERN STARBOARD CORNER  ‐0.073 0.086 0.000 
BOW BM  28.378 1.805 7.796 
STERN BM  ‐40.306 1.805 2.255 
USBL BM  ‐28.354 1.738 ‐4.204 
8160 BM  8.407 0.395 ‐4.400 
8111 BM  8.532 3.002 ‐4.666 
POS GPS ANT RAIL BM  ‐12.011 1.785 10.381 
POS IMU ANT DECK BM  ‐11.790 1.780 9.305 
POS GPS ANT STARBOARD  ‐11.886 2.794 13.051 
POS GPS ANT PORT  ‐11.892 0.797 13.047 
TRANSOM PIVOT POINT STARBOARD  ‐39.727 3.366 2.385 
TRANSOM PIVOT POINT PORT  ‐39.722 0.240 2.345 
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IMU Reference Points 
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POS GPS ANTENNAS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



NOAA SHIP FAIRWEATHER 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 

 
 
 

BOW CENTERLINE REFERENCE POINT 
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CENTERLINE REFERENCE POINT ON G DECK 
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CENTERLINE REFERENCE POINT ON RAIL AT G DECK 
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CENTERLINE STERN REFERENCE POINT 
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TRANSOM REFERENCE POINT ON PORT SIDE 

 

 
TRANSOM REFERENCE POINT ON STARBOARD SIDE 
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8111 REFERENCE POINT 
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8160 REFERENCE POINT 
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USBLE REFERENCE POINT 

 

 



Fairweather  Draft - 2009

2009 (April) Fwd Aft slope IMU Depth (ft) IMU Depth (m)
x1 y1 x2 y2 Min Max

Empty 5.25 13.83 189 12.83 -0.00544 13.43 4.093 12.83 14.17
Full 5.25 13.00 189 14.17 0.00635 13.47 4.106

5.25 189 0.00000 0.00 0.000
5.25 189 0.00000 0.00 0.000
5.25 189 0.00000 0.00 0.000

Draft at IMU (ft) 13.45 4.100 AVG Value Used in Offsets
The IMU x-value (ft): 79.36 0.029 0.009 STDEV Value used for Waterline Loading Uncertainty

x-value (m): 24.19

Immediately prior to the FA field season, the draft measurements were taken prior to fueling when the takes were 
very empty after shipyard  (Empty) . And again after fueling and once the engineers had transferred the fuel in a 
satisfactory manner (Full).  The waterline at the IMU was then calculated based on a linear interpolation.
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Immediately prior to the FA field season, the draft measurements were taken prior to fueling when the takes were 
very empty after shipyard  (Empty) . And again after fueling and once the engineers had transferred the fuel in a 
satisfactory manner (Full).  The waterline at the IMU was then calculated based on a linear interpolation.
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NOAA SHIP FAIRWEATHER 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
PURPOSE 
 
The primary purpose of the survey was to accurately determine the spatial relationship of various 
components of a POS MV navigation system aboard the NOAA ship FAIRWEATHER.  
Reference points were also established to determine the spatial location of differential GPS 
antennas,   Additionally, various reference points (bench marks) were restablished onboard the 
vessel to aid in future spatial surveys aboard the boat. 
 
 
PROJECT DETAILS 
 
This survey was conducted while the ship was docked at the USCG in Seattle, WA .  The weather 
was cool with a steady breeze.   
 
 
INSTRUMENTATION 
 
The Topcon 3000LW total station was used to make all measurements. 

Technical Data: 
   Angle Measurement 
   Smallest unit in display 0.1 seconds 
 
  Standard Deviation 
   Horizontal angle  1.0 seconds 
   Vertical angle   1.0 seconds 
   Distance measurement 2mm + 2ppm 
 
A standard “peanut” prism was used as a sighting target.  This prism was configured to have a zero 
mm offset.   
 
 
PERSONNEL 
  
  
 Steve Breidenbach NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
 
 Dennis Lokken           NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
 
  
 



NOAA SHIP FAIRWEATHER 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
ESTABLISHING THE REFERENCE FRAME 
 
To conduct this survey a local coordinate reference frame was established where the X axis runs 
along the centerline of the boat and is positive from IMU towards the bow of the boat.  The Y axis 
is perpendicular to the centerline of the boat (X axis) and is positive from IMU towards the right, 
when looking at the boat from the stern.  The Z axis is positive in an upward direction from the 
IMU.  In this reference frame the IMU has the following coordinates; 
X = 100.000(m) 
Y = 100.000(m) 
Z  = 100.000(m) 
 
At the end of the survey all the coordinates were rotated to a right-handed coordinate system.  The 
coordinates were translated to the IMU origin and the Granite Block origin. 
 
 
 
 
 
DISCUSSION 
 
I recommend conducting the survey again, once the ship is put into dry dock.  Conducting a survey 
such as this while the boat is in the water requires that the automatic compensators in the survey 
instrument be turned off.  The survey is therefore conducted with all survey instrumentation set up 
relative to the mean movement of the related level vials.  While every effort was made to make the 
most precise measurements possible, some additional error accumulation cannot be avoided under 
these type observing conditions.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



The positions given for the IMU GPS antenna are to the bottom of the bolt as depicted on the 
photo below. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Position of the C-NAV Antenna 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Point Summary Report 

Name  Std Dev n (m)  Std Dev e (m)  Std Dev Hz (m)  Std Dev u (m)  

10FLOOR  0.003  0.003  0.004  0.002  

11FLOOR  0.003  0.004  0.005  0.002  

1CLEAT  0.004  0.018  0.019  0.002  

1DECK  0.004  0.018  0.018  0.002  

1FLOOR  0.000  0.000  0.000  0.000  

1LOCKER  0.004  0.004  0.005  0.003  

1RAIL  0.004  0.022  0.023  0.002  

1WALL  0.003  0.002  0.004  0.001  

1WALL3  0.003  0.003  0.004  0.002  

2CLEAT  0.003  0.021  0.021  0.002  

2CLEAT1  0.004  0.022  0.022  0.003  

2FLOOR  0.001  0.001  0.001  0.001  

2RAIL  0.004  0.022  0.022  0.002  

2WALL  0.002  0.003  0.004  0.002  

3ANT  0.003  0.006  0.007  0.003  

3FLOOR  0.002  0.002  0.003  0.002  

3WALL  0.003  0.003  0.005  0.002  

4FLOOR  0.001  0.001  0.002  0.003  

5FLOOR  0.002  0.004  0.005  0.001  

6FLOOR  0.002  0.002  0.003  0.003  

7FLOOR  0.005  0.003  0.006  0.002  

8FLOOR  0.004  0.004  0.005  0.002  

9FLOOR  0.002  0.013  0.013  0.003  

ABOLT  0.003  0.026  0.026  0.003  

ANT DECK  0.003  0.006  0.007  0.003  



Name  Std Dev n (m)  Std Dev e (m)  Std Dev Hz (m)  Std Dev u (m)  

ANT DECK BM  0.004  0.007  0.008  0.003  

ANT PORT  0.003  0.007  0.008  0.003  

ANT RAIL  0.004  0.006  0.007  0.003  

ANT RAIL BM  0.003  0.007  0.007  0.003  

ANT STAR  0.004  0.007  0.008  0.003  

BOW BM  0.004  0.023  0.024  0.003  

BOW BM2  0.004  0.023  0.023  0.003  

BRIDGEPORT  0.005  0.011  0.012  0.003  

BRIDGESTAR  0.005  0.011  0.012  0.003  

BRIDGESTAR2  0.005  0.011  0.012  0.003  

DOOR  0.001  0.001  0.002  0.001  

GRANITE BOW  0.002  0.001  0.002  0.001  

GRANITE CENTER  0.002  0.001  0.002  0.001  

GRANITE PORT  0.002  0.001  0.002  0.001  

GRANITE STAR  0.003  0.002  0.003  0.001  

GRANITE STERN  0.002  0.001  0.002  0.001  

IMU BM  0.003  0.001  0.003  0.003  

IMU BOW PORT  0.002  0.001  0.002  0.001  

IMU BOW STAR  0.002  0.001  0.002  0.001  

IMU CENTER  0.000  0.000  0.000  0.000  

IMU STERN PORT  0.002  0.001  0.002  0.001  

IMU STERN STAR  0.002  0.001  0.002  0.001  

LADDER  0.002  0.002  0.002  0.001  

MVP BM  0.004  0.023  0.023  0.003  

RAIL STAR  0.006  0.015  0.016  0.003  

RAIL STAR1  0.004  0.005  0.007  0.003  

RAILPORT  0.005  0.015  0.016  0.003  



Name  Std Dev n (m)  Std Dev e (m)  Std Dev Hz (m)  Std Dev u (m)  

RAILSTAR  0.005  0.015  0.016  0.003  

STEARN BM  0.004  0.024  0.024  0.003  

STERN BM  0.003  0.024  0.024  0.002  
 
 
 
 
COORDINATES 
 
 
                                                                                IMU Origin                                                                               
                                                               Right-handed Coordinate System                                                            
    
Name Easting (x) meters Northing (y) meters Elevation (z) meters 
IMU CENTER 0 0 0 
IMU BOW PORT CORNER 0.073 -0.084 -0.006 
IMU BOW STAR CORNER 0.071 0.088 -0.004 
IMU STERN STAR CORNER -0.068 0.089 -0.003 
IMU STERN PORT CORNER -0.065 -0.086 -0.006 
GRANITE BOW 0.147 0.48 0.108 
GRANITE STAR -0.002 0.574 0.111 
GRANITE STERN -0.148 0.478 0.109 
GRANITE PORT -0.003 0.382 0.106 
GRANITE CENTER -0.002 0.477 0.108 
IMU BM 0.034 -0.263 -0.496 
STERN BM -40.32 1.927 -2.184 
MVP BM -38.721 5.985 -2.018 
STEARN BM -40.313 1.921 -2.181 
POS GPS ANT STARBOARD -11.917 3.171 -12.936 
POS GPS ANT PORT -11.92 1.177 -12.98 
A FRAME BOLT -43.019 1.975 -7.142 
POS GPS ANT RAIL BM -12.037 2.101 -10.376 
POS IMU ANT DECK BM -11.823 2.07 -9.301 
C-NAV ANT -10.075 4.131 -11.377 
BOW BM 28.346 2.077 -7.853 
 
 



                                                                 Granite Block Origin 
                                                        Right-handed Coordinate System 
    
Name Easting (x) meters Northing (y) meters Elevation (z) meters 
IMU CENTER 0.002 -0.477 -0.108 
IMU BOW PORT CORNER 0.075 -0.561 -0.114 
IMU BOW STARBOARD CORNER 0.073 -0.39 -0.112 
IMU STERN STARBOARD CORNER -0.065 -0.388 -0.111 
IMU STERN PORT CORNER -0.063 -0.563 -0.114 
GRANITE BOW 0.149 0.003 0 
GRANITE STAR 0 0.097 0.003 
GRANITE STERN -0.145 0.001 0.001 
GRANITE PORT 0 -0.095 -0.002 
GRANITE CENTER 0 0 0 
IMU BM 0.036 -0.74 -0.604 
STERN BM -40.317 1.45 -2.292 
MVP BM -38.719 5.508 -2.126 
STEARN BM -40.31 1.444 -2.289 
POS GPS ANT STARBOARD -11.915 2.694 -13.044 
POS GPS ANT PORT -11.918 0.699 -13.088 
A FRAME BOLT -43.017 1.498 -7.25 
POS GPS ANT RAIL BM -12.034 1.623 -10.484 
POS IMU ANT DECK BM -11.821 1.593 -9.409 
C-NAV ANT -10.073 3.654 -11.485 
BOW BM 28.349 1.6 -7.961 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
POS GPS RAIL BM AND POS GPS DECK BM 



 
 
IMU BM 











 



Westlake Consultants, Inc.
9/23/2003

Definitions and Basis for Dimensions/Locations

Northings 

Northings (Port - Starboard) are with reference to the IMU Foundation Plate centerline scribe.
Positive values are starboard of the IMU.
Negative values are port of the IMU.
Calculated values are in italics.

Eastings 

Eastings (Stern to Bow ) are with reference to the IMU Foundation Plate centerline scribe.
Positive values are forward of the IMU. 
Negative values are aft of the IMU.
Calculated values are in italics.

Elevations  

Elevations are with reference to the IMU Foundation Plate centerline scribe = 0 elevation. 
Positive values are below the IMU (toward the keel).
Negative values are toward the topside.

Dimensions 

All dimensions are in feet and decimal feet. All dimensions provided are "offsets" to IMU centerline.

Ship's Centerline Data 

At project initiation, control was established to define the ship's centerline 
as a plane running from a point on the centerline of the keel at the stern through a 
point on the centerline of the keel near the bow, to a point on the bow splitting the bow chock. 

IMU Referenced Data - Procedure
All data was originally referenced to the ship's geometry. 
Following location of the IMU, data was transformed to the IMU as point of origin for 
Northings, Eastings, and Elevation. All dimensions provided with reference to the IMU are "offsets."
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Westlake Consultants, Inc.
9/23/2003

Ship's Centerline - Control Measurements 
(Prior to location of IMU and referencing of data to IMU as point of origin (0,0,0)

Defined by measurements at the keel centerline 
longitude transverse elevation

near the bow 1190.674 1000.000 135.8672
at the stern (point of origin) 1000.000 1000.000 100.0000
along the keel (approx 180' forward) 1180.121 1000.000 116.6810

Ship's Baseline

Defined by measurements on the keel 
longitude transverse elevation

at the stern (point of origin) 1000.000 1000.000 100.0000
and approx. 129' forward of stern 1129.120 999.985 100.0022
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Westlake Consultants, Inc.
9/23/2003

IMU Foundation Plate
EASTING NORTHING ELEVATION

Horizontal alignment per scribed lines 
on IMU foundation plate 0.001

0.000

Scribed lines - intersection/centerline of IMU plate
0.000 0.000 0.000

Elevation checks near four corners of IMU Foundation plate *
0.001

-0.001
0.000

-0.001

SUMMARY 
•  IMU foundation plate is level to within +/-0.001 feet.
•  IMU foundation plate is located 12.856 feet above baseline established at the keel.
•  IMU is parallel to ship's centerline to within +/- 0.001 feet.

Location of scribed centerline intersection is 6.122 feet port of ship's centerline.
•  IMU foundation plate centerline is located 11.638' feet forward of bulkhead 52. 

* elevation check adjusted for target 
that created 10 mm offset =.03281 

feet
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Granite Block 
EASTING NORTHING ELEVATION

Horizontal alignment per scribed lines
1.584
1.583

Scribed lines - intersection/centerline of granite block 
-0.003 1.583

Deviation
Elevation checks near four corners of granite block from level

-0.217 -0.001
-0.217 -0.001
-0.216 0.001
-0.215 0.001

SUMMARY 
•  Granite block is level to within +/-0.001 foot 

of average elevation = -0.21632 feet
•  Granite block is parallel to ship's centerline to within  0.001 foot 

Location is  4.54 feet to port of ship's centerline and 1.583 feet starboard of IMU.
•  Granite block is aligned with IMU to within 0.003 feet longitudinally. 

* elevation check adjusted for target that created 10 
mm offset = 0.03281 feet
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Array Acoustical Centers - Referenced to IMU 

EASTING NORTHING ELEVATION

PORT ARRAY (81-60) 25.149 1.619 14.956

Explanation of Calculations
Acoustic center is defined as the center of the transmitter array with the 
elevation = 83 mm below mounting face of array.

Easting
Center of array is defined by the foundation plate bolt centerlines (1/2 distance between bolts)

27.008 Forward edge of foundation as measured 
- 0.104 Forward edge of foundation to centerline of forward bolt hole
- 1.755 Distance from bolt hole centerline to center of array 
25.149 feet forward of IMU 

Northing
Center of array is defined as the mid-point between the bolt holes on the foundation. 

1.369 Port edge of foundation  as measured 
+ 0.078 Port edge of foundation to centerline of bolt hole - per Cascade General 
 + 0.172 Distance from bolt hole centerline to array center 

1.619 feet starboard of IMU

Elevation 
Per Reson drawing 2148M011_001  the elevation is 83 mm below array mounting surface

14.679 Array foundation elevation as measured. 
  0.005 Isolation "shim" added between foundation and array 
  0.272 83 mm below array mounting surface to acoustical center 
14.956 feet below IMU 
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Array Acoustical Centers - Referenced to IMU 
EASTING NORTHING ELEVATION

STARBOARD ARRAY (81-11) 27.072 9.41 15.042

Explanation of Calculations
Acoustic center is defined as midpoint of the transmitter array in the longitudinal and transverse axes. 
The elevation is defined as the center of the receiving array. 

Easting
Center of array is defined as 0.235' aft of the forward bolt centerlines on transmitter array foundation

28.563 Forward edge of foundation fixture plate as measured (receiving plate forward edge)
27.349 Forward edge of transmitter array foundation as calculated 

 - 0.042 Forward edge of foundation to centerline of forward bolt hole - per design
 - 0.235 Distance from bolt hole centerline to center of array - per design
27.072 feet forward of IMU 

Northing
Center of array is defined as the mid-point between the bolt holes on the transmitter array foundation.

9.410 Centerline of array foundation as measured on scribe - aft section of fixture plate
9.410 feet starboard of IMU

Elevation 
Elevation is 0.401 feet above receiver array mounting surface

16.085 Mounting foundation fixture plate as measured. 
15.447 Receiver foundation elevation - as calculated 

 + 0.005 Isolation "shim" added between foundation and array 
 - 0.410 Design distance from mounting surface of array to acoustic center 
15.042 feet below IMU 
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Longitudinal Array Foundation - Port Side 
EASTING NORTHING ELEVATION

Horizontal alignment measured  at port edge of array foundation
1.369
1.369

Forward edge of array foundation - measured
27.008

Horizontal alignment - calculated  to array centerline 
1.619
1.619

deviation from 
Elevation checks near four corners of array foundation level (average)

14.680 0.001
14.681 0.002
14.678 -0.001
14.677 -0.002

SUMMARY 
•  Port longitudinal array foundation average elevation is 14.679 feet.

Variation in elevation is +0.002 to -0.002 feet.
•  Port longitudinal array foundation is parallel to ship's centerline and 1.369 feet starboard of IMU.

Calculated array centerline is 1.619 feet starboard of IMU 

Foundation edge is 0.25 feet port of 
array centerline
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Longitudinal Array Foundation - Starboard Side 
EASTING NORTHING ELEVATION deviation from 

Horizontal alignment measured  on fixture plate scribe - parallel
9.410 0.002
9.406 -0.002

Forward edge of array foundation fixture plate - measured
28.563

deviation from
Elevation checks near four corners of array foundation "fixture plate" average

16.085 0.000
16.085 0.000
16.084 0.000
16.085 0.000

Calculated locations of longitudinal and transverse array foundations
Forward edge
Receiver (transverse) 28.563
Transmitter (longitudinal) 27.349

difference = 1.214

NOTE:   On Transmitter array foundation - from forward edge to center of forward holes = 0.042'
On Receiver array foundation distance from forward edge to center of forward holes = 0.076'

Calculated elevation of longitudinal and transverse array foundations
Receiver/Transverse Foundation 15.446
Transmitter/Longitudinal Foundation 15.709

difference = 0.263

SUMMARY 
•  Starboard longitudinal array foundation (measured at fixture plate) average elevation is 16.085 feet.

Deviation from level (average elevation) is less than 0.001 feet. 
•  Starboard longitudinal array foundation averages 9.408 feet starboard of IMU.

Variation from parallel is from -0.002  feet to +0.002 feet from average. 
•  Starboard longitudinal array foundation forward edge is 28.563 feet forward of IMU. 

Design location is 3.292 feet 
starboard of ship centerline 
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Transverse Array Foundation - Port Side
EASTING NORTHING ELEVATION

Forward Edge - Transverse array foundation - measured
28.343
28.338

Port edge - Transverse array - measured
-0.181

Centerline of array - calculated  
28.093
28.088

Port edge of foundation plus 1.806 feet 1.624
to calculated array centerline 

deviation from 
Elevation checks near four corners of array foundation level

14.679 0.002
14.675 -0.001
14.675 -0.001
14.677 0.001

SUMMARY 
•  Transverse array foundation average measured elevation is 14.677 feet 

below IMU (0.006 feet above design location).
Deviation from level (average elevation) is 0.003 to -0.001 feet

•  Transverse array foundation centerline (calculated) averages 28.090 feet forward of IMU.
Variation from parallel to ship's centerline is from -0.003 to 0.003 feet (from average). 

•  Transverse array centerline is calculated to be 1.624 feet starboard of IMU. 

Foundation forward edge minus        
0.25 feet to array centerline

0.861 feet below baseline with 0.965 
foot offset = 98.180 feet average 
elevation
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Transverse Array Foundation - Starboard Side

NOTE: Direct Measurements were not taken to the transverse array because a single "fixture plate" covered bo
transmitter and receiver foundations. The data provided here is primarily "calculated".

EASTING NORTHING ELEVATION

Forward edge - as measured on fixture plate
Receiver - (transverse) 28.563

as measured 
Transmitter  (longitudinal) 27.349

difference = 1.214

NOTE:   On Transmitter array foundation - from forward edge to center of forward holes = 0.042'
On Receiver array foundation distance from forward edge to center of forward holes = 0.076'

Horizontal Alignment 9.406
centerline scribe on fixture plate 
as measured - forward portion of plate
(near receiver array)
Average of measurements on fixture plate 9.408

Elevation of longitudinal and transverse array foundations
Receiver/Transducer Transverse Foundation 15.446
Transmitter/Longitudinal Foundation 15.709

difference = 0.263
Based on measured elevations averaging 16.085 feet across fixture plate

SUMMARY
•  Transverse array foundation is calculated to be 15.446 feet below IMU - calculated from measured elevation 

of 16.085 feet.  Deviation in elevation measurements across the  array fixture plate is less than 0.001 fe
•  Transverse array foundation forward edge (measured) is 28.563 feet forward of IMU.
•  Transverse array centerline is measured to be 9.406 feet starboard of IMU. 

Variation from parallel of the fixture plate across entire starboard array is ± 0.002  feet (from average). 
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Antennae
EASTING NORTHING ELEVATION

Stbd POS MV Antenna -Location -35.866 12.925 -38.209
Port POS MV Antenna - Location -35.739 -0.409 -38.283

Foundation Plate Stack Antenna Alignment 7.677
Foundation Plate Stack Antenna Alignment 7.677

Port GYRO Foundation Plate Alignment 2.411
Port GYRO Foundation Plate Alignment 2.411

Stbd GYRO Foundation Plate Alignment 3.866
Stbd GYRO Foundation Plate Alignment 3.867

SUMMARY
•  Foundation plate stack antenna alignment is parallel to ship's centerline.
•  Port GYRO Foundation Plate is aligned parallel to ship's centerline.
•  Starboard GYRO Foundation Plate is aligned parallel to ship's centerline.
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Fill in Yellow squares only!
Measuring Party:
Waterline Measurements should be Negative!

Date: 4/7/2009 Dn 097
Fuel Level: .5+

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0327 -0.0443 -0.0770

Stdev

BM Z-value (m) BM C to WL Average (m)
BM C to WL (m) -0.927 (This value added to 1010_Offsets & Measurements_200X.xls)

Individual -0.88217 -0.93783
measurement -0.88617 -0.94483
StDev for TPU xls 0.04986 -0.89617 -1.01283 utilized in Offsets and Measurements and TPU spreadsheet
(of 6 #'s)

-0.8680

-88.5

Benchmark A to Waterline

-86.80

-86.6 -89.2

-87.6 -96.0

Waterline Measurements
Rice, Argento, Campbell, Beduhn

1010

-86.2

Benchmark B to Waterline

-0.965
-0.02017 -0.05283

-0.9123

-91.23

0.041430.00721

-0.888



All offsets are in the Theodolite Coordinate System
BM E x 1.665536 Port Ant x 2.316862

y -0.892424 y -0.886431
z 1.612667 z Unknown

BM F x 1.668082 Stbd Ant x 2.324270
y -0.001217 y 0.952574
z 1.649000 z Unknown

BM G x 1.668115
y 0.957794
z 1.578000

Measuring Party (fill in yellow spaces only): Date: Serial #- Port Serial #- Stbd
4/7/2009

z Values

60162863 60145247Rice, Argento, Campbell, Beduhn

This spreadsheet is designed to compute the z-values of the phase centers of 
the new POS M/V antenna.

z-Values
Distances Ant. Base Phase Center
Port Ant to BM 'E' 0.693 0.693 0.693 0.70575 1.884369 1.930369
Port Ant to BM 'F' 1.11 1.11 1.112 1.1234167 1.888889 1.934889
Port Ant to BM 'G' 1.967 1.97 1.97 1.98175 1.902489 1.948489

1.886629 1.932629 AVERAGE
0.0094 STDEV

Stbd Ant to BM 'E' 1.959 1.964 1.962 1.9744167 1.858381 1.904381
Stbd Ant to BM 'F' 1.166 1.167 1.167 1.1794167 1.874221 1.920221
Stbd Ant to BM 'G' 0.707 0.705 0.705 0.7184167 1.870499 1.916499

1.872360 1.918360 AVERAGE
Antenna Post Diameter Radius 0.0083 STDEV

0.0255 0.01275

The distances from the antenna post to each benchmark was measured 
three times and averaged. The post offset to phase center (radius) was then 
added.

The distance is 0.046m (4.60cm) from the bottom of the 
antenna to the Phase center, obtained from the POSM/V 
v4 guide, see image above. 



79
Date DN

Serial Number of Transducer
2701011

Campbell, Argento, Beduhn
Personnel

Offsets from Aft Benchmark to Phase Center of Transducer

3/20/2009 Launch 1010
Vessel

Instructions: The purpose of this measurement is to check for 
gross movement of the tranducer.  Fill in yellow spaces only.

While the boat is in the cradle, gently lower the transducer and 
lock it in place.  Using a metric tape measure, plumb bob and 
carpenter's level, measure the horizontal and vertical offsets from 
the aft benchmark (BM H) to the phase center of the transducer.  
The phase center is measured at the forward edge of the black 
insulating layer, as shown in the photos.  If you have trouble 
locating the center, borrow a compass from the navigation 
department.

Notwithstanding a major accident, BM H will be outboard, aft and 
higher than the phase center; as such, enter all offsets as positive 
numbers (in cm) and the proper signs will be applied.  

Once offsets have been measured, apply a digital level to the IMU 
to determine any pitch or roll bias in the orientation of the launch.  
For the purposes of this spreadsheet, a positive angle (measured 
in degrees) will imply the bow is higher than the stern and the port 
side is higher than the starboard side.

All measurements should be done in triplicate to aid in the 
calculation of the uncertainty (needed in the HVF).  The IMU to 

BM H

Offset Measurements (positive cm): Average Angle Bias (deg):
Bow-Stern 10.6 10.7 11.0 10.8 Bow Up Bow-Stern 0.16
Port-Stbd 15.9 15.9 15.8 15.9 Port Up Port-Stbd 0.05
Up-Down 35.5 35.4 36.0 35.6 The measuring crew should Up-Down 0.30

 insure there will be no yaw bias.
BM H to Phase Center IMU to Phase Center

(Theodolite Coordinate System) (CARIS Coordinate System)

x #REF! cm x #REF! m

y #REF! cm y #REF! m

z #REF! cm z #REF! m

Measured by NOAA Personnel Calculated Value for check purposes
inserted into Offset Worksheet, 
if to be used in IMU to 8101 calculation

Std Dev:

These 2009 values were not used for the hvf 
offsets due to the angle bias not being entered. 
The 2008 values were used instead and the 2009 
values were used as a check that the unit had not 
been displaced.

Phase Center values will be calculated automatically.



 1010 Offsets and Measurements - Summary

Measurement IMU to RP* 8101 to RP*
aka
Coord. Sys. Caris Caris Caris Caris Caris
x 0.000 0.250 0.250 1.147 n/a
y 0.000 -0.133 -0.133 1.066 n/a
z 0.000 0.549 0.549 3.665 -0.256

*IMU is RP (Reference Pt)

Vessel Offsets for 1010_8101 are derived from the Horizontal, Vertical & XYZ worksheets in this spreadsheet. 2008 Measured Values

Coord. Sys.
Theodolite IMU (m) x 3.516 IMU (m) x 3.516 IMU (m) x 3.516

y 0.011 y 0.011 y 0.011
z -1.183 z -1.183 z -1.183

BM H x 3.271447 Port Antenna x 2.317 BM C x 0.000
y 0.425598 y -0.886 y 0.000
z -1.37667 z 1.933 z 0.000

IMU x -0.244 IMU to x -1.199 BM C to IMU
to BM H y 0.415 Port Antenna y -0.897 x n/a

z -0.194 z 3.116 y n/a
z -1.183

BM H to x 11.10496 IMU to x -0.133
Phase Ctr (cm)   y -16.466 Phase Ctr y 0.250 BM C to Waterline
measured z -35.540 z -0.549 measured x n/a

y n/a
BM H to x 0.11105 z -0.927
Phase Ctr (m)     y -0.16466

z -0.3554
see 

Coord. Sys.
Theodolite IMU to x -0.133 x 1.066 x n/a

Phase Ctr y 0.250 y 1.147 y n/a
z -0.549 z -3.665 z 0.256

Coord. Sys. CARIS Coord. Sys. CARIS Coord. Sys. CARIS
x 0.250 x 1.147 x n/a
y -0.133 y 1.066 y n/a
z 0.549 z 3.665 z -0.256

RP* to Waterline

RP to Waterline

RP to WaterlineIMU to 8101 IMU to 8101 Port Ant to 8101

Nav to Trans x,y,zSWATH1 x,y,z  & MRU to Trans
Port Ant to 8101

Port Ant to 8101

IMU to 8101

8101 to RP* IMU to 8101
Calculations



 1010 Offsets and Measurements - Summary

Caris Pos/Mv Caris Pos/Mv
Scalar Distance 1.839 -0.897 -1.199 -0.011 -1.176

-1.199 -0.897 -1.176 -0.011
-3.117 -3.117 -0.243 -0.243

2009 Measured Values 2007 Measured Values

Port Ant (m) x 2.317 IMU (m) x 3.516 IMU (m) y 0.011
y -0.886 y 0.011 x is n/a z -1.183
z 1.933 z -1.183

Heave Pt (m)
Stbd Ant (m) x 2.324 Port Ant (m) x 2.317 (centerline) y 0.000

y 0.953 y -0.886
z 1.918 z 1.934 BM C to Waterline (m) -0.940

measured scalar dist 

BM C
x&y are n/a z 0.000

BM C to Waterline (m)
(Heave Pt) z -0.940

IMU to LCG x -1.176
See IMU to Heave tab

x -1.199 x -1.176
Scalar Distance 1.839 y -0.897 y -0.011

z 3.117 z 0.243

Coord. Sys. Pos/Mv Coord. Sys. Pos/Mv
x -1.199 x -1.176
y -0.897 y -0.011
z -3.117 z -0.243

See IMU to Heave tab

IMU to Port Antenna

Port Ant to Stbd Ant IMU to Port Antenna IMU to Heave

IMU to Heave

IMU to Port Antenna IMU to Heave

Port Ant to Stbd Ant

Port Ant to Stbd Ant

Values in the POSMV remained as entered in 2008. 



Description of Offsets for Launch 1010
All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 1010 was based from benchmark (BM) C as the 0 point.  Physical locations were measured with x,y,z offsets 
from this point.  These locations were used to calculate offsets of items with respect to each other, as described for each offset.

x=0.250

z=0.549

z=3.665

x=1.147

z=-3.112

x=-0.897
1.839

z=-0.243
x=-0.011

z=0.549

y=-0.133

z=3.661

y=1.066

z=-0.256

z=-3.117

y=-1.199

z=-0.243
y=-1.176



x y z x y z x y z x y z x y z
0.250 -0.133 0.549 1.147 1.066 3.665 N/A N/A -0.256 -0.897 -1.199 -3.117 -0.011 -1.176 -0.243

IMU to Port Antenna IMU to Heave
Scalar Distance

1.839

IMU to 8101 Port Ant to 8101 RP to Waterline Port Ant to Stbd Ant

The physical positions of the IMU 
and the phase center of the 8101 
with respect to the Ship 
Reference Frame were 
measured by NOAA personnel.  
These physical measurements 
were used to calculate the xyz 
offsets from the IMU to BM H. 
Measurements from BM H to the 
Phase Center of the 8101 were 
collected by NOAA personnel 
while the boat was secured on 
the pier and thought to be as 
level as possible.  The measured 
offsets from BM H to the phase 
center were then added to the 
offset from the IMU to BM H.  
The result is the offset from the 
IMU to the phase center of the 
transducer.  The values in the X 
and Y fields are transposed and 
the inverse of the Z value is used 
to give the offsets in CARIS 
coordinates.

NOAA personnel calculated the 
distance between the port 
antenna and the phase center of 
the port antenna subtracting  the 
IMU to Port Antenna value from 
the IMU to Phase Center value.   

The average vertical distance 
from BM A and B to the waterline 
was measured by 
FAIRWEATHER personnel using 
a steel tape and bubble level.  
These values were used to 
calculate the BM C to the 
waterline value.  With the 
knowledge of the BM C height 
above the IMU, the waterline 
height above the IMU could be 
calculated.  On launch 1010, the 
IMU is used as the reference 
point.  

The location of the IMU and the 
location of the port antenna were 
measured by NOAA personnel 
with respect to the Ship 
Reference Frame (SRF).  The 
xyz offsets from the IMU to the 
port antenna could be calculated 
from these physical locations. 

The heave point was positioned 
differently on each of the axes.  
The distance for the longitundinal 
axis was determined as 
described in the "IMU to Heave" 
tab in this workbook.  The 
athwart ships axis was the vessel
centerline.  Lastly, the waterline 
was used as the height of the 
heave point, which was 
calculated earlier in 'RP to 
Waterline'.  

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
measured by NOAA personnel 
with respect to the SRF.  The 
scalar distance between the 
phase centers was then 
calculated. 



1010 Vessel Diagram
All Values Shown are in Theodolite Coordinates

Note:   Both antenna have been replaced for the POS 
V4.  While their x-y values are not thought to have 
changed, the z-value has been remeasured.
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Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: FAIRWEATHER Vessel: 1010
Date: 4/15/2009 Dn: 105
Personnel: W Renoud, L Morgan, T Beduhn

PCS Serial # IMU Serial #

IP Address: 129.100.1.231

Port Antenna Serial # Stbd Antenna Serial #

POS controller Version (Use Menu Help > About) 3.4.0.0

POS Version (Use Menu View > Statistics)

GPS Receivers
Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:
Approximate Position: Lat 47 43 41

Lon 122 16 30

DGPS Beacon Station: DGPS Receiver Serial#:
Frequency: 302HZ

294

MV-320,VER4,S/N2564,HW2.6-7,SW03.42-May28/07,ICD03.25, 
OS425B14,IMU2,PGPS13,SGPS13,RTK-0,THV-0,DPW-0

60162863 60145247

NOAA POS/MV Calibration Report

Lake Washington, N of Sandpoint

2564

Whidbey 0331-12579-0008

4624A70264

4622A68956



Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

PDOP 1.736 (Use View> GAMS Solution)

POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Configuration Notes:

Secondary GPS



POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time:
End time:
Heading accuracy achieved for calibration: 0.091°

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

GAMS Status Online X
Save Settings X

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: 1010_Dn105_POS_Config_new.nvm

General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:
a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.



SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

COM2

COM3

COM4

COM5



SETTINGS Continued
Heave Filter (Use Settings > Heave)

Events (Use Settings > Events)

Time Sync (Use Settings > Time Sync)

User Time Conversion (Units/Sec.)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)



Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

Frame Control (Use Tools > Config)

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled

GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

4/17/2009
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

4/17/2009
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

0:00 51
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

0:00 51
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

0:00 15 20
SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

TH_1010_107

47/39/15.82 122/15/31.53

09107210.0nv 47/39/08.84 122/14/06.18

Launch 1010

Marcum, Rice, Forney, Beduhn

Rice, Beduhn, Forney, Marcum

not availableSwing Arm-Hull Mount

107

Reson 8101

357372701011

4/15/2009

Lake Washington, Seattle, Washington

09107175_4616.5nv

Swing Arm

10m-80m

5-10kt, >1ftLake Washington

DGPS - Woodby Island

3/20/2009

09107202.3nv

107

Beacon: 302 Hz Whidbey, MBES lines 2009__1071850_1 through 2009__1072047_5, 24 lines collected

47/39/01.97 122/16/17.32



NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

1 271 5.4
1 093 5.1
1 272 5.0
1 091 5.0
1 272 2.9
1 090 2.7
1 272 2.5

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

1 2009__1071850_1 272 4
1 2009__1071910_1 92 4
1 2009__1071905_1 93 4
1 2009__1071907_1 271 4
1 2009__1071903_1 270 4

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

1 2009__1071945_4 272 4
1 2009__1071938_4 272 4
1 2009__1071935_4 94 4
1 2009__1071941_4 93 4
1 2009__1071955_2 092 4
1 2009__1071959_2 272 4
1 2009__1071949_2 092 4
1 2009__1071952_2 272 4

ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

2 2009__1072043_5 04 3.8
2 2009__1072039_5 183 3.5
2 2009__1072047_5 184 3.5
2 2009__1072035_5 03 3.9

XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

XTF Line Filename

XTF Line Filename

XTF Line Filename

2009_1071925_1

2009_1071917_1

S

2009_1071914_1

N
N
N

S

N

S

2009_1071923_1

2009_1071929_1

2009_1071931_1

S

2009_1071927_1



Processing Log
4/18/2009
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
-0.05 0.20 1.50 0.50
0.02 -0.35 1.50 0.35
0.01 0.43 1.48 0.28
0.06 1.48
0.02 0.00 1.46 0.20
0.00 -0.40 1.48 0.60

0.01 -0.02 1.48 0.39
0.04 0.36 0.04 0.02 0.16 0.08
0.00 -0.02 1.48 0.39

Resulting HVF File Name
Actual values used

MRU Align StdDev gyro 0.16 Value from standard deviation of Heading offset values 0.075
MRU Align StdDev 
gyro

MRU Align StdDev Roll/Pitch 0.19 Value from averaged standard deviations of pitch and roll offset values 0.025
MRU Align StdDev 
Roll/Pitch

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 04/24/09CST/FOO/Welton

na

PATCH TEST RESULTS/CORRECTORS

FOO Ringel
B. Welton

FINAL VALUES
Standard Deviation

averages with outliers removed

Data converted --> HDCS_Data in CARIS

108 Welton

Final Values based on

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias
Compute correctors in this order

Lines from Dn108 (2009_1081822_11 through 2009_1082211_2) were also utilized to assess patch test values.

CST Morgan

G. Rice
N.Morgan
A. Raymond

Averages

Do not enter/apply correctors until all evaluations are complete and analyzed.

Initial MRU values were too high, TPU values reassessed with outliers removed.

FA_1010_Reson8101_2009.hvf

Dn108 did not have True Heave applied as the Pos file was not logged, therefore a full patch write-up was not conducted.

Removed N. Morgan pitch (-1.6 deg) and yaw (1.62) values from the averages as outliers.  



Ellipsoid Referenced Dynamic Draft Launch 1010

4/17/2009 107 Lake Washington Rice
Date DN Local Area Processor

SEAI TH_1010_107.000.002 1018_ERDDM.txt
Primary Station POSPac File SBET File

proc_erddm.py, v0.12 4
Processing Method Coefficients



2009 HVF Values
2009-ERDDM-Descrete

speed (m/s) draft (m)
0 0

0.5 -0.05
1 -0.07

1.5 -0.06
2 -0.03

2.5 -0.01
3 0.01

3.5 0.02
4 0.02

4.5 -0.01
5 -0.05

5.5 -0.1
6 -0.17

2008 2007 2006

speed (m/s) draft (m) speed (m/s) draft speed (m/s) draft
0 0 0 0 0 0

2.68 0.08 2.58 -0.041 2.385 -0.07
3.81 0.11 3.1 -0.031 3.205 -0.03
4.68 0.17 3.98 0.023 4.2 -0.02
5.92 0.08 4.6 0.053 5.065 -0.01

5.17 0.102 6.29 -0.03
5.37 0.089

Dynamic Draft Comparison

-0.2

-0.15

-0.1

-0.05

0

0.05

0.1

0.15

0.2

0 1 2 3 4 5 6 7 8

Speed (m/s)

D
ra

ft 
(m

)
2009-ERDDM-Descrete

2008

2007

2006



Reference Surface Acquisition Log
Vessel

4/18/2009 108
Date Dn Local Area Wx

Personnel

Comments

1727 34 44.2
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

2110 37.1 48.2
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast # XTF Line Filename Heading Line Type Remarks
240 ref
061 ref
240 ref
061 ref
240 ref
061 ref

ref
ref
ref
ref north_south

150 ref
345 ref
155 ref
345 ref

2158 161 ref
132 Heading
312 Heading
132 Heading
312 Heading

Launch 1010

09108211.0nv 47/40/30.96 122/25/31.12

122/25/35.7047/40/27.30009108172.7nv

Andrews, Rice, Beduhn, Raymond

Shilshole Reference Surface <1ft, <5kts

2009_1082123_3
2009_1082126_7
2009_1082128_8
2009_1082130_5
2009_1082132_4
2009_1082135_9
2009_1082137_9
2009_1082139_10
2009_1082142_11

2009_1082149_13
2009_1082151_1

2009_1082146_12

2153
2155

2009_1082208_1
2009_1082207_1

2009_1082211_2
2009_1082210_2

east-west
east-west
east-west
east-west
east-west
east-west
north-south
north-south
north-south

north-south
north-south
north-south
north-south
north-south

2110



Measurement
aka SWATH1 x,y,z  & MRU to Trans Nav to Trans x,y,z
Coord. Sys. Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x -0.396 0.502 n/a Scaler Distance 1.834 -0.898 -1.101 0.015 -1.114
y 0.982 2.082 n/a -1.101 -0.898 -1.114 0.015
z 0.751 3.919 -0.333 -3.161 -3.161 -0.336 -0.336

Vessel Offsets Horizontal,  Vertical & XYZ worksheets in this spreadsheet. 2009 Measured Value

Calculations
Coord. Sys.
Theodolite IMU (m) x 3.54587 IMU (m) x 3.545867

y -0.01516 y -0.01516
z -0.85883 z -0.85883

BM H x 3.30204 Port Ant (m) x 2.445
y 0.43081 y -0.913
z -1.0485 z 2.309

IMU x -0.244 IMU to x -1.101
to BM H y 0.446 Port Antenna y -0.898

z -0.190 z 3.168

BM H to x 122.533 IMU to x 0.982
Phase Ctr (cm)   y -84.216 Phase Ctr y -0.396
measured z -56.133 z -0.751

BM H to x 1.225
Phase Ctr (m)     y -0.842

z -0.561

Coord. Sys.
Theodolite IMU to x 0.982 x 2.082

Phase Ctr y -0.396 y 0.502
z -0.751 z -3.919

Coord. Sys. CARIS Coord. Sys. CARIS
x -0.396 x 0.502
y 0.982 y 2.082
z 0.751 z 3.919

IMU to HeaveRP* to Waterline  Port Ant to Stbd Ant IMU to Port AntIMU to 8125 Port Ant to 8125

IMU to 8125 Port Ant to 8125

IMU to 8125 Port Ant to 8125



Description of Offsets for Launch 1018
All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 1018 was based from benchmark (BM) C as the 0 point.  Physical locations were measured with x,y,z offsets from this point.  These locations 
were used to calculate offsets of items with respect to each other, as described for each offset.

x=0.282

z=0.548

z=3.717

x=1.181

z=-3.161

x=-0.898
1.834

z=-0.296
x=0.015

z=0.548

y=-0.145

z=3.717

z=-0.333

y=0.955

z=-3.161

y=-1.101

z=-0.336
y=-1.114

x=-0.396
z=0.751

y=0.982
z=0.751

y=2.082

z=3.919

x=0.502

z=3.919



x y z x y z x y z x y z x y z
0.282 -0.145 0.548 1.181 0.955 3.717 N/A N/A -0.333 -0.898 -1.101 -3.161 0.015 -1.114 -0.336

x y z x y z
-0.396 0.982 0.751 0.502 2.082 3.919

IMU to 8101 Port Ant to 8101 RP to Waterline Port Ant to Stbd Ant IMU to Port Antenna

IMU to 8125

IMU to Heave
Scalar Distance

1.834

Port Ant to 8125

The physical positions of the IMU 
and the phase center of the 8101 
with respect to the Ship 
Reference Frame were 
measured by NOAA personnel.  
These physical measurements 
were used to calculate the xyz 
offsets from the IMU to BM H. 
Measurements from BM H to the 
Phase Center of the 8101 were 
collected by NOAA personnel 
while the boat was secured on 
the pier and thought to be as 
level as possible.  The measured 
offsets from BM H to the phase 
center were then added to the 
offset from the IMU to BM H.  
The result is the offset from the 
IMU to the phase center of the 
transducer.  The values in the X 
and Y fields are transposed and 
the inverse of the Z value is used 
to give the offsets in CARIS 
coordinates.

NOAA personnel calculated the 
distance between the port 
antenna and the phase center of 
the port antenna subtracting  the 
IMU to Port Antenna value from 
the IMU to Phase Center value.   

The average vertical distance 
from BM A and B to the waterline 
was measured by 
FAIRWEATHER personnel using 
a steel tape and bubble level.  
These values were used to 
calculate the BM C to the 
waterline value.  With the 
knowledge of the BM C height 
above the IMU, the waterline 
height above the IMU could be 
calculated.  On launch 1018, the 
IMU is used as the reference 
point. 

The location of the IMU and the 
location of the port antenna were 
measured by NOAA personnel 
with respect to the Ship 
Reference Frame (SRF).  The 
xyz offsets from the IMU to the 
port antenna could be calculated 
from these physical locations. 

The heave point was positioned 
differently on each of the axes.  
The distance for the longitundinal 
axis was determined as 
described in the "IMU to Heave" 
tab in this workbook.  The 
athwart ships axis was the vessel 
centerline.  Lastly, the waterline 
was used as the height of the 
heave point, which was 
calculated earlier in 'RP to 
Waterline'.  

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
measured by NOAA personnel 
with respect to the SRF.  The 
scalar distance between the 
phase centers was then 
calculated. 



1018 Vessel Diagram
All Values Shown are in Theodolite Coordinates

Note:   Both antenna have been replaced for the POS 
V4.  While their x-y values are not thought to have 
changed, the z-value has been remeasured.



Fill in Yellow squares only!
Measuring Party:
Waterline measurements should be negative!

Date: 4/7/2009
Fuel Level: 0.75

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0237 -0.0060 -0.0297

Stdev

BM Z-value (m) BM C to WL Average (m)
BM C to WL (m) -0.526 (Add this value to 1018_Offsets & Measurements_200X.xls)

Individual -0.50867 -0.53433
measurement -0.51367 -0.54533
StDev for TPU xls 0.016742 -0.51167 -0.54333 utilized in Offsets and Measurements and TPU spreadsheet
(of 6 #'s)

Measuring Party:

Date: 4/16/2009
Fuel Level: half full

Measure 1 Draft Tube: na

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0237 0.0040 -0.0197

Stdev

BM Z-value (m) BM C to WL Average (m)
BM C to WL (m) -0.533 (or add this value to 1018_Offsets & Measurements_2008)

Individual -0.52467 -0.54633
measurement -0.52367 -0.54633
StDev for TPU xls 0.011572 -0.52067 -0.53533
(of 6 #'s)

-82.4 -82.2

1018

-0.523 -0.543

0.00208 0.00635

0.29933 0.27567

-82.23

-0.8183

-82.3 -82.2

-82.0 -81.1

-81.83

-0.8223

Benchmark A to Waterline Benchmark B to Waterline

-80.8 -81.0

-81.9

-81.67

0.29933

0.00252 0.00586

1018
Benchmark A to Waterline Benchmark B to Waterline

-0.541

-81.3 -82.1

-0.8167

-81.1

-81.07

-0.8107

Waterline Measurements
Rice, Argento, Campbell, Beduhn

Raymond, Welton

0.27567
-0.511



All offsets are in the Theodolite Coordinate System
BM E x 1.825761 Port Ant x 2.445325

y -0.861405 y -0.913449
z 2.018667 z Unknown

BM F x 1.826865 Stbd Ant x 2.444676
y -0.002043 y 0.920569
z 2.054333 z Unknown

BM G x 1.828354
y 0.918931
z 1.998333

Measuring Party (fill in yellow spaces only): Date: Serial #- Port Serial #- Stbd
4/7/2009

z-Values
Distances Ant. Base Phase Center
Port Ant to BM 'E' 0.652 0.652 0.653 0.665083 2.254818 2.300818
Port Ant to BM 'F' 1.109 1.11 1.111 1.12275 2.272081 2.318081
Port Ant to BM 'G' 1.941 1.945 1.943 1.95575 2.292759 2.338759

2.263449 2.309449 AVERAGE
0.019 STDEV

Stbd Ant to BM 'E' 1.884 1.882 1.889 1.89775 2.225956 2.271956
Stbd Ant to BM 'F' 1.111 1.112 1.113 1.12475 2.233664 2.279664
Stbd Ant to BM 'G' 0.648 0.647 0.647 0.660083 2.234669 2.280669

2.234166 2.280166 AVERAGE
Antenna Post Diameter Radius 0.005 STDEV

0.0255 0.01275

Rice, Argento, Campbell, Beduhn 60145158 60130644

This spreadsheet is designed to compute the z-values of the phase 
centers of the new POS M/V antenna.

The distances from the antenna post to each benchmark was measured 
three times and averaged. The post offset to phase center (radius) was 
then added.

The distance is 0.046m (4.60cm) from the bottom of 
the antenna to the Phase center, obtained from the 
POSM/V v4 guide, see image above. 



79
Date DN

Serial Number of Transducer

Offset Measurements (positive cm): Average Angle Bias (deg):
Bow-Stern 8.7 8.7 8.8 8.7 Bow Up Bow-Stern 0.06
Port-Stbd 15.9 15.9 15.8 15.9 Port Up Port-Stbd 0.06
Up-Down 35.5 35.4 36.0 35.6 The measuring crew should Up-Down 0.32

 insure there will be no yaw bias.

BM H to Phase Center IMU to Phase Center (8101)
(Theodolite Coordinate System) (CARIS Coordinate System)

x 8.733 cm x 0.287 m

y -15.867 cm y -0.156 m

z -35.633 cm z 0.546 m

Measured by NOAA Personnel Calculated Value for check purposes
inserted into Offset Worksheet, 
if to be used in IMU to 8101 calculation

Offsets from Aft Benchmark to Phase Center of Transducer

3/20/2009

3102026

launch 1018 Campbell, Argento, Rice, Beduhn
Vessel Personnel

These 2009 values were not used for the hvf 
offsets due to the angle bias not being 
entered. The 2008 values were used instead 
and the 2009 values were used as a check 
that the unit had not been displaced.

Std Dev:

* see Math Explanation tab

Instructions:  The purpose of this measurement is to check for 
gross movement of the tranducer. Fill in yellow spaces only. 

While the boat is in the cradle, gently lower the transducer and 
lock it in place.  Using a metric tape measure, plumb bob and 
carpenter's level, measure the horizontal and vertical offsets from 
the aft benchmark (BM H) to the phase center of the transducer.  
The phase center is measured at the forward edge of the black 
insulating layer, as shown in the photos.  If you have trouble 
locating the center, borrow a compass from the navigation 
department.

Notwithstanding a major accident, BM H will be outboard, aft and 
higher than the phase center; as such, enter all offsets as positive 
numbers (in cm) and the proper signs will be applied.  

Once offsets have been measured, apply a digital level to the IMU 
to determine any pitch or roll bias in the orientation of the launch.  
For the purposes of this spreadsheet, a positive angle (measured 
in degrees) will imply the bow is higher than the stern and the port 
side is higher than the starboard side.

All measurements should be done in triplicate to aid in the 
calculation of the uncertainty (needed in the HVF).  The IMU to 
Phase Center  values will be calculated automatically.

BM H



119
Date DN

Serial Number of Transducer

Offset Measurements (positive cm): Average Angle Bias (deg):
Bow-Stern 123.2 122.0 122.4 122.5 Bow Up -0.5 Bow-Stern 0.61
Port-Stbd 84.2 84.4 84.1 84.2 Port Up -2.0 Port-Stbd 0.15
Up-Down 55.7 56.2 56.5 56.1 The measuring crew should Up-Down 0.40

 insure there will be no yaw bias.

BM H to Phase Center IMU to Phase Center (8125)
(Theodolite Coordinate System) (CARIS Coordinate System)

x 122.533 cm x -0.396 m

y -84.233 cm y 0.982 m

z -56.133 cm z 0.751 m

Measured by NOAA Personnel Calculated Value for check purposes
inserted into Offset Worksheet, 
if to be used in IMU to 8101 calculation

Std Dev:

* see Math Explanation tab

Offsets from Aft Benchmark to Phase Center of Transducer

4/29/2009

4400007

launch 1018 Argento, Andrews, Foster, Nuckols
Vessel Personnel

Instructions:  The purpose of this measurement is to check for 
gross movement of the tranducer. Fill in yellow spaces only. 

While the boat is in the cradle, connect the 8125 sled with the 
sonar head attached.  Using a metric tape measure, plumb bob 
and carpenter's level, measure the horizontal and vertical offsets 
from the aft benchmark (BM H) to the phase center of the 
transducer.  The phase center is measured at the center middle of 
the black insulating layer below the flat faced transducer, as 
shown in the photos.  If you have trouble locating the center, 
borrow a compass from the navigation department.

Notwithstanding a major accident, BM H will be outboard, aft and 
higher than the phase center; as such, enter all offsets as positive 
numbers (in cm) and the proper signs will be applied.  

Once offsets have been measured, apply a digital level to the IMU 
to determine any pitch or roll bias in the orientation of the launch.  
For the purposes of this spreadsheet, a positive angle (measured 
in degrees) will imply the bow is higher than the stern and the port 
side is higher than the starboard side.

All measurements should be done in triplicate to aid in the 
calculation of the uncertainty (needed in the HVF).  The IMU to 
Phase Center  values will be calculated automatically.

Phase center
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Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: FAIRWEATHER Vessel: 1018
Date: 4/15/2009 Dn: 104
Personnel: Andrews, Welton, Forney, Shetler 

PCS Serial # IMU Serial #

IP Address: 129.100.1.231

Port Antenna Serial # Stbd Antenna Serial #

POS controller Version (Use Menu Help > About) 3.4.0.0

POS Version (Use Menu View > Statistics) MV-320,Ver 4
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:
Approximate Position: Lat 47 39 35.8

Lon 122 15 35.6

DGPS Beacon Station: DGPS Receiver Serial#:
Frequency: 302

2560

Whidbey Island 0328-12352-0001

4624A70243

4624A70263

007

NOAA POS/MV Calibration Report

Lake Washington, Seattle, WA

60145158 60130644



Satellite Constellation (Use View> GPS Data)

Primary GPS

PDOP 1.823 (Use View> GAMS Solution)

POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Configuration Notes:

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time: 1722 UTC
End time: 1723 UTC
Heading accuracy achieved for calibration: 0.324

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

GAMS Status Online Ready Online
Save Settings Yes

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: C:\Documents and Settings\1018acq\Desktop\POS-MV Settings\GAMS_Parameter_104_2009.nvm

Secondary GPS



General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:
a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.



SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

COM2

COM3



SETTINGS Continued
Heave Filter (Use Settings > Heave)

Events (Use Settings > Events)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)



Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

4/16/2009
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

4/16/2009
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

0:00
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

POSMV v4 GPS (DGPS corrected)

CalmL. Washington

03/20/2009

Launch 1018

Welton, ENS Morgan, Raymond, Heiner

FOO Ringel, CST Morgan, LT Welton, ENS Morgan

not available1018

106

8101

L. Washington

Hull mounted swing arm

344973102026

04/15/2009

081060818

106

TH_1018_Patch_Test_Dn105

30-190 feet



ROLL
SV Cast # Heading Speed (kts) Remarks

005_1832.81X 3 5.9 roll
183 6.0
03 6.0

PITCH
SV Cast # Heading Speed (kts) Remarks

274 5.1
092 5.1
272 5.2
092 5.1

HEADING/YAW
SV Cast # Heading Speed (kts) Remarks

91060818 274 5.1
092 5.1
272 5.2
092 5.1

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

272 4.8
092 8.0

092 5.1

Processing Log

4/16/2009
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

DN106

Do not enter/apply correctors until all evaluations are complete and analyzed.

001_1823.81X

Compute correctors in this order

timing

001_1741.81X

ENS Morgan

timing

Heading

001_1811.81X

Data converted --> HDCS_Data in CARIS

Heading

Heading (1805 overtaking boat noise)

001_1741.81X
002_1751.81X
002_1801.81X

Heading

Heading001_1730.81X

005_1838.81X
005_1844.81X

roll
roll

yes

na

zerotide.tid

yes

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

XTF Line Filename

XTF Line Filename

XTF Line Filename
001_1730.81X
001_1741.81X
002_1751.81X
002_1801.81X

XTF Line Filename



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
-0.05 -0.80 2.88 -0.40
0.00 0.30 2.86 -0.50
0.03 -0.94 2.86 -0.35
-0.03 -1.06 2.90 -0.10

-0.01 -0.63 2.88 -0.34
0.04 0.63 0.13 0.02 0.17 0.04
0.00 -0.63 2.88 -0.34

CST/FOO Averages Averages Averages

Resulting HVF File Name
Actual values used

MRU Align StdDev gyro 0.17 Value from standard deviation of Heading offset values 0.035
MRU Align StdDev 
gyro

MRU Align StdDev Roll/Pitch 0.32 Value from averaged standard deviations of pitch and roll offset values 0.075
MRU Align      
StdDev Roll/Pitch

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 4/18/09

Initial MRU values were too high, TPU values reassessed with outliers removed.

Values based on two patch tests- one performed on DN106 in Lake Washington using the bounded slope method and one 
performed on DN107on the Shilshole reference surface using the target method.  

FA_1018_Reson8101_2009

Nick
Bri

Final Values based on

Averages
Standard Deviation

FINAL VALUES

FOO (in progress)

Ringel, Welton, Morgan

PATCH TEST RESULTS/CORRECTORS

CST



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

6/27/2009
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

6/27/2009
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

Launch 1018

178 Shumagin Islands, Near Northeast Harbor

Welton, FOO Ringel, CST Morgan

8125 1018 uknown (on loan from RUDE)

4400007 31562

Sled hull mount 4/29/2009

POSMV w/ DGPS correctors 4/15/2009

178 Shumagin Islands, Near Northeast Harbor Wind lgt vrb, waves <1ft (Awesome)

rock 20-30 meters

Froelich, Francksen, Walker

2009-178_1018.000



NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks
H12702_1018_Dn1 022 6.0

PITCH view parallel to track, same line (nadir) over feature or bounded slope [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks
H12702_1018_Dn1 110 6.0

290 6.0

HEADING/YAW view parallel to track, offset lines from feature or slope (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

110 6.0
290 6.0

ROLL view across track, same line over flat area in [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks
H12702_1018_Dn1 110 6.0

290 6.0

view parallel to track, one line with induced roll (outerbeam) or same lines over bounded slope or 
feature (nadir) [run same direction, different speed]

Line Filename
2009L_1781804 roll time bias method

Line Filename
2009L_1781750
2009L_1781753

Line Filename
2009L_1781756
2009L_1781800

Line Filename
2009L_1781750
2009L_1781753



Processing Log

6/27/2009
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -0.90 -1.98 -2.20
0.00 -0.30 -1.95 -1.70
0.00 -0.40 -1.91 -1.50

0.00 -0.53 -1.95 -1.80
0.00 0.32 0.04 0.36
0.00 -0.53 -1.95 -1.80

Resulting HVF File Name

MRU Align StdDev gyro 0.36 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.18 Value from averaged standard deviations of pitch and roll offset values

178 `

Data converted --> HDCS_Data in CARIS

Previous in Time

predicted- Sand Point, AK

Compute correctors in this order
1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Do not enter/apply correctors until all evaluations are complete and analyzed.

PATCH TEST RESULTS/CORRECTORS

Welton
FOO
CST

Averages
Standard Deviation

FINAL VALUES

Final Values based on Averages

added to FA_1018_Reson8125_2009



Date 4/16/2009 DN 105 Wind calm
Vessel # 1018 Location L. Wash Seas calm

Average Depth 30m Personnel Welton, Morgan, Raymond, Heiner

RPM Speed Az Hypack Line Name                       Acquisition Comments
650 4.9 90 007_1923.81X forgot to let truheave settle prior to running into the line
850 5.9 270 007_1930.81X forgot to let truheave settle prior to running into the line
650 4.9 90 007_1942.81X
850 5.9 270 007_1952.81X

1050 7 90 007_2001.81X
1250 7.9 270 007_2008.81X

1450 8.7 90 007_2016.81X
Stop1 0 - 007_2023.81X
Stop2 0 - 007_2025.81X
Stop3 0 - 007_2028.81X

Launch DDSSM DATA ACQUISITION FORM



                                      DDSSM DATA PROCESSING AND RESULTS FORM

Date 4/18/2009 DN 106 Wind calm
Vessel # 1018 Location Seas calm

  Average Depth Personnel

SVP file loaded

Tide file loaded

Speed (m/s) Speed (Kts) Speed (RPM) Hypack Line Name CARIS Line Name Depth Loc 1 Diff Loc 1 Depth Loc 2 Diff Loc 2 Depth Loc 3 Diff Loc 3 Average

0 0 0 27.6557457 25.9568637 29.8462362

2.52 4.9 650 007_1942.81X 007_1942 27.6090035 -0.0467422 25.8629032 -0.0939605 29.7750175 -0.0712187 -0.0624817

3.07 5.9 850 007_1952.81X 007_1952 27.5795859 -0.0761598 25.844337 -0.1125267 29.7651968 -0.0810394 -0.0882821

3.66 7 1050 007_2001.81X 007_2001 27.5550541 -0.1006916 25.7653247 -0.191539 29.7330816 -0.1131546 -0.130974

4.06 7.9 1250 007_2008.81X 007_2008 27.5219777 -0.133768 25.7774865 -0.1793773 29.7278022 -0.118434 -0.1489711

Lk Washington

4.47 8.7 1450 007_2016.81X 007_2016 27.5246716 -0.1310741 25.7636516 -0.1932122 29.6939714 -0.1522648 -0.1517868

-0.25
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Ellipsoid Referenced Dynamic Draft Launch 1018

4/16/2009 106 Lake Washington Rice
Date DN Local Area Processor

SEAI TH_1018_patch_test_dn105.000.002 1018_ERDDM.txt
Primary Station POSPac File SBET File

proc_erddm.py, v0.12 4
Processing Method Coefficients



2009 HVF Values
2009-ERDDM-Descrete 2009 Bottom Referenced

speed (m/s) draft (m) speed (m/s) draft (m)

-0.2
-0.15

-0.1
-0.05

0
0.05

0.1
0.15

0.2
0.25

0 2 4 6 8D
ra

ft 
(m

)

Speed (m/s)

Dynamic Draft Comparison 2009-ERDDM-Descrete

2009 Bottom Referenced

2008

2007

2006

p ( ) ( ) p ( ) ( )
0 0 0 0

0.5 0.05 2.52 0.062
1 0.06 3.07 0.088

1.5 0.07 3.66 0.131
2 0.07 4.06 0.149

2.5 0.07 4.47 0.152
3 0.09

3.5 0.1
4 0.1

4.5 0.07
5 0

5.5 -0.15

speed (m/s) draft (m) speed (m/s) draft (m) speed (m/s) draft (m)
0 0 0 0 0 0

3.09 0.09 2.58 0.039 2.5 0.109
4.12 0.18 3.1 0.061 3 0.079
5.14 0.19 3.82 0.11 4 0.135
6.17 0.21 4.24 0.151 5.1 0.19

4.81 0.133 6 0.01
5.32 0.074

2008 2007 2006



                                         DDSSM DATA PROCESSING AND RESULTS FORM

Date 4/18/2009 DN 219 Wind calm
Vessel # 1018 Location Seas calm

  Average Depth 16 meters Personnel Welton, Rice, Beduhn

SVP file loaded 092192151.svp

Tide file loaded 946-2620 9462620.tid

Speed (m/s)Speed (Kts)Speed (RPM Hypack Line Name Depth Loc 1 Diff Loc 1 Depth Loc 2 Diff Loc 2 Depth Loc 3 Diff Loc 3 Average
0 0 0 2142 17.5421699 0 16.9987276 0 16.87650376 0

5 650 2050/2055 17.58894816 0.046778256 16.99016 -0.008567602 16.84873958 -0.027764188 0.003482155
5.5 774 2123/2128 17.56613327 0.023963362 16.96695 -0.031777602 16.89124567 0.014741905 0.002309222
6.3 890 2101/2105 17.56247363 0.020303723 16.97538 -0.023347602 16.88678976 0.010285998 0.00241404

7.1/7.2 1060 2133/2136 17.50604808 -0.036121821 16.9098 -0.088927602 16.82672642 -0.049777349 -0.058275591

Dutch Harbor, AK
NOTE: Conducted with 

sled-mounted 8125.

7.4/7.5 1120 2109/2112 17.53315974 -0.009010164 16.951 -0.047727602 16.80605949 -0.070444274 -0.042394013
8.4/8.5 1425 2116/2119 17.51770889 -0.07123927 16.916 -0.07416 16.8116773 -0.037062276 -0.060820515
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Reference Surface Acquisition Log
Vessel

4/17/2009 107
Date Dn Local Area Wx

Personnel

Comments

0944 38.8
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast # XTF Line Filename Heading Line Type Remarks

Launch 1018

122/25/2747/40/2609107094.4nv

Argento, Andrews, Renoud, Welton

Shilshole Bay Clear, wind up to 10kts





Description of Offsets for FAIRWEATHER S-220
All Values Shown are in CARIS Coordinates

IMU to Heave Point
x: 1.866
y: -7.028
z: -2.086

IMU=Reference Point (RP)
x: 0.000
y: 0.000
z: 0.000

IMU to Seabat 8111
x: 2.868
y: 8.252
z: 4.752

IMU to Seabat 8160
x: 0.493
y: 7.665
z: 4.726

Scaler Distance 1.997

IMU to Port Antenna
x: 0.797

y: -11.892
z: -13.047

IMU to Heave Point
x: 1.866
y: -7.028
z: -2.086

Port Antenna to 8160
x: -0.304
y: 19.557
z: 17.766

Port Antenna to 8111
x: 2.071
y: 20.144
z: 17.792

IMU to Seabat 8160
x: 0.493
y: 7.665
z: 4.726

IMU to Seabat 8111
x: 2.868
y: 8.252
z: 4.752

IMU=Reference Point (RP)
x: 0.000
y: 0.000
z: 0.000

Port Antenna to 8111
x: 2.071
y: 20.144
z: 17.792

Port Antenna to 8160
x: -0.304
y: 19.557
z: 17.766

IMU to Port Antenna
x: 0.797

y: -11.892
z: -13.047



Fairweather  Draft - 2009

2009 (April) Fwd Aft slope IMU Depth (ft) IMU Depth (m)
x1 y1 x2 y2 Min Max

Empty 5.25 13.83 189 12.83 -0.00544 13.43 4.093 12.83 14.17
Full 5.25 13.00 189 14.17 0.00635 13.47 4.106

5.25 189 0.00000 0.00 0.000
5.25 189 0.00000 0.00 0.000
5.25 189 0.00000 0.00 0.000

Draft at IMU (ft) 13.45 4.100 AVG Value Used in Offsets
The IMU x-value (ft): 79.36 0.029 0.009 STDEV Value used for Waterline Loading Uncertainty

x-value (m): 24.19

Immediately prior to the FA field season, the draft measurements were taken prior to fueling when the takes were 
very empty after shipyard  (Empty) . And again after fueling and once the engineers had transferred the fuel in a 
satisfactory manner (Full).  The waterline at the IMU was then calculated based on a linear interpolation.
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Immediately prior to the FA field season, the draft measurements were taken prior to fueling when the takes were 
very empty after shipyard  (Empty) . And again after fueling and once the engineers had transferred the fuel in a 
satisfactory manner (Full).  The waterline at the IMU was then calculated based on a linear interpolation.
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Westlake Consultants, Inc.
9/23/2003

Definitions and Basis for Dimensions/Locations

Northings 

Northings (Port - Starboard) are with reference to the IMU Foundation Plate centerline scribe.
Positive values are starboard of the IMU.
Negative values are port of the IMU.
Calculated values are in italics.

Eastings 

Eastings (Stern to Bow ) are with reference to the IMU Foundation Plate centerline scribe.
Positive values are forward of the IMU. 
Negative values are aft of the IMU.
Calculated values are in italics.

Elevations  

Elevations are with reference to the IMU Foundation Plate centerline scribe = 0 elevation. 
Positive values are below the IMU (toward the keel).
Negative values are toward the topside.

Dimensions 

All dimensions are in feet and decimal feet. All dimensions provided are "offsets" to IMU centerline.

Ship's Centerline Data 

At project initiation, control was established to define the ship's centerline 
as a plane running from a point on the centerline of the keel at the stern through a 
point on the centerline of the keel near the bow, to a point on the bow splitting the bow chock. 

IMU Referenced Data - Procedure
All data was originally referenced to the ship's geometry. 
Following location of the IMU, data was transformed to the IMU as point of origin for 
Northings, Eastings, and Elevation. All dimensions provided with reference to the IMU are "offsets."
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Westlake Consultants, Inc.
9/23/2003

Ship's Centerline - Control Measurements 
(Prior to location of IMU and referencing of data to IMU as point of origin (0,0,0)

Defined by measurements at the keel centerline 
longitude transverse elevation

near the bow 1190.674 1000.000 135.8672
at the stern (point of origin) 1000.000 1000.000 100.0000
along the keel (approx 180' forward) 1180.121 1000.000 116.6810

Ship's Baseline

Defined by measurements on the keel 
longitude transverse elevation

at the stern (point of origin) 1000.000 1000.000 100.0000
and approx. 129' forward of stern 1129.120 999.985 100.0022
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Westlake Consultants, Inc.
9/23/2003

IMU Foundation Plate
EASTING NORTHING ELEVATION

Horizontal alignment per scribed lines 
on IMU foundation plate 0.001

0.000

Scribed lines - intersection/centerline of IMU plate
0.000 0.000 0.000

Elevation checks near four corners of IMU Foundation plate *
0.001

-0.001
0.000

-0.001

SUMMARY 
•  IMU foundation plate is level to within +/-0.001 feet.
•  IMU foundation plate is located 12.856 feet above baseline established at the keel.
•  IMU is parallel to ship's centerline to within +/- 0.001 feet.

Location of scribed centerline intersection is 6.122 feet port of ship's centerline.
•  IMU foundation plate centerline is located 11.638' feet forward of bulkhead 52. 

* elevation check adjusted for target 
that created 10 mm offset =.03281 

feet
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Westlake Consultants, Inc.
9/23/2003

Granite Block 
EASTING NORTHING ELEVATION

Horizontal alignment per scribed lines
1.584
1.583

Scribed lines - intersection/centerline of granite block 
-0.003 1.583

Deviation
Elevation checks near four corners of granite block from level

-0.217 -0.001
-0.217 -0.001
-0.216 0.001
-0.215 0.001

SUMMARY 
•  Granite block is level to within +/-0.001 foot 

of average elevation = -0.21632 feet
•  Granite block is parallel to ship's centerline to within  0.001 foot 

Location is  4.54 feet to port of ship's centerline and 1.583 feet starboard of IMU.
•  Granite block is aligned with IMU to within 0.003 feet longitudinally. 

* elevation check adjusted for target that created 10 
mm offset = 0.03281 feet
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Westlake Consultants, Inc.
9/23/2003

Array Acoustical Centers - Referenced to IMU 

EASTING NORTHING ELEVATION

PORT ARRAY (81-60) 25.149 1.619 14.956

Explanation of Calculations
Acoustic center is defined as the center of the transmitter array with the 
elevation = 83 mm below mounting face of array.

Easting
Center of array is defined by the foundation plate bolt centerlines (1/2 distance between bolts)

27.008 Forward edge of foundation as measured 
- 0.104 Forward edge of foundation to centerline of forward bolt hole
- 1.755 Distance from bolt hole centerline to center of array 
25.149 feet forward of IMU 

Northing
Center of array is defined as the mid-point between the bolt holes on the foundation. 

1.369 Port edge of foundation  as measured 
+ 0.078 Port edge of foundation to centerline of bolt hole - per Cascade General 
 + 0.172 Distance from bolt hole centerline to array center 

1.619 feet starboard of IMU

Elevation 
Per Reson drawing 2148M011_001  the elevation is 83 mm below array mounting surface

14.679 Array foundation elevation as measured. 
  0.005 Isolation "shim" added between foundation and array 
  0.272 83 mm below array mounting surface to acoustical center 
14.956 feet below IMU 
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Westlake Consultants, Inc.
9/23/2003

Array Acoustical Centers - Referenced to IMU 
EASTING NORTHING ELEVATION

STARBOARD ARRAY (81-11) 27.072 9.41 15.042

Explanation of Calculations
Acoustic center is defined as midpoint of the transmitter array in the longitudinal and transverse axes. 
The elevation is defined as the center of the receiving array. 

Easting
Center of array is defined as 0.235' aft of the forward bolt centerlines on transmitter array foundation

28.563 Forward edge of foundation fixture plate as measured (receiving plate forward edge)
27.349 Forward edge of transmitter array foundation as calculated 

 - 0.042 Forward edge of foundation to centerline of forward bolt hole - per design
 - 0.235 Distance from bolt hole centerline to center of array - per design
27.072 feet forward of IMU 

Northing
Center of array is defined as the mid-point between the bolt holes on the transmitter array foundation.

9.410 Centerline of array foundation as measured on scribe - aft section of fixture plate
9.410 feet starboard of IMU

Elevation 
Elevation is 0.401 feet above receiver array mounting surface

16.085 Mounting foundation fixture plate as measured. 
15.447 Receiver foundation elevation - as calculated 

 + 0.005 Isolation "shim" added between foundation and array 
 - 0.410 Design distance from mounting surface of array to acoustic center 
15.042 feet below IMU 
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Westlake Consultants, Inc.
9/23/2003

Longitudinal Array Foundation - Port Side 
EASTING NORTHING ELEVATION

Horizontal alignment measured  at port edge of array foundation
1.369
1.369

Forward edge of array foundation - measured
27.008

Horizontal alignment - calculated  to array centerline 
1.619
1.619

deviation from 
Elevation checks near four corners of array foundation level (average)

14.680 0.001
14.681 0.002
14.678 -0.001
14.677 -0.002

SUMMARY 
•  Port longitudinal array foundation average elevation is 14.679 feet.

Variation in elevation is +0.002 to -0.002 feet.
•  Port longitudinal array foundation is parallel to ship's centerline and 1.369 feet starboard of IMU.

Calculated array centerline is 1.619 feet starboard of IMU 

Foundation edge is 0.25 feet port of 
array centerline
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Westlake Consultants, Inc.
9/23/2003

Longitudinal Array Foundation - Starboard Side 
EASTING NORTHING ELEVATION deviation from 

Horizontal alignment measured  on fixture plate scribe - parallel
9.410 0.002
9.406 -0.002

Forward edge of array foundation fixture plate - measured
28.563

deviation from
Elevation checks near four corners of array foundation "fixture plate" average

16.085 0.000
16.085 0.000
16.084 0.000
16.085 0.000

Calculated locations of longitudinal and transverse array foundations
Forward edge
Receiver (transverse) 28.563
Transmitter (longitudinal) 27.349

difference = 1.214

NOTE:   On Transmitter array foundation - from forward edge to center of forward holes = 0.042'
On Receiver array foundation distance from forward edge to center of forward holes = 0.076'

Calculated elevation of longitudinal and transverse array foundations
Receiver/Transverse Foundation 15.446
Transmitter/Longitudinal Foundation 15.709

difference = 0.263

SUMMARY 
•  Starboard longitudinal array foundation (measured at fixture plate) average elevation is 16.085 feet.

Deviation from level (average elevation) is less than 0.001 feet. 
•  Starboard longitudinal array foundation averages 9.408 feet starboard of IMU.

Variation from parallel is from -0.002  feet to +0.002 feet from average. 
•  Starboard longitudinal array foundation forward edge is 28.563 feet forward of IMU. 

Design location is 3.292 feet 
starboard of ship centerline 
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Westlake Consultants, Inc.
9/23/2003

Transverse Array Foundation - Port Side
EASTING NORTHING ELEVATION

Forward Edge - Transverse array foundation - measured
28.343
28.338

Port edge - Transverse array - measured
-0.181

Centerline of array - calculated  
28.093
28.088

Port edge of foundation plus 1.806 feet 1.624
to calculated array centerline 

deviation from 
Elevation checks near four corners of array foundation level

14.679 0.002
14.675 -0.001
14.675 -0.001
14.677 0.001

SUMMARY 
•  Transverse array foundation average measured elevation is 14.677 feet 

below IMU (0.006 feet above design location).
Deviation from level (average elevation) is 0.003 to -0.001 feet

•  Transverse array foundation centerline (calculated) averages 28.090 feet forward of IMU.
Variation from parallel to ship's centerline is from -0.003 to 0.003 feet (from average). 

•  Transverse array centerline is calculated to be 1.624 feet starboard of IMU. 

Foundation forward edge minus        
0.25 feet to array centerline

0.861 feet below baseline with 0.965 
foot offset = 98.180 feet average 
elevation
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Westlake Consultants, Inc.
9/23/2003

Transverse Array Foundation - Starboard Side

NOTE: Direct Measurements were not taken to the transverse array because a single "fixture plate" covered bo
transmitter and receiver foundations. The data provided here is primarily "calculated".

EASTING NORTHING ELEVATION

Forward edge - as measured on fixture plate
Receiver - (transverse) 28.563

as measured 
Transmitter  (longitudinal) 27.349

difference = 1.214

NOTE:   On Transmitter array foundation - from forward edge to center of forward holes = 0.042'
On Receiver array foundation distance from forward edge to center of forward holes = 0.076'

Horizontal Alignment 9.406
centerline scribe on fixture plate 
as measured - forward portion of plate
(near receiver array)
Average of measurements on fixture plate 9.408

Elevation of longitudinal and transverse array foundations
Receiver/Transducer Transverse Foundation 15.446
Transmitter/Longitudinal Foundation 15.709

difference = 0.263
Based on measured elevations averaging 16.085 feet across fixture plate

SUMMARY
•  Transverse array foundation is calculated to be 15.446 feet below IMU - calculated from measured elevation 

of 16.085 feet.  Deviation in elevation measurements across the  array fixture plate is less than 0.001 fe
•  Transverse array foundation forward edge (measured) is 28.563 feet forward of IMU.
•  Transverse array centerline is measured to be 9.406 feet starboard of IMU. 

Variation from parallel of the fixture plate across entire starboard array is ± 0.002  feet (from average). 
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Westlake Consultants, Inc.
9/23/2003

Antennae
EASTING NORTHING ELEVATION

Stbd POS MV Antenna -Location -35.866 12.925 -38.209
Port POS MV Antenna - Location -35.739 -0.409 -38.283

Foundation Plate Stack Antenna Alignment 7.677
Foundation Plate Stack Antenna Alignment 7.677

Port GYRO Foundation Plate Alignment 2.411
Port GYRO Foundation Plate Alignment 2.411

Stbd GYRO Foundation Plate Alignment 3.866
Stbd GYRO Foundation Plate Alignment 3.867

SUMMARY
•  Foundation plate stack antenna alignment is parallel to ship's centerline.
•  Port GYRO Foundation Plate is aligned parallel to ship's centerline.
•  Starboard GYRO Foundation Plate is aligned parallel to ship's centerline.
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NOAA SHIP FAIRWEATHER 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
PURPOSE 
 
The primary purpose of the survey was to accurately determine the spatial relationship of various 
components of a POS MV navigation system aboard the NOAA ship FAIRWEATHER.  
Reference points were also established to determine the spatial location of differential GPS 
antennas,   Additionally, various reference points (bench marks) were restablished onboard the 
vessel to aid in future spatial surveys aboard the boat. 
 
 
PROJECT DETAILS 
 
This survey was conducted while the ship was docked at the USCG in Seattle, WA .  The weather 
was cool with a steady breeze.   
 
 
INSTRUMENTATION 
 
The Topcon 3000LW total station was used to make all measurements. 

Technical Data: 
   Angle Measurement 
   Smallest unit in display 0.1 seconds 
 
  Standard Deviation 
   Horizontal angle  1.0 seconds 
   Vertical angle   1.0 seconds 
   Distance measurement 2mm + 2ppm 
 
A standard “peanut” prism was used as a sighting target.  This prism was configured to have a zero 
mm offset.   
 
 
PERSONNEL 
  
  
 Steve Breidenbach NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
 
 Dennis Lokken           NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
 
  
 



NOAA SHIP FAIRWEATHER 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
ESTABLISHING THE REFERENCE FRAME 
 
To conduct this survey a local coordinate reference frame was established where the X axis runs 
along the centerline of the boat and is positive from IMU towards the bow of the boat.  The Y axis 
is perpendicular to the centerline of the boat (X axis) and is positive from IMU towards the right, 
when looking at the boat from the stern.  The Z axis is positive in an upward direction from the 
IMU.  In this reference frame the IMU has the following coordinates; 
X = 100.000(m) 
Y = 100.000(m) 
Z  = 100.000(m) 
 
At the end of the survey all the coordinates were rotated to a right-handed coordinate system.  The 
coordinates were translated to the IMU origin and the Granite Block origin. 
 
 
 
 
 
DISCUSSION 
 
I recommend conducting the survey again, once the ship is put into dry dock.  Conducting a survey 
such as this while the boat is in the water requires that the automatic compensators in the survey 
instrument be turned off.  The survey is therefore conducted with all survey instrumentation set up 
relative to the mean movement of the related level vials.  While every effort was made to make the 
most precise measurements possible, some additional error accumulation cannot be avoided under 
these type observing conditions.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



The positions given for the IMU GPS antenna are to the bottom of the bolt as depicted on the 
photo below. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Position of the C-NAV Antenna 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Point Summary Report 

Name  Std Dev n (m)  Std Dev e (m)  Std Dev Hz (m)  Std Dev u (m)  

10FLOOR  0.003  0.003  0.004  0.002  

11FLOOR  0.003  0.004  0.005  0.002  

1CLEAT  0.004  0.018  0.019  0.002  

1DECK  0.004  0.018  0.018  0.002  

1FLOOR  0.000  0.000  0.000  0.000  

1LOCKER  0.004  0.004  0.005  0.003  

1RAIL  0.004  0.022  0.023  0.002  

1WALL  0.003  0.002  0.004  0.001  

1WALL3  0.003  0.003  0.004  0.002  

2CLEAT  0.003  0.021  0.021  0.002  

2CLEAT1  0.004  0.022  0.022  0.003  

2FLOOR  0.001  0.001  0.001  0.001  

2RAIL  0.004  0.022  0.022  0.002  

2WALL  0.002  0.003  0.004  0.002  

3ANT  0.003  0.006  0.007  0.003  

3FLOOR  0.002  0.002  0.003  0.002  

3WALL  0.003  0.003  0.005  0.002  

4FLOOR  0.001  0.001  0.002  0.003  

5FLOOR  0.002  0.004  0.005  0.001  

6FLOOR  0.002  0.002  0.003  0.003  

7FLOOR  0.005  0.003  0.006  0.002  

8FLOOR  0.004  0.004  0.005  0.002  

9FLOOR  0.002  0.013  0.013  0.003  

ABOLT  0.003  0.026  0.026  0.003  

ANT DECK  0.003  0.006  0.007  0.003  



Name  Std Dev n (m)  Std Dev e (m)  Std Dev Hz (m)  Std Dev u (m)  

ANT DECK BM  0.004  0.007  0.008  0.003  

ANT PORT  0.003  0.007  0.008  0.003  

ANT RAIL  0.004  0.006  0.007  0.003  

ANT RAIL BM  0.003  0.007  0.007  0.003  

ANT STAR  0.004  0.007  0.008  0.003  

BOW BM  0.004  0.023  0.024  0.003  

BOW BM2  0.004  0.023  0.023  0.003  

BRIDGEPORT  0.005  0.011  0.012  0.003  

BRIDGESTAR  0.005  0.011  0.012  0.003  

BRIDGESTAR2  0.005  0.011  0.012  0.003  

DOOR  0.001  0.001  0.002  0.001  

GRANITE BOW  0.002  0.001  0.002  0.001  

GRANITE CENTER  0.002  0.001  0.002  0.001  

GRANITE PORT  0.002  0.001  0.002  0.001  

GRANITE STAR  0.003  0.002  0.003  0.001  

GRANITE STERN  0.002  0.001  0.002  0.001  

IMU BM  0.003  0.001  0.003  0.003  

IMU BOW PORT  0.002  0.001  0.002  0.001  

IMU BOW STAR  0.002  0.001  0.002  0.001  

IMU CENTER  0.000  0.000  0.000  0.000  

IMU STERN PORT  0.002  0.001  0.002  0.001  

IMU STERN STAR  0.002  0.001  0.002  0.001  

LADDER  0.002  0.002  0.002  0.001  

MVP BM  0.004  0.023  0.023  0.003  

RAIL STAR  0.006  0.015  0.016  0.003  

RAIL STAR1  0.004  0.005  0.007  0.003  

RAILPORT  0.005  0.015  0.016  0.003  



Name  Std Dev n (m)  Std Dev e (m)  Std Dev Hz (m)  Std Dev u (m)  

RAILSTAR  0.005  0.015  0.016  0.003  

STEARN BM  0.004  0.024  0.024  0.003  

STERN BM  0.003  0.024  0.024  0.002  
 
 
 
 
COORDINATES 
 
 
                                                                                IMU Origin                                                                               
                                                               Right-handed Coordinate System                                                            
    
Name Easting (x) meters Northing (y) meters Elevation (z) meters 
IMU CENTER 0 0 0 
IMU BOW PORT CORNER 0.073 -0.084 -0.006 
IMU BOW STAR CORNER 0.071 0.088 -0.004 
IMU STERN STAR CORNER -0.068 0.089 -0.003 
IMU STERN PORT CORNER -0.065 -0.086 -0.006 
GRANITE BOW 0.147 0.48 0.108 
GRANITE STAR -0.002 0.574 0.111 
GRANITE STERN -0.148 0.478 0.109 
GRANITE PORT -0.003 0.382 0.106 
GRANITE CENTER -0.002 0.477 0.108 
IMU BM 0.034 -0.263 -0.496 
STERN BM -40.32 1.927 -2.184 
MVP BM -38.721 5.985 -2.018 
STEARN BM -40.313 1.921 -2.181 
POS GPS ANT STARBOARD -11.917 3.171 -12.936 
POS GPS ANT PORT -11.92 1.177 -12.98 
A FRAME BOLT -43.019 1.975 -7.142 
POS GPS ANT RAIL BM -12.037 2.101 -10.376 
POS IMU ANT DECK BM -11.823 2.07 -9.301 
C-NAV ANT -10.075 4.131 -11.377 
BOW BM 28.346 2.077 -7.853 
 
 



                                                                 Granite Block Origin 
                                                        Right-handed Coordinate System 
    
Name Easting (x) meters Northing (y) meters Elevation (z) meters 
IMU CENTER 0.002 -0.477 -0.108 
IMU BOW PORT CORNER 0.075 -0.561 -0.114 
IMU BOW STARBOARD CORNER 0.073 -0.39 -0.112 
IMU STERN STARBOARD CORNER -0.065 -0.388 -0.111 
IMU STERN PORT CORNER -0.063 -0.563 -0.114 
GRANITE BOW 0.149 0.003 0 
GRANITE STAR 0 0.097 0.003 
GRANITE STERN -0.145 0.001 0.001 
GRANITE PORT 0 -0.095 -0.002 
GRANITE CENTER 0 0 0 
IMU BM 0.036 -0.74 -0.604 
STERN BM -40.317 1.45 -2.292 
MVP BM -38.719 5.508 -2.126 
STEARN BM -40.31 1.444 -2.289 
POS GPS ANT STARBOARD -11.915 2.694 -13.044 
POS GPS ANT PORT -11.918 0.699 -13.088 
A FRAME BOLT -43.017 1.498 -7.25 
POS GPS ANT RAIL BM -12.034 1.623 -10.484 
POS IMU ANT DECK BM -11.821 1.593 -9.409 
C-NAV ANT -10.073 3.654 -11.485 
BOW BM 28.349 1.6 -7.961 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
POS GPS RAIL BM AND POS GPS DECK BM 
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NOAA SHIP FAIRWEATHER 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
PURPOSE 
 
The primary purpose of the survey was to precisely determine the spatial relationship of various 
components of a POS MV navigation system aboard the NOAA ship FAIRWEATHER.  
Additionally, various reference points (bench marks) were re-established onboard the vessel to 
aid in future spatial surveys aboard the boat. 
 
 
PROJECT DETAILS 
 
This survey was conducted while the ship was in dry dock at the Lake Union dry dock in Seattle, 
WA.  The weather conditions over the two days required to conduct this survey were windy, 
cool, with intermittent rain.   
 
 
INSTRUMENTATION 
 
The Leica TC2003 total station was used to make all measurements. 

Technical Data: 
    
  Standard Deviation 
   Horizontal angle  0.5 seconds 
   Vertical angle   0.5 seconds 
   Distance measurement 0.2mm + 2ppm 
 
A Leica precision prism was used as a sighting target.  This prism was configured to have a zero 
mm offset.   
 
 
PERSONNEL 
  
  
 Kendall Fancher NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
 
 Dennis Lokken           NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
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DEFINITION OF THE REFERENCE FRAME 
 
To conduct this survey a local coordinate reference frame was established where the Northing 
(Y) axis runs along the centerline of the ship and is positive from the IMU towards the bow of 
the ship.  The Easting (X) axis is perpendicular to the centerline of the ship and is positive from 
the IMU towards the right, when looking at the ship from the stern.  The Up (Z) axis is positive 
in an upward direction from the IMU.   
 
 
SURVEY METHODOLOGY 
 
02/15/2009 
 
Coordinates of 100.000N, 100.000E, and 100.000U were assumed for temporary control point 1.  
A distance and height difference were measured between temporary control points 1 and 3.  
These values were used to determine the coordinates at temporary control point 3.  Temporary 
control points 1 and 3 were located along the top deck and on the north side of the dry dock 
vessel.   
 
Temporary control point 1 was occupied and temporary control point 3 was observed for a 
backsight.  After initialization, temporary control points 2 and 4(located on the top deck of the 
dry dock vessel), H1 (located on the bottom deck of the dry dock vessel), and BOW BM were 
observed in both direct and reverse. 
 
Temporary control point 2 was occupied and temporary control point 3 was observed for a 
backsight.  After initialization, temporary control point W1 (located on the top deck of the dry 
dock vessel) and D1 (located inside the ship on the D deck along the port side) were observed in 
both direct and reverse.  Temporary control point 1 was also observed and yielded an inverse 
check of 0.001m horizontally and 0.001m vertically. 
  
Temporary control point 4 was occupied and control point 1 was observed for a backsight.  After 
initialization, temporary control point 5 (located on the south side and on the top deck of the dry 
dock vessel) was observed in both direct and reverse.  
 
Temporary control point 5 was occupied and control point 4 was observed for a backsight.  After 
initialization, temporary control point D2 (located inside the ship on the D deck along the 
starboard side) was observed in both direct and reverse. 
 



Temporary control point H1 was occupied and control point 1 was observed for a backsight.  
After initialization, temporary control point H2 (located on the bottom deck of the dry dock 
vessel), and USBL BM were observed in both direct and reverse. 
 
Temporary control point H2 was occupied and temporary control point H1 was observed for a 
backsight.  After initialization, 8111 BM and 8160 BM were observed in both direct and reverse.  
Temporary control point W1 was also observed and yielded an inverse check of 0.019m 
horizontally and 0.033m vertically. 
 
Temporary control point D1 was occupied and temporary control point D2 was observed for a 
backsight.  After initialization, temporary control point D3 (located in the doorway leading to the 
mess hall on the D deck) was observed in both direct and reverse.   
 
Temporary control point D3 was occupied and temporary control point D1 was observed for a 
backsight.  After initialization, temporary control point C1 (located on the C deck near the IMU) 
was observed in both direct and reverse.  Temporary control point D2 was also observed and 
yielded an inverse check of 0.026m horizontally and 0.0001m vertically. 
 
Temporary control point C1 was occupied and temporary control point D3 was observed for a 
backsight.  After initialization, IMU, IMU BOW PORT CORNER, IMU BOW STAR CORNER, 
IMU STERN STAR CORNER, and IMU STERN PORT CORNER were observed in both direct 
and reverse. 
 
02/16/2009 
 
Temporary control point 4 was occupied and control point 1 was observed for a backsight.  After 
initialization, temporary control point 6 (located on the south side and on the top deck of the dry 
dock vessel) and BOW BM were observed in both direct and reverse. Temporary control point 
D2 was also observed and yielded an inverse check of 0.0004m horizontally and 0.083m 
vertically. 
 
Temporary control point 6 was occupied and temporary control point 4 was observed for a 
backsight.  After initialization, TRANSOM PIVOT POINT PORT, STERN BM, POS GPS ANT 
RAIL BM, POS IMU ANT DECK BM, POS GPS ANT STARBOARD, and POS GPS ANT 
PORT were observed in both direct and reverse. 
 
Temporary control point 3 was occupied and temporary control point 1 was observed for a 
backsight.  After initialization, TRANSOM PIVOT POINT STARBOARD, STERN BM, POS 
GPS ANT STARBOARD, and POS GPS ANT PORT were observed in both direct and reverse. 
Temporary control point 6 was also observed and yielded an inverse check of 0.0006m 
horizontally and 0.001m vertically.  
 
The reference frame was rotated using STERN BM as the point of rotation.  A zero degree 
azimuth was used during the rotation from STERN BM to BOW BM. The reference frame was 
then translated to relocate the origin of the reference frame to the IMU. 
 



NOAA SHIP FAIRWEATHER 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
INVERSE RESULTS 
 
Inverses were computed between the determined positions of those ship benchmarks and 
sensor points which were determined from two separate locations  The results of these inverses 
are: 
 
ID    Horizontal Dist.(m) Elevation Diff(m) 
BOW BM    0.0150    0.0240 
STERN BM    0.0060    0.0010 
POS GPS ANT STARBOARD  0.0100    0.0001 
POS GPS ANT PORT   0.0100    0.0000 
 
 
DISCUSSION 
 
The Fairweather was in dry dock during this survey, however, the dry dock vessel was still 
subject to movement due to wave action.   Conducting a survey such as this while the ship is 
moving requires that the automatic compensators in the survey instrument be turned off.  The 
survey is therefore conducted with all survey instrumentation set up relative to the mean 
movement of the related level vials.  While every effort was made to make the most precise 
measurements possible, some additional error accumulation cannot be avoided under these type 
observing conditions.   
 
The POS GPS antenna coordinates were determined to the top center of the antennas.  The Z 
value should be corrected to the Antenna Reference Point (ARP).  In order to apply this 
correction, the mechanical height of the antenna should be determined and subtracted from the Z 
value determined during this survey for both of the POS GPS antennas. 
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Coordinate Listing using IMU as the Reference Frame Origin  
 
 

ID  X(NORTHING)m Y(EASTING)m  Z(UP)m 
IMU CENTER  0.000 0.000 0.000 
IMU STERN PORT CORNER  ‐0.071 ‐0.089 ‐0.001 
IMU BOW PORT CORNER  0.070 ‐0.086 ‐0.001 
IMU BOW STARBOARD CORNER  0.069 0.087 0.000 
IMU STERN STARBOARD CORNER  ‐0.073 0.086 0.000 
BOW BM  28.378 1.805 7.796 
STERN BM  ‐40.306 1.805 2.255 
USBL BM  ‐28.354 1.738 ‐4.204 
8160 BM  8.407 0.395 ‐4.400 
8111 BM  8.532 3.002 ‐4.666 
POS GPS ANT RAIL BM  ‐12.011 1.785 10.381 
POS IMU ANT DECK BM  ‐11.790 1.780 9.305 
POS GPS ANT STARBOARD  ‐11.886 2.794 13.051 
POS GPS ANT PORT  ‐11.892 0.797 13.047 
TRANSOM PIVOT POINT STARBOARD  ‐39.727 3.366 2.385 
TRANSOM PIVOT POINT PORT  ‐39.722 0.240 2.345 
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IMU Reference Points 
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POS GPS ANTENNAS 
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BOW CENTERLINE REFERENCE POINT 
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CENTERLINE REFERENCE POINT ON G DECK 
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CENTERLINE REFERENCE POINT ON RAIL AT G DECK 
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CENTERLINE STERN REFERENCE POINT 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
NOAA SHIP FAIRWEATHER 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 

 
TRANSOM REFERENCE POINT ON PORT SIDE 

 

 
TRANSOM REFERENCE POINT ON STARBOARD SIDE 
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8111 REFERENCE POINT 
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8160 REFERENCE POINT 

 
 
 
 
 
 



NOAA SHIP FAIRWEATHER 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 

 
USBLE REFERENCE POINT 

 

 











Measurement
Coord. Sys. Caris Caris Caris
x 2.868 2.071 n/a Scaler Distance 1.997
y 8.252 20.144 n/a
z 4.752 17.792 0.014

*Top of IMU is RP (Reference Pt)

2009 Measured Value

Calculations

Coord. Sys. Westlake NGS 2009 IMU Base to baseline at Keel NGS 2009
IMU easting 0.000 Top of Port x -11.892 (ft) elevation 12.856 Top of x -11.892
Base northing 0.000 Ant y 0.797 IMU Base to baseline at Keel Port Ant y 0.797

(ft/m) elevation 0.000 (m) z 13.047 (m) elevation 3.919 (m) z 13.047
Westlake Top of Ant to Phase Center 
8111 easting 27.072 (m) z 0.007 Waterline to Keel Top of Ant to Phase Center 

(ft) northing 9.410 Phase Cntr x -11.892 (ft) elevation 13.45 (m) z 0.007
elevation 15.042 Port Ant y 0.797 Waterline to Keel

Westlake (m) z 13.040 (m) elevation 4.100 NGS 2009
8111 easting 8.252 CARIS See Ship's Draft Tab Top of x -11.886

(m) northing 2.868 Port x 0.797 Stbd Ant y 2.794
elevation 4.585 Ant y -11.892 Top of IMU to Base of IMU (m) z 13.051

Westlake (m) z -13.040 (m) elevation 0.168
Base of IMU to Top of IMU Westlake Top of IMU to Keel

(m) elevation -0.168 (m) easting 8.252 (m) 4.086
Top of IMU northing 2.868
 to 8111 elevation 4.752
CARIS

(m) x 2.868
Top of IMU y 8.252
 to 8111 z 4.752

These rows 
Westlake (m) easting 8.252 CARIS x 2.071 (m) easting N/A
unless noted Top of IMU northing 2.868 y 20.144 Waterline northing N/A Scalar Distance (m) 1.997
otherwise  to 8111 elevation 4.752 (m) z 17.792  to IMU elevation 0.014

Coord Sys. CARIS Coord Sys. CARIS Coord. Sys.CARIS
x 2.868 x 2.071 x N/A
y 8.252 y 20.144 y N/A
z 4.752 z 17.792 z 0.014

See Description Tab

IMU to 8111

IMU to 8111 Port Ant to Stbd AntPort Ant to 8111 Waterline to RP*

Port Ant to 8111 Waterline to RP*

Waterline to RP* Port Ant to Stbd Ant

Port Ant to Stbd Ant

Vessel Offsets for S220_8111 are derived from Westlake-Survey-Report-NOAA-Fairweather-09-23-03.pdf
and Fairweather_NGS_Report_Feb_2007.doc

IMU to 8111 (MRU to Trans) Port Ant to 8111 (Nav to Trans)



Caris Pos/Mv Caris Pos/Mv
0.797 -11.892 1.866 -7.028

-11.892 0.797 -7.028 1.866
13.047 -13.047 -2.086 -2.086

NGS 2009 IMU to Bulkhd (Frame) 52 IMU Base to baseline at Keel
IMU Top (m) x 0.000 (ft) easting -11.638 (ft) elevation 12.856

y 0.000 (m) easting -3.547 (m) elevation 3.919
z 0.000

NGS 2009 Frame 0 (FP) to Frame 52 Top of IMU to Base of IMU
Top of Port x -11.892 (m) easting -27.737 (m) elevation 0.168
Ant y 0.797 Top of IMU to Keel

(m) z 13.047 IMU to Frame 0 (FP) (m) elevation 4.086
(m) easting 24.190

Top of Ant to Phase Center Center of Gravity above baseline
(m) z 0.007 Heave Pt* to Frame 0 (FP) (ft) elevation 16.37

(ft) easting 102.42 Mean Metacentric height
NGS 2009 (m) easting 31.218 (ft) elevation 3.88
Phase Cntr x -11.892
Port Ant y 0.797 IMU to Centerline Heave Pt* to baseline at Keel

(m) z 13.047 (ft) northing 6.122 (ft) elevation 20.25
(m) northing 1.866 (m) elevation 6.172

Heave Pt* to Centerline (*Heave Pt is Metacenter)
(m) northing 0 (FP is Forward Perpendicular)

NGS 2009 (m)        x -11.892 (m) easting -7.028
Top of IMU y 0.797 Top of IMU northing 1.866
 to Port Ant z 13.047 to Heave Pt* elevation -2.086

Coord Sys. Pos/Mv Coord. Sys. Pos/Mv
x -11.892 x -7.028
y 0.797 y 1.866
z -13.047 z -2.086

see Description Tab

IMU to Port Ant

IMU to Heave

IMU to HeaveIMU to Port Ant

IMU to Heave

IMU to Port Ant

Value in POSMV is top of 
antenna rather than the phase 
center to IMU. 



Measurement
Coord. Sys. Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.493 -0.304 n/a Scaler Distance 1.997 0.797 -11.892 1.866 -7.028
y 7.665 19.557 n/a -11.892 0.797 -7.028 1.866
z 4.726 17.766 0.014 13.047 -13.047 -2.086 -2.086

*Top of IMU is RP (Reference Pt)

Derivations
Coord. Sys.

Westlake NGS 2009
IMU easting 0.000 Top of Port x -11.892
Base northing 0.000 Ant y 0.797

(ft/m) elevation 0.000 (m) z 13.047
Westlake Top of Ant to Phase Center 
8160 easting 25.149 (m) z 0.007

(ft) northing 1.619 Phase Cntr x -11.892
elevation 14.956 Port Ant y 0.797

Westlake (m) z 13.040
8160 easting 7.665 CARIS

(m) northing 0.493 Port x 0.797
elevation 4.559 Ant y -11.892

(m) z -13.040
Base of IMU to Top of IMU Westlake

(m) elevation -0.168 (m) easting 7.665
Top of IMU northing 0.493
 to 8160 elevation 4.726
CARIS

(m) x 0.493
Top of IMU y 7.665
 to 8111 z 4.726

Westlake easting 7.665 CARIS x -0.304
Top of IMU northing 0.493 y 19.557
to 8160 (m) elevation 4.726 (m) z 17.766

Coord Sys Caris Coord Sys Caris
x 0.493 x -0.304
y 7.665 y 19.557
z 4.726 z 17.766

Port Ant to 8160

IMU to Port Ant

IMU to 8160

IMU to 8160 (MRU to Trans)

IMU to 8160

Port Ant to 8160 (Nav to Trans)

Port Ant to 8160

IMU to HeavePort Ant to Stbd AntWaterline to RP*

Vessel Offsets for S220_8111 are derived from Westlake-Survey-Report-NOAA-Fairweather-09-23-03.pdf, 
Fairweather_NGS_Report_02-07.pdf, and , FairweatherCenterlineSurvey_03-09.pdf.



Description of Offsets for FAIRWEATHER S-220
All Values Shown are in CARIS Coordinates

IMU to Heave Point
x: 1.866
y: -7.028
z: -2.086

IMU=Reference Point (RP)
x: 0.000
y: 0.000
z: 0.000

IMU to Seabat 8111
x: 2.868
y: 8.252
z: 4.752

IMU to Seabat 8160
x: 0.493
y: 7.665
z: 4.726

Scaler Distance 1.997

IMU to Port Antenna
x: 0.797

y: -11.892
z: -13.047

IMU to Heave Point
x: 1.866
y: -7.028
z: -2.086

Port Antenna to 8160
x: -0.304
y: 19.557
z: 17.766

Port Antenna to 8111
x: 2.071
y: 20.144
z: 17.792

IMU to Seabat 8160
x: 0.493
y: 7.665
z: 4.726

IMU to Seabat 8111
x: 2.868
y: 8.252
z: 4.752

IMU=Reference Point (RP)
x: 0.000
y: 0.000
z: 0.000

Port Antenna to 8111
x: 2.071
y: 20.144
z: 17.792

Port Antenna to 8160
x: -0.304
y: 19.557
z: 17.766

IMU to Port Antenna
x: 0.797

y: -11.892
z: -13.047



x y z x y z
2.868 8.252 4.752 0.493 7.665 4.726

x y z x y z
2.071 20.144 17.792 -0.304 19.557 17.766

x y z
Scaler Distance 1.997 0.797 -11.892 13.047

x y z x y z From pg 3 of the Westlake Survey
n/a n/a 0.014 1.866 -7.028 -2.086

Lynn - read through and check

IMU to 8160 (MRU to Trans)

The lever arms between the IMU 
and phase center of the 8111 
transducer are taken from the 
Westlake report with the addition 
of the 0.168 m offset included for 
the height of the IMU.

Port Ant to 8160 (Nav to Trans)

The lever arms between the IMU 
and phase center of the 8160 
transducer are taken from the 
Westlake report with the addition of 
the 0.168 m offset included for the 
height of the IMU.

This information comes from a 
combination of the Westlake and 
NGS surveys. Subtraction of the 
distance between Top of Antenna 
and the Phase Center were 
included in final value 
determination. Relative positions 
obtained from Port Ant to 8111 via 
IMU.

This information comes from a 
combination of the Westlake and 
NGS surveys. Subtraction of the 
distance between Top of Antenna 
and the Phase Center were 
included in final value 
determination. Relative positions 
obtained from Port Ant to 8160 via 
IMU.

Referencing the metacenter (Heave Point, HP) to the IMU information requires information about the frame spacing of the vessel.  From the 
Westlake survey, the IMU is located 3.547 m forward of frame 52.  From Inclination document, the HP is 31.217 m aft of the forward 
perpendicular.  From engineering drawings of the ship frame spacing is approximately 21 inches.  The calculation for the longitudinal location 
of the HP with respect to frame zero, the Forward Perpendicular (FP) is as follows:

52 (frame) * 21 (inches/frame)/12(inches/ft)*.3048(m/ft)-3.547 m = 24.190 m from frame 0.

31.217 m (HP aft of FP) – 24.190 m (IMU aft of FP) =  7.027 m (HP aft of IMU)

The calculation for the vertical separation between the IMU and the HP is based on the height of the metacenter being 6.172m and the height
of the IMU being 4.087 m above the keel.  Differencing yields the metacenter being 2.085 m above the IMU.

The calculation for the athwartship separation is based upon the assumption that the HP is on the centerline and the knowledge that the IMU 
is 1.866 m to port of the centerline.

Port Ant to Stbd Ant

Using the NGS 2009 survey values 
for the antennas, a calculated 
vector for antenna separation was 
determined. The distance from Top 
of Antenna to Phase Center does 
not affect this calculation and 
therefore was not included.

This information comes directly 
from the NGS 2009 survey.  
Subtraction of the distance 
between Top of Antenna and the 
Phase Center were included in 
final value determination.

IMU to Heave

* From the Art Anderson inclination experiment the position of the metacenter was used as the position of the ship’s Heave Point. (There may
be a better way to determine the Heave Point, but this decision was based upon available information).  The metacenter is defined by the 
center of buoyancy.  As a vessel inclines through small angles, the center of buoyancy moves through the arc of a circle whose center is at 
the metacenter.  

Important numbers and information determined from the Art Anderson report are the location of the metacenter and how it is positioned with 
respect to the vessel.  The longitudinal location of the metacenter is defined as 102.42 feet (31.217 m) aft of the forward perpendicular.  The 
height of the metacenter is 20.25 feet (6.172 m) above the keel.  There is an assumption of the metacenter being on the centerline of the 
vessel.  Similar values for the RAINIER’s metacenter are 32.52 m aft of the forward perpendicular and 5.2 m above the keel.  The difference 
in the height of the metacenter can be attributed to the difference between the FA’s and RA’s average draft which is 13.12 feet as opposed to 
approximately 14.5 feet respectively.

IMU to 8111 (MRU to Trans)

Port Ant to 8111 (Nav to Trans)

Waterline to RP*

IMU to Heave

The height of the IMU above the 
keel comes from the Westlake 
survey value of 3.919 m plus the 
measured value of the top of the 
IMU to the base plate, to get an 
IMU height above the keel.  The 
draft (waterline to keel) used for the 
FAIRWEATHER is based on 
observations, Ship's Draft 
spreadsheet.  Differencing the 
value of IMU to keel and waterline 
to keel gives the waterline to RP 
distance.  

Key points on the IMU, from the 
Westlake survey, are its location 
with respect to the ship’s reference
frame.  It is 4.087 m (3.919 m to 
base line + 0.168 m for IMU height 
above base plate) above the keel, 
1.866 m port of centerline and 
3.547 m forward of frame 52.  This 
information is needed to reference 
the IMU to the ship’s Heave 
Measurement Location (Heave 
Point). *

IMU to Port Ant

IMU to Heave



Sources

On September 23, 2003 an offset survey of the NOAA Ship FAIRWEATHER was conducted by:
Westlake Consultants, Incorporated
15115 SW Sequoia Parkway, Suite 150
Tigard, Oregon 97224
Phone (503) 684-0652

…and the relocation of the POS M/V antenna forced a partial resurvey in Feb. 2007 by Steven Breidenbach of NGS.

On July 16, 2004 an inclination experiment was conducted at MOC-P by:

Art Anderson Associates
202 Pacific Avenue
Bremerton, WA  98337-1932

Calculations

These values relate the physical positions of one sensor to the next with the base plate of the IMU being the point of origin.  All 
dimensions in the document are given in feet and decimal feet.  

The values for the required lever arms are listed in the S220_Offsets and Measurements spreadsheet.  The reference point and the 
IMU are identical.  Difference in documentation between Westlake and FA calculations are based off of measuring up from the 
IMU base (Westlake’s origin) and the top of the IMU.  The top center of the IMU for the POS/MV is the defined origin for the 
POS/MV and the origin that is being used on all FAIRWEATHER vessels.  The distance from the base plate to the top of the 
IMU is 0.168 m, a value measured by ship’s complement.  Conversions factor from feet to meters is 0.3048 m/ft.

As a requirement for the TPE, the standard deviation for each position is 3 mm.  This value is based upon a conversation with 
Elaine McDonald of Westlake and is followed up by an Email documenting that fact.  The email is located at the end of this 
document.

Offset values for the ship were derived from three sources.  Two static offset surveys, an inclination experiment, and values measured or 
approximated by ship’s personnel.













x y z x y z
2.868 8.252 4.752 0.493 7.665 4.726

x y z x y z
2.071 20.144 17.792 -0.304 19.557 17.766

x y z
Scaler Distance 1.997 0.797 -11.892 13.047

x y z x y z From pg 3 of the Westlake Survey
n/a n/a 0.014 1.866 -7.028 -2.086

Lynn - read through and check

IMU to 8160 (MRU to Trans)

The lever arms between the IMU 
and phase center of the 8111 
transducer are taken from the 
Westlake report with the addition 
of the 0.168 m offset included for 
the height of the IMU.

Port Ant to 8160 (Nav to Trans)

The lever arms between the IMU 
and phase center of the 8160 
transducer are taken from the 
Westlake report with the addition of 
the 0.168 m offset included for the 
height of the IMU.

This information comes from a 
combination of the Westlake and 
NGS surveys. Subtraction of the 
distance between Top of Antenna 
and the Phase Center were 
included in final value 
determination. Relative positions 
obtained from Port Ant to 8111 via 
IMU.

This information comes from a 
combination of the Westlake and 
NGS surveys. Subtraction of the 
distance between Top of Antenna 
and the Phase Center were 
included in final value 
determination. Relative positions 
obtained from Port Ant to 8160 via 
IMU.

Referencing the metacenter (Heave Point, HP) to the IMU information requires information about the frame spacing of the vessel.  From the 
Westlake survey, the IMU is located 3.547 m forward of frame 52.  From Inclination document, the HP is 31.217 m aft of the forward 
perpendicular.  From engineering drawings of the ship frame spacing is approximately 21 inches.  The calculation for the longitudinal location 
of the HP with respect to frame zero, the Forward Perpendicular (FP) is as follows:

52 (frame) * 21 (inches/frame)/12(inches/ft)*.3048(m/ft)-3.547 m = 24.190 m from frame 0.

31.217 m (HP aft of FP) – 24.190 m (IMU aft of FP) =  7.027 m (HP aft of IMU)

The calculation for the vertical separation between the IMU and the HP is based on the height of the metacenter being 6.172m and the height
of the IMU being 4.087 m above the keel.  Differencing yields the metacenter being 2.085 m above the IMU.

The calculation for the athwartship separation is based upon the assumption that the HP is on the centerline and the knowledge that the IMU 
is 1.866 m to port of the centerline.

Port Ant to Stbd Ant

Using the NGS 2009 survey values 
for the antennas, a calculated 
vector for antenna separation was 
determined. The distance from Top 
of Antenna to Phase Center does 
not affect this calculation and 
therefore was not included.

This information comes directly 
from the NGS 2009 survey.  
Subtraction of the distance 
between Top of Antenna and the 
Phase Center were included in 
final value determination.

IMU to Heave

* From the Art Anderson inclination experiment the position of the metacenter was used as the position of the ship’s Heave Point. (There may
be a better way to determine the Heave Point, but this decision was based upon available information).  The metacenter is defined by the 
center of buoyancy.  As a vessel inclines through small angles, the center of buoyancy moves through the arc of a circle whose center is at 
the metacenter.  

Important numbers and information determined from the Art Anderson report are the location of the metacenter and how it is positioned with 
respect to the vessel.  The longitudinal location of the metacenter is defined as 102.42 feet (31.217 m) aft of the forward perpendicular.  The 
height of the metacenter is 20.25 feet (6.172 m) above the keel.  There is an assumption of the metacenter being on the centerline of the 
vessel.  Similar values for the RAINIER’s metacenter are 32.52 m aft of the forward perpendicular and 5.2 m above the keel.  The difference 
in the height of the metacenter can be attributed to the difference between the FA’s and RA’s average draft which is 13.12 feet as opposed to 
approximately 14.5 feet respectively.

IMU to 8111 (MRU to Trans)

Port Ant to 8111 (Nav to Trans)

Waterline to RP*

IMU to Heave

The height of the IMU above the 
keel comes from the Westlake 
survey value of 3.919 m plus the 
measured value of the top of the 
IMU to the base plate, to get an 
IMU height above the keel.  The 
draft (waterline to keel) used for the 
FAIRWEATHER is based on 
observations, Ship's Draft 
spreadsheet.  Differencing the 
value of IMU to keel and waterline 
to keel gives the waterline to RP 
distance.  

Key points on the IMU, from the 
Westlake survey, are its location 
with respect to the ship’s reference
frame.  It is 4.087 m (3.919 m to 
base line + 0.168 m for IMU height 
above base plate) above the keel, 
1.866 m port of centerline and 
3.547 m forward of frame 52.  This 
information is needed to reference 
the IMU to the ship’s Heave 
Measurement Location (Heave 
Point). *

IMU to Port Ant

IMU to Heave



Sources

On September 23, 2003 an offset survey of the NOAA Ship FAIRWEATHER was conducted by:
Westlake Consultants, Incorporated
15115 SW Sequoia Parkway, Suite 150
Tigard, Oregon 97224
Phone (503) 684-0652

…and the relocation of the POS M/V antenna forced a partial resurvey in Feb. 2007 by Steven Breidenbach of NGS.

On July 16, 2004 an inclination experiment was conducted at MOC-P by:

Art Anderson Associates
202 Pacific Avenue
Bremerton, WA  98337-1932

Calculations

These values relate the physical positions of one sensor to the next with the base plate of the IMU being the point of origin.  All 
dimensions in the document are given in feet and decimal feet.  

The values for the required lever arms are listed in the S220_Offsets and Measurements spreadsheet.  The reference point and the 
IMU are identical.  Difference in documentation between Westlake and FA calculations are based off of measuring up from the 
IMU base (Westlake’s origin) and the top of the IMU.  The top center of the IMU for the POS/MV is the defined origin for the 
POS/MV and the origin that is being used on all FAIRWEATHER vessels.  The distance from the base plate to the top of the 
IMU is 0.168 m, a value measured by ship’s complement.  Conversions factor from feet to meters is 0.3048 m/ft.

As a requirement for the TPE, the standard deviation for each position is 3 mm.  This value is based upon a conversation with 
Elaine McDonald of Westlake and is followed up by an Email documenting that fact.  The email is located at the end of this 
document.

Offset values for the ship were derived from three sources.  Two static offset surveys, an inclination experiment, and values measured or 
approximated by ship’s personnel.
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Ship: FAIRWEATHER Vessel: S220
Date: 4/27/2009 Dn: 117
Personnel: Campbell, Rice

PCS Serial # IMU Serial # 292

IP Address: 129.100.1.231

Port Antenna Serial # Stbd Antenna Serial #

POS controller Version (Use Menu Help > About) 4.0.2.0

POS Version (Use Menu View > Statistics) 320 Version 4
GPS Receivers

Primary Receiver BD950 SN:4611A66708 v.00211

Secondary Receiver BD950 SN:4602A62806 v.00211

Calibration area
Location:
Approximate Position: Lat    

Lon    
DGPS Beacon Station: Alert Bay
Frequency: 309

NOAA POS/MV Calibration Report

Central Fitz Hugh Sound, BC, Canada

2411

60103854 60125191



Satellite Constellation (Use View> GPS Data)

Primary GPS
Sketch general SV configuration or insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

0.808 0.807

VDOP VDOP
1.172 1.169

Sattelites in use: 10 Sattelites in use: 10
L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP (Use View> GAMS Solution)

POS/MV Configuration
Settings Gams Parameter Setup (Use Settings>Installation>GAMS Installation)

  
    

   
   

  

Configuration Notes: Antenna separation based on 2007 survey.

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V3 Installation and Operation Guide, 4-25)

Start time: 19:59:38
End time: 20:34:44
Heading accuracy achieved for calibration: 0.253

Calibration Results:
 Gams Parameter Setup  (Use Settings>Installation>GAMS Installation)

   

   
  
  

GAMS Status Online Yes
Save Settings  

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name:

Secondary GPS

N



General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:
a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

COM2

COM3

COM4



SETTINGS Continued COM5

Heave Filter (Use Settings > Heave)

Events (Use Settings > Events)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)

INSTALLATION Continued
Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)



Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

Frame Control (Use Tools > Config)

(Use Settings> Installation> GPS Receiver Configuration)
GPS  Receiver Configuration 

Primary GPS  Receiver

Secondary GPS Receiver



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

4/28/2009
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

4/29/2009
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

Ptly cloudy, cool, Moira Rock

Applanix Pos MV

Moira Rock

2/15/2009Hull, curved transducer

S220 8111

Morgan, Welton, Raymond, Stuart, Ringel

Mar-2009Fairweather

118

Reson 8111

35652Unknown

4/27/2009

BOT_0004

BOT_0005

119

Back time cast number BOT_005

55\04\48.48 131\58\23.30



NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks
BOT_0005 206 3.7
BOT_0005 033 3.8
BOT_0005 207 9.0
BOT_0005 034 8.7
BOT_0005 207 9.0
BOT_0006 206 9.1

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks
BOT_0005 207 6.5
BOT_0005 033 6.5
BOT_0005 210 6.2
BOT_0005 033 7.2

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks
BOT_0005 031 6.5
BOT_0006 031 6.5
BOT_0006 208 6.5
BOT_0006 207 6.6

ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks
BOT_0004 270 5.3

086 5.4
268 5.4
091 5.7

view parallel to track, one line with induced roll (outerbeam) or same lines target or slope (nadir) 
[same direction, different speed]

2009_1190800

2009_1190857

2009_1190714
2009_1190732
2009_1190749

7m stb over tgt
30m stb over target redo:do not use for patch
5m port over target

2009__1190827

Line 3:good line held true
Line 4: good line held true

15m starboard over target

10m port over target

back time cast 0605
good line held true

8m starboard over target
30m port over target redo:do not use for patch

started to starboard, straightened smartly

2009_1190811

Line 3:good line held true

XTF Line Filename

2009__1190911
2009__1190937
2009__1191002

Line4: good line held true

good line
Off line to Starboard 20ish meters at start
mostly good line, 10m off at start
mostly good line, 20m off Starboard at start

2009__1190503
2009__1190519
2009__1190534
2009__1190548

XTF Line Filename

XTF Line Filename

XTF Line Filename
2009__1190608
2009__1190633
2009__1190645
2009_1190658



Processing Log

4/29/2009
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
-0.05 0.30 0.00 -0.30
0.04 -0.40 0.00 -0.40
-0.07 0.25 0.02 -0.70
0.00 -0.20 -0.02 -0.30
0.04 -0.30 0.00 -0.20

-0.01 -0.07 0.00 -0.38
0.05 0.32 0.10 0.01 0.19 0.08
0.00 -0.07 0.00 -0.38

CST/FOO

Resulting HVF File Name
Actual values used

MRU Align StdDev gyro 0.19 Value from standard deviation of Heading offset values 0.082
MRU Align StdDev 
gyro

MRU Align StdDev Roll/Pitch 0.17 Value from averaged standard deviations of pitch and roll offset values 0.057
MRU Align      
StdDev Roll/Pitch

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 05/06/09

Initial MRU values were too high, TPU values reassessed with outliers removed.

FA_S220_Reson8111_2009.hvf

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data converted --> HDCS_Data in CARIS

Stuart119

Averages
Standard Deviation

FINAL VALUES

L. Stuart
CST Morgan
FOO

CST Morgan

PosPac_S220_118.005

zerotide.tid

Moira_Rock_S220_SV.svp

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

B. Welton
A. Raymond

Final Values based on Average of all results



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

4/28/2009
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

4/28-29/2009
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth
BOT_0003 55/05.9346 131/56.5637

Applanix Pos MV

Moira Rock

2/15/2009Hull, flat faced

S220 8160

Morgan, Welton, Raymond, Campbell, Ringel

2004Fairweather  - S220

118

Reson 8160

35385Unknown

4/27/2009

01

NMEA Output was not run during SV Cast resulting in no positions, an approximate position for Cast #3 is entered below

PosPac_S220_118

Clear, cool, 2 foot chop, 10-12 kts NNWMoira Rock

BOT_0001

BOT_0002



NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks
BOT_0001 032 6.6

033 4.4
207 7.0

207 4.3
032 9.6
207 9.2

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks
BOT_0001 033 6.5

207 6.4
032 6.6
207 7.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks
BOT_0002 024 5.5

213 5.5
027 5.5
213 5.6

ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks
BOT_0003 270 6.2

090 6.3
270 5.0
090 6.8
270 6.3
090 6.0

Latency
Latency
Latency

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

2009_1190007

2009_1190034

2009_1182317
2009_1182347
2009_1182332

XTF Line Filename

SE Good line

good line
good line

Good pitch line

First line!!

2009_1190203
NW inboard and better overlap

NW line, good outer beam overlap with feature.
XTF Line Filename

SE

good line2009__1190408

XTF Line Filename
80m to port at beginning of line
lost bottom track mid line
poor line tracking
good line

good line

2009__1190307
2009__1190323
2009__1190338
2009__1190353

2009__1190426

2009_1190131
2009_1190147

HSX Line Filename
2009_1182240
2009_1182305
2009_1182317
2009_1182332

2009_1190112

Pretty good line.

2009_1190023

Also good Pitch line



Processing Log

4/29/2009
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.04 -0.40 -0.04 -0.40
0.00 -0.35 -0.07 0.60
0.05 -0.16 -0.04 0.55
0.01 -0.35 -0.04 0.60
0.00 -0.10 -0.05 0.50

0.02 -0.27 -0.05 0.37
0.02 0.13 0.029 0.01 0.43 0.05
0.00 -0.27 -0.50 0.37

Resulting HVF File Name
Actual values used

MRU Align StdDev gyro 0.43 Value from standard deviation of Heading offset values 0.048
MRU Align StdDev 
gyro

MRU Align StdDev Roll/Pitch 0.07 Value from averaged standard deviations of pitch and roll offset values 0.021
MRU Align      
StdDev Roll/Pitch

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 5/6/2009

Initial MRU values were too high, TPU values reassessed with outliers removed.

Data converted --> HDCS_Data in CARIS

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data analyzed was collected on Dn 118 and 119.

Stuart119

Final Values based on

Averages
Standard Deviation

FINAL VALUES

A. Raymond
B. Campbell
FOO

CST Morgan

PosPac_S220_118.000

zerotide.tid

Moira_Rock_S220_SV.svp

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

CST Morgan
B. Welton
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G.Rice 

2/26/09 

Fairweather Elipsoidally Referenced Dynamic Draft 
Measurement 

Lake Washington, February 23rd 2009 

 

On Feb 23rd, 2009 the NOAA Ship Fairweather conducted a dynamic draft measurement 

(DDM) on Lake Washington using post processed kinematics (PPK). A standard 

operating procedure was defined before the test and is included as Appendix A. The plan 

was to determine the how much, at different speeds, the vessel’s draft changes with 

reference to ellipsoidal height. During the test, Fairweather stopped between speeds to 

allow for a static height measurement. Due to time constraints this test was only run with 

approximate speeds of 4 knots, 6 knots, 8 knots, and 10 knots.  

 

Because this DDM was conducted on Lake Washington, any change in water level was 

assumed to be negligible. Since it was further assumed there was no current, speed 

through the water was determined using over-ground speed (GPS). Wind was from the 

North at approximately 10 knots. The ship was light on fuel, without launches, and 

drawing two feet less in the stern than would normally be expected during survey 

operations. 

 

POSPac file recording from the POS/MV began before getting underway, approximately 

an hour before the DDM was performed. After the test, the data were imported into 

POSPac processing software and reference stations were uploaded using the “smart 

select” option. Six stations were selected, three from CORS and three from SOPAC. The 

Smart Base Quality Check was run and it identified one position to be adjusted and two 

that could be set to control; these changes were accepted. Applanix Smart Base was run 

to generate a local virtual reference station. Processors then ran the GNSS-Inertial 

Processor, using the SmartBase GNSS Mode with a zero initialization for Roll, Pitch and 

Heading. Lever Arms and Mounting Arms were set to be in the 10cm uncertainty range. 
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A coordinate system of UTM zone 10 with the GEOID03 (Conus) was used while 

processing the data. Figure 1 is a screen grab of the network. Reference station distance 

from the working area ranged from 1500 meters to 35 kilometers. 

 
Figure 1 – The network used consisting of six reference stations. 

 

Once processed in POSPac the Display Plots were reviewed. No problems were found. 

The X, Y and Z Reference-Primary GPS Lever Arms varied by as much as 0.2 meters 

over the course of the exercise, although the Z Lever Arm agreed to within 3cm with the 

typical values found during the Ernest Sound Project. The Altitude SBET and the 

associated RMS values can be found in Figure 2 and Figure 3 respectively. 
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Figure 2 – The altitude time series during this test as seen in POSPac. 

 
Figure 3 – The estimated vertical error time series from POSPac. 
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Because the noise associated with altitude readings (Figure 2) is within the uncertainty 

shown in Figure 3, this noise is not considered significant.  Two approaches were 

considered for determining authentic draft measurement from within the noise. The first 

approach selects specific sections of data that have relatively small changes in speed and 

average them for both speed and ellipsoidal height. The draft, then, is the result of 

subtracting the average ellipsoidal height recorded at rest from the averaged ellipsoidal 

height at speed. The second method plots a best-fit polynomial curve to the distribution 

of all data on a speed vs ellipsoidal height axis (Figure 4). This is more robust and just as 

accurate as the first approach. Consider that survey vessels are often making changes to 

speed or course during operations, changes for which typical DDM tests do not account. 

The second method described was used here. 

 
Figure 4 – Ellipsoidal Height data as a function of the Speed with the best-fit curve. 

 
Figure 4 shows the data clusters at each of the target speeds. These clusters of data 

weight the best-fit curve to the correct shape. Data points from speed changes 

demonstrate the variation likely during survey operations and are an indicator of the 
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uncertainty for DDM. While the best-fit curve does not pass through each cluster, its 

proximity is within the vertical uncertainty for these measurements.  

 

The equation for the best-fit curve can be used to give the delta draft table needed by 

Caris. By simply plugging in different speeds the change in draft is given when the 

ellipsoidal offset at rest is subtracted from the equation, resulting in a zero y intercept. 

This is accomplished here by using the y intercept derived by the polynomial fit. If 

insufficient data from at rest is supplied to the best-fit process or the fit is poor this can 

result in a vertical offset. Since the table in Caris assumes down is positive the equation 

will also need to be multiplied by (-1). Equation 1 was derived using the described 

process and was used to populate Table 1. 

 
423 10*)*41.69*93.46*15.2( −++−=Δ SpeedSpeedSpeedDraft                    (1) 

 
Table 1 The computed Dynamic Draft Table for Caris 

Speed (m/s)  Delta Draft (m) 

0 0 

0.5 0.005 

1.0 0.011 

1.5 0.020 

2.0 0.031 

2.5 0.043 

3.0 0.057 

3.5 0.072 

4.0 0.089 

4.5 0.107 

5.0 0.125 

5.5 0.144 

6.0 0.164 
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While the number of terms in Equation 1 might be excessive it was deemed prudent to 

have too many rather than too few coefficients. 

 

Past dynamic draft values for Fairweather have varied and have had mixed success. The 

values used from the 2006 season have generally been accepted to work best and were 

used for 2008 when the 2008 values proved to be insufficient. Figure 5 allows for a visual 

comparison of these values. 

 
Figure 5 – A comparison of the 2009 ellipsoidally referenced measurements to those from previous 

years. 
 

The best-fit polynomial curve can be evaluated by subtracting its values from all test 

data. Calculating the standard deviation for these residual values give an estimate of the 

uncertainty in the estimate from the best-fit curve (Figure 6). 
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Figure 6 – The residual difference between the measurement data and the best-ft curve. 

 

Two standard deviations for the residual difference was calculated to be 4.7cm. While 

this is accurate for this test it is not accurate to say this depicts the uncertainty for 

dynamic draft in general. The changes in draft while changing speed was captured by this 

method but the further uncertainty caused by currents is not. It is standard for the vessel 

speed through the water to be approximated by the speed over ground on many NOAA 

vessels. Since this impacts how Caris implements the dynamic draft table it also impacts 

the delta draft used. 

 

In conclusion, this method for estimating the dynamic draft appears reliable from the 

comparison with previous year’s results as well as robust because of its inclusion of many 

measurements. Due to time constraints this test was limited to four speeds at 10 minutes 

each. More time at each speed and at more speeds would add to the reliability of the 

estimates. Differences between the best-fit curves for the geoid verse the ellipsoid varied 

by as much as 4 mm and was not considered significant. 
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Appendix A 
G. Rice 

2/3/08 

 

Dynamic Draft Measurements Using POSPac 
 

1. Scope: 
This document is for the initial attempt to use POSPac to measure dynamic draft relative 

to the ellipsoid aboard the NOAA Ship FAIRWEATHER. This process is only a 

preliminary and should be updated with lessons learned after the initial attempt.  

 

2. Background: 
This process is for a body of water with a static water level over short time periods, such 

as a lake. Tides will not be taken into account and it is assumed that currents are 

negligible. The ellipsoid is assumed to be relatively parallel to the water level over the 

area of this test. Time periods of static vessel settlement at the end of each line will help 

to confirm this assumption. V-datum does exist for the area of Lake Washington (where 

this test will be performed) so if needed the navigation information can be converted to 

the geoid. Since vertical data will only be referenced internally (at rest compared to 

underway) the datum does not matter as long as it is parallel to the water level plane. 

Because of the availability of reference stations for an established network the data will 

be processed to the ITRF ellipsoid. 

 

3. Data Collection: 
The POS/MV should be turned on and logging POSPac for 30 minutes before the 

beginning of the evolution. If time allows log the status of water and fuel tanks, which 

small boats are aboard and what the draft marks read. Once on location for the test sit 

static for 2 minutes and then again in between every line and again at the end of the test. 

Each line should be driven at speed for 5 minutes in each direction. The two minute rest 

can occur before or after turning around to begin the next line. Speed estimates are to 
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ensure proper space is available for each line only. Maintaining the same shaft RPM and 

propeller pitch for both directions is more important than having the same speed. Line 

speeds are as follows: 

Line 1 

Start/End 

Line 2 

Start/End 

Approximate 

speed (kts) 

Shaft  

RPM 

Propeller 

Pitch 

Comments 

  2 120 30  

  4 130 40  

  6 140 50  

  8 150 60  

  10 160 70  

  12 170 80  

 

Record the start and end time for each line according to the time in the POS Controller. 

 

4. Data Processing: 
The data will be processed through POSPac using either a Virtual Reference Station in a 

network or a single station. Output will likely be examined in either Python or Matlab to 

estimate actual Dynamic Draft Measurements.  
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SeaBat 8160 Noise Analysis 

1.0 Overview 
 
For mid and deep water sonar systems, noise emanating from the vessel on which the sonar is 
mounted is a major determinant in the performance of the sonar.   In addition to sources such as 
echosounders and other acoustic devices, such as doppler logs, mechanical noise from the 
engines and drive trains, and flow noise will also affect performance, with the magnitude of the 
noise varying with vessel speed. 
 
This document describes the noise analysis test done on the RESON SeaBat 8160 installed on 
the NOAA S/V Fairweather, on 10 October 2004. 

2.0 Test Conduct 
 
The following is a description of the system setup and test protocol used to test the SeaBat 8160 
multibeam sonar. 

2.1 Sonar Setup 
 
To determine the amount of in-band noise seen by the sonar, the system was configured as 
follows: 

 
Setting Value 
Power Off 
Gain Manual Fixed 20 
Range  100 meters 

 
Data collection was done using a RESON engineering utility, which collects the full amplitude 
and phase time series data from the sonar.  Figure 1 shows a sample screen capture, in this case 
one of the data sets taken at six knots, with a shaft speed of 140 RPM.  At least ten (10) 
collections were done for each test case, and the results for first 10 measurements each test case 
were averaged for the report. 

2.2 Vessel Operation 
 
Normal survey speed for the vessel is approximately 10 knots.  To bracket this range, and to 
check at possible lower survey speeds, the test was defined to cover the range of 2 to 12 knots, in 
2 knot steps.  The initial tests were at a shaft speed of 130 RPM, with the speed adjusted by 
changing the pitch on the propellers.  Additional tests were run at shaft speeds of 140 and 150 
RPM, with the pitch adjusted to achieve speeds of 6, 8 and 10 knots.  A log of data collections 
for the tests is provided in Appendix A. 
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All the underway data collections were done in water depths of 200 to 300 meters.  The zero 
speed data collections were done at anchor, in water depths of about 30 meters. 
 

 
Figure 1 - Snapshot Utility Screen Capture 

2.3 Data Analysis 
 
The data from each of the test cases were collated in an Excel spreadsheet, shown in Appendix 
B.  A graph of the measured noise levels, as a function of vessel speed and shaft RPM is shown 
in Figure 2.  The noise level is a unitless value that represents the average of all the amplitude 
samples, from all the beams for the sampled sonar ping.  This value represents a combination of 
the electrical noise in the sonar, and the response to all acoustic energy, within the bandwidth of 
the sonar, impinging on the receive array.   
 
For each the 130, 140 and 150 RPM tests, the plot shows the noise level as a function of vessel 
speed.  Only one sample was taken at 160 RPM, since to achieve the 12 knot speed, it was 
necessary to run at that RPM, with the pitch set to maximum test value of 10 feet. 
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8160 Noise vs. Speed

0.0

100.0

200.0

300.0

400.0

500.0

600.0

700.0

800.0

0 2 4 6 8 10 12 14

Speed (knots)

A
vg

 N
oi

se
 L

ev
el

130 RPM 140 RPM 150 RPM 160 RPM

Figure 2 - Noise Plot 

3.0 Conclusions 
 

a. It appears that the best survey speed, from a noise perspective, is at approximately 10 
knots.  Both lower and higher speeds correlate with higher noise levels. 

b. For lower survey speeds, it would be desirable to use a lower shaft RPM, combined with 
a higher pitch setting, to minimize the noise level seen by the sonar. 

c. The reason for the higher noise levels seen in the zero speed, at anchor collections is 
undetermined, by may be a result of the much shallower operating depth, and increased 
reverberation of vessel mechanical noise reflected off the bottom. 
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Appendix A – Test Log 
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Appendix B – Noise Analysis Spreadsheet 
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SeaBat 8111 Noise Analysis 

1.0 Overview 
 
For mid and deep water sonar systems, noise emanating from the vessel on which the sonar is 
mounted is a major determinant in the performance of the sonar.   In addition to sources such as 
echosounders and other acoustic devices, such as doppler logs, mechanical noise from the 
engines and drive trains, and flow noise will also affect performance, with the magnitude of the 
noise varying with vessel speed. 
 
This document describes the noise analysis test done on the RESON SeaBat 8111 installed on 
the NOAA S/V Fairweather, on 11 October 2004. 

2.0 Test Conduct 
 
The following is a description of the system setup and test protocol used to test the SeaBat 8111 
multibeam sonar. 

2.1 Sonar Setup 
 
To determine the amount of in-band noise seen by the sonar, the system was configured as 
follows: 

 
Setting Value 
Power Off 
Gain Manual Fixed 20 
Range  100 meters 

 
Data collection was done using a RESON engineering utility, which collects the full amplitude 
and phase time series data from the sonar.  Figure 1 shows a sample screen capture, in this case 
one of the data sets taken at six knots, with a shaft speed of 140 RPM.  At least ten (10) 
collections were done for each test case, and the results for first 10 measurements each test case 
were averaged for the report. 

2.2 Vessel Operation 
 
Normal survey speed for the vessel is approximately 10 knots.  To bracket this range, and to 
check at possible lower survey speeds, the test protocol was defined to cover the range of 2 to 12 
knots, in 2 knot steps.  The tests were conducted at shaft speeds of 120 to 170 RPM, in 10 RPM 
steps, with the speed adjusted by changing the pitch on the propellers.  For each RPM value, the 
speeds that could be achieved at that shaft speed were tested.  A log of data collections for the 
tests is provided in Appendix A. 
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All the underway data collections were done in water depths of 120 to 160 fathoms.  The zero 
speed data collections, with the engines on, were done at anchor in about 30 meters of water, and 
out in the bay, at water depths of about 130 fathoms. 
 

 
Figure 1 - Snapshot Utility Screen Capture 

2.3 Data Analysis 
 
The data from each of the test cases were collated in an Excel spreadsheet, shown in Appendix 
B.  A graph of the measured noise levels, as a function of vessel speed and shaft RPM is shown 
in Figure 2.  The noise level is a unitless value that represents the average of all the amplitude 
samples, from all the beams for the sampled sonar ping.  This value represents a combination of 
the electrical noise in the sonar, and the response to all acoustic energy, within the bandwidth of 
the sonar, impinging on the receive array.   
 
For each the tests, the plot shows the noise level as a function of vessel speed.  Again, the tests 
were run at the speeds that could be achieved at the selected shaft RPM. 
 
In an effort to resolve the cause of the high noise levels at anchor seen in the 8160 tests, noise 
tests with the engines at idle (110 shaft RPM, 0 pitch) in both shallow and deep water.  In deeper 



 

 

  
 

 
Fairweather 8111 Noise Analysis Report Page 3 of 6
 

water, much lower noise levels were observed, apparently due to the greater attenuation of the 
noise from the various acoustic sources on the ship over the greater range. 
 

8111 Noise Analysis
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Figure 2 - Noise Plot 

3.0 Conclusions 
 

a. It appears that the best survey speed for the 8111, from a noise perspective, is in the 
range of 8 to 10 knots.  Both lower and higher speeds correlate with higher noise levels. 

b. It would be desirable to use shaft speeds of 140 RPM, or lower, to minimize the noise 
level seen by the sonar. 

c. Significantly increased levels of reverberation from acoustic sources on the vessel are 
seen in shallower water.  If this causes any degradation in the quality of the soundings in 
the 8111, increased power levels, higher than those recommended in the sonar settings 
guide, should be used to compensate. 
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Appendix A – Test Logs 
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Appendix B – Noise Analysis Spreadsheet 
 

 
 



Appendix IV 
 
 
Total Propagated Error (TPE) 
 
 

• Fairweather TPE Values 
• Tide TPE Values 

 



Vessel FAIRWEATHER-S220 FAIRWEATHER-S220 1010 1018 1018
Sonar System Reson 8111 Reson 8160 Reson 8101 Reson 8101 Reson 8125

MRU to Trans X 2.868 0.493 0.250 0.282 -0.396
MRU to Trans Y 8.252 7.665 -0.133 -0.145 0.982
MRU to Trans  Z 4.752 4.726 0.549 0.548 0.751
Nav to Trans X 2.071 -0.304 1.147 1.181 0.502
Nav to Trans Y 20.144 19.557 1.066 0.955 2.082
Nav to Trans Z 17.792 17.766 3.665 3.717 3.919
Trans Roll 0.00 0.00 0.000 0.00 0.00

Vessel FAIRWEATHER-S220 FAIRWEATHER-S220 1010 1018 1018
Sonar System Reson 8111 Reson 8160 Reson 8101 Reson 8101 Reson 8101

Status

Version          
2009.3

Standard Deviation

POS/MV         
Model 320

Positioning System POS/MV          
Model 320

Positioning System

POS/MV         
Model 320

POS/MV          
Model 320 V4

POS/MV          
Model 320 V4

Offsets

FAIRWEATHER SURVEY

Documents Title                      
FA_TPE_Values_2009

POS/MV         
Model 320 V3

Process Owner   
Survey

Offsets

Last update        
July 18, 2009

Approval Date     
July 18, 2009     

POS/MV         
Model 320 V3

POS/MV         
Model 320 V3

POS/MV         
Model 320

               
Appendix IV

POS/MV          
Model 320

Motion Gyro (deg) 0.02 0.02 0.02 0.02 0.02 Finalized
Heave% Amp 5 5 5 5 5 Finalized
Heave (m) 0.05 0.05 0.05 0.05 0.05 Finalized
Roll (deg) 0.02 0.02 0.02 0.02 0.02 Finalized
Pitch (deg) 0.02 0.02 0.02 0.02 0.02 Finalized
Position Nav (m) 0.5* 0.5 0.5 0.5 0.5 Finalized
Vessel Speed (m/s) 0.03 0.03 0.03 0.03 0.03 Finalized
Timing Trans (s) 0.005 0.005 0.005 0.005 0.005 Finalized
Nav Timing (s) 0.005 0.005 0.005 0.005 0.005 Finalized
Gyro Timing (s) 0.005 0.005 0.005 0.005 0.005 Finalized
Heave Timing (s) 0.005 0.005 0.005 0.005 0.005 Finalized
Pitch Timing (s) 0.005 0.005 0.005 0.005 0.005 Finalized
Roll Timing (s) 0.005 0.005 0.005 0.005 0.005 Finalized
Offset X (m) 0.007 0.007 0.007 0.007 0.007 Finalized
Offset Y (m) 0.007 0.007 0.007 0.007 0.007 Finalized
Offset Z (m) 0.008 0.008 0.007 0.007 0.007 Finalized
Loading 0.01 0.01 0.050 0.017 0.017 Finalized
Draft (m) 0.014 0.014 0.035 0.035 0.035 Finalized
DeltaDraft (m) 0.050 0.050 0.060 0.060 0.060 Finalized
MRU alignStdev gyro 0.082 0.048 0.075 0.035 0.036 Finalized, 8125-P183^
MRU align roll/pitch 0.057 0.021 0.025 0.075 0.180 Finalized, 8125-P183^
Tide Meas (m) 0.01 0.01 0.01 0.01 0.01 Project Dependent**
Tide Zoning (m) Project Dependent Project Dependent Project Dependent Project Dependent Project Dependent Project Dependent**
SV Meas (m/s) 0.5 0.5 1.0 1.0 1.0 Defaults, Project Dependent**
Surface SV (m/s) 0.5 0.5 1.0 1.0 1.0 Defaults, Project Dependent**

*Position Nav adjusted in the HVF to 5m when acquiring in Coarse Acquisition mode, additional information will be submitted in the DAPR and/or the DR.
**Default values listed, descriptive report will list actual values applied if supplied with Project Instructions or calculated with the Sound speed estimator.
^MRU values for 1018 8125 may change as new patch test values are used.
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Tide Measurement Tide Zoning 95% Tide Zoning 1-sigma SV Msrd (m/s) Surface SV (m/s)
Project H# (Use in Caris) (Provided by CO-OPS) (Use in Caris) (Use in Caris) (Use in Caris)

OPR-O119-FA-09 8101 1.00 1.00
Ernest Sound 0.00 0.14 0.07 8125 1.00 0.50

8111/8160 0.50 0.50

OPR-P183-FA-09 8101 1.00 1.00
Shumagin Islands 0.00 0.00 0.00 8125 1.00 0.50

and Vicinity (TCARI is a special case, see FOO for more info) 8111/8160 0.50 0.50

OPR-P357-FA-09 8101 1.00 1.00
Kachemak bay 0.00 0.00 0.00 8125 1.00 0.50

(TCARI is a special case, see FOO for more info) 8111/8160 0.50 0.50



Appendix V 
 
 
Additional Calibration Reports 
 
 

• Control 
• Diver Least Depth Gauge 
• Laser Level 
• Leadlines 
• Sound Velocity 
• Total Stations 

 



                                                                                                     
Vertical Control Equipment Test 

April 2009 
 
The 2009 test of the Fairweathers’ vertical control equipment included testing five 8210 Sutron 
“bubbler” Tide Gauges that were provided by the Center for Operational Oceanographic 
Products and Services (CO-OPS).  The gauges are equipped with Paros Scientific Sensors (SDI-
12) for measuring pressure.  Each year, the gauges are checked by the CO-OPS Field Operations 
Center to ensure their accuracy. 
 
CO-OPS does not provide calibration or quality assurance documentation to the 
FAIRWEATHER.  FAIRWEATHER personnel are responsible for installation and removal of 
the water level gauges.  CO-OPS is responsible for delivering final approved vertical correctors 
to the FAIRWEATHER for application to the hydrographic data set.  As FAIRWEATHER 
receives new gauges, data quality assurance checks will be conducted in a similar manner as the 
procedures listed below to ensure full functionality prior to deployment. 

Five tide gauges: #10 (3344973C), #12 (3344B1D0), #13 (3344C740), #14 (3344D436) and #17 
(3351E1F2) were set up and tested by ship personnel at the Sand Point Pier in Seattle, WA from 
April 1st through April 17th, 2009.  Each gauge was tested for at least 48 hours to insure proper 
data collection.  The orifice was placed just off the pier by the gauge in approximately 10 meters 
of water. The GPS antenna was facing open sky to the South-Southwest. The set-up was 
periodically checked to insure proper transmission and to check for any leaks in the system. 
Table #1 below lists pertinent information for the five gauges tested at Sand Point. 
 
CO-OPS was able to verify that all the above gauges had strong transmissions to the GOES 
satellite, and were collecting accurate tide curves. 
 

  
  

Gauge # PAROS Ser# GOES Channel Plat ID Tx Time 
10 97043 116 3344973C 0:37:32 
12 85173 116 3344B1D0 0:17:02 
13 85220 116 3344C740 0:20:02 
14 86002 116 3344D436 0:23:32 
17 79049 116 3351E1F2 0:18:02 

Table 1: 2009 Gauge information 



Kukkamake February 26, 2009 (Dn 057) 
 
On February 26, 2009 (Dn 057) SST Campbell, ENS Forney, AST Renoud and AST Beduhn 
performed a Kukkamaki on both Carl Zeiss N12 (Stadia:333) levels (S/N 100056 and S/N 
103267). The Kukkamaki were performed in conjunction with the Tides Training portion of 
Hydroschool 2009 at Sand Point. 
 
The Kukkamaki course was set up in the parking lot on Lake Washington behind the Dive 
Building. The weather was sunny and cold with moderate wind. A 40 meter straight line was 
measured on level ground and divided into 10 meter intervals. The level was then set on the 
30 meter mark and a backsight and forsight were shot to the 20 and 40 meter marks 
respectively. Next the level was set up at the 0 meter mark, and a backsight and foresight 
were shot to the 20 and 40 meter marks, respectively. (See Fig. 1)  
 
The Carl Zeiss level, S/N 100056 had a collimation error of 0.026, and Zeiss level S/N 
103267 also had a collimation error of 0.026. Error values for both Zeiss levels fall within the 
+/- 0.05 tolerance requirements of the Field Procedures Manual, May 2008. 
 
 

 
Fig 1. Diagram of Kukkamaki setup 

 
 



 
 



 
 





SURVEY DATASHEET (Version 1.0)

PID: BBBK46
Designation: VIXEN HBR 2009

Stamping: VIXEN HBR 2009
Stability:

Setting: In rock outcrop or ledge
Description: A modified 3.5 inch bronze NOS disk is cemented into a rock

outcrop on the West Side of Magnetic Point on the eastern side of
Ernest Sound. The mark is approximately 10 feet above the high
water mark on the south side of the westward of two humps, and it
protrudes south out of a wooded area and is nearly surrounded at
high water. This mark was leveled as part of a series of NOS
benchmarks for a tide station originally designated as Vixen Harbor.

Observed: 2009-05-20T08:00:00Z
Source: OPUS - page5 0810.20 Close-up View

REF_FRAME:  
NAD_83(CORS96)

EPOCH:  
2003.0000

SOURCE:   NAVD88 (Computed using
GEOID06)

UNITS:
 m

 SET
PROFILE   DETAILS

LAT: 55° 47' 18.23740" ±  0.005  m
LON: -132° 11' 27.06511" ±  0.010  m

ELL HT: 1.331 ±  0.015  m
X: -2413974.145 ±  0.004  m
Y: -2663096.964 ±  0.015  m
Z: 5251232.937 ±  0.011  m

ORTHO HT: 5.768 ±  0.121  m

UTM  8 SPC  5001(AK 1 )
NORTHING: 6186101.208m 441196.443m

EASTING: 676130.571m 911250.506m
CONVERGENCE: 2.32366467° 1.22996338°

POINT SCALE: 0.99998052 0.99990050
COMBINED FACTOR: 0.99998032 0.00000000

CONTRIBUTED BY

glen.rice
National Oceanic and Atmospheric
Administration

Horizon View

The numerical values for this position solution have satisfied the quality control criteria of the National Geodetic Survey. The contributor has
verified that the information submitted is accurate and complete.

Map data ©2009 Tele Atlas - Terms of Use

SURVEY DATASHEET ( Version 1.0 ) http://beta.ngs.noaa.gov/CORS-Proxy/oraOpusDbWeb/getDatasheet.jsp?...
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 FILE: VIXE1201.09O 000038260 
 
                              NGS OPUS SOLUTION REPORT 
                              ======================== 
 
All computed coordinate accuracies are listed as peak-to-peak values. 
For additional information: www.ngs.noaa.gov/OPUS/Using_OPUS.html#accuracy 
 
      USER: weston.renoud@noaa.gov                  DATE: May 06, 2009 
RINEX FILE: vixe120s.09o                            TIME: 06:03:36 UTC 
 
 
  SOFTWARE: page5  0810.20 master11.pl 081023      START: 2009/04/30  18:28:00 
 EPHEMERIS: igr15294.eph [rapid]                    STOP: 2009/05/01  02:35:00 
  NAV FILE: brdc1200.09n                        OBS USED: 14778 / 16367   :  90% 
  ANT NAME: ASH701975.01AGP NONE             # FIXED AMB:    97 /   102   :  95% 
ARP HEIGHT: 1.3                              OVERALL RMS: 0.016(m) 
 
 
 REF FRAME: NAD_83(CORS96)(EPOCH:2003.0000)            ITRF00 (EPOCH:2009.3286) 
       
         X:     -2413974.164(m)   0.036(m)          -2413975.012(m)   0.036(m) 
         Y:     -2663096.982(m)   0.041(m)          -2663095.882(m)   0.041(m) 
         Z:      5251232.967(m)   0.060(m)           5251233.143(m)   0.060(m) 
 
       LAT:   55 47 18.23725      0.011(m)        55 47 18.24701      0.011(m) 
     E LON:  227 48 32.93477      0.009(m)       227 48 32.85632      0.009(m) 
     W LON:  132 11 27.06523      0.009(m)       132 11 27.14368      0.009(m) 
    EL HGT:            1.371(m)   0.080(m)                 1.378(m)   0.080(m) 
 ORTHO HGT:            5.808(m)   0.144(m) [NAVD88 (Computed using GEOID06)] 
 
                        UTM COORDINATES    STATE PLANE COORDINATES 
                         UTM (Zone 08)         SPC (5001 AK 1) 
Northing (Y) [meters]     6186101.204           441196.438 
Easting (X)  [meters]      676130.569           911250.504 
Convergence  [degrees]     2.32366465           1.22996336 
Point Scale                0.99998052           0.99990050 
Combined Factor            0.99998031           0.00000000 
 
US NATIONAL GRID DESIGNATOR:  8UPG7613186101(NAD 83) 
 
 
 
                              BASE STATIONS USED 
PID       DESIGNATION                        LATITUDE    LONGITUDE DISTANCE(m) 
DK6423 BIS5 BIORKA ISLAND 5 CORS ARP       N565116.162 W1353221.387  238727.4 
DJ3035 LEV6 LEVEL ISLAND 6 CORS ARP        N562756.364 W1330532.511   93963.3 
DK6482 AIS5 ANNETTE ISLAND 5 CORS ARP      N550408.647 W1313558.255   88401.3 
 
                 NEAREST NGS PUBLISHED CONTROL POINT 
UV5996      LOOK 1916                      N554728.961 W1321123.951     336.0 
 
 
  



                          BASE STATION INFORMATION  
                                                    
 STATION NAME: bis5  a    2 (Biorka Island 5; Biorka Island, Alaska  USA) 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2494921.0833  -2448390.9914   5317113.6533  MON @ 1997.0000 (M) 
 XYZ        -0.0164         0.0037         0.0005  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0034        -0.0019         0.0813  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0037        -0.0015         0.0689  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.2022         0.0456         0.0062  VEL TIMES 12.3286 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0351        -0.0318         0.0662  ARP TO L1 PHASE CENTER 
 XYZ  -2494921.3206  -2448390.9776   5317113.7257  L1 PHS CEN @ 2009.3286 
 XYZ         0.0000         0.0001         0.0001  + XYZ ADJUSTMENTS 
 XYZ  -2494921.3205  -2448390.9775   5317113.7257  NEW L1 PHS CEN @ 2009.3286 
 XYZ  -2494921.2855  -2448390.9457   5317113.6595  NEW ARP @ 2009.3286 
 XYZ  -2494921.2855  -2448390.9457   5317113.6595  NEW MON @ 2009.3286 
 LLH  56 51 16.17152  224 27 38.53076     66.8349  NEW L1 PHS CEN @ 2009.3286 
 LLH  56 51 16.17163  224 27 38.53088     66.7536  NEW ARP @ 2009.3286 
 LLH  56 51 16.17163  224 27 38.53088     66.7536  NEW MON @ 2009.3286 
 
 STATION NAME: lev6  a    2 (Level Island 6; Level Island, Alaska  USA) 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2412812.0457  -2579074.2577   5293282.2476  MON @ 1997.0000 (M) 
 XYZ        -0.0190         0.0003        -0.0044  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0034        -0.0019         0.0813  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0037        -0.0015         0.0689  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.2342         0.0037        -0.0542  VEL TIMES 12.3286 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0340        -0.0336         0.0659  ARP TO L1 PHASE CENTER 
 XYZ  -2412812.3140  -2579074.2876   5293282.2592  L1 PHS CEN @ 2009.3286 
 XYZ        -0.0000         0.0000         0.0000  + XYZ ADJUSTMENTS 
 XYZ  -2412812.3140  -2579074.2875   5293282.2593  NEW L1 PHS CEN @ 2009.3286 
 XYZ  -2412812.2799  -2579074.2540   5293282.1934  NEW ARP @ 2009.3286 
 XYZ  -2412812.2799  -2579074.2540   5293282.1934  NEW MON @ 2009.3286 
 LLH  56 27 56.37385  226 54 27.40784     25.4801  NEW L1 PHS CEN @ 2009.3286 
 LLH  56 27 56.37396  226 54 27.40796     25.3988  NEW ARP @ 2009.3286 
 LLH  56 27 56.37396  226 54 27.40796     25.3988  NEW MON @ 2009.3286 
 
 STATION NAME: ais5  a    2 (Annette Island 5; Annette Island, Alaska  USA) 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2430153.8469  -2737192.9494   5205816.7670  MON @ 1997.0000 (M) 
 XYZ        -0.0147        -0.0013        -0.0087  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0034        -0.0019         0.0813  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0037        -0.0015         0.0689  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.1812        -0.0160        -0.1073  VEL TIMES 12.3286 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0342        -0.0356         0.0647  ARP TO L1 PHASE CENTER 
 XYZ  -2430154.0623  -2737193.0011   5205816.7244  L1 PHS CEN @ 2009.3286 
 XYZ         0.0000        -0.0000        -0.0000  + XYZ ADJUSTMENTS 
 XYZ  -2430154.0623  -2737193.0011   5205816.7244  NEW L1 PHS CEN @ 2009.3286 
 XYZ  -2430154.0281  -2737192.9654   5205816.6597  NEW ARP @ 2009.3286 
 XYZ  -2430154.0281  -2737192.9654   5205816.6597  NEW MON @ 2009.3286 
 LLH  55  4  8.65794  228 24  1.66886     32.4119  NEW L1 PHS CEN @ 2009.3286 
 LLH  55  4  8.65805  228 24  1.66897     32.3306  NEW ARP @ 2009.3286 
 LLH  55  4  8.65805  228 24  1.66897     32.3306  NEW MON @ 2009.3286 
 
  



                         REMOTE STATION INFORMATION 
                                                    
 STATION NAME: vixe       1 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2413975.4955  -2663095.9246   5251234.3436  MON @ 2009.3281 (M) 
 NEU         0.0025         0.0026         1.3000  MON TO ARP (M) 
 NEU        -0.0025        -0.0026         0.0637  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0012         0.0008         0.0440  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.4876        -0.5418         1.0765  MON TO ARP 
 XYZ        -0.0274        -0.0263         0.0513  ARP TO L1 PHASE CENTER 
 XYZ  -2413976.0104  -2663096.4927   5251235.4713  L1 PHS CEN @ 2009.3286 
 
 BASELINE NAME:   bis5  vixe 
 XYZ         0.4944         0.0601        -1.2254  + XYZ ADJUSTMENTS 
 XYZ  -2413975.5160  -2663096.4326   5251234.2459  NEW L1 PHS CEN @ 2009.3286 
 XYZ  -2413975.4887  -2663096.4063   5251234.1947  NEW ARP @ 2009.3286 
 XYZ  -2413975.0011  -2663095.8645   5251233.1182  NEW MON @ 2009.3286 
 LLH  55 47 18.24711  227 48 32.85611      2.7099  NEW L1 PHS CEN @ 2009.3286 
 LLH  55 47 18.24719  227 48 32.85626      2.6462  NEW ARP @ 2009.3286 
 LLH  55 47 18.24711  227 48 32.85611      1.3462  NEW MON @ 2009.3286 
 
 BASELINE NAME:   lev6  vixe 
 XYZ         0.4956         0.0484        -1.2118  + XYZ ADJUSTMENTS 
 XYZ  -2413975.5149  -2663096.4443   5251234.2595  NEW L1 PHS CEN @ 2009.3286 
 XYZ  -2413975.4875  -2663096.4180   5251234.2082  NEW ARP @ 2009.3286 
 XYZ  -2413974.9999  -2663095.8762   5251233.1318  NEW MON @ 2009.3286 
 LLH  55 47 18.24714  227 48 32.85661      2.7255  NEW L1 PHS CEN @ 2009.3286 
 LLH  55 47 18.24722  227 48 32.85676      2.6618  NEW ARP @ 2009.3286 
 LLH  55 47 18.24714  227 48 32.85661      1.3618  NEW MON @ 2009.3286 
 
 BASELINE NAME:   ais5  vixe 
 XYZ         0.4596         0.0195        -1.1652  + XYZ ADJUSTMENTS 
 XYZ  -2413975.5509  -2663096.4732   5251234.3062  NEW L1 PHS CEN @ 2009.3286 
 XYZ  -2413975.5235  -2663096.4468   5251234.2549  NEW ARP @ 2009.3286 
 XYZ  -2413975.0359  -2663095.9051   5251233.1784  NEW MON @ 2009.3286 
 LLH  55 47 18.24677  227 48 32.85619      2.7897  NEW L1 PHS CEN @ 2009.3286 
 LLH  55 47 18.24685  227 48 32.85634      2.7260  NEW ARP @ 2009.3286 
 LLH  55 47 18.24677  227 48 32.85619      1.4260  NEW MON @ 2009.3286 
 
                                   G-FILES  
                                            
Axx2009 430   9 5 1 
B2009 4301828   9 5 1 235 1 page5 v0810.20IGS     226 1 2 27NGS   2009 5 6IFDDFX 
Iant_info.003        NGS   20090501 
C00090001 -809462844   24 2147049188   30  658805413   33 X1209AVIXEX1209ABIS5 
D  1  2  4808077  1  3 -9110619  2  3 -5412684 
  
Axx2009 430   9 5 1 
B2009 4301828   9 5 1 235 1 page5 v0810.20IGS     226 1 2 27NGS   2009 5 6IFDDFX 
Iant_info.003        NGS   20090501 
C00090002   11627200   25  840216222   34  420490616   38 X1209AVIXEX1209ALEV6 
D  1  2  6906117  1  3 -8609405  2  3 -3610684 
  
Axx2009 430   9 5 1 
B2009 4301828   9 5 1 235 1 page5 v0810.20IGS     226 1 2 27NGS   2009 5 6IFDDFX 
Iant_info.003        NGS   20090501 
C00090003 -161789922   38 -740970604   54 -454165187   57 X1209AVIXEX1209AAIS5 
D  1  2  7937919  1  3 -6704252  2  3 -1704411 
 
  



                   POST-FIT RMS BY SATELLITE VS. BASELINE 
                                                          
            OVERALL     02     03     04     06     07     08     09     10 
 bis5-vixe|  0.015  0.022  0.059  0.016    ...  0.015  0.014    ...  0.018 
                11     12     13     14     16     17     18     19     20 
 bis5-vixe|  0.011    ...  0.017  0.014  0.018  0.017    ...  0.017  0.014 
                22     23     24     25     28     30     31     32 
 bis5-vixe|  0.018  0.013    ...  0.015  0.022    ...  0.018  0.020        
 
            OVERALL     01     02     03     04     06     07     08     09 
 lev6-vixe|  0.015    ...  0.018  0.001  0.016    ...  0.015  0.014    ... 
                10     11     12     13     14     16     17     18     19 
 lev6-vixe|  0.018  0.012    ...  0.016  0.014  0.013  0.018    ...  0.019 
                20     22     23     24     25     28     30     31     32 
 lev6-vixe|  0.014  0.019  0.014    ...  0.015    ...    ...  0.019    ... 
 
            OVERALL     02     03     04     06     07     08     09     10 
 ais5-vixe|  0.017  0.025  0.008  0.021    ...  0.014  0.016    ...  0.020 
                11     12     13     14     16     17     18     19     20 
 ais5-vixe|  0.013    ...  0.021  0.015  0.012  0.022    ...  0.019  0.022 
                22     23     24     25     28     30     31     32 
 ais5-vixe|  0.021  0.016    ...  0.015  0.022    ...  0.017  0.019        
 
                        OBS BY SATELLITE VS. BASELINE 
                                                      
            OVERALL     02     03     04     06     07     08     09     10 
 bis5-vixe|   5152    289      1    375    ...    421    269    ...    246 
                11     12     13     14     16     17     18     19     20 
 bis5-vixe|    389    ...    191    220      9    247    ...    139    608 
                22     23     24     25     28     30     31     32 
 bis5-vixe|    110    642    ...    531     61    ...    385     19        
            OVERALL     01     02     03     04     06     07     08     09 
 lev6-vixe|   4998    ...    252      1    380    ...    427    254    ... 
                10     11     12     13     14     16     17     18     19 
 lev6-vixe|    234    399    ...    196    221      8    262    ...    137 
                20     22     23     24     25     28     30     31     32 
 lev6-vixe|    584    110    612    ...    523    ...    ...    398    ... 
            OVERALL     02     03     04     06     07     08     09     10 
 ais5-vixe|   4628    151      1    314    ...    411    234    ...    209 
                11     12     13     14     16     17     18     19     20 
 ais5-vixe|    384    ...    163    221      8    151    ...    108    566 
                22     23     24     25     28     30     31     32 
 ais5-vixe|    112    616    ...    523     48    ...    390     18        
                                            
 
 Covariance Matrix for the xyz OPUS Position (meters2). 
    0.0000058778     0.0000005693    -0.0000006648 
    0.0000005693     0.0000110489    -0.0000003393 
   -0.0000006648    -0.0000003393     0.0000128489 
 
 Covariance Matrix for the enu OPUS Position (meters2). 
    0.0000076436    -0.0000022269     0.0000012035 
   -0.0000022269     0.0000097701     0.0000014095 
    0.0000012035     0.0000014095     0.0000123618 
 
 Horizontal network accuracy =    0.00730 meters. 
 Vertical network accuracy   =    0.00689 meters. 
 
  



                       Derivation of NAD 83 vector components 
 
  
  Position of reference station ARP in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Xa(m)           Ya(m)           Za(m) 
       BIS5  -2494920.44060  -2448392.05858   5317113.38841    2003.00 
       LEV6  -2412811.42529  -2579075.35282   5293281.97185    2003.00 
       AIS5  -2430153.20716  -2737194.06415   5205816.48535    2003.00 
  
  Position of reference station monument in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Xr(m)           Yr(m)           Zr(m) 
       BIS5  -2494920.44060  -2448392.05858   5317113.38841    2003.00 
       LEV6  -2412811.42529  -2579075.35282   5293281.97185    2003.00 
       AIS5  -2430153.20716  -2737194.06415   5205816.48535    2003.00 
  
  Velocity of reference station monument in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Vx (m/yr)       Vy (m/yr)       Vz (m/yr) 
       BIS5         0.00490         0.00450         0.00990 
       LEV6         0.00220         0.00120         0.00480 
       AIS5         0.00620        -0.00040         0.00060 
  
  Vectors from unknown station monument to reference station monument 
  in NAD_83(CORS96)(EPOCH:2003.0000). 
                Xr-X= DX(m)     Yr-Y= DY(m)     Zr-Z= DZ(m) 
       BIS5    -80946.27660    214704.92342     65880.42141    2003.00 
       LEV6      1162.73871     84021.62918     42049.00485    2003.00 
       AIS5    -16179.04316    -74097.08215    -45416.48165    2003.00 
 
This position and the above vector components were computed without any  
knowledge by the National Geodetic Survey regarding the equipment or  
field operating procedures used. 
 



  

The NGS Data Sheet

See file  dsdata.txt for more information about the datasheet.

DATABASE =  ,PROGRAM = datasheet, VERSION = 7.67
1        National Geodetic Survey,   Retrieval Date = AUGUST  4, 2009
 AI4914 ***********************************************************************
 AI4914  DESIGNATION -  BM NO 37
 AI4914  PID         -  AI4914
 AI4914  STATE/COUNTY-  AK/KETCHIKAN GATEWAY BOROUGH
 AI4914  USGS QUAD   -  KETCHIKAN B-5
 AI4914
 AI4914                         *CURRENT SURVEY CONTROL
 AI4914  ___________________________________________________________________
 AI4914* NAD 83(2007)-  55 19 58.66141(N)    131 37 31.81957(W)     ADJUSTED  
 AI4914* LOCAL TIDAL -         8.25   (meters)      27.1    (feet)  LEVELING  
 AI4914  ___________________________________________________________________
 AI4914  EPOCH DATE  -        2007.00
 AI4914  X           -  -2,415,358.879 (meters)                     COMP
 AI4914  Y           -  -2,718,046.174 (meters)                     COMP
 AI4914  Z           -   5,222,559.311 (meters)                     COMP
 AI4914  LAPLACE CORR-          -0.13  (seconds)                    DEFLEC99
 AI4914  ELLIP HEIGHT-           3.778 (meters)          (02/10/07) ADJUSTED
 AI4914  GEOID HEIGHT-          -5.88  (meters)                     GEOID06
 AI4914
 AI4914  ------- Accuracy Estimates (at 95% Confidence Level in cm) --------
 AI4914  Type    PID    Designation                      North   East  Ellip
 AI4914  -------------------------------------------------------------------
 AI4914  NETWORK AI4914 BM NO 37                          0.63   0.45   1.57
 AI4914  -------------------------------------------------------------------
 AI4914  VERT ORDER  -  THIRD ?
 AI4914
 AI4914.The horizontal coordinates were established by GPS observations
 AI4914.and adjusted by the National Geodetic Survey in February 2007.
 AI4914
 AI4914.The datum tag of NAD 83(2007) is equivalent to NAD 83(NSRS2007).
 AI4914.See National Readjustment for more information.
 AI4914.The horizontal coordinates are valid at the epoch date displayed above.
 AI4914.The epoch date for horizontal control is a decimal equivalence
 AI4914.of Year/Month/Day.
 AI4914
 AI4914.The orthometric height was determined by differential leveling.
 AI4914.The vertical network tie was performed by a horz. field party for horz.
 AI4914.obs reductions. Reset procedures were used to establish the elevation.
 AI4914
 AI4914.Photographs are available for this station.
 AI4914
 AI4914.The X, Y, and Z were computed from the position and the ellipsoidal ht.
 AI4914
 AI4914.The Laplace correction was computed from DEFLEC99 derived deflections.
 AI4914
 AI4914.The ellipsoidal height was determined by GPS observations
 AI4914.and is referenced to NAD 83.
 AI4914
 AI4914.The geoid height was determined by GEOID06.
 AI4914
 AI4914;                    North         East     Units Scale Factor Converg.
 AI4914;SPC AK 1     -   391,423.859   948,202.671   MT  0.99990058   +1 41 48.4
 AI4914;UTM  09      - 6,134,983.224   333,464.473   MT  0.99994023   -2 09 35.6

DATASHEETS http://www.ngs.noaa.gov/cgi-bin/ds_mark.prl?PidBox=AI4914
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 AI4914
 AI4914!             -  Elev Factor  x  Scale Factor =   Combined Factor
 AI4914!SPC AK 1     -   0.99999941  x   0.99990058  =   0.99989999
 AI4914!UTM  09      -   0.99999941  x   0.99994023  =   0.99993964
 AI4914
 AI4914                          SUPERSEDED SURVEY CONTROL
 AI4914
 AI4914  NAD 83(1992)-  55 19 58.65991(N)    131 37 31.82053(W) AD(       ) B
 AI4914  ELLIP H (04/28/00)    3.819  (m)                       GP(       ) 4 1
 AI4914
 AI4914.Superseded values are not recommended for survey control.
 AI4914.NGS no longer adjusts projects to the NAD 27 or NGVD 29 datums.
 AI4914.See file dsdata.txt to determine how the superseded data were derived.
 AI4914
 AI4914_U.S. NATIONAL GRID SPATIAL ADDRESS:  9UUB3346434983(NAD 83)
 AI4914_MARKER: DB = BENCH MARK DISK
 AI4914_SETTING: 32 = SET IN A RETAINING WALL OR CONCRETE LEDGE
 AI4914_SP_SET: RETAINING WALL
 AI4914_STAMPING: NO 37 1956
 AI4914_MARK LOGO: CGS   
 AI4914_MAGNETIC: O = OTHER; SEE DESCRIPTION
 AI4914_STABILITY: B = PROBABLY HOLD POSITION/ELEVATION WELL
 AI4914_SATELLITE: THE SITE LOCATION WAS REPORTED AS SUITABLE FOR
 AI4914+SATELLITE: SATELLITE OBSERVATIONS - January 04, 2007
 AI4914
 AI4914  HISTORY     - Date     Condition        Report By
 AI4914  HISTORY     - 1956     MONUMENTED       CGS
 AI4914  HISTORY     - 20050420 GOOD             NGS
 AI4914  HISTORY     - 20070104 GOOD             INDIV
 AI4914
 AI4914                          STATION DESCRIPTION
 AI4914
 AI4914'DESCRIBED BY COAST AND GEODETIC SURVEY 1956
 AI4914'DESCRIBED BY R+M CONSULTANTS 1999 (RHB) .  THE STATION IS LOCATED
 AI4914'APPROXIMATELY 1.6 KM (1.00 MI) SOUTHEASTERLY OF DOWNTOWN KETCHIKAN
 AI4914'ALASKA AT THE KETCHIKAN COAST GUARD BASE.  OWNERSHIP-- UNITED STATES
 AI4914'COAST GUARD, C/O PCC CHUCK SHAFFER I.S.C.  KETCHIKAN, 1300 STEDMAN
 AI4914'STREET, KETCHIKAN ALASKA 99901, PHONE NUMBER 907-228-0380, FAX NUMBER
 AI4914'907-228-0314, ACCESS IS RESTRICTED.  CONTACT THE CHIEF PETTY OFFICER
 AI4914'AT LEAST 48 HOURS PRIOR TO ENTRY.
 AI4914'TO REACH THE STATION FROM THE INTERSECTION OF STEDMAN STREET AND
 AI4914'DEERMOUNT STREET, AT THE SOUTHEASTERLY END OF KETCHIKAN, PROCEED
 AI4914'SOUTHEAST 1.0 KM (0.60 MI) ALONG STEDMAN STREET TO THE COAST GUARD
 AI4914'BASE AND THE STATION ON THE RIGHT.
 AI4914'THE STATION IS A STANDARD USCGS BRASS BENCH MARK DISK STAMPED --NO 37
 AI4914'1956-- AND SET FLUSH WITH A CONCRETE RETAINING WALL IN FRONT OF THE
 AI4914'COAST GUARD ADMINISTRATION BUILDING.  THE STATION IS LOCATED 26.5 M
 AI4914'(86.9 FT) 351 DEGREES MAGNETIC AZIMUTH FROM THE NORTHEAST CORNER OF
 AI4914'THE COAST GUARD ADMINISTRATION BUILDING, 3.0 M (9.8 FT) 134 DEGREES
 AI4914'MAGNETIC AZIMUTH FROM THE NORTH END OF A GUARD RAIL, AND 42.2 M (138.5
 AI4914'FT) 95 DEGREES MAGNETIC AZIMUTH FROM A FIRE HYDRANT.
 AI4914
 AI4914                          STATION RECOVERY (2005)
 AI4914
 AI4914'RECOVERY NOTE BY NATIONAL GEODETIC SURVEY 2005 (RA)
 AI4914'RECOVERED IN GOOD CONDITION.
 AI4914
 AI4914                          STATION RECOVERY (2007)
 AI4914
 AI4914'RECOVERY NOTE BY INDIVIDUAL CONTRIBUTORS 2007 (JPP)
 AI4914'RECOVERED AS DESCRIBED

 *** retrieval complete.
 Elapsed Time = 00:00:00
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 FILE: USCG1212.09O 000038225 
 
                              NGS OPUS SOLUTION REPORT 
                              ======================== 
 
All computed coordinate accuracies are listed as peak-to-peak values. 
For additional information: www.ngs.noaa.gov/OPUS/Using_OPUS.html#accuracy 
 
      USER: weston.renoud@noaa.gov                  DATE: May 06, 2009 
RINEX FILE: uscg121u.09o                            TIME: 01:51:09 UTC 
 
 
  SOFTWARE: page5  0810.20 master30.pl 081023      START: 2009/05/01  20:56:00 
 EPHEMERIS: igr15295.eph [rapid]                    STOP: 2009/05/01  23:05:00 
  NAV FILE: brdc1210.09n                        OBS USED:  4299 /  4471   :  96% 
  ANT NAME: ASH701975.01AGP NONE             # FIXED AMB:    25 /    28   :  89% 
ARP HEIGHT: 1.5                              OVERALL RMS: 0.016(m) 
 
 
 REF FRAME: NAD_83(CORS96)(EPOCH:2003.0000)            ITRF00 (EPOCH:2009.3313) 
       
         X:     -2415358.948(m)   0.060(m)          -2415359.797(m)   0.060(m) 
         Y:     -2718046.293(m)   0.089(m)          -2718045.189(m)   0.089(m) 
         Z:      5222559.332(m)   0.048(m)           5222559.513(m)   0.048(m) 
 
       LAT:   55 19 58.65822      0.078(m)        55 19 58.66849      0.078(m) 
     E LON:  228 22 28.18196      0.066(m)       228 22 28.10437      0.066(m) 
     W LON:  131 37 31.81804      0.066(m)       131 37 31.89563      0.066(m) 
    EL HGT:            3.872(m)   0.058(m)                 3.872(m)   0.058(m) 
 ORTHO HGT:            9.747(m)   0.133(m) [NAVD88 (Computed using GEOID06)] 
 
                        UTM COORDINATES    STATE PLANE COORDINATES 
                         UTM (Zone 09)         SPC (5001 AK 1) 
Northing (Y) [meters]     6134983.124           391423.761 
Easting (X)  [meters]      333464.496           948202.701 
Convergence  [degrees]    -2.15989498           1.69678539 
Point Scale                0.99994023           0.99990058 
Combined Factor            0.99993962           0.00000000 
 
US NATIONAL GRID DESIGNATOR:  9UUB3346434983(NAD 83) 
 
 
 
                              BASE STATIONS USED 
PID       DESIGNATION                        LATITUDE    LONGITUDE DISTANCE(m) 
DK6423 BIS5 BIORKA ISLAND 5 CORS ARP       N565116.162 W1353221.387  296620.9 
DJ3035 LEV6 LEVEL ISLAND 6 CORS ARP        N562756.364 W1330532.511  155952.3 
DK6482 AIS5 ANNETTE ISLAND 5 CORS ARP      N550408.647 W1313558.255   29425.0 
 
                 NEAREST NGS PUBLISHED CONTROL POINT 
AI4914      BM NO 37                       N551958.661 W1313731.819       0.0 
 
 
  



                          BASE STATION INFORMATION  
                                                    
 STATION NAME: bis5  a    2 (Biorka Island 5; Biorka Island, Alaska  USA) 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2494921.0833  -2448390.9914   5317113.6533  MON @ 1997.0000 (M) 
 XYZ        -0.0164         0.0037         0.0005  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0034        -0.0019         0.0813  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0037        -0.0015         0.0689  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.2022         0.0456         0.0062  VEL TIMES 12.3313 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0351        -0.0318         0.0662  ARP TO L1 PHASE CENTER 
 XYZ  -2494921.3206  -2448390.9775   5317113.7257  L1 PHS CEN @ 2009.3313 
 XYZ        -0.0000        -0.0000        -0.0000  + XYZ ADJUSTMENTS 
 XYZ  -2494921.3206  -2448390.9776   5317113.7257  NEW L1 PHS CEN @ 2009.3313 
 XYZ  -2494921.2855  -2448390.9458   5317113.6595  NEW ARP @ 2009.3313 
 XYZ  -2494921.2855  -2448390.9458   5317113.6595  NEW MON @ 2009.3313 
 LLH  56 51 16.17151  224 27 38.53076     66.8349  NEW L1 PHS CEN @ 2009.3313 
 LLH  56 51 16.17162  224 27 38.53087     66.7536  NEW ARP @ 2009.3313 
 LLH  56 51 16.17162  224 27 38.53087     66.7536  NEW MON @ 2009.3313 
 
 STATION NAME: lev6  a    2 (Level Island 6; Level Island, Alaska  USA) 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2412812.0457  -2579074.2577   5293282.2476  MON @ 1997.0000 (M) 
 XYZ        -0.0190         0.0003        -0.0044  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0034        -0.0019         0.0813  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0037        -0.0015         0.0689  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.2343         0.0037        -0.0543  VEL TIMES 12.3313 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0340        -0.0336         0.0659  ARP TO L1 PHASE CENTER 
 XYZ  -2412812.3140  -2579074.2876   5293282.2592  L1 PHS CEN @ 2009.3313 
 XYZ        -0.0000         0.0000        -0.0000  + XYZ ADJUSTMENTS 
 XYZ  -2412812.3140  -2579074.2876   5293282.2592  NEW L1 PHS CEN @ 2009.3313 
 XYZ  -2412812.2800  -2579074.2540   5293282.1933  NEW ARP @ 2009.3313 
 XYZ  -2412812.2800  -2579074.2540   5293282.1933  NEW MON @ 2009.3313 
 LLH  56 27 56.37384  226 54 27.40784     25.4801  NEW L1 PHS CEN @ 2009.3313 
 LLH  56 27 56.37395  226 54 27.40796     25.3988  NEW ARP @ 2009.3313 
 LLH  56 27 56.37395  226 54 27.40796     25.3988  NEW MON @ 2009.3313 
 
 STATION NAME: ais5  a    2 (Annette Island 5; Annette Island, Alaska  USA) 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2430153.8469  -2737192.9494   5205816.7670  MON @ 1997.0000 (M) 
 XYZ        -0.0147        -0.0013        -0.0087  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0034        -0.0019         0.0813  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0037        -0.0015         0.0689  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.1813        -0.0160        -0.1073  VEL TIMES 12.3313 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0342        -0.0356         0.0647  ARP TO L1 PHASE CENTER 
 XYZ  -2430154.0623  -2737193.0011   5205816.7244  L1 PHS CEN @ 2009.3313 
 XYZ        -0.0000         0.0000        -0.0000  + XYZ ADJUSTMENTS 
 XYZ  -2430154.0623  -2737193.0011   5205816.7244  NEW L1 PHS CEN @ 2009.3313 
 XYZ  -2430154.0282  -2737192.9654   5205816.6597  NEW ARP @ 2009.3313 
 XYZ  -2430154.0282  -2737192.9654   5205816.6597  NEW MON @ 2009.3313 
 LLH  55  4  8.65794  228 24  1.66886     32.4119  NEW L1 PHS CEN @ 2009.3313 
 LLH  55  4  8.65805  228 24  1.66897     32.3306  NEW ARP @ 2009.3313 
 LLH  55  4  8.65805  228 24  1.66897     32.3306  NEW MON @ 2009.3313 
 
  



                         REMOTE STATION INFORMATION 
                                                    
 STATION NAME: uscg       1 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2415360.6791  -2718045.9236   5222561.0525  MON @ 2009.3312 (M) 
 NEU         0.0025         0.0026         1.5000  MON TO ARP (M) 
 NEU        -0.0025        -0.0026         0.0637  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0012         0.0008         0.0440  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.5634        -0.6380         1.2351  MON TO ARP 
 XYZ        -0.0274        -0.0269         0.0510  ARP TO L1 PHASE CENTER 
 XYZ  -2415361.2699  -2718046.5885   5222562.3386  L1 PHS CEN @ 2009.3313 
 
 BASELINE NAME:   bis5  uscg 
 XYZ         0.9053         0.7027        -1.5713  + XYZ ADJUSTMENTS 
 XYZ  -2415360.3646  -2718045.8858   5222560.7673  NEW L1 PHS CEN @ 2009.3313 
 XYZ  -2415360.3372  -2718045.8589   5222560.7163  NEW ARP @ 2009.3313 
 XYZ  -2415359.7738  -2718045.2209   5222559.4812  NEW MON @ 2009.3313 
 LLH  55 19 58.66769  228 22 28.10655      5.4148  NEW L1 PHS CEN @ 2009.3313 
 LLH  55 19 58.66777  228 22 28.10670      5.3511  NEW ARP @ 2009.3313 
 LLH  55 19 58.66769  228 22 28.10655      3.8511  NEW MON @ 2009.3313 
 
 BASELINE NAME:   lev6  uscg 
 XYZ         0.8455         0.7092        -1.5248  + XYZ ADJUSTMENTS 
 XYZ  -2415360.4245  -2718045.8793   5222560.8138  NEW L1 PHS CEN @ 2009.3313 
 XYZ  -2415360.3971  -2718045.8524   5222560.7628  NEW ARP @ 2009.3313 
 XYZ  -2415359.8336  -2718045.2144   5222559.5277  NEW MON @ 2009.3313 
 LLH  55 19 58.66761  228 22 28.10377      5.4730  NEW L1 PHS CEN @ 2009.3313 
 LLH  55 19 58.66769  228 22 28.10392      5.4093  NEW ARP @ 2009.3313 
 LLH  55 19 58.66761  228 22 28.10377      3.9093  NEW MON @ 2009.3313 
 
 BASELINE NAME:   ais5  uscg 
 XYZ         0.8950         0.7912        -1.5237  + XYZ ADJUSTMENTS 
 XYZ  -2415360.3749  -2718045.7973   5222560.8149  NEW L1 PHS CEN @ 2009.3313 
 XYZ  -2415360.3476  -2718045.7704   5222560.7639  NEW ARP @ 2009.3313 
 XYZ  -2415359.7841  -2718045.1324   5222559.5288  NEW MON @ 2009.3313 
 LLH  55 19 58.67014  228 22 28.10278      5.4202  NEW L1 PHS CEN @ 2009.3313 
 LLH  55 19 58.67022  228 22 28.10293      5.3565  NEW ARP @ 2009.3313 
 LLH  55 19 58.67014  228 22 28.10278      3.8565  NEW MON @ 2009.3313 
 
                                   G-FILES  
                                            
Axx2009 5 1   9 5 1 
B2009 5 12056   9 5 123 5 1 page5 v0810.20IGS     226 1 2 27NGS   2009 5 5IFDDFX 
Iant_info.003        NGS   20090501 
C00090001 -795615118   66 2696542751   78  945541782   67 X1219AUSCGX1219ABIS5 
D  1  2  2500896  1  3 -8353636  2  3 -3886207 
  
Axx2009 5 1   9 5 1 
B2009 5 12056   9 5 123 5 1 page5 v0810.20IGS     226 1 2 27NGS   2009 5 5IFDDFX 
Iant_info.003        NGS   20090501 
C00090002   25475536   48 1389709604   61  707226656   63 X1219AUSCGX1219ALEV6 
D  1  2  4114541  1  3 -8151359  2  3 -1359443 
  
Axx2009 5 1   9 5 1 
B2009 5 12056   9 5 123 5 1 page5 v0810.20IGS     226 1 2 27NGS   2009 5 5IFDDFX 
Iant_info.003        NGS   20090501 
C00090003 -147942441   83 -191478330   77 -167428691   87 X1219AUSCGX1219AAIS5 
D  1  2  9292636  1  3 -1168614  2  3    -2618 
 
  



                   POST-FIT RMS BY SATELLITE VS. BASELINE 
                                                          
            OVERALL     02     04     07     11     13     14     16     17 
 bis5-uscg|  0.020  0.025  0.019    ...  0.017  0.025    ...  0.028    ... 
                20     23     25     30     31     32 
 bis5-uscg|    ...  0.019  0.028    ...  0.016  0.018                      
 
            OVERALL     02     04     07     11     13     14     16     17 
 lev6-uscg|  0.012  0.022  0.015    ...  0.014  0.012    ...  0.029    ... 
                20     23     25     30     31     32 
 lev6-uscg|    ...  0.011  0.013    ...  0.010  0.010                      
 
            OVERALL     02     04     07     11     13     14     16     17 
 ais5-uscg|  0.015  0.026  0.019    ...  0.016  0.020    ...  0.024    ... 
                20     23     25     30     31     32 
 ais5-uscg|    ...  0.012  0.018    ...  0.012  0.012                      
 
                        OBS BY SATELLITE VS. BASELINE 
                                                      
            OVERALL     02     04     07     11     13     14     16     17 
 bis5-uscg|   1428     40    217    ...     85    166    ...    106    ... 
                20     23     25     30     31     32 
 bis5-uscg|    ...    256     91    ...    211    256                      
            OVERALL     02     04     07     11     13     14     16     17 
 lev6-uscg|   1441     27    221    ...     85    166    ...    131    ... 
                20     23     25     30     31     32 
 lev6-uscg|    ...    252     91    ...    212    256                      
            OVERALL     02     04     07     11     13     14     16     17 
 ais5-uscg|   1430     40    198    ...     79    159    ...    141    ... 
                20     23     25     30     31     32 
 ais5-uscg|    ...    256     89    ...    212    256                      
                                            
 
 Covariance Matrix for the xyz OPUS Position (meters2). 
    0.0000301089     0.0000018736    -0.0000015562 
    0.0000018736     0.0000349644    -0.0000005678 
   -0.0000015562    -0.0000005678     0.0000356156 
 
 Covariance Matrix for the enu OPUS Position (meters2). 
    0.0000303908    -0.0000022471     0.0000006067 
   -0.0000022471     0.0000336197    -0.0000000685 
    0.0000006067    -0.0000000685     0.0000366785 
 
 Horizontal network accuracy =    0.01384 meters. 
 Vertical network accuracy   =    0.01188 meters. 
 
  



                       Derivation of NAD 83 vector components 
 
  
  Position of reference station ARP in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Xa(m)           Ya(m)           Za(m) 
       BIS5  -2494920.44060  -2448392.05858   5317113.38841    2003.00 
       LEV6  -2412811.42529  -2579075.35282   5293281.97185    2003.00 
       AIS5  -2430153.20716  -2737194.06415   5205816.48535    2003.00 
  
  Position of reference station monument in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Xr(m)           Yr(m)           Zr(m) 
       BIS5  -2494920.44060  -2448392.05858   5317113.38841    2003.00 
       LEV6  -2412811.42529  -2579075.35282   5293281.97185    2003.00 
       AIS5  -2430153.20716  -2737194.06415   5205816.48535    2003.00 
  
  Velocity of reference station monument in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Vx (m/yr)       Vy (m/yr)       Vz (m/yr) 
       BIS5         0.00490         0.00450         0.00990 
       LEV6         0.00220         0.00120         0.00480 
       AIS5         0.00620        -0.00040         0.00060 
  
  Vectors from unknown station monument to reference station monument 
  in NAD_83(CORS96)(EPOCH:2003.0000). 
                Xr-X= DX(m)     Yr-Y= DY(m)     Zr-Z= DZ(m) 
       BIS5    -79561.49260    269654.23442     94554.05641    2003.00 
       LEV6      2547.52271    138970.94018     70722.63985    2003.00 
       AIS5    -14794.25916    -19147.77115    -16742.84665    2003.00 
 
This position and the above vector components were computed without any  
knowledge by the National Geodetic Survey regarding the equipment or  
field operating procedures used. 
 



FILE: 10541220.09o 000038259 
 
                              NGS OPUS SOLUTION REPORT 
                              ======================== 
 
All computed coordinate accuracies are listed as peak-to-peak values. 
For additional information: www.ngs.noaa.gov/OPUS/Using_OPUS.html#accuracy 
 
      USER: weston.renoud@noaa.gov                  DATE: May 06, 2009 
RINEX FILE: 1054122b.09o                            TIME: 05:56:23 UTC 
 
 
  SOFTWARE: page5  0810.20 master11.pl 081023      START: 2009/05/02  01:31:00 
 EPHEMERIS: igr15296.eph [rapid]                    STOP: 2009/05/02  03:27:30 
  NAV FILE: brdc1220.09n                        OBS USED:  4571 /  4715   :  97% 
  ANT NAME: TRM55971.00     NONE             # FIXED AMB:    28 /    29   :  97% 
ARP HEIGHT: 1.5                              OVERALL RMS: 0.012(m) 
 
 
 REF FRAME: NAD_83(CORS96)(EPOCH:2003.0000)            ITRF00 (EPOCH:2009.3318) 
       
         X:     -2415358.872(m)   0.005(m)          -2415359.721(m)   0.005(m) 
         Y:     -2718046.148(m)   0.053(m)          -2718045.044(m)   0.053(m) 
         Z:      5222559.317(m)   0.036(m)           5222559.498(m)   0.036(m) 
 
       LAT:   55 19 58.66217      0.038(m)        55 19 58.67244      0.038(m) 
     E LON:  228 22 28.17972      0.033(m)       228 22 28.10212      0.033(m) 
     W LON:  131 37 31.82028      0.033(m)       131 37 31.89788      0.033(m) 
    EL HGT:            3.770(m)   0.037(m)                 3.770(m)   0.037(m) 
 ORTHO HGT:            9.645(m)   0.125(m) [NAVD88 (Computed using GEOID06)] 
 
                        UTM COORDINATES    STATE PLANE COORDINATES 
                         UTM (Zone 09)         SPC (5001 AK 1) 
Northing (Y) [meters]     6134983.248           391423.882 
Easting (X)  [meters]      333464.461           948202.658 
Convergence  [degrees]    -2.15989552           1.69678487 
Point Scale                0.99994023           0.99990058 
Combined Factor            0.99993964           0.00000000 
 
US NATIONAL GRID DESIGNATOR:  9UUB3346434983(NAD 83) 
 
 
 
                              BASE STATIONS USED 
PID       DESIGNATION                        LATITUDE    LONGITUDE DISTANCE(m) 
DK6423 BIS5 BIORKA ISLAND 5 CORS ARP       N565116.162 W1353221.387  296620.7 
DJ3035 LEV6 LEVEL ISLAND 6 CORS ARP        N562756.364 W1330532.511  155952.1 
DK6482 AIS5 ANNETTE ISLAND 5 CORS ARP      N550408.647 W1313558.255   29425.1 
 
                 NEAREST NGS PUBLISHED CONTROL POINT 
AI4914      BM NO 37                       N551958.661 W1313731.819       0.0 
 
  



                          BASE STATION INFORMATION  
                                                    
 STATION NAME: bis5  a    2 (Biorka Island 5; Biorka Island, Alaska  USA) 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2494921.0833  -2448390.9914   5317113.6533  MON @ 1997.0000 (M) 
 XYZ        -0.0164         0.0037         0.0005  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0034        -0.0019         0.0813  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0037        -0.0015         0.0689  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.2022         0.0456         0.0062  VEL TIMES 12.3318 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0351        -0.0318         0.0662  ARP TO L1 PHASE CENTER 
 XYZ  -2494921.3206  -2448390.9775   5317113.7257  L1 PHS CEN @ 2009.3318 
 XYZ        -0.0000        -0.0000         0.0000  + XYZ ADJUSTMENTS 
 XYZ  -2494921.3206  -2448390.9775   5317113.7257  NEW L1 PHS CEN @ 2009.3318 
 XYZ  -2494921.2855  -2448390.9458   5317113.6595  NEW ARP @ 2009.3318 
 XYZ  -2494921.2855  -2448390.9458   5317113.6595  NEW MON @ 2009.3318 
 LLH  56 51 16.17151  224 27 38.53076     66.8349  NEW L1 PHS CEN @ 2009.3318 
 LLH  56 51 16.17162  224 27 38.53087     66.7536  NEW ARP @ 2009.3318 
 LLH  56 51 16.17162  224 27 38.53087     66.7536  NEW MON @ 2009.3318 
 
 STATION NAME: lev6  a    2 (Level Island 6; Level Island, Alaska  USA) 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2412812.0457  -2579074.2577   5293282.2476  MON @ 1997.0000 (M) 
 XYZ        -0.0190         0.0003        -0.0044  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0034        -0.0019         0.0813  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0037        -0.0015         0.0689  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.2343         0.0037        -0.0543  VEL TIMES 12.3318 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0340        -0.0336         0.0659  ARP TO L1 PHASE CENTER 
 XYZ  -2412812.3140  -2579074.2876   5293282.2592  L1 PHS CEN @ 2009.3318 
 XYZ        -0.0000         0.0000         0.0000  + XYZ ADJUSTMENTS 
 XYZ  -2412812.3140  -2579074.2876   5293282.2592  NEW L1 PHS CEN @ 2009.3318 
 XYZ  -2412812.2800  -2579074.2540   5293282.1933  NEW ARP @ 2009.3318 
 XYZ  -2412812.2800  -2579074.2540   5293282.1933  NEW MON @ 2009.3318 
 LLH  56 27 56.37384  226 54 27.40784     25.4801  NEW L1 PHS CEN @ 2009.3318 
 LLH  56 27 56.37395  226 54 27.40796     25.3988  NEW ARP @ 2009.3318 
 LLH  56 27 56.37395  226 54 27.40796     25.3988  NEW MON @ 2009.3318 
 
 STATION NAME: ais5  a    2 (Annette Island 5; Annette Island, Alaska  USA) 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2430153.8469  -2737192.9494   5205816.7670  MON @ 1997.0000 (M) 
 XYZ        -0.0147        -0.0013        -0.0087  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0034        -0.0019         0.0813  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0037        -0.0015         0.0689  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.1813        -0.0160        -0.1073  VEL TIMES 12.3318 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0342        -0.0356         0.0647  ARP TO L1 PHASE CENTER 
 XYZ  -2430154.0624  -2737193.0011   5205816.7244  L1 PHS CEN @ 2009.3318 
 XYZ         0.0000         0.0000         0.0000  + XYZ ADJUSTMENTS 
 XYZ  -2430154.0624  -2737193.0011   5205816.7244  NEW L1 PHS CEN @ 2009.3318 
 XYZ  -2430154.0282  -2737192.9654   5205816.6597  NEW ARP @ 2009.3318 
 XYZ  -2430154.0282  -2737192.9654   5205816.6597  NEW MON @ 2009.3318 
 LLH  55  4  8.65794  228 24  1.66886     32.4119  NEW L1 PHS CEN @ 2009.3318 
 LLH  55  4  8.65805  228 24  1.66897     32.3306  NEW ARP @ 2009.3318 
 LLH  55  4  8.65805  228 24  1.66897     32.3306  NEW MON @ 2009.3318 
 
  



                         REMOTE STATION INFORMATION 
                                                    
 STATION NAME: 1054       1 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2415360.1829  -2718045.5883   5222560.7616  MON @ 2009.3317 (M) 
 NEU        -0.0016        -0.0007         1.5000  MON TO ARP (M) 
 NEU         0.0016         0.0007         0.0850  ARP TO L1 PHASE CENTER (M) 
 NEU         0.0008         0.0012         0.0701  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.5681        -0.6383         1.2328  MON TO ARP 
 XYZ        -0.0307        -0.0356         0.0708  ARP TO L1 PHASE CENTER 
 XYZ  -2415360.7818  -2718046.2622   5222562.0652  L1 PHS CEN @ 2009.3318 
 
 BASELINE NAME:   bis5  1054 
 XYZ         0.4618         0.5681        -1.2792  + XYZ ADJUSTMENTS 
 XYZ  -2415360.3200  -2718045.6941   5222560.7861  NEW L1 PHS CEN @ 2009.3318 
 XYZ  -2415360.2893  -2718045.6585   5222560.7152  NEW ARP @ 2009.3318 
 XYZ  -2415359.7211  -2718045.0202   5222559.4824  NEW MON @ 2009.3318 
 LLH  55 19 58.67263  228 22 28.10122      5.3319  NEW L1 PHS CEN @ 2009.3318 
 LLH  55 19 58.67258  228 22 28.10118      5.2469  NEW ARP @ 2009.3318 
 LLH  55 19 58.67263  228 22 28.10122      3.7469  NEW MON @ 2009.3318 
 
 BASELINE NAME:   lev6  1054 
 XYZ         0.4650         0.5483        -1.2431  + XYZ ADJUSTMENTS 
 XYZ  -2415360.3167  -2718045.7139   5222560.8221  NEW L1 PHS CEN @ 2009.3318 
 XYZ  -2415360.2860  -2718045.6783   5222560.7513  NEW ARP @ 2009.3318 
 XYZ  -2415359.7179  -2718045.0400   5222559.5185  NEW MON @ 2009.3318 
 LLH  55 19 58.67296  228 22 28.10211      5.3687  NEW L1 PHS CEN @ 2009.3318 
 LLH  55 19 58.67290  228 22 28.10207      5.2837  NEW ARP @ 2009.3318 
 LLH  55 19 58.67296  228 22 28.10211      3.7837  NEW MON @ 2009.3318 
 
 BASELINE NAME:   ais5  1054 
 XYZ         0.4596         0.5153        -1.2692  + XYZ ADJUSTMENTS 
 XYZ  -2415360.3222  -2718045.7469   5222560.7960  NEW L1 PHS CEN @ 2009.3318 
 XYZ  -2415360.2915  -2718045.7113   5222560.7252  NEW ARP @ 2009.3318 
 XYZ  -2415359.7233  -2718045.0730   5222559.4924  NEW MON @ 2009.3318 
 LLH  55 19 58.67172  228 22 28.10312      5.3634  NEW L1 PHS CEN @ 2009.3318 
 LLH  55 19 58.67167  228 22 28.10308      5.2784  NEW ARP @ 2009.3318 
 LLH  55 19 58.67172  228 22 28.10312      3.7784  NEW MON @ 2009.3318 
 
                                   G-FILES  
                                            
Axx2009 5 2   9 5 2 
B2009 5 2 130   9 5 2 327 1 page5 v0810.20IGS     226 1 2 27NGS   2009 5 6IFDDFX 
Iant_info.003        NGS   20090501 
C00090001 -795615644   35 2696540744   64  945541770   54 X1229A1054X1229ABIS5 
D  1  2  5925660  1  3 -7873734  2  3 -3932368 
  
Axx2009 5 2   9 5 2 
B2009 5 2 130   9 5 2 327 1 page5 v0810.20IGS     226 1 2 27NGS   2009 5 6IFDDFX 
Iant_info.003        NGS   20090501 
C00090002   25474379   48 1389707860  105  707226749   74 X1229A1054X1229ALEV6 
D  1  2  8548113  1  3 -6918825  2  3 -5342543 
  
Axx2009 5 2   9 5 2 
B2009 5 2 130   9 5 2 327 1 page5 v0810.20IGS     226 1 2 27NGS   2009 5 6IFDDFX 
Iant_info.003        NGS   20090501 
C00090003 -147943048   35 -191478924   46 -167428327   63 X1229A1054X1229AAIS5 
D  1  2  8769931  1  3 -7728950  2  3 -8819178 
 
  



                   POST-FIT RMS BY SATELLITE VS. BASELINE 
                                                          
            OVERALL     03     06     07     08     10     13     15     16 
 bis5-1054|  0.012  0.012    ...    ...  0.007  0.012  0.011  0.013    ... 
                19     23     24     25     28 
 bis5-1054|  0.014  0.013    ...  0.010  0.011                             
 
            OVERALL     03     06     07     08     10     13     15     16 
 lev6-1054|  0.012  0.014    ...    ...  0.007  0.011  0.012  0.017    ... 
                19     23     24     25     28 
 lev6-1054|  0.016  0.011    ...  0.010  0.010                             
 
            OVERALL     03     06     07     08     10     13     15     16 
 ais5-1054|  0.012  0.013    ...    ...  0.008  0.012  0.013  0.015    ... 
                19     23     25     28 
 ais5-1054|  0.015  0.013  0.010  0.012                                    
 
                        OBS BY SATELLITE VS. BASELINE 
                                                      
            OVERALL     03     06     07     08     10     13     15     16 
 bis5-1054|   1534    165    ...    ...    233    224    190     62    ... 
                19     23     24     25     28 
 bis5-1054|    204     50    ...    233    173                             
            OVERALL     03     06     07     08     10     13     15     16 
 lev6-1054|   1486    165    ...    ...    233    215    193     62    ... 
                19     23     24     25     28 
 lev6-1054|    202     50    ...    233    133                             
            OVERALL     03     06     07     08     10     13     15     16 
 ais5-1054|   1551    164    ...    ...    233    217    202     62    ... 
                19     23     25     28 
 ais5-1054|    221     51    233    168                                    
                                            
 
 Covariance Matrix for the xyz OPUS Position (meters2). 
    0.0000105644     0.0000015661    -0.0000012555 
    0.0000015661     0.0000383044    -0.0000017924 
   -0.0000012555    -0.0000017924     0.0000274689 
 
 Covariance Matrix for the enu OPUS Position (meters2). 
    0.0000212492    -0.0000110088     0.0000079720 
   -0.0000110088     0.0000255317    -0.0000008251 
    0.0000079720    -0.0000008251     0.0000295569 
 
 Horizontal network accuracy =    0.01224 meters. 
 Vertical network accuracy   =    0.01066 meters. 
 
  



                       Derivation of NAD 83 vector components 
 
  
  Position of reference station ARP in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Xa(m)           Ya(m)           Za(m) 
       BIS5  -2494920.44060  -2448392.05858   5317113.38841    2003.00 
       LEV6  -2412811.42529  -2579075.35282   5293281.97185    2003.00 
       AIS5  -2430153.20716  -2737194.06415   5205816.48535    2003.00 
  
  Position of reference station monument in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Xr(m)           Yr(m)           Zr(m) 
       BIS5  -2494920.44060  -2448392.05858   5317113.38841    2003.00 
       LEV6  -2412811.42529  -2579075.35282   5293281.97185    2003.00 
       AIS5  -2430153.20716  -2737194.06415   5205816.48535    2003.00 
  
  Velocity of reference station monument in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Vx (m/yr)       Vy (m/yr)       Vz (m/yr) 
       BIS5         0.00490         0.00450         0.00990 
       LEV6         0.00220         0.00120         0.00480 
       AIS5         0.00620        -0.00040         0.00060 
  
  Vectors from unknown station monument to reference station monument 
  in NAD_83(CORS96)(EPOCH:2003.0000). 
                Xr-X= DX(m)     Yr-Y= DY(m)     Zr-Z= DZ(m) 
       BIS5    -79561.56860    269654.08942     94554.07141    2003.00 
       LEV6      2547.44671    138970.79518     70722.65485    2003.00 
       AIS5    -14794.33516    -19147.91615    -16742.83165    2003.00 
 
This position and the above vector components were computed without any  
knowledge by the National Geodetic Survey regarding the equipment or  
field operating procedures used. 



 FILE: 10661210.09o 000038258 
 
                              NGS OPUS SOLUTION REPORT 
                              ======================== 
 
All computed coordinate accuracies are listed as peak-to-peak values. 
For additional information: www.ngs.noaa.gov/OPUS/Using_OPUS.html#accuracy 
 
      USER: weston.renoud@noaa.gov                  DATE: May 06, 2009 
RINEX FILE: 1066121x.09o                            TIME: 05:55:21 UTC 
 
 
  SOFTWARE: page5  0810.20 master29.pl 081023      START: 2009/05/01  23:15:00 
 EPHEMERIS: igr15295.eph [rapid]                    STOP: 2009/05/02  01:23:00 
  NAV FILE: brdc1210.09n                        OBS USED:  4958 /  5204   :  95% 
  ANT NAME: TRM55971.00     NONE             # FIXED AMB:    31 /    37   :  84% 
ARP HEIGHT: 1.5                              OVERALL RMS: 0.013(m) 
 
 
 REF FRAME: NAD_83(CORS96)(EPOCH:2003.0000)            ITRF00 (EPOCH:2009.3315) 
       
         X:     -2415358.876(m)   0.004(m)          -2415359.725(m)   0.004(m) 
         Y:     -2718046.200(m)   0.072(m)          -2718045.096(m)   0.072(m) 
         Z:      5222559.312(m)   0.019(m)           5222559.493(m)   0.019(m) 
 
       LAT:   55 19 58.66097      0.058(m)        55 19 58.67125      0.058(m) 
     E LON:  228 22 28.18151      0.045(m)       228 22 28.10391      0.045(m) 
     W LON:  131 37 31.81849      0.045(m)       131 37 31.89609      0.045(m) 
    EL HGT:            3.789(m)   0.017(m)                 3.789(m)   0.017(m) 
 ORTHO HGT:            9.664(m)   0.121(m) [NAVD88 (Computed using GEOID06)] 
 
                        UTM COORDINATES    STATE PLANE COORDINATES 
                         UTM (Zone 09)         SPC (5001 AK 1) 
Northing (Y) [meters]     6134983.210           391423.846 
Easting (X)  [meters]      333464.491           948202.691 
Convergence  [degrees]    -2.15989510           1.69678528 
Point Scale                0.99994023           0.99990058 
Combined Factor            0.99993963           0.00000000 
 
US NATIONAL GRID DESIGNATOR:  9UUB3346434983(NAD 83) 
 
 
 
                              BASE STATIONS USED 
PID       DESIGNATION                        LATITUDE    LONGITUDE DISTANCE(m) 
DK6423 BIS5 BIORKA ISLAND 5 CORS ARP       N565116.162 W1353221.387  296620.8 
DJ3035 LEV6 LEVEL ISLAND 6 CORS ARP        N562756.364 W1330532.511  155952.2 
DK6482 AIS5 ANNETTE ISLAND 5 CORS ARP      N550408.647 W1313558.255   29425.1 
 
                 NEAREST NGS PUBLISHED CONTROL POINT 
AI4914      BM NO 37                       N551958.661 W1313731.819       0.0 
 
 
  



                          BASE STATION INFORMATION  
                                                    
 STATION NAME: bis5  a    2 (Biorka Island 5; Biorka Island, Alaska  USA) 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2494921.0833  -2448390.9914   5317113.6533  MON @ 1997.0000 (M) 
 XYZ        -0.0164         0.0037         0.0005  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0034        -0.0019         0.0813  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0037        -0.0015         0.0689  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.2022         0.0456         0.0062  VEL TIMES 12.3316 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0351        -0.0318         0.0662  ARP TO L1 PHASE CENTER 
 XYZ  -2494921.3206  -2448390.9775   5317113.7257  L1 PHS CEN @ 2009.3315 
 XYZ         0.0000        -0.0000        -0.0000  + XYZ ADJUSTMENTS 
 XYZ  -2494921.3206  -2448390.9776   5317113.7257  NEW L1 PHS CEN @ 2009.3315 
 XYZ  -2494921.2855  -2448390.9458   5317113.6595  NEW ARP @ 2009.3315 
 XYZ  -2494921.2855  -2448390.9458   5317113.6595  NEW MON @ 2009.3315 
 LLH  56 51 16.17151  224 27 38.53076     66.8349  NEW L1 PHS CEN @ 2009.3315 
 LLH  56 51 16.17162  224 27 38.53087     66.7536  NEW ARP @ 2009.3315 
 LLH  56 51 16.17162  224 27 38.53087     66.7536  NEW MON @ 2009.3315 
 
 STATION NAME: lev6  a    2 (Level Island 6; Level Island, Alaska  USA) 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2412812.0457  -2579074.2577   5293282.2476  MON @ 1997.0000 (M) 
 XYZ        -0.0190         0.0003        -0.0044  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0034        -0.0019         0.0813  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0037        -0.0015         0.0689  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.2343         0.0037        -0.0543  VEL TIMES 12.3316 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0340        -0.0336         0.0659  ARP TO L1 PHASE CENTER 
 XYZ  -2412812.3140  -2579074.2876   5293282.2592  L1 PHS CEN @ 2009.3315 
 XYZ         0.0000        -0.0000        -0.0000  + XYZ ADJUSTMENTS 
 XYZ  -2412812.3140  -2579074.2876   5293282.2592  NEW L1 PHS CEN @ 2009.3315 
 XYZ  -2412812.2800  -2579074.2540   5293282.1933  NEW ARP @ 2009.3315 
 XYZ  -2412812.2800  -2579074.2540   5293282.1933  NEW MON @ 2009.3315 
 LLH  56 27 56.37384  226 54 27.40784     25.4801  NEW L1 PHS CEN @ 2009.3315 
 LLH  56 27 56.37395  226 54 27.40796     25.3988  NEW ARP @ 2009.3315 
 LLH  56 27 56.37395  226 54 27.40796     25.3988  NEW MON @ 2009.3315 
 
 STATION NAME: ais5  a    2 (Annette Island 5; Annette Island, Alaska  USA) 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2430153.8469  -2737192.9494   5205816.7670  MON @ 1997.0000 (M) 
 XYZ        -0.0147        -0.0013        -0.0087  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0034        -0.0019         0.0813  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0037        -0.0015         0.0689  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.1813        -0.0160        -0.1073  VEL TIMES 12.3316 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0342        -0.0356         0.0647  ARP TO L1 PHASE CENTER 
 XYZ  -2430154.0624  -2737193.0011   5205816.7244  L1 PHS CEN @ 2009.3315 
 XYZ         0.0000        -0.0000         0.0000  + XYZ ADJUSTMENTS 
 XYZ  -2430154.0624  -2737193.0011   5205816.7244  NEW L1 PHS CEN @ 2009.3315 
 XYZ  -2430154.0282  -2737192.9654   5205816.6597  NEW ARP @ 2009.3315 
 XYZ  -2430154.0282  -2737192.9654   5205816.6597  NEW MON @ 2009.3315 
 LLH  55  4  8.65794  228 24  1.66886     32.4119  NEW L1 PHS CEN @ 2009.3315 
 LLH  55  4  8.65805  228 24  1.66897     32.3306  NEW ARP @ 2009.3315 
 LLH  55  4  8.65805  228 24  1.66897     32.3306  NEW MON @ 2009.3315 
 
  



                         REMOTE STATION INFORMATION 
                                                    
 STATION NAME: 1066       1 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2415360.3732  -2718045.6145   5222560.7825  MON @ 2009.3314 (M) 
 NEU        -0.0016        -0.0007         1.5000  MON TO ARP (M) 
 NEU         0.0016         0.0007         0.0850  ARP TO L1 PHASE CENTER (M) 
 NEU         0.0008         0.0012         0.0701  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.5681        -0.6383         1.2328  MON TO ARP 
 XYZ        -0.0307        -0.0356         0.0708  ARP TO L1 PHASE CENTER 
 XYZ  -2415360.9721  -2718046.2884   5222562.0861  L1 PHS CEN @ 2009.3315 
 
 BASELINE NAME:   bis5  1066 
 XYZ         0.6505         0.5484        -1.2812  + XYZ ADJUSTMENTS 
 XYZ  -2415360.3216  -2718045.7400   5222560.8049  NEW L1 PHS CEN @ 2009.3315 
 XYZ  -2415360.2908  -2718045.7043   5222560.7341  NEW ARP @ 2009.3315 
 XYZ  -2415359.7227  -2718045.0661   5222559.5013  NEW MON @ 2009.3315 
 LLH  55 19 58.67204  228 22 28.10288      5.3675  NEW L1 PHS CEN @ 2009.3315 
 LLH  55 19 58.67198  228 22 28.10284      5.2825  NEW ARP @ 2009.3315 
 LLH  55 19 58.67204  228 22 28.10288      3.7825  NEW MON @ 2009.3315 
 
 BASELINE NAME:   lev6  1066 
 XYZ         0.6466         0.4762        -1.3003  + XYZ ADJUSTMENTS 
 XYZ  -2415360.3255  -2718045.8122   5222560.7858  NEW L1 PHS CEN @ 2009.3315 
 XYZ  -2415360.2948  -2718045.7766   5222560.7150  NEW ARP @ 2009.3315 
 XYZ  -2415359.7266  -2718045.1383   5222559.4822  NEW MON @ 2009.3315 
 LLH  55 19 58.67018  228 22 28.10544      5.3840  NEW L1 PHS CEN @ 2009.3315 
 LLH  55 19 58.67013  228 22 28.10540      5.2990  NEW ARP @ 2009.3315 
 LLH  55 19 58.67018  228 22 28.10544      3.7990  NEW MON @ 2009.3315 
 
 BASELINE NAME:   ais5  1066 
 XYZ         0.6477         0.5316        -1.2860  + XYZ ADJUSTMENTS 
 XYZ  -2415360.3244  -2718045.7568   5222560.8001  NEW L1 PHS CEN @ 2009.3315 
 XYZ  -2415360.2937  -2718045.7212   5222560.7293  NEW ARP @ 2009.3315 
 XYZ  -2415359.7255  -2718045.0829   5222559.4965  NEW MON @ 2009.3315 
 LLH  55 19 58.67156  228 22 28.10340      5.3718  NEW L1 PHS CEN @ 2009.3315 
 LLH  55 19 58.67151  228 22 28.10336      5.2868  NEW ARP @ 2009.3315 
 LLH  55 19 58.67156  228 22 28.10340      3.7868  NEW MON @ 2009.3315 
 
                                   G-FILES  
                                            
Axx2009 5 1   9 5 2 
B2009 5 12315   9 5 2 123 1 page5 v0810.20IGS     226 1 2 27NGS   2009 5 6IFDDFX 
Iant_info.003        NGS   20090501 
C00090001 -795615628   39 2696541203   52  945541582   57 X1219A1066X1219ABIS5 
D  1  2  5936586  1  3 -9007484  2  3 -5245597 
  
Axx2009 5 1   9 5 2 
B2009 5 12315   9 5 2 123 1 page5 v0810.20IGS     226 1 2 27NGS   2009 5 6IFDDFX 
Iant_info.003        NGS   20090501 
C00090002   25474467   53 1389708843   69  707227111   69 X1219A1066X1219ALEV6 
D  1  2  7879129  1  3 -8769746  2  3 -5475035 
  
Axx2009 5 1   9 5 2 
B2009 5 12315   9 5 2 123 1 page5 v0810.20IGS     226 1 2 27NGS   2009 5 6IFDDFX 
Iant_info.003        NGS   20090501 
C00090003 -147943027   41 -191478825   47 -167428368   50 X1219A1066X1219AAIS5 
D  1  2  9402615  1  3 -8031189  2  3 -8318564 
 
  



                   POST-FIT RMS BY SATELLITE VS. BASELINE 
                                                          
            OVERALL     02     03     04     06     07     08     10     13 
 bis5-1066|  0.013  0.017  0.022  0.012    ...  0.011  0.018  0.015    ... 
                16     20     23     24     25     31     32 
 bis5-1066|  0.013  0.011  0.010    ...  0.007    ...  0.026               
 
            OVERALL     02     03     04     06     07     08     10     13 
 lev6-1066|  0.012  0.016  0.021  0.012    ...  0.010  0.015  0.015    ... 
                16     20     23     24     25     31     32 
 lev6-1066|  0.014  0.013  0.009    ...  0.007    ...  0.027               
 
            OVERALL     02     03     04     06     07     08     10     13 
 ais5-1066|  0.012  0.018  0.019  0.015    ...  0.009  0.017  0.017    ... 
                16     20     23     25     31     32 
 ais5-1066|  0.013  0.014  0.009  0.008    ...    ...                      
 
                        OBS BY SATELLITE VS. BASELINE 
                                                      
            OVERALL     02     03     04     06     07     08     10     13 
 bis5-1066|   1700    197     54    111    ...    254    105     92    ... 
                16     20     23     24     25     31     32 
 bis5-1066|    244    118    254    ...    254    ...     17               
            OVERALL     02     03     04     06     07     08     10     13 
 lev6-1066|   1702    197     35    111    ...    254    105     95    ... 
                16     20     23     24     25     31     32 
 lev6-1066|    245    129    251    ...    254    ...     26               
            OVERALL     02     03     04     06     07     08     10     13 
 ais5-1066|   1556     70     67     98    ...    254    104     77    ... 
                16     20     23     25     31     32 
 ais5-1066|    245    133    254    254    ...    ...                      
                                            
 
 Covariance Matrix for the xyz OPUS Position (meters2). 
    0.0000133578     0.0000013105    -0.0000015235 
    0.0000013105     0.0000214978    -0.0000013592 
   -0.0000015235    -0.0000013592     0.0000233556 
 
 Covariance Matrix for the enu OPUS Position (meters2). 
    0.0000156481    -0.0000033255     0.0000020278 
   -0.0000033255     0.0000186598     0.0000012414 
    0.0000020278     0.0000012414     0.0000239032 
 
 Horizontal network accuracy =    0.01018 meters. 
 Vertical network accuracy   =    0.00959 meters. 
 
  



                       Derivation of NAD 83 vector components 
 
  
  Position of reference station ARP in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Xa(m)           Ya(m)           Za(m) 
       BIS5  -2494920.44060  -2448392.05858   5317113.38841    2003.00 
       LEV6  -2412811.42529  -2579075.35282   5293281.97185    2003.00 
       AIS5  -2430153.20716  -2737194.06415   5205816.48535    2003.00 
  
  Position of reference station monument in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Xr(m)           Yr(m)           Zr(m) 
       BIS5  -2494920.44060  -2448392.05858   5317113.38841    2003.00 
       LEV6  -2412811.42529  -2579075.35282   5293281.97185    2003.00 
       AIS5  -2430153.20716  -2737194.06415   5205816.48535    2003.00 
  
  Velocity of reference station monument in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Vx (m/yr)       Vy (m/yr)       Vz (m/yr) 
       BIS5         0.00490         0.00450         0.00990 
       LEV6         0.00220         0.00120         0.00480 
       AIS5         0.00620        -0.00040         0.00060 
  
  Vectors from unknown station monument to reference station monument 
  in NAD_83(CORS96)(EPOCH:2003.0000). 
                Xr-X= DX(m)     Yr-Y= DY(m)     Zr-Z= DZ(m) 
       BIS5    -79561.56460    269654.14142     94554.07641    2003.00 
       LEV6      2547.45071    138970.84718     70722.65985    2003.00 
       AIS5    -14794.33116    -19147.86415    -16742.82665    2003.00 
 
This position and the above vector components were computed without any  
knowledge by the National Geodetic Survey regarding the equipment or  
field operating procedures used. 



Dive Completed: April 22, 2009 (DN112)
Location: Lake Washington, Seattle, Washington

Latitude - 47/39/01.97N Longitude - 22/16/17.32W
Divers: ENS Glen Rice, ENS Mark Andrews, SST Adam Argento & LTjg Caryn Arnold
DLDG S/N: 68337
CTD S/N: 4616
Surface Pressure (mb): 1021
Surface Gauge Reading (psia): 14.78

Lead Line 
(M)

1st DLDG 
reading (psia)

2nd DLDG 
reading (psia)

Average 
(psia)

Computed 
Depth (M)

1 16.04 16.23 16.14 1.03
2 17.57 17.64 17.61 2.06
3 19.02 19.08 19.05 3.07
4 20.43 20.48 20.46 4.07
5 21.86 21.90 21.88 5.06
6 23.25 - 23.25 6.02

Notes:

Divers Least Depth Gauge Report

The dive was completed on DN112 and the cast used for this report was from DN107.  (SVP file 09107175)

Report Prepared by: LTjg Arnold





NOAA Ship FAIRWEATHER
LASER RANGEFINDER Accuracy test

Testing date: 04/13/2009, 04/22/2009
Testing personnel: Mark Andrews, Matthew Andring, Annie Raymond, Patricia Raymond, Glen Rice

Trial
Actual 

Distance
LR 001481 
Distance

LR  
000676 

Distance
Actual 
Height

LR 001481 
Height

LR  
000676 
Height

1 10 10.1 10.1 2.0 2.1 2.0
2 10 10.0 10.0 2.0 2.0 2.0
3 10 10.0 10.0 2.0 2.0 2.0
4 20 20.1 20.2 2.0 2.1 2.1
5 20 20.1 20.1 2.0 2.0 2.0
6 20 20.1 20.1 2.0 2.1 2.1
7 50 50.0 50.1 2.0 2.0 1.8
8 50 50.1 50.1 2.0 2.1 1.9
9 50 50.1 50.0 2.0 1.8 1.9

10 100 100.1 100.2 2.0 2.0 2.1
11 100 100.0 100.1 2.0 2.0 2.0
12 100 100.2 100.1 2.0 1.8 1.7

Trial
Actual 

Distance
LR i0929 
Distance

Actual 
Height

LR i0929 
Height

1 10 9.94 1.0 1.10
2 10 9.93 1.0 0.98
3 10 9.95 1.0 1.06
4 20 19.91 1.0 1.07
5 20 19.90 1.0 1.11
6 20 19.88 1.0 0.96
7 50 49.92 1.0 0.94
8 50 49.90 1.0 0.93
9 50 49.88 1.0 1.04

10 100 99.90 1.0 1.19
11 100 99.89 1.0 1.06
12 100 99.89 1.0 1.08

LR = Laser Rangefinder
All distances are measured in meters.





Checked by: AR

Lead Line Corrector
(c = b - a)

-0.008

-0.008

-0.008

-0.01

-0.013

-0.015

-0.016

-0.017

-0.018

-0.02

Average Correction -0.0133

0.004547282

Lead Line & Sounding Pole Calibration Report

Standard Deviation

9.98

9

10

Date of Calibration: 4/20/09

8.982

2 1.992

3 2.992

7 6.984

4 3.99

Field unit: FA

1 0.992

Measured by: AR/LS Recorded by: AR

Graduated Marking
(a)

Chief of Party: CDR Baird              

Lead Line / Sounding Pole Unit of Measure:  Meters (measured from bottom of lead to bottom of mark)

Method of Calibration:                  x Steel tape          � Permanent graduation marks          �  
Other

Lead Line / Sounding Pole Identification Number:
Line 10-01-05 w/ lead 20-05

8 7.983

6 5.985

Calibration Measurement
(b)

Location: Seattle, WA

5 4.987



Checked by:  DF

Lead Line Corrector
(c = b - a)

0

-0.005

-0.01

-0.115

-0.118

-0.26

-0.033

-0.038

-0.045

-0.054

Average Correction -0.0678

0.079147963

Method of Calibration:                  x Steel tape          � Permanent graduation marks          �  
Other

Location: Seattle, WA

Lead Line & Sounding Pole Calibration Report
Field unit: FA

Lead Line / Sounding Pole Identification Number: 10_5_09

Date of Calibration: 4/27/09

3 2.99

Chief of Party: CDR Baird              

Lead Line / Sounding Pole Unit of Measure:  Meters (measured from bottom of lead to bottom of mark)

Measured by:DF/BN Recorded by: DF

Graduated Marking
(a)

Calibration Measurement
(b)

1 1

2 1.995

9 8.955

4 3.885

5 4.882

6 5.74

7 6.967

8 7.962

10 9.946

Standard Deviation



Checked by: AR

Lead Line Corrector
(c = b - a)

0

-0.01

-0.11

-0.024

-0.03

-0.035

-0.045

-0.05

-0.055

-0.06

Average Correction -0.0419

0.030722594

Calibration Measurement
(b)

Location: Seattle, WA

5 4.97

8 7.95

6 5.965

Field unit: FA

1 1

Measured by: AR/LS Recorded by: AR

Graduated Marking
(a)

Chief of Party: CDR Baird              

Lead Line / Sounding Pole Unit of Measure:  Meters (measured from bottom of lead to bottom of mark)

Method of Calibration:                  x Steel tape          � Permanent graduation marks          �  
Other

Lead Line / Sounding Pole Identification Number:
Line 10-02-05 w/ lead 10-02-04

Date of Calibration: 4/20/09

8.945

2 1.99

3 2.89

7 6.955

4 3.976

Lead Line & Sounding Pole Calibration Report

Standard Deviation

9.94

9

10



Checked by: 

Lead Line Corrector
(c = b - a)

0.021
0.002
-0.007
-0.012
-0.009
-0.002
-0.006
-0.005
-0.006
-0.009
-0.007
-0.008
-0.012
-0.014
-0.016
-0.017
-0.018
-0.014
-0.019
-0.014

Average Correction -0.0086
0.008875751

17 16.982

20 19.986

18 17.986
19 18.981

10 9.991
11 10.993
12 11.992

14

8 7.995
9 8.994

Standard Deviation

13 12.988

14.984
16 15.983

13.986
15

7 6.994

5 4.991
6 5.998

1 1.021
2 2.002
3 2.993
4 3.988

Method of Calibration:                  x Steel tape          � Permanent graduation marks          �  Other

Location: Seattle, WA

Chief of Party: CDR Baird              

Lead Line / Sounding Pole Unit of Measure:  Meters (measured from bottom of lead to bottom of mark)

Measured by: DF/BN Recorded by: DF

Graduated Marking
(a)

Calibration Measurement
(b)

Lead Line & Sounding Pole Calibration Report
Field unit: FA

Lead Line / Sounding Pole Identification Number:  
20_01_05 (Lead 10_02_04)

Date of Calibration: 4/28/2009



Checked by:  

Lead Line Corrector
(c = b - a)

0.004
-0.002
-0.008
-0.012
-0.02

-0.026
-0.03

-0.033
-0.038
-0.045
-0.0113
-0.011
-0.015
-0.015
-0.013
-0.015
-0.015
-0.013
-0.01
-0.01

Average Correction -0.016915
0.011978809Standard Deviation

7 6.97
8 7.967
9 8.962

10 9.955

3 2.992
4 3.988
5 4.98
6 5.974

Measured by:  DF/BN/JL Recorded by: DF

Graduated Marking
(a)

Calibration Measurement
(b)

1 1.004
2 1.998

Lead Line & Sounding Pole Calibration Report
Field unit: FA

Lead Line / Sounding Pole Identification Number: 20_02_05

Date of Calibration:04/28/2009

Method of Calibration:                  x Steel tape          � Permanent graduation marks          �  
Other

Location: Seattle, WA

Chief of Party: CDR Baird              

Lead Line / Sounding Pole Unit of Measure:  Meters (measured from bottom of lead to bottom of mark)

17 16.985

13 12.985

16 15.985

14 13.985
15 14.987

11 10.9887
12 11.989

20 19.99

18 17.987
19 18.99



Checked by: 

Lead Line Corrector
(c = b - a)

-0.002
-0.025
-0.027
-0.004
-0.035
-0.039
-0.034
-0.041
-0.045
-0.048
-0.042
-0.047
-0.046
-0.051
-0.051
-0.05

-0.052
-0.049
-0.032
-0.026
-0.024
-0.047
-0.044
-0.035
-0.045
-0.047
-0.05

-0.044
-0.049
-0.043

Average Correction -0.03
0.015937377

Method of Calibration:                  x Steel tape          � Permanent graduation marks          �  
Other

Location: Seattle, WA

Chief of Party: CDR Baird              

Lead Line / Sounding Pole Unit of Measure:  Meters (measured from bottom of lead to bottom of mark)

Lead Line & Sounding Pole Calibration Report
Field unit: FA

Lead Line / Sounding Pole Identification Number:   30_01_03 (Lead 10_02_04)

Date of Calibration: 04/28/2009

1 0.998
2 1.975

Measured by: DF/BN/MA Recorded by: DF

Graduated Marking
(a)

Calibration Measurement
(b)

5 4.965
6 5.961

3 2.973
4 3.996

9 8.955
10 9.952

7 6.966
8 7.959

24 23.965

Standard Deviation

25.953

28 27.956

11 10.958
12 11.953

23 22.956

25 24.955
26

16 15.95

29 28.951
30 29.957

27 26.95

13 12.954
14 13.949
15 14.949

21 20.976

17 16.948
18 17.951

22 21.953

19 18.968
20 19.974



SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4585
CALIBRATION DATE: 24-Dec-08 

SBE19plus TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

 
ITS-90 COEFFICIENTS

a0 =  1.152958e-003

a1 =  2.769577e-004

a2 = -1.238595e-006

a3 =  1.923712e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            686671.898             1.0001              0.0001

   4.5000            613990.153             4.4999             -0.0001

  15.0000            430449.356            15.0002              0.0002

  18.5000            380356.864            18.4999             -0.0001

  24.0000            311746.237            24.0000             -0.0000

  29.0001            259029.610            29.0000             -0.0001

  32.5000            226970.136            32.5001              0.0001

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2
(R)] + a3[ln

3
(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4585
CALIBRATION DATE: 24-Dec-08 

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 
COEFFICIENTS:

g = -1.030096e+000

h =  1.490529e-001

i = -1.755436e-004

j =  3.495131e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2630.81     0.0000      0.00000

   1.0000    34.9056    2.98287    5188.24     2.9829      0.00001

   4.5000    34.8856    3.29062    5382.83     3.2906     -0.00001

  15.0000    34.8424    4.27448    5961.81     4.2745     -0.00002

  18.5000    34.8329    4.62033    6152.16     4.6203      0.00000

  24.0000    34.8221    5.17939    6447.70     5.1794      0.00002

  29.0001    34.8149    5.70213    6711.97     5.7021      0.00001

  32.5000    34.8105    6.07509    6894.15     6.0751     -0.00001

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2
 + if

3
 + jf

4
) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4585
CALIBRATION DATE: 29-Dec-08 

SBE19plus PRESSURE CALIBRATION DATA
 5076 psia S/N 5433

 
COEFFICIENTS:

PA0 =    5.029148e-001

PA1 =    1.546002e-002

PA2 =   -6.698233e-010

PTEMPA0 = -6.561551e+001

PTEMPA1 =  5.126876e+001

PTEMPA2 = -2.271790e-001

PTCA0 =  5.087931e+005

PTCA1 = -1.387413e+000

PTCA2 =  1.147553e-001

PTCB0 =  2.398063e+001

PTCB1 = -2.075000e-003

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.43 509698.5   1.6       14.38  -0.00         32.50     1.93   509770.31

 1026.03 575213.9   1.6     1025.77  -0.01         29.00     1.86   509746.37

 2037.81 641125.8   1.6     2037.49  -0.01         24.00     1.76   509720.20

 3049.21 707405.4   1.6     3049.00  -0.00         18.50     1.65   509705.55

 4061.89 774171.3   1.6     4061.98   0.00         15.00     1.58   509700.64

 5073.45 841224.4   1.6     5073.30  -0.00          4.50     1.38   509686.80

 4060.64 774087.2   1.6     4060.79   0.00          1.00     1.31   509690.08

 3049.89 707478.4   1.6     3050.21   0.01

 2037.97 641159.4   1.6     2038.09   0.00         TEMP(ITS90)   SPAN(mV)

 1026.00 575237.5   1.6     1026.17   0.00            -5.00       23.99

   14.44 509714.6   1.6       14.59   0.00            35.00       23.91

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2
)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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SEA-BIRD ELECTRONICS, INC.
1808 - 136th Place Northeast, Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 53036

Model Number SBE 19Plus

Date of Report: 12/29/2008

Serial Number: 19P36026-4585

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to conductivity. 

Users must choose whether the 'as received'  calibration or the previous calibration better  represents the sensor condition 

during  deployment.  In SEASOFT enter the chosen coefficients using the program SEACON.  The coefficient 'slope' 

allows small corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained 

after a repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 12/24/2008 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00020 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Customer: Pacific Marine Center / NOAA

Job Number: 53036

Model Number SBE 19Plus

Date of Report: 12/29/2008

Serial Number: 19P36026-4585

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 12/24/2008 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00040 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  If 

the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients using the program  SEACON.  The coefficient 'offset' 

allows a small correction for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients 

obtained after a repair apply only to subsequent data.

SEA-BIRD ELECTRONICS, INC.
1808 - 136th Place Northeast, Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4616
CALIBRATION DATE: 30-Dec-08 

SBE19plus TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

 
ITS-90 COEFFICIENTS

a0 =  1.281404e-003

a1 =  2.533926e-004

a2 =  1.063479e-006

a3 =  1.058343e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            622339.390             1.0001              0.0001

   4.5000            552555.458             4.4998             -0.0002

  15.0000            379373.339            14.9999             -0.0001

  18.5000            332879.949            18.5004              0.0004

  24.0000            269786.136            24.0000              0.0000

  29.0000            221773.322            28.9995             -0.0005

  32.5001            192769.169            32.5004              0.0003

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2
(R)] + a3[ln

3
(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4616
CALIBRATION DATE: 30-Dec-08 

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 
COEFFICIENTS:

g = -1.045676e+000

h =  1.453624e-001

i = -2.792262e-004

j =  4.047864e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2686.32     0.0000      0.00000

   1.0000    34.6635    2.96415    5258.47     2.9642      0.00001

   4.5000    34.6435    3.27002    5454.79     3.2700     -0.00001

  15.0000    34.6004    4.24792    6039.09     4.2479     -0.00000

  18.5000    34.5912    4.59172    6231.25     4.5917     -0.00001

  24.0000    34.5806    5.14743    6529.62     5.1474      0.00001

  29.0000    34.5733    5.66698    6796.43     5.6670      0.00001

  32.5001    34.5689    6.03772    6980.38     6.0377     -0.00001

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2
 + if

3
 + jf

4
) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4616
CALIBRATION DATE: 23-Dec-08 

SBE19plus PRESSURE CALIBRATION DATA
 1450 psia S/N 5512

 
COEFFICIENTS:

PA0 =    8.151393e-001

PA1 =    4.427036e-003

PA2 =   -1.489407e-011

PTEMPA0 = -7.628063e+001

PTEMPA1 =  4.917975e+001

PTEMPA2 = -2.452670e-001

PTCA0 =  5.204151e+005

PTCA1 =  1.499910e+001

PTCA2 = -2.797969e-001

PTCB0 =  2.473825e+001

PTCB1 =  5.000000e-005

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.56 523716.6   2.0       14.62   0.00         32.50     2.24   523831.27

  300.91 588379.6   2.0      300.80  -0.01         29.00     2.16   523832.41

  587.28 653125.0   2.0      587.23  -0.00         24.00     2.06   523825.60

  873.71 717921.0   2.0      873.75   0.00         18.50     1.95   523815.10

 1160.12 782709.1   2.0     1160.11  -0.00         15.00     1.87   523797.80

 1446.59 847531.7   2.0     1446.51  -0.01          4.50     1.66   523711.29

 1160.83 782900.4   2.0     1160.96   0.01          1.00     1.58   523637.33

  587.26 653145.1   2.0      587.32   0.00

  300.86 588375.3   2.0      300.78  -0.01         TEMP(ITS90)   SPAN(mV)

   14.56 523715.6   2.0       14.61   0.00            -5.00       24.74

                                                        35.00       24.74

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2
)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS

-0.50

-0.25

0.00

0.25

0.50

0 250 500 750 1000 1250 1500

R
e

s
id

u
a

l,
 (

%
 F

S
R

)

Pressure (PSIA)

23-Dec-08    -0.00



Customer: Pacific Marine Center / NOAA

Job Number: 53036

Model Number SBE 19Plus

Date of Report: 12/30/2008

Serial Number: 19P36026-4616

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 12/30/2008 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00077 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  If 

the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients using the program  SEACON.  The coefficient 'offset' 

allows a small correction for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients 

obtained after a repair apply only to subsequent data.

SEA-BIRD ELECTRONICS, INC.
1808 - 136th Place Northeast, Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



SEA-BIRD ELECTRONICS, INC.
1808 - 136th Place Northeast, Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 53036

Model Number SBE 19Plus

Date of Report: 12/30/2008

Serial Number: 19P36026-4616

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to conductivity. 

Users must choose whether the 'as received'  calibration or the previous calibration better  represents the sensor condition 

during  deployment.  In SEASOFT enter the chosen coefficients using the program SEACON.  The coefficient 'slope' 

allows small corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained 

after a repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 12/30/2008 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00010 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4617
CALIBRATION DATE: 20-Dec-08 

SBE19plus TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

 
ITS-90 COEFFICIENTS

a0 =  1.246846e-003

a1 =  2.697109e-004

a2 = -7.052860e-007

a3 =  1.823959e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            585630.424             0.9999             -0.0001

   4.5000            518793.136             4.5001              0.0001

  15.0000            354138.373            15.0001              0.0001

  18.5000            310211.898            18.4997             -0.0003

  24.0000            250739.695            24.0003              0.0003

  29.0000            205606.492            29.0000             -0.0000

  32.5000            178394.119            32.5000             -0.0000

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2
(R)] + a3[ln

3
(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4617
CALIBRATION DATE: 20-Dec-08 

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 
COEFFICIENTS:

g = -1.000141e+000

h =  1.279500e-001

i = -2.981125e-004

j =  3.615456e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2801.87     0.0000      0.00000

   1.0000    34.8741    2.98043    5589.41     2.9804     -0.00000

   4.5000    34.8541    3.28794    5800.77     3.2879      0.00000

  15.0000    34.8109    4.27102    6429.24     4.2710      0.00000

  18.5000    34.8011    4.61657    6635.72     4.6166      0.00000

  24.0000    34.7896    5.17509    6956.19     5.1751     -0.00000

  29.0000    34.7810    5.69719    7242.59     5.6972     -0.00001

  32.5000    34.7748    6.06957    7439.93     6.0696      0.00001

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2
 + if

3
 + jf

4
) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4617
CALIBRATION DATE: 23-Dec-08 

SBE19plus PRESSURE CALIBRATION DATA
 1450 psia S/N 5513

 
COEFFICIENTS:

PA0 =   -6.055955e-001

PA1 =    4.445261e-003

PA2 =   -1.492962e-011

PTEMPA0 = -7.890859e+001

PTEMPA1 =  4.909915e+001

PTEMPA2 = -3.861224e-001

PTCA0 =  5.192474e+005

PTCA1 = -1.257329e+001

PTCA2 =  2.871586e-001

PTCB0 =  2.460838e+001

PTCB1 =  6.750000e-004

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.56 522528.9   2.0       14.57   0.00         32.50     2.31   522669.88

  300.91 586983.0   2.0      300.87  -0.00         29.00     2.24   522666.19

  587.28 651477.4   2.0      587.23  -0.00         24.00     2.13   522662.57

  873.71 716034.6   2.0      873.74   0.00         18.50     2.02   522651.21

 1160.12 780599.0   2.0     1160.16   0.00         15.00     1.94   522650.29

 1446.59 845193.3   2.0     1446.58  -0.00          4.50     1.72   522724.31

 1160.83 780743.0   2.0     1160.80  -0.00          1.00     1.65   522781.82

  587.26 651494.2   2.0      587.30   0.00

  300.86 586980.7   2.0      300.86   0.00         TEMP(ITS90)   SPAN(mV)

   14.56 522528.9   2.0       14.57   0.00            -5.00       24.61

                                                        35.00       24.63

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2
)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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Customer: Pacific Marine Center / NOAA

Job Number: 53036

Model Number SBE 19Plus

Date of Report: 12/22/2008

Serial Number: 19P36026-4617

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 12/20/2008 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00088 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  If 

the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients using the program  SEACON.  The coefficient 'offset' 

allows a small correction for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients 

obtained after a repair apply only to subsequent data.

SEA-BIRD ELECTRONICS, INC.
1808 - 136th Place Northeast, Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



SEA-BIRD ELECTRONICS, INC.
1808 - 136th Place Northeast, Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 53036

Model Number SBE 19Plus

Date of Report: 12/22/2008

Serial Number: 19P36026-4617

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to conductivity. 

Users must choose whether the 'as received'  calibration or the previous calibration better  represents the sensor condition 

during  deployment.  In SEASOFT enter the chosen coefficients using the program SEACON.  The coefficient 'slope' 

allows small corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained 

after a repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 12/20/2008 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00020 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 6121
CALIBRATION DATE: 28-Aug-08 

SBE19plus TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

 
ITS-90 COEFFICIENTS

a0 =  1.289081e-003

a1 =  2.567873e-004

a2 =  1.103918e-007

a3 =  1.347008e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            648503.186             1.0001              0.0001

   4.5000            575581.220             4.4999             -0.0001

  15.0000            394150.390            15.0001              0.0001

  18.5000            345412.610            18.5001              0.0001

  24.0000            279302.814            24.0000             -0.0000

  29.0001            229064.831            28.9999             -0.0002

  32.5000            198774.661            32.5001              0.0001

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2
(R)] + a3[ln

3
(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 6121
CALIBRATION DATE: 28-Aug-08 

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 
COEFFICIENTS:

g = -1.002097e+000

h =  1.438184e-001

i = -5.214257e-004

j =  5.901932e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2648.58     0.0000      0.00000

   1.0000    34.8850    2.98128    5283.22     2.9813      0.00003

   4.5000    34.8648    3.28885    5482.95     3.2888     -0.00002

  15.0000    34.8213    4.27216    6076.87     4.2721     -0.00002

  18.5000    34.8119    4.61785    6272.01     4.6178     -0.00000

  24.0000    34.8011    5.17661    6574.84     5.1766      0.00002

  29.0001    34.7946    5.69917    6845.52     5.6992      0.00002

  32.5000    34.7904    6.07198    7032.01     6.0720     -0.00002

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2
 + if

3
 + jf

4
) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 6121
CALIBRATION DATE: 26-Aug-08 

SBE19plus PRESSURE CALIBRATION DATA
  870 psia S/N 2752079

 
COEFFICIENTS:

PA0 =   -6.478769e-001

PA1 =    2.639452e-003

PA2 =    1.757831e-011

PTEMPA0 = -6.128910e+001

PTEMPA1 =  5.471751e+001

PTEMPA2 = -5.689142e-001

PTCA0 =  5.247839e+005

PTCA1 = -1.748425e+001

PTCA2 =  2.632259e-001

PTCB0 =  2.511463e+001

PTCB1 = -1.075000e-003

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.68 530344.0   1.5       14.69   0.00         32.50     1.75   530426.41

  179.95 592865.0   1.5      179.94  -0.00         29.00     1.68   530439.09

  359.94 660894.0   1.5      359.90  -0.00         24.00     1.59   530454.71

  539.94 728875.0   1.5      539.90  -0.00         18.50     1.48   530483.73

  719.93 796800.0   1.5      719.91  -0.00         15.00     1.42   530518.13

  874.90 855228.0   1.5      874.89  -0.00          4.50     1.22   530644.39

  719.95 796828.0   1.5      719.99   0.00          1.00     1.15   530705.47

  539.97 728912.0   1.5      540.00   0.00

  359.97 660927.0   1.5      359.99   0.00         TEMP(ITS90)   SPAN(mV)

  179.96 592874.0   1.5      179.97   0.00            -5.00       25.12

   14.69 530337.0   1.5       14.68  -0.00            35.00       25.08

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2
)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 6122
CALIBRATION DATE: 28-Aug-08 

SBE19plus TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

 
ITS-90 COEFFICIENTS

a0 =  1.310924e-003

a1 =  2.514962e-004

a2 =  7.231185e-007

a3 =  1.086082e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            640421.220             1.0002              0.0002

   4.5000            567849.949             4.4997             -0.0003

  15.0000            387722.085            15.0001              0.0001

  18.5000            339446.305            18.5003              0.0003

  24.0000            274051.763            23.9999             -0.0001

  29.0001            224421.051            28.9998             -0.0003

  32.5000            194523.508            32.5002              0.0002

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2
(R)] + a3[ln

3
(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 6122
CALIBRATION DATE: 28-Aug-08 

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 
COEFFICIENTS:

g = -9.949806e-001

h =  1.571158e-001

i = -4.874166e-004

j =  6.173091e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2523.23     0.0000      0.00000

   1.0000    34.8850    2.98128    5044.97     2.9813     -0.00000

   4.5000    34.8648    3.28885    5236.00     3.2888     -0.00000

  15.0000    34.8213    4.27216    5803.96     4.2722      0.00001

  18.5000    34.8119    4.61785    5990.56     4.6178     -0.00000

  24.0000    34.8011    5.17661    6280.15     5.1766      0.00000

  29.0001    34.7946    5.69917    6539.03     5.6992     -0.00000

  32.5000    34.7904    6.07198    6717.42     6.0720      0.00000

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2
 + if

3
 + jf

4
) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 6122
CALIBRATION DATE: 26-Aug-08 

SBE19plus PRESSURE CALIBRATION DATA
  870 psia S/N 2752080

 
COEFFICIENTS:

PA0 =   -1.047938e-001

PA1 =    2.635617e-003

PA2 =    2.031440e-011

PTEMPA0 = -6.085315e+001

PTEMPA1 =  5.350080e+001

PTEMPA2 = -1.784269e-001

PTCA0 =  5.243776e+005

PTCA1 =  1.680541e-001

PTCA2 = -1.070257e-001

PTCB0 =  2.507825e+001

PTCB1 = -5.500000e-004

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.68 529945.0   1.5       14.68   0.00         32.50     1.75   530023.07

  179.95 592575.0   1.5      179.92  -0.00         29.00     1.69   530041.09

  359.94 660723.0   1.5      359.90  -0.00         24.00     1.60   530065.44

  539.94 728813.0   1.5      539.91  -0.00         18.50     1.49   530093.22

  719.93 796824.0   1.5      719.90  -0.00         15.00     1.43   530105.65

  874.90 855331.0   1.5      874.89  -0.00          4.50     1.23   530137.68

  719.95 796862.0   1.5      720.00   0.01          1.00     1.16   530118.67

  539.97 728851.0   1.5      540.01   0.00

  359.97 660760.0   1.5      359.99   0.00         TEMP(ITS90)   SPAN(mV)

  179.96 592598.0   1.5      179.98   0.00            -5.00       25.08

   14.69 529948.0   1.5       14.69   0.00            35.00       25.06

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2
)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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Applied Microsystems 
2071 Malaview Avenue 

Sidney, B.C.   V8L 5X6   CANADA 
Tel: +1-250-656-0771   Fax: +1-250-655-3655 

 
 

004986 Certificate of Calibration 
 
 
Customer:                        NOAA - Pacific Marine Center 
 
Asset Serial Number:   004986 
 
Asset Type:    004986 (Smart SV&P) 
 
Calibrated Pressure Range: 1000 dBar 
 

 
 
 
Certification Date:   02/10/2008 (dd/mm/yyyy) 
 
Certified By:   

 
Robert Haydock,  
President 
Applied Microsystems

   
Applied Microsystems certifies that the equipment described above has been calibrated with 
equipment referenced to traceable standards.  Any repairs / calibrations completed on this 
instrument were approved by the instrument owner under purchase order.   
 
This instrument has been recalibrated.  Please be sure to update your records.  Please also ensure 
that you update the instrument’s coefficient values in any post-processing software (ie. Smart Talk) 
that you use.  Instrument configuration files are available at our Client Service & Support Portal 
(see web address below). 
 
For a complete service history of this instrument, please consult our on-line Client Service & 
Support Portal at http://www.appliedmicrosystems.com/customers/index.htm 



Sound Velocity Calibration

Coefficients

A=1.521719E+3

B=-1.065195E+2

C=8.413916E+0

D=-7.328216E-1

m/s=A+B*((NH-N)/(NH-NL))+C*((NH-N)/(NH-NL))^2+D*((NH-N)/(NH-NL))^3

2071 Malaview Ave West, Sidney, British Columbia, Canada V8L 5X6

Phone: (250) 656-0771 Fax: (250) 655-3655

Canada & USA: 800-663-8721

Email: info@AppliedMicrosystems.com Web: http://www.aml.bc.ca

Date:

Instrument SN:

Calibrator:  

RMS Error:  

Range:  

9/23/2008

004986

Les Woodland

0.018

1400 to 1550 m/s



Pressure Calibration

Coefficients

A=-1.774596E+3  G=-3.214595E-7

B=9.062190E-2  H=9.150362E-9

C=2.005744E-2  I=-1.404551E-8

D=-3.298937E-4  J=3.282178E-10

E=5.909598E-2  K=-4.517941E-12

F=-7.414152E-6  L=-5.695738E-14

dBar=A+B*T+C*T^2+D*T^3+(E+F*T+G*T^2+H*T^3)*Raw+(I+J*T+K*T^2+L*T^3)*Raw^2

2071 Malaview Ave West, Sidney, British Columbia, Canada V8L 5X6

Phone: (250) 656-0771 Fax: (250) 655-3655

Canada & USA: 800-663-8721

Email: info@AppliedMicrosystems.com Web: http://www.aml.bc.ca

Date ( mm/dd/yy ):

Instrument SN:

Calibrator:  

RMS Error:  

Range:  

09/30/08

004986

Les Woodland

0.086

1000 dBar









 

Applied Microsystems certifies that the above described equipment has been tested in accordance 
with the product’s technical specifications, brochures, and / or relevant drawings.  Applied 
Microsystems certifies that calibrations on this instrument have been completed with equipment 
reference to traceable standards. 
 
Instrument configuration files and soft copy certificates are available at Applied Microsystems 
Client Service and Support Portal at http://www.appliedmicrosystems.com/customers/index.htm 
 

Applied Microsystems 
2071 Malaview Avenue 

Sidney, B.C.   V8L 5X6   CANADA 
Tel: +1-250-656-0771   Fax: +1-250-655-3655 

 

005466 Certificate of Conformity 
 
 
Customer:  NOAA Ship Fairweather  
 
Our Reference: Project 14065 NOAA Ship Fairweather; Smart SV&P-MVP (Sept-

08) 
 
Customer Purchase Order: Phone Order 
 
Asset Serial Number:   005466 
 
Asset Type:    005466 (Smart SV&P for Brooke MVP) 
  
Calibrated Pressure Range: 1000 dBar 
 
Additional Description: RS 485 communication at 19200 baud 
 

 
 
Certification Date:   30/10/2008 (dd/mm/yyyy) 
 
Certified By:   

 
Robert Haydock,  
President 
Applied Microsystems 
 
 



Sound Velocity Calibration

Coefficients

A=1.533131E+3

B=-1.137455E+2

C=1.040759E+1

D=-1.332106E+0

m/s=A+B*((NH-N)/(NH-NL))+C*((NH-N)/(NH-NL))^2+D*((NH-N)/(NH-NL))^3

2071 Malaview Ave West, Sidney, British Columbia, Canada V8L 5X6

Phone: (250) 656-0771 Fax: (250) 655-3655

Canada & USA: 800-663-8721

Email: info@AppliedMicrosystems.com Web: http://www.aml.bc.ca

Date (mm/dd/yy):

Instrument SN:

Calibrator:  

RMS Error:  

Range:  

30/10/08

005466

Matt Tradewell

0.020

1400 to 1550 m/s



Pressure Calibration

Coefficients

A=-1.238729E+3  G=-1.128182E-6

B=-3.145002E-1  H=1.415759E-8

C=3.012141E-2  I=-4.262089E-9

D=-3.571170E-4  J=-1.925685E-10

E=4.398952E-2  K=1.080000E-11

F=2.278661E-5  L=-1.832266E-13

dBar=A+B*T+C*T^2+D*T^3+(E+F*T+G*T^2+H*T^3)*Raw+(I+J*T+K*T^2+L*T^3)*Raw^2

2071 Malaview Ave West, Sidney, British Columbia, Canada V8L 5X6

Phone: (250) 656-0771 Fax: (250) 655-3655

Canada & USA: 800-663-8721

Email: info@AppliedMicrosystems.com Web: http://www.aml.bc.ca

Date:

Instrument SN:

Calibrator:  

RMS Error:  

Range:  

10/23/2008

005466

Matt Tradewell

0.0604

1000 dBar



AML Calibration Equipment 

Temperature Calibrations 

Performed using either of two Hart Scientific "Black Stack" Model 1560 Power Bases with attached 
Hart Scientific Model 2563 Thermistor Modules connected to a Thermometrics AS125 4 Wire 
Thermistor Standard

1: Hart Scientfic  Power Base 1560 S/N 79263 /  Thermistor Module  2563 S/N 79039 / 
Thermometrics AS125 4  Wire Thermistor Standard S/N 2131
2: Hart Scientfic power Base 1560 S/N A05690 / Thermistor Module 2563 S/N A05693 / 
Thermometrics AS125 4 Wire Thermistor Standard S/N 2128

Temperature calibration equipment is calibrated yearly and verified bi-monthly as per Applied 
Microsystems Ltd. Calibration Schedule T11.2 utilizing a Hart Scientific Model 5901 Triple Point of 
Water Cell. All temperature calibrations and verifications are ITS-90 and NIST traceable

Pressure Calibrations  

Performed using a Budenburg Model 380D S/N 18564 Range 0-8000 psi Deadweight Tester. 
Calibrations and verifications are implemented as per Applied Microsystems Ltd. Calibration 
Schedule T11.2. All pressure calibrations and verifications are NIST traceable.

Conductivity Calibrations  

Performed using either of two Guildline 8400B  S/N 59251 or Guildline 8400  S/N  43385 Autosals. 
Both Conductivity Calibrators are calibrated and verified using Ocean Scientific International IAPSO 
Standard Seawater as per Applied Microsystems ltd. Calibration Schedule T11.2. All Conductivity 
Calibrations and verifications are NIST traceable

Battery Channel Calibrations  

Performed using a Precision Fluke Model 45 Multimeter S/N 4720162. Calibrations and verifications 
are implemented as per Applied Microsystems Ltd. Calibration Schedule T11.2 All calibrations and 
verifications are NIST traceable.
 
Sound Velocity Calibrations 

Performed using an Applied Microsystems Ltd Temperature Standard  S/N 9998 in distilled water, 
<5 ppm TDS, and sound velocity reference is Del Grosso and Mader's Pure Water Equation. 
Calibrations and verifications are implemented as per Applied Microsystems Ltd. Calibration 
Schedule T11.2 All temperature calibrations and verifications are ITS-90 and NIST traceable. 



SVP Test and Calibration certificate

SVP Type : SVP70 Date of issue : 01-04-2009

SVP Serial No. 4008077

Functionality Test : Sign : ___________________________

Temperature Calibration : Hart 1504 s/n A6B554 & Thermistor s/n 3014

Point 1: 4.6 °C

Point 2: 16.5 °C

Point 3: 25.5 °C

Pressure Calibration : Custom Built Tank (TestUnit ASF150 Ser# 41-10-0007-R03)

Point 1: 0 Bar

Point 2: 301.7 Bar

Point 3: 603.6 Bar

RMS Speed of Sound Errors

Temperature Validation : 0.0033 m/s

Pressure Validation : 0.0845 m/s

Calibration Completed : Sign : ___________________________

Final Function Test : Sign : ___________________________

QA Signature : Inits : ______________



SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 0117
CALIBRATION DATE: 08-Jan-08 

SBE 45 CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 
COEFFICIENTS:

g = -1.031942e+000

h =  1.269033e-001

i = -2.218276e-004

j =  3.318496e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

WBOTC = -3.1803e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2855.80    0.00000      0.00000

   1.0000    34.7807    2.97321    5622.31    2.97324      0.00003

   4.4999    34.7610    3.28001    5832.94    3.27999     -0.00003

  14.9999    34.7176    4.26078    6459.57    4.26076     -0.00001

  18.5000    34.7080    4.60555    6665.57    4.60555     -0.00000

  24.0000    34.6969    5.16282    6985.35    5.16285      0.00002

  29.0000    34.6902    5.68399    7271.30    5.68399      0.00001

  32.4999    34.6851    6.05568    7468.33    6.05567     -0.00001

 

f = INST FREQ * sqrt(1.0 + WBOTC * t) / 1000.0

Conductivity = (g + hf
2
 + if

3
 + jf

4
) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 0117
CALIBRATION DATE: 11-Dec-07 

SBE 45 CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 
COEFFICIENTS:

g = -1.029836e+000

h =  1.264890e-001

i = -1.244736e-004

j =  2.698268e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

WBOTC = -3.1803e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2854.99    0.00000      0.00000

   1.0000    35.7009    3.04425    5671.69    3.04426      0.00001

   4.5000    35.6792    3.35798    5885.14    3.35797     -0.00001

  15.0000    35.6327    4.36100    6519.96    4.36099     -0.00001

  18.5000    35.6226    4.71361    6728.60    4.71359     -0.00002

  23.9999    35.6111    5.28357    7052.48    5.28361      0.00003

  29.0000    35.6023    5.81635    7341.91    5.81634     -0.00001

  32.5001    35.5947    6.19615    7541.26    6.19615     -0.00000

 

f = INST FREQ * sqrt(1.0 + WBOTC * t) / 1000.0

Conductivity = (g + hf
2
 + if

3
 + jf

4
) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 0117
CALIBRATION DATE: 08-Jan-08 

SBE 45 TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

 
ITS-90 COEFFICIENTS

a0 = -2.444687e-004

a1 =  3.101067e-004

a2 = -4.608202e-006

a3 =  2.066460e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                                OUTPUT                                    (ITS-90)                                  (ITS-90)

   1.0000             825687.0             1.0001              0.0001

   4.4999             708009.0             4.4998             -0.0001

  14.9999             455003.1            15.0000              0.0001

  18.5000             395051.1            18.5000              0.0000

  24.0000             318250.6            23.9999             -0.0001

  29.0000             263033.5            29.0000             -0.0000

  32.4999             230938.9            32.4999              0.0000

 

Temperature ITS-90 = 1/{a0 + a1[ln(n)] + a2[ln
2
(n)] + a3[ln

3
(n)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 0117
CALIBRATION DATE: 11-Dec-07 

SBE 45 TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

 
ITS-90 COEFFICIENTS

a0 = -1.865866e-004

a1 =  2.970047e-004

a2 = -3.621420e-006

a3 =  1.819198e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                                OUTPUT                                    (ITS-90)                                  (ITS-90)

   1.0000             825650.8             1.0001              0.0001

   4.5000             707981.6             4.4999             -0.0001

  15.0000             455000.0            15.0002              0.0002

  18.5000             395058.3            18.4998             -0.0002

  23.9999             318252.4            24.0001              0.0002

  29.0000             263036.0            28.9998             -0.0002

  32.5001             230933.8            32.5002              0.0001

 

Temperature ITS-90 = 1/{a0 + a1[ln(n)] + a2[ln
2
(n)] + a3[ln

3
(n)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)

-0.08

-0.04

0.00

0.04

0.08

-5 0 5 10 15 20 25 30 35

R
e

s
id

u
a

l,
 (

D
e

g
re

e
s
 C

)

Temperature, Degrees C

23-Dec-06  -33.75
11-Dec-07    0.00



SEA-BIRD ELECTRONICS, INC.
1808 - 136th Place Northeast, Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 48749

Model Number SBE 45

Date of Report: 1/8/2008

Serial Number: 4536628-0117

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients using the program SEACON.  The 

coefficient 'slope' allows small corrections for drift between calibrations (consult the SEASOFT manual).  Calibration 

coefficients obtained after a repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 12/11/2007 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00150 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/8/2008 Drift sinceDrift sinceDrift sinceDrift since N/A PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Customer: Pacific Marine Center / NOAA

Job Number: 48749

Model Number SBE 45

Date of Report: 1/8/2008

Serial Number: 4536628-0117

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 12/11/2007 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.03490 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/8/2008 Drift sinceDrift sinceDrift sinceDrift since N/A Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  If 

the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients using the program  SEACON.  The coefficient 'offset' 

allows a small correction for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients 

obtained after a repair apply only to subsequent data.

SEA-BIRD ELECTRONICS, INC.
1808 - 136th Place Northeast, Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report













Appendix VI 
 
 
Correspondence 
 
 

• PPK DDSSM Permission 
• FA Hydrographic Resolution Waiver Request 
• FA Hydrographic Resolution Waiver Acceptance 

 



----- Original Message -----
From  Briana.Welton@noaa.gov
Date  Thu, 23 Apr 2009 17:06:02 -0700
To  CO.Fairweather@noaa.gov, XO.Fairweather@noaa.gov
Subject  Fwd: Re: Dynamic draft using PPK

----- Original Message -----
From  Olivia.Hauser@noaa.gov
Date  Thu, 23 Apr 2009 09:14:31 -0700
To  Olivia Hauser <Olivia.Hauser@noaa.gov>
Cc  Edward.J.Vandenameele@noaa.gov, "Jack L. Riley" 
<Jack.Riley@noaa.gov>, Glen Rice <Glen.Rice@noaa.gov>, Grant Froelich 
<Grant.Froelich@noaa.gov>, Steve Brodet <Steve.Brodet@noaa.gov>, 
FOO.Thomas.Jefferson@noaa.gov, FOO Rainier <FOO.Rainier@noaa.gov>, 
FOO.Fairweather@noaa.gov, Briana Welton <Briana.Welton@noaa.gov>, 'Corey
Allen' <Corey.Allen@noaa.gov>
Subject  Re: Dynamic draft using PPK

Hello All,

I spoke with EJ who conferred with Jeff Ferguson and they both agreed 
that if you decide to use the PPK method to determine dynamic draft on 
your vessel, include it in the HSRRs with the following information and 
they will be approved. Please include a statement that it is a deviation
from the FPM, what you did to get your values and a comparison to either
previous dynamic draft tables or one obtained concurrently using an 
approved method. (Basically the write-ups you already have). The HSRRs 
will be approved with the deviation, and we'll work on getting the FPM 
updated for next year.

V/R, Olivia

----- Original Message -----
From: Olivia Hauser <olivia.hauser@noaa.gov>
Date: Tuesday, April 21, 2009 12:08 pm
Subject: Dynamic draft using PPK
To: edward.j.vandenameele@noaa.gov, "Jack L. Riley" 
<Jack.Riley@noaa.gov>,  Glen Rice <Glen.Rice@noaa.gov>, Grant Froelich 
<Grant.Froelich@noaa.gov>,  Steve Brodet <Steve.Brodet@noaa.gov>, 
foo.thomas.jefferson@noaa.gov, FOO Rainier <FOO.Rainier@noaa.gov>,  
foo.fairweather@noaa.gov, Briana Welton <Briana.Welton@noaa.gov>,  
'Corey Allen' <Corey.Allen@noaa.gov>

> LCDR van den Ameele,
> 
>  This is a follow-up to our phone conversation the other day. Both FA
> and
>  RA have tested the use of PPK to determine the dynamic draft for
> their
>  vessels with positive results. Currently the FPM states that this is
> not
>  a valid method to determine dynamic draft. Can we change that? I have
>
>  attached the two write ups/reports that were created from these
> tests.
>  The only major item of concern here is the removal of tide. Both of
> the
>  test cases were conducted in areas where tide is negligible which



> made
>  the use of this data easy. It may noe be as simple in areas with
> large
>  tidal fluctuations. Is there a way we can remove tide from the SBET
>  (Jack or Steve)? Also, ENS Rice wrote the python script that created
> the
>  final curves and graphs in both reports. It might be in our best
>  interest to include these in pydro or provide them in another form to
>
>  all the field units if they decide to use this method.
> 
>  I recommend that we change the FPM to include this method as an
>  acceptable method to calculate dynamic draft.
> 
>  V/R, Olivia
> 
>  --
>  LTJG Olivia Hauser
>  NOAA HSTP Field Support Liaison, East
>  439 W. York Street, Norfolk, VA 23510
>  Voice: 757-441-6319 x 105
>  Fax: 757-441-6601
>  Cell: 302-229-3368
>  olivia.hauser@noaa.gov
>  



                                                        

UNITED STATES DEPARTMENT OF COMMERCE 
National Oceanic and Atmospheric Administration 
NOAA Marine and Aviation Operations 
NOAA Ship Fairweather S-220 
1010 Stedman Street 
Ketchikan, AK 99901 
 

            May 8, 2009 
 
 
MEMORANDUM FOR: Jeffery Ferguson 
    Chief, Hydrographic Surveys Division 
 
 
FROM:   CDR Douglas D. Baird, Jr., NOAA 
    Commanding Officer, NOAA Ship Fairweather 
 
SUBJECT:   Waiver from HTD 2009-02 specifications 
 
Fairweather personnel have examined 2009 reference surface and project related data with the 
Hydrographic Technical Directive 2009-02 CUBE criteria and specifications in mind, and 
have determined that adhering to those specifications would be an onerous task. 
 
In order to meet the HTD 2009-02 criteria for complete coverage surveys for the 2, 4, & 8 
meter grid resolutions the survey launches would have to clutch-in and clutch-out of gear to 
move slowly enough and the ship would be reduced to bare steerage and significantly reduced 
swath coverages.   
 
I am willing to slow the platforms down to six knots speed over ground – this is just a touch 
over clutch-in speed on Fairweather’s two survey launches, and allows the ship to maintain 
positive control for most conditions.  And we will reduce the swath coverage to 50º off nadir 
to both port and starboard. 
 
I propose the following grid resolutions for the 2009 calendar year projects, using at least 5 
soundings per node, at 6 knots, displaying 50º off nadir: 
 
0 to 23 meters …………. 1 meter grid resolution 
18 to 40 meters …........... 2 meter grid resolution 
35 to 80 meters ………... 4 meter grid resolution 
75 to 160 meters .……… 8 meter grid resolution 
155+ meters …………  16 meter grid resolution 
 
Since it is very rare for Fairweather to be required to conduct object detection surveys, this 
waiver request is strictly for complete coverage multibeam surveys.   
 

 



                                                        
 

 

UNITED STATES DEPARTMENT OF COMMERCE 
National Oceanic and Atmospheric Administration 
NATIONAL OCEAN SERVICE 
Office of Coast Survey 
Silver Spring, Maryland 20910-3282 

19 May 2009 
 
 
MEMORANDUM FOR:  Commander Douglas D. Baird Jr., NOAA 
  Commanding Officer, NOAA Ship Fairweather 

  
FROM: Jeffrey Ferguson 

Chief, Hydrographic Surveys Division 
 

SUBJECT: Waiver from HTD 2009-02 Specifications 
 
The NOAA Ship Fairweather’s waiver, dated May 8, 2009, requesting a departure from the grid 
resolution requirements specified in Hydrographic Technical Directive 2009-02 is approved.   
 
The NOAA Ship Fairweather will use the following grid resolutions for complete coverage 
multibeam on 2009 calendar year surveys, obtaining at least 5 soundings per node: 
 
0 to 23 meters…………………1 meter grid resolution 
18 to 40 meters………………..2 meter grid resolution 
35 to 80 meters………………..4 meter grid resolution 
75 to 160 meters………………8 meter grid resolution 
155+ meters………………….16 meter grid resolution 
 
 
cc Chiefs; OPS, PHB, AHB 
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